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Disclaimer

This document and its contents, including the viewpoints, dates and functional content expressed herein are the
proprietary copyrighted property of Epicor Software Corporation, are intended for informational purposes only and
are believed to be accurate as of its date of publication. However, Epicor Software Corporation makes no guarantee,
representations or warranties with regard to the enclosed information and specifically disclaims any applicable implied
warranties, such as fitness for a particular purpose, merchantability, satisfactory quality or reasonable skill and care.
As each user of Epicor software is likely to be unique in their requirements in the use of such software and their business
processes, users of this document are always advised to discuss the content of this document with their Epicor support
representative, account manager and/or consulting personnel. All information contained herein is subject to change
without notice and changes to this document since printing and other important information about the software
product are made or published in release notes, and you are urged to obtain the current release notes for the software
product. The usage of any Epicor software shall be pursuant to an Epicor end user license agreement and the performance
of any consulting services by Epicor personnel shall be pursuant to Epicor's services terms and conditions. Usage of the
solution(s) described in this document with other Epicor software or third party products may require the purchase of
licenses for such other products. Where any software is expressed to be compliant with applicable laws or other statutory
or regulatory requirements in this document, such compliance is not a warranty and is based solely on Epicor's current
understanding of such laws and requirements. All laws and requirements are subject to varying interpretations as well
as to change and accordingly, Epicor cannot guarantee that the software will be compliant and up to date with such
changes. All statements of platform and product compatibility in this document shall be considered individually in
relation to the products referred to in the relevant statement, i.e., where any Epicor software is stated to be compatible
with one product and also stated to be compatible with another product, it should not be interpreted that such Epicor
software is compatible with both of the products running at the same time on the same platform or environment.
Additionally platform or product compatibility may require the application of Epicor or third-party updates, patches
and/or service packs and Epicor has no responsibility for compatibility issues which may be caused by updates, patches
and/or service packs released by third parties after the date of publication of this document. Epicor, Business Inspired
and the Epicor logo are trademarks of Epicor Software Corporation, registered in the United States, certain other
countries and/or the EU. All other trademarks mentioned are the property of their respective owners. Copyright ©
Epicor Software Corporation 2014. All rights reserved. No part of this publication may be reproduced in any form
without the prior written consent of Epicor Software Corporation.
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Introduction

The Epicor ERP Application User Guide contains a complete overview of the major ERP modules. This guide begins
with a chapter that describes the primary navigational features of the interface. It then explores the major setup
programs within the application you can leverage to fine-tune ERP to match the business needs of your
organization. You examine how to define features like multiple books, multiple currencies, Site configuration,
Restrictions on Hazardous Substances (RoHS), and many other setup features. Together, these chapters round
out the primary information you need to know about the Epicor application.

The majority of the guide explores the main data flow of the entire suite of modules – taking a quote and then
eventually posting its cash results to books. The first block of chapters describe the sales order flow, from customer
relationships to managing incoming demand to building sales orders. You then review how to engineer parts
that are then used on jobs for production within a manufacturing center. Related chapters detail managing
materials through purchasing and inventory, as well as scheduling material releases to your jobs for on-time
completion. Another series of chapters describes how you create complex projects for a variety of uses, like
manufacturing a related line of products or evaluating product quality. Time and Expense functionality provides
you with the functionality for tracking both time and expense costs against all your projects. The guide concludes
with the financial functionality – Accounts Receivable, Accounts Payable, Advanced Allocations, and General
Ledger.

The guide is intended for a wide audience. Managers and administrators can use it to explore and better understand
the overall architecture of the manufacturing, distribution, service, and financial functionality, and new users can
leverage the guide as a teaching tool for specific modules. For more experienced users, it can also serve as a
reference guide for key descriptions of the primary programs and fields. The Epicor ERP Application User Guide
provides an excellent way to learn the basic, standard workflow of ERP by describing how regular tasks are carried
out from start to finish.

When delivered in PDF format, the guide is split into two parts to make the PDF files a more manageable size.
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Chapter 1: Purchasing

Purchase Management and its associated Supplier Relationship Management and Purchase Contract modules handle
entering purchase orders and tracking supplier performance. The central program that controls purchasing activity is
Purchase Order Entry. Each purchase order (PO) can contain multiple detail lines, and each detail line indicates planned
receipts to inventory, direct receipts to a sales order, or direct receipts to a manufacturing job. Purchase order receipt
processing also updates suggested supplier and detailed purchase history files, so your purchasing history is continuously
updated to help you make future purchasing decisions.

Both contract and consolidated purchase orders (POs) can also be created through Purchase Order Entry. Through
these additional module licenses, you create a contract PO with a specific supplier to purchase part quantities using a
recurring, regular schedule. The contract PO is active throughout the purchase schedule as various receipt transactions
are placed against it to satisfy the requirements of the contract. Consolidated purchase orders are global POs you can
create to buy part quantities for all the companies within your organization. Each release on a consolidated PO can be
designated for a selected company, Site, and warehouse, ensuring that the correct parts and quantities arrive where
they are needed.

If your organization licenses the Supplier Relationship Management (SRM) module, you can leverage the request for
quote (RFQ) functionality. Use this feature set to create request for quote records that you then send out to various
competing suppliers. You evaluate the responses from these suppliers in order to decide which businesses can provide
your company with the quantities, price points, and delivery dates you need for your manufacturing and servicing
business flow.

The RFQ information can then be reviewed through a central SRM tool, the Buyer Workbench. Through this tool, buyers
can see the current state of their RFQs and purchase orders. All the entry programs involved in the purchasing process
can be launched through this tool, including Purchase Order Entry, RFQ Entry, and various Suggestion programs. When
you combine Purchase Management with the added SRM tools, purchase contracts, and multi-site functionality, you
have complete control over your purchasing business flow.

Setup

This section describes the primary records you need to create for the purchasing functionality. These programs
are contained within the Setup folder for the Purchase Management module. Only the primary records are
described here. Some areas within the next Operations section may also document setup records if they are
required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for the Purchase
Management module; the Configuration topic details the options you define within Company Configuration.
You can also review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Buyer

Use Buyer Maintenance to define records for buyers responsible for your company’s purchasing activities. You
select buyers in the purchase orders you create. Buyer Maintenance is an important program, as the values you
define for your buyers affect the entire purchasing flow. You can use it to link a buyer to a part class and specify
approved purchase amounts for buyers.

Menu Path: Material Management > Purchase Management > Setup > Buyer

To add a new buyer:
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1. Click New on the Standard toolbar.

2. Enter an identifier in the Buyer field. This value uniquely identifies the record on various reports.

3. Optionally, select the Person/Contact identifier for this buyer record if one exists. If one does not exist, the
application uses the values in the buyer information fields to automatically create a person/contact record.

 If you have an individual who needs to be defined on
multiple records, like a shop employee who is also a buyer,
you can define this person in Person/ Contact Maintenance
first and then link this person record to other records
throughout the application. To learn about this
functionality, review the Personnel chapter in the Epicor
ERP Implementation Guide.

4. In the Name field, enter the complete name for this buyer. This value displays on various purchasing programs
and reports.

5. Enter a PO Limit for this buyer. This value defines how much the buyer can spend on each purchase order.
If this value is set to 0 (zero), the buyer has unlimited purchasing capability.

6. Select an Approval Person. This individual is the person who verifies purchases for this buyer when the
buyer’s total amount of purchases exceeds the PO Limit.

7. Enter the Email Address for this buyer.

8. Select the Consolidated Purchasing check box to indicate this buyer can make global purchases. If your
organization has the Multi-Site Management license, this check box is available. The consolidated purchasing
functionality controls purchasing and accounts payable functions across multiple companies, even though
companies may exist on separate servers and databases. When you assign a buyer these rights, this individual
can create global purchase orders that split off quantities to separate companies and sites for receipt. For
more information, review the Consolidated Purchase Orders section later in this chapter.

The new Buyer ID must also be added as an authorized
user in order to view purchase orders.

9. If you want this buyer record to be the first option that displays on Buyer drop-down lists throughout the
application, select the System Default check box.
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10. If you want name and email address changes made to this buyer record to automatically update the linked
person record within Person/Contact Maintenance, select the Sync. Name and/or Sync. Email check boxes.

11. You next define the users who can make purchases on behalf of the buyer. These individuals are called
authorized users. To add an Authorized User to the buyer record, click the Down Arrow next to the New
button; select New Authorized User.

12. Click the User drop-down list to select an individual who will be able to make purchases for this buyer. All
users entered through User Maintenance (a System Management program) display on this list.

13. If the authorized user record can be a default user for this buyer, select the Default Buyer check box. In
order to define a team of individuals who can make purchases for this buyer, you can select this check box
on multiple default user records.

14. When you finish, click Save.

Part Maintenance

You enter and update records for parts you purchase through Part Maintenance. This program contains default
values you use with purchased parts. By establishing these default values, you simplify user workflows and
eliminate redundant keystrokes when you enter your purchase orders.

This section assumes you have already created purchased part records, but still need to update them to contain
the current purchasing information.

Menu Path: Material Management > Purchase Management > Setup > Part

To update purchasing information on a part:

1. Click the Part button to find and select the purchased part record you want to update.
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2. In the Part Search window, you can filter the search to only retrieve purchased parts by clicking the Part
Type drop-down list and selecting the Purchased option.

3. Click Search.

4. Select the appropriate part from the search results.

5. Click OK.

6. Each purchased part has a Primary Purchasing Unit of Measure. This value can be identical or different
from the Primary Units of Measure defined for Inventory or Sales. The Inventory unit of measure defines
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the standard measure used for this purchased part in your stock, while the Sales unit of measure defines
the standard measure used for this purchased part by your customer.

7. If this part record can be used across multiple companies within your organization, select the Global check
box. This record is now considered a global purchased part by the application, and the record can be used
on purchase orders across all companies within your organization.

8. After you select the Global check box, you can then select the Consolidated Purchasing check box. This
indicates buyers can select this part on consolidated purchase orders. These purchase orders can be used
to buy part quantities and services for all companies within your organization. To learn more about how to
create multi-company purchases, review the Consolidated Purchase Orders section later in this chapter.
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9. The Sites > Detail sheet contains additional purchasing information for parts.

10. Select the Buyer responsible for making purchases for this part. You create buyer records within Buyer
Maintenance, a program described in the previous section.

11. Enter a Min Order Qty value. This value defines the smallest, or minimum quantity that must be ordered
for each purchase order release from the primary supplier.

12. The Lead Time value defines how long, in days, it takes for the primary supplier to fill purchase orders for
this part. This value is used by the Material Requirements Planning (MRP) functionality to determine when
purchased part quantities are available for use within your manufacturing center.

13. Click the Supplier button to find and select the supplier. You can also enter the supplier directly.

14. Select the Generate PO Suggestions check box if you want the application to automatically create a list
of suggested purchases based on time-phased information. To do this, you use the Generate PO Suggestions
functionality. You can then create actual purchase orders from these suggestions in Purchase Order Entry.
This functionality is described later in this chapter.

15. If you select the Allow Consumption of Minimum Qty check box on the site record, you can define Urgent
Planning options. These options are an alternate set of values available when you generate PO suggestions.
If the projected On-Hand Quantity falls below the Safety Stock quantity during the lead time date range
(MRP Scheduled Start Date + Lead Time), the Urgent Planning values are used to calculate the PO suggestion
quantities instead. Through these parameters, you can define the specific quantities, lead times, and suppliers
to use for immediate supply needs.
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16. You can also enter comments for each purchased part. To do this, navigate to the Reporting > Comments
> Purchasing sheet.

17. Enter the text you need in the Purchasing Comments field.

18. To copy these comments to the Manufacturing Comments sheet, click the Duplicate button.

19. When you finish updating the purchased part record, click Save on the Standard toolbar.

Supplier Maintenance

Suppliers are businesses from whom you purchase products and services. Use the Supplier Maintenance program
to create supplier records. These records are used in several programs, and are required for creating purchase
orders and accounts payable invoices.

Menu Path: Material Management > Purchase Management > Setup > Supplier

To add a supplier:
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1. Click New on the Standard toolbar.

2. Enter a Supplier ID. This value is the primary identifier used on various programs and reports for this supplier.

3. Enter the Name of this supplier.

Each supplier is automatically assigned a unique internal
number. This internal number (which you do not see and
cannot change) causes the application to rapidly access
the supplier record. Since this internal number never
changes, you can change the Supplier ID. To do this, click
the Change ID button.

4. If this supplier record can be used across multiple companies within your organization, select the Global check
box. This record is now considered a global supplier by the application, and the record can be accessed
across all companies within your organization.

5. After you select the Global check box, you can then select the Consolidated Purchasing check box. This
indicates you can select this supplier record on multi-company, or consolidated purchase orders. A buyer
can then create a purchase order for this supplier that purchases quantities or services for all companies
within your organization. For more details about how to create multi-company purchases, review the
Consolidated Purchase Orders section later in this chapter.

6. The Approved check box is selected by default when entering a new supplier.

7. If you want all materials purchased from this supplier to be evaluated for quality, select the Inspection
Required check box. Any materials purchased from this supplier are automatically received into inspection;
you cannot change this value during purchase order entry or receipt entry. If you do not select this check
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box on the supplier record, however, you can select it later during either purchase order entry or receipt
entry.

8. Optionally, select the default language that prints on reports from the Language drop-down list. By default,
all part Description values that use this selected language also display on these reports.

9. If you need, enter the Account Ref number for the account you have with this supplier.

10. Optionally, select the Group you want for this supplier record. Supplier groups organize your supplier records
along any criteria you need, like Plastic Supply or Paint Services. You create these groups within Supplier
Group Maintenance and then select them from this drop-down list. For details about this program, review
application help.

11. Use the Country Entry field to specify the Intrastat code for the area or city that is the entry point for goods
shipped from this supplier. Leave this field blank to use the Border Crossing value within the Country record.

12. If you want, select the default payment Terms by which this supplier bills your company. Payment terms
define when payment discounts and late fees are assessed against an Accounts Payable invoice.

13. Use the Calendar button to find and select the production calendar this supplier uses to manufacture
products. This calendar is useful for determining when a purchased quantity will arrive at your company.

14. Click the FOB drop-down list to select the free on board location for this supplier. This location indicates
the point at which title of the shipped goods changes from the supplier to your company. You create free
on board options within FOB Maintenance.

15. If you want, enter the Minimum Order Value for this supplier. This value specifies the lowest total quantity
amount you will allow for any purchase order placed with this supplier. This field helps you avoid making
small purchases below your company’s normal order quantity. Whenever a total quantity on a purchase
order is less than this value, a warning message displays.
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16. Select the Payment Method you use to pay this supplier. These methods indicate whether the supplier is
paid manually or electronically. The option you select on this drop-down list becomes the default value on
all Accounts Payable invoices and Accounts Payable payment groups created for the supplier. If you need,
you can override this method on a specific invoice or payment group.

17. When you finish, click Save.

Supplier Address

To enter the supplier address and phone numbers:

1. Enter address and phone information on the Supplier> Address sheet. These values are the main remit-to
address for the supplier.

2. Use the Official Registration section to enter the supplier’s legal tax information used by the taxing locality.

3. Optionally, select a restriction type for this supplier on the RoHS sheet. You define restriction types through
the Substance Restriction Type Maintenance program. For more information, review the Epicor ERP
Implementation Guide.

4. When you finish, click Save.
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Purchase Points

Purchase points define alternate addresses for the supplier. Purchase points are locations from which the current
supplier ships material or provides services for your company.

To enter purchase points for the supplier:

1. Click the Down Arrow next to the New button; select New Purchase Point.

2. Enter a Purchase Point number, Name, and Mailing Address for each supplier purchase point.

3. When selected, the Primary Purchase Point check box sets this purchase point as the main location from
where you purchase goods or services from this supplier. As you create a purchase order for this supplier,
this purchase point’s address is the default address that populates the purchase order’s address fields.

Only one purchase point can be selected as the primary
location for each supplier.
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Contacts

You can optionally enter contacts for each supplier and/or purchase point address. To enter contacts:

1. Click the Down Arrow next to the New button; select New Contact or New PP Contact.

2. The Contacts > Detail sheet displays – either for the supplier or the purchase point – depending on the
option selected from the New menu.

3. Optionally, select the Person/Contact identifier for this contact record if one exists. If one does not exist,
the application uses the values in the contact information fields to automatically create a person/contact
record.

4. In the Name field, enter the contact’s complete name.

If you have an individual who needs to be defined on
multiple records, like a supplier contact who is also a
purchase point contact, you can define this person in
Person/Contact Maintenance first and then link this person
record to other records throughout the application. To
learn about this functionality, review the Personnel chapter
in the Epicor ERP Implementation Guide.

5. Optionally, use the Function, Role, Title, and Reports To fields to define this person’s position within the
supplier organization.

6. Enter the contact’s Email address.

7. Select the Primary Contact check box to indicate this person is the main contact at this location. This
individual displays by default on all Contact drop-down lists for records linked to this supplier.

8. If you want name, email, phone, and weblink changes made to this contact record to automatically update
the person record within Person/Contact Maintenance, select the Sync. Name, Sync. Phone, Sync. Email,
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and Sync. Links check boxes. Any data changes made within the selected fields automatically update other
records that share the same contact.

9. Use the fields within the Phone/Fax section to enter all of the contact’s phone numbers.

10. Continue to add the contacts you need. When you finish, click Save on the Standard toolbar.

Supplier Price Lists

Use Supplier Price List Maintenance to set up different price lists for suppliers defined in the application. This
functionality is valuable when you want to buy the same products from different suppliers with different price
lists. Such lists can account for different currencies, different situations (for example - promotional or retail), or
seasons. You may also have different prices based on quantity breaks for each supplier.

Menu Path: Material Management > Purchase Management > Setup > Supplier Price List

Add a Price List

1. Click the Supplier button to find and select the Supplier ID. You can also enter the Supplier ID directly.
When selected, the supplier description and currency display.

2. Click the Down Arrow next to the New button; select New Part.

3. Click the Part button to find and select the part number. You can also enter the part number directly.
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4. Click the Supplier UOM drop-down list to select the unit of measure this supplier uses for this part.

5. Enter the Effective date and Expires date for the price. These values define the period during which this
price list is considered active by the application.

6. The application uses the Effective date and Expires date to calculate the number of Days this price list is
active.

7. Enter the Base Unit Price for the part.

8. The Price Per value defines the quantity against which the Base Unit Price is calculated. Select an option
from this drop-down list. Available options:

• /1

• /100

• /1000

9. The Discount % specifies the overall discount allowed by this supplier. If you enter a value in this field, it
further reduces the price of the purchased parts.

10. You can also select a Price Break Modifier, either a Flat Unit Price or Percent of Base, for the current part.
The selected modifier determines the effective unit price for the related quantity.

11. The Conversion section defines the overall formula used to calculate the conversion between the Purchasing
(supplier’s)unit of measure code and the Base unit of measure code.

12. If you want to change this formula, select the Override Conversion check box.

13. Click Save on the Standard toolbar.

Add a Price Break

Use the Price Breaks sheet to establish price break information for the specified supplier. This information represents
changes to the base unit price specified for the part in the Parts > Detail sheet, based on quantity or volume
purchases.

1. Click the Down Arrow next to the New button; select New Price Break.
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2. Enter the Minimum Quantity. This value specifies the minimum purchase quantity required to obtain the
related price. This value uses the supplier’s unit of measure.

3. Enter the Days Out to specify the number of days in which these price breaks expire. The application
calculates the Expiration Date based on this value.

4. Use the Price Modifier field to define the effective unit price for the price break. Depending on the Price
Break Modifier you selected on the Parts > Detail sheet, this value is either a flat amount or a percentage.

5. The Effective Price field displays the amount charged for a unit of the purchased part after the price break
is applied.

6. Continue to add the price breaks you need. When you finish, click Save on the Standard toolbar.

Add a Supplier Part

Use the Supplier Parts sheet to identify supplier parts and relate them to the qualified manufacturer’s and
manufacturer’s part numbers for this part. Single or multiple qualified manufacturer’s part numbers can be
associated with a specified supplier part number. This creates a link between your internal part number, approved
supplier part source, and qualified manufacturer’s part numbers.

1. Click the Down Arrow next to the New button; select New Supplier Part.

2. Enter the Supplier Part and Reference to specify the supplier part number for the supplier and any additional
reference information.

The Supplier Part is the identification number your supplier assigns and uses to track this part number. Each
part can have multiple supplier part numbers, if desired. Parts can also be assigned multiple qualified
manufacturers and manufacturer’s parts. For more information on part cross reference functionality, review
the Part Cross References section in the Inventory Management chapter.

3. Enter the Supplier Lead Time. This value specifies the number of days it generally takes to receive this
supplier part from the supplier after you send the purchase order.

4. Click the Manufacturer drop-down list and select the identity of the manufacturer for the specified supplier
part number.
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5. Click the Manufacturer Part drop-down list and select the manufacturer's part identification for the specified
supplier part number.

6. The Life Cycle field displays the current status of the part within its product life cycle. This status is defined
within Qualified Manufacturer Maintenance, and it displays here for your reference.

7. The Market Availability field displays information you can use as a lead time comparison for the purchased
part from various qualified manufacturers. A value of 45-60 days, for example, indicates this part is generally
available for purchase during the next 45 to 60 days. This information is also entered within Qualified
Manufacturer Maintenance, and it displays here for your reference.

8. Select the Default for Purchases check box to indicate if multiple parts exist, the current multiple supplier
parts exist, the current supplier part is the default version used on purchase orders. However, you can override
this value on a specific purchase order.

9. Continue to add the supplier parts you need. When you finish, click Save on the Standard toolbar.

Add a Supplier Part Restriction

Use the RoHS sheet to add a restriction on the use of certain hazardous substances that apply to this part. The
RoHS values are added to the part, not the supplier part.

1. Click the Down Arrow next to the New button; select New Restriction.

2. Click the Restriction Type drop-down list to select the appropriate restriction type.

 You define substances and restriction types through the
Substance Maintenance and Substance Restriction Type
Maintenance programs. For more information, review the
Epicor ERP Implementation Guide.

3. The default Description from the selected restriction type displays.

4. Select the Roll Up check box to indicate an indirect roll-up needs to be run to process parts for compliance.
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5. Select the Override check box when a roll-up will not be calculated for the current substance restriction
type.

6. The Compliance Date specifies the date on which the RoHS part compliance process will run. This date is
automatically defined after you click the Override check box.

7. The Last Roll Up field displays the date on which the compliance roll-up was previously run against this
purchased part.

8. Continue to define the restrictions you need. When you finish, click Save on the Standard toolbar.

Add a Subcontract Part

Use the Subcontract Operations sheet to enter supplier pricing detail for subcontract services. For each subcontract
part, you can define price breaks and substance restrictions.

1. Click the Down Arrow next to the New button; select New Subcontract Part.

2. Click the Part button to find and select the subcontract part to add to the list. You can also enter the part
directly.

3. Notice several fields are identical to the fields on the Parts > Detail sheet. Select the Supplier UOM from
the drop-down list to specify the unit of measure this supplier uses for this subcontract part.

4. Click the Subcontract Operation drop-down list and select the type of operation. You enter operations
through Operation Maintenance, and all operations entered through this program display on this drop-down
list.

5. Enter the Effective date and the Expires date for the price. These values define the period during which
this price list is considered active by the application.

6. The application uses the Effective date and Expires date to calculate the number of Days this price list is
active.

7. Enter the additional miscellaneous charge amount, if any, associated with the subcontract service in the
Misc Amt field. In the Misc Code field, select the appropriate purchase miscellaneous charge.
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8. Enter the Base Unit Price for the part.

9. The Price Per value defines the quantity against which the Base Unit Price is calculated. Select an option
from this drop-down list. Available options:

• /1

• /100

• /1000

10. The Discount % specifies the overall discount allowed by this supplier. If you enter a value in this field, it
further reduces the price of the purchased parts.

11. You can also select a Price Break Modifier, either Flat Unit Price or Percent of Base, for the subcontract
part. The selected modifier determines the effective unit price for the related quantity.

12. Notice you can create price breaks and define RoHS restrictions for the subcontract part.

13. When you finish, click Save on the Standard toolbar.

Operations

This section details the operations available for the purchasing functionality. Each operation is described as a
workflow to help guide you through the process from start to finish. These programs are primarily found within
the General Operations folder for the various purchasing modules. If a unique setup record is required to run the
operation, this record is also described in this section.

RFQ Entry

Use RFQ Entry to enter and print new Request for Quotes (RFQs) and to make changes to existing RFQs. Each
RFQ contains detail lines that define the part quantities and/or subcontracted operations you need for the requested
parts. You can then send your RFQ to the potential supplier.

If you use the consolidated purchasing functionality, your RFQ is sent to a central purchasing company as an RFQ
suggestion where it is processed and distributed to potential companies.

Menu Path: Material Management > Supplier Relationship Management > General Operations > RFQ Entry

Create the RFQ

To create a request for quote record:
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1. Click the Down Arrow next to the New button; select New RFQ.

2. The current Date displays. If you need, you can select a different date from the calendar.

3. Click the Due Date drop-down list to select the due date by which you want to complete the bidding on
the current RFQ.

4. Click the Decision drop-down list to select the date by which you want to make a decision about the various
supplier offers.

5. Click the Respond drop-down list to select the date by which you want all suppliers to send in their quotes.

6. If you want this RFQ to automatically print using the Business Activity Management functionality, select the
Auto-Print Ready check box. The RFQ will automatically print using the rules you defined for the Business
Activity Management event. For more information on this functionality, review application help or the Epicor
ICE Tools User Guide.

7. When you finish entering the header information, click Save on the Standard toolbar.
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Select the Part

You next must select the part or parts for which you are creating this RFQ. You create detail lines for each part
you want to include on the RFQ.

To add parts:

1. Click the Down Arrow next to the New button; select New Line.

2. Click the Part button to find and select the part you need. You can also enter the part number directly.

3. The part’s Description automatically displays.

4. If you need to select a specific revision, either click the Rev button or use the drop-down list to indicate the
part revision you need.

5. The Our UOM and Supplier UOM drop-down lists display the units of measure defined for the purchased
part. These values default from the part record, but if you need, you can change them.

6. Select the Item Type for the RFQ detail line. Select Material for a part quantity or select Subcontract
Operation for a subcontract service.

7. Click the Operation drop-down list to select the operation for which this part or service is being purchased.
All of the active operations defined within Operation Maintenance display on this drop-down list.
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Select the Suppliers

You next select the suppliers you want to compete over this request. You can select as many suppliers as you
want.

To add suppliers to the current RFQ:

1. Click the Down Arrow next to the New button; select New Supplier.

2. A new line displays within the Request Quotes From grid.

3. Click the Supplier Wizard button to click through a series of steps that help you decide which supplier you
want to include on the RFQ.

4. You can also click the Add button to find and select a specific supplier for the detail line.

5. Repeat these steps to place all the suppliers you want on this RFQ. When you finish, click Save on the
Standard toolbar.

Define Price Breaks

You need your suppliers to include the price breaks they will give you based on the quantities you may order. To
do this, you use the Quantities sheet.

1. Click the Down Arrow next to the New button; select New Quantity.
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2. A new line displays within the Quantities to print on RFQ grid.

3. Enter the price break quantity you want quoted within the Quantity Break field.

4. Repeat these steps to enter the price breaks you need. When you finish, click Save on the Standard toolbar.

Supplier Responses

Use the Supplier Responses program to enter and track responses from suppliers to a request for quote (RFQ)
record. Each supplier response consists of a price or a list of prices for the part or service operation defined on
the RFQ detail line. You can then save these price values to a supplier list. You can also accept the price and turn
the supplier response into a purchase order.

Menu Path: Material Management > Supplier Relationship Management > General Operations > Supplier
Responses

To incorporate supplier responses into a price list:

1. Click the Responses button to find and select the RFQ for which you received a response.

2. The RFQ displays within the RFQ Listing grid.

3. Click the Responses button to find and select the response value you need. You can also enter the responses
value directly. Available options:

• Waiting - The default response for a RFQ line for which you have not yet entered a response.

• Not Waiting - Use this response if you have received a response from the supplier, but you do not want
to enter it into the program.

• Close Line - Use this response if you have received a response from the supplier, but you do not want
to enter it into the program, or if the supplier is not going to send a response.

• Received - This response is generated by the program when you enter supplier pricing information. You
cannot manually enter this response; it displays automatically.

• Accepted - You can manually change a RFQ line with a current response of Received to this response.
This response means that you have decided to accept the supplier’s pricing, and your job or quote will
update with the pricing information.

4. You can enter responses by clicking the Add Supplier Responses button.
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5. You can also click the Actions menu and select Add Supplier Part and Prices. Supplier Price List
Maintenance launches, displaying the supplier defined on the selected RFQ line. You can then update this
supplier’s price list with the part and prices from the current response.

6. To immediately create a purchase order from the RFQ detail line, click the Create PO button. You can also
click the Actions menu and select Create PO. Purchase Order Entry launches and information from this
RFQ detail line populates the equivalent fields on the new purchase order.

Purchase Order Entry

Purchase Order Entry is used to enter and print new purchase orders and to make changes to existing purchase
orders.

Menu Path: Material Management > Purchase Management > General Operations > Purchase Order Entry

New Purchase Orders

To enter a new purchase order:

1. Click New on the Standard toolbar.
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2. On the Summary sheet, the PO Number defaults to 0. When the PO is first saved, the purchase order
number is assigned automatically.

3. The purchase order Type defaults to Standard. The type determines if the resulting material and financial
transactions reflect a buy-sell or transfer relationship. Other purchase order Type options:

• Customer Managed -  Select this option if the material purchased is inventory you are storing on behalf
of a customer. Customer-managed items can be used in the production of products for this customer,
or they may be shipped by you directly to your customer’s customer. Although you are storing the
inventory, your company never legally owns these part quantities.

• Supplier Managed - Select this option if the material purchased is inventory you are storing as
consignment inventory from the supplier. You can also use these part quantities on jobs; once you
consume this inventory on a job, your company legally owns it.

4. The PO Date defaults to today’s date. You can change this date if you need.

5. Click the Supplier button to find and select the Supplier ID. You can also enter the Supplier ID directly.

6. Click Save.

Purchase Orders - Lines

To enter purchase order lines:

1. Click the Down Arrow next to the New button; select New Line.

2. Navigate to the Lines > Detail sheet.
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3. In the Buy For section, select the appropriate option – either Inventory, Other, Job Material, or
Subcontract Operation. If you assign more than one release to a purchase order line, the Buy For selection
set for the line is disabled and set to Inventory. You can change this setting for individual shipping releases
of each line on the Releases > Detail sheet. You can also change the purpose of the purchase during the
receipt of the purchase order line or release.

4. In the Part/Rev field, enter the part number you are purchasing.

5. In the Our Qty field, enter the quantity as it is stored within your inventory.

6. If you need, you can change the Unit of Measure (Our Quantity) used with the part. In this example, EA
displays, designating the Each unit of measure.

7. Once you enter a quantity in the Our Qty field, the Supplier Qty automatically calculates.

8. If you click the Supplier Qty radio button, the Supplier Qty and Unit of Measure (Supplier Quantity) fields
activate. Use this function when you need to modify the quantity to reflect supplier values for the part.
When you change a value here, the Our Qty field updates using the conversion factor defined on the supplier
price list.

9. Enter the Unit Price. If a unit price value is defined on the supplier price list, this value populates the field
by default.

10. If this purchase order detail line is subject to Use Tax, select the Taxable check box. This type of tax is levied
in the United States. This internal corporate tax is self-assessed when a product is purchased by a resident
of the state that issues the tax. It does not affect the invoice total, but it does affect the general ledger. Use
tax strictly accounts for storage and consumption of goods used internally by the company in a specific state
(not for resale). For more information about use taxes, review the Global Tax Engine chapter in the Epicor
ERP Implementation Guide.

11. If you want to update both Our Qty and Supplier Qty values manually, select the Override Conversion check
box. This activates both fields; directly enter the values you need. The conversion formula is not run against
either value, so the values you enter are not changed by the application.

12. If you want to change the default price retrieved from the associated supplier price list (if any) that displays
in the Unit Price field, select the Override Price List  check box. If you clear the check box (default value),
you cannot manually override the displayed unit price.

13. Click Save on the Standard toolbar.

14. Notice the Totals section updates with the current cost of the detail line.

15. If this part has a manufacturer’s part cross reference, select the organization you need from the Manufacturer
drop-down list.

16. Click the Manufacturer Part drop-down list to select the reference this manufacturer uses for this part.
For more information about creating part cross references for your purchased parts, review the Part Cross
References section within the Inventory Management chapter.
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Complete Purchase Order Lines

To complete purchase order lines:

1. Optionally, you can click the Price Breaks button to launch Supplier Price List Maintenance. Use this program
to enter or update price breaks for the part number on the purchase order line.

2. If you want to review your purchasing history for this part, click the Purchase Advisor button.

3. Use the Purchase Advisor program to review useful information about the part on the purchase order line.
It provides answers to the questions: Have I purchased it before?, Do I have any on order?, Do I have any
on hand?, Do I have approved suppliers?, Do I have supplier price lists?, Do I have compliant suppliers?, or
Do I have compliant parts?
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4. When you finish reviewing your purchase history, click the Close button. You return to the Purchase Order
Entry > Detail sheet.

5. To review the part cross references for the current purchased part, click the Cross Reference Options button.

6. The Part Cross Reference Options window displays.

7. Use this window to indicate how you want Manufacturer, Supplier, and Substitute part cross references
to print on the purchase order. Identical options are available on all drop-down lists; you can print the
selected reference, all references, or no references.

8. Click OK to close this window.

Purchase Orders – Inspection Plans

You can verify purchased quantities meet quality standards through the Quality Assurance functionality. As part
quantities are received, inspectors can review them and record any nonconformance quantities using the programs
available within the Quality Assurance module.

The purchasing functionality also interacts with the Enhanced Quality Assurance module so inspectors can evaluate
part quantities using specifications and inspection plans. You can define both part specifications and multiple
inspection plans for each purchased part. Your inspectors can then select and use a specification and inspection
plan to evaluate received part quantities.

To set up an inspection plan for a detail line:

1. Select the Inspection Required check box to indicate the parts specified on this purchase order line must
be inspected when you receive them at your shipping location. When you enter a receipt for this line, parts
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are automatically received into Inspection. If this check box is selected on either the part class or supplier
record linked to this purchase order, this check box is automatically selected and cannot be changed.

2. You can now link this detail line to an inspection plan. Click the Down Arrow next to the New button;
select New Inspection.

3. The Lines > Inspection > Detail sheet displays.

4. Click the Inspection Plan button to find and select the inspection plan you want to link to this purchase
order detail line.

5. Select the plan Revision that applies to this part from the drop-down list.

6. Click the Specification ID button to find and select a specification for this purchase order detail line.

7. Now define the specification revision you need from the Revision drop-down list.

8. When you finish, click Save on the Standard toolbar.
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You create inspection plans and part specifications within the Enhanced Quality Assurance module. To learn
more about this functionality, review the Quality Assurance chapter.

Purchase Order - Releases

To enter purchase order releases:

1. Click the Down Arrow next to the New button; select New Release.

2. The Release field displays the number of the current release.

3. The Buy For section indicates why this part quantity is being purchased – for Inventory, Other, Job Material,
or Subcontract Operation. You select this value on the Lines > Detail sheet.

4. If either the Material or the Subcontract Operation option is selected in the Buy For section, the Job field is
active. This indicates you are purchasing materials for a job or a subcontract operation. Either enter the job
number directly or click the Job button to find and select this record.

5. When you enter the job number, the Asm and Mtl fields activate. You can now enter the appropriate job
assembly number or the appropriate material sequence number in these respective fields.

6. If this purchase order line is for a sales order release selected as a drop shipment, use the Sales Order field
to define the specific sales order release you want to link to this purchase order release. To do this, either
enter the sales order directly or click the Sales Order button to find and select this record. You can also
use this field to enter additional Buy To Order sales releases to the current purchase order line. Use the
Line/Release fields to enter the specific detail line and release from the sales order.

7. When you save the release, the application links the sales order release to the Buy To Order purchase order
line. The Sold To, Ship To Cust, and Ship To fields display customer information from the selected sales
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order. The fields respectively display the customer to whom you sold the parts, the ship to customer who
is receiving the parts, and the identifier for the ship to location.

8. If this release is a drop shipment to be sent directly from your supplier to your customer, the Drop Ship
check box is selected.

9. You can view the drop ship address by clicking the Drop Ship Address sheet.

10. If this release is being sent to a location that is not one of the customer’s ship to locations, the One Time
check box is selected.

11. The Date/Quantity section displays specific information about the Due Date, Promise Date, and quantities
for this purchase order release.

12. The Site/Warehouse section displays information about the Site and warehouse involved in this purchase
order release transaction.

13. If this purchase is for a customer with whom you are storing inventory quantities, click the Managed
Customer button to find and select this customer record. You then receive this part quantity using 3PL
(Third Party Logistics) processing.

14. If this purchase order release is part of a larger project, click the Project button to find and select the specific
project you need. To learn more about projects, review the Project Management chapter.

15. The G/L Account section displays the Book, Account, and Description values. These values indicate the
account number and the GL book to which you eventually post this transaction. For details about this feature,
review the Consolidation and the General Ledger chapter.

16. The Container ID value defines the container used to receive this part quantity. The status of the shipment
displays next to this field. In this example, the part quantity is not yet sent, so the Not Shipped icon displays.
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17. When you finish the purchase order release, click Save on the Standard toolbar.

Purchase Order - Miscellaneous Charges

You can add miscellaneous charges to a purchase order header, or to a specific purchase order line. To add
miscellaneous charges to a purchase order line:

1. Click the Down Arrow next to the New button; select New Line Misc Charge.

2. The Lines > Miscellaneous Charges sheet displays.

3. Select a charge from the Charge ID drop-down list. You create these charges in Miscellaneous
Charge/Credit Maintenance.

4. Enter the Amount you need for the miscellaneous charge.

5. Select the Taxable check box to indicate this miscellaneous charge is subject to sales tax.

6. Click Save on the Standard toolbar.
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Submit for Approval

Once the purchase order lines are complete, you are ready to submit this purchase order for approval. To indicate
a purchase order is ready to approve:

1. Navigate to the Summary sheet.

2. Select the Unapproved check box.

3. The indicator changes to Approved.

4. If the buyer on the purchase order has exceeded the purchase limit, however, a dialog box displays stating
the purchase order must be approved by the person selected as the authorized approver for this buyer. Click
OK to close this message.

5. In this case, Pending now displays instead of the Approved status indicator. If any purchase orders are
pending, they must first be approved before they can be printed.

6. The individual defined as the Approval Person in Buyer Maintenance (discussed previously in this chapter)
is required to approve any pending purchase orders. The approver, in this example Howard Low, must then
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log into the application and launch Purchase Order Entry. To approve a pending purchase order, from the
Actions menu, select Approvals.

7. The PO Approval Activity program displays. This program lists any purchase orders pending approval. The
approver can manually select the purchase orders to approve.

8. Click OK to approve those purchase orders.

9. If the buyer’s limit was not exceeded, or once the approver approves a purchase order, the purchase order
is now approved and is ready to be printed.
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10. To print the purchase order, from the Actions menu, select Print.

Consolidated Purchase Orders

If your organization has the Multi-Site Management license, you can create consolidated purchase orders. These
purchase orders control purchases for separate companies and sites across your organization. Through this feature,
you indicate which company can receive various quantities and services on the consolidated purchase order. You
indicate the specific company, site and warehouse on each purchase order release.

To create a consolidated purchase order:

1. Click the Down Arrow next to the New button; select New Consolidated PO.

2. Notice the Global PO check box is selected, indicating this purchase order will be used for consolidated
purchasing.

3. Click the Supplier button to find and select the supplier who will fulfill this purchase order. The supplier
record you select must be defined as a Global supplier available for consolidated purchasing. You activate
this functionality within Supplier Maintenance; review this section earlier in this chapter for details.
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4. Select the Buyer responsible for handling this purchase order. Just like the supplier record, the buyer record
must also be defined as able to make consolidated purchases. You likewise activate this functionality within
Buyer Maintenance; review this section earlier in this chapter for more information.

5. Define the other header information as you need. When you are ready to create detail lines, click the Down
Arrow next to the New button; select New Line.

6. Click the Part/Rev button to find and select the part you are purchasing. You can also enter the part directly.
You must select a global part available for consolidated purchasing. You activate this functionality within
Part Maintenance; review this section earlier in this chapter for details.

7. In the Quantity/Cost section, enter the total quantity values you need for the detail line and any other
information you need.
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8. You can now create the purchase order releases you need for each company that will receive quantities
from this purchase order. To do this, click the Down Arrow next to the New button; select New Release.

9. Enter the Quantity you want on this release.

10. You can create a new release for a specific global company, and even define the site and warehouse that
will receive this quantity. To do this, click the Global Company drop-down list and select the global company
that will receive the quantity.

11. To indicate the part quantity will go to a site within this company, click the Global Site drop-down list and
select an option.

12. You can also indicate a specific global warehouse will receive this quantity. Click the Warehouse drop-down
list to select the warehouse you need.

13. Continue to add the releases you need for other companies within your organization. When you finish, click
Save on the Standard toolbar.

The part quantities the multiple companies receive for this consolidated purchase order can now be recorded.

To learn how to set up and run the various multi-company
features, review the Multi-Site Technical Reference Guide within
application help.
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Contract Purchase Orders

You use purchase contracts to buy inventory quantities through a recurring schedule. You can establish delivery
schedules to regularly re-issue material against which recurring deliveries are made. This functionality is available
if your company uses the Purchase Contracts Management module.

For example, if you need a quantity of Part ABC to be purchased monthly, you do not need to enter a separate
purchase order each month. Instead, you can set up a contract purchase order schedule and maintain this record
automatically. You can assign contract line items to purchase orders. These line items automate delivery schedules
with delivery dates, prices, and corresponding quantities.

To create a contract purchase order:

1. Click the Down Arrow next to the New button; select New Contract PO.

2. Click the Supplier button to find and select the supplier for the purchase order. You can also enter the
Supplier ID directly.

3. Notice the Contract PO check box is selected.

4. You need to define the length of the recurring contract. Enter Start Date and End Date values. This contract
purchase order will be active between the dates you enter in these fields.
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5. Continue to select and enter the header information you need. When you are ready to add detail lines, click
the Down Arrow next to the New button; select New Line.

6. Click the Part/Rev  button to find and select a part. This part must be linked to a part schedule that defines
how often you want to receive quantities from this supplier. This supplier must also be approved for
distributing this part.

You create part schedules within Part Schedule
Maintenance. This setup program is available within the
Purchase Contracts Management module.

7. In the Contract Qty  field, enter the total part quantity you want to receive.

8. Notice you can also select a different unit of measure for this quantity.

9. Enter the Contract Price  for each unit of the purchased part.

10. You can also select a different Price Per  value. Available options:

• /1 (Each)

• /100

• /1000

11. Select the Contract Active  check box to indicate you want to receive quantities through this contract
purchase order.

12. Continue to add detail lines and releases as you need. When you finish, click Save on the Standard  toolbar.
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Purchase Order Suggestions

The Generate Suggestions program automatically creates a list of suggested purchases based on time-phased
information. You can then create actual purchase orders from these suggestions in Purchase Order Entry.

The Generate Suggestions program builds suggestions from two places - time-phased information and requisitions
marked as Send To Purchasing. For time-phased purchase orders, the program deletes and rebuilds some or all
time-phased purchase orders as is appropriate for the date when suggestions are generated and for the selected
processing option.

Menu Path: Material Management > Purchase Management > General Operations > Generate Suggestions

Generate Purchase Order Suggestions

1. Select the Net Change or Regenerative  processing option. The Net Change option only updates purchase
order suggestions that occurred since the last time the process was run. The Regenerative option deletes
all of the existing purchase order suggestions and generates new records based on the current state of the
database.

2. Enter a Cutoff Date. Any time-phased records that occur on or before this date are turned into purchase
order suggestions.

3. If you want multi-company purchasing suggestions to generate, select the Run Consolidated Purch check
box. Use this option to review and process purchase order suggestions from other companies. This check
box is available if you are logged into the central purchasing company. You can run a full regeneration on
your consolidated purchase orders if your organization has a Multi-Site Management license.

4. If you want to generate purchase order suggestions for purchase contracts, select the Include Contract
PO Parts  check box. This check box is available if your organization uses the Purchase Contracts Management
module.

5. Click the Process button on the Standard toolbar.
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Review Purchase Order Suggestions

You are now ready to review the new purchase order suggestions that were generated. You do this in the New
PO Suggestions program.

Menu Path: Material Management > Purchase Management > General Operations > New PO Suggestions

To review the generated purchase order suggestions:

1. Click Search on the Standard toolbar to retrieve the list of suggestions.

2. The New Purchase Order Suggestion Search program opens. Click the Search button. The buyer can
limit the search by defining both a buyer and a cutoff date.

3. Select the purchase suggestions records you wish to process.

4. Click OK.
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5. Select the Buy check box for each suggestion that you want to create a purchase order.

6. When you finish selecting the desired suggestions, from the Actions menu, select Generate Purchase
Orders.

7. When Purchase Order Suggestion displays, select Generate Orders for Current Buyer, then click  OK.

8. To the Continue with Generate? message, click Yes to confirm the action.
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9. Suggestions selected as Buy are now removed from the list and new purchase orders for those suggestions
are created. The updated records display on the Tree View.
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Review New Purchase Orders

You can review these newly created purchase orders in Purchase Order Entry or by running the Open Purchase
Orders report.

Menu Path: Material Management > Purchase Management > Reports > Open Purchase Orders

1. Enter the From and To dates to determine the report date parameters.

2. Specify if you want Supplier Managed or Customer Managed inventory information included in the
report.

3. Specify if you want Supplier Part or Manufacturer Part cross reference information included in the report.

4. Optionally, enter Filter Summary criteria.

5. When you finish, click Print on the Standard toolbar to print the report.
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Inter-Company Purchase Orders

If your organization has installed the Multi-Site Management license, you can use the inter-company trading
functionality to create supplier-customer relationships between companies within your organization. You do this
by setting up your companies as customer and supplier records, and then linking them through external company
records. You can then create Inter-company purchase orders (ICPOs) between multiple companies within your
database.

You can create ICPOs and suggestions that originate in a customer company and are received automatically by
a supplier company. The supplier company can either send purchase suggestions back to the customer company,
or convert the ICPO into a sales order for processing and fulfillment. They then fulfill this demand by selling and
shipping the item back to the customer company.

The two (or multiple) companies must use the Epicor application and be set up for inter-company trading; they
can then send ICPO suggestions to each other. As long as the purchase order suggestions were created in the
application and sent electronically, you can automatically generate sales orders from the resulting ICPOs.

Sales Company – Manufacturing Company Scenario

You have a Sales company that sells a manufactured item to an end user (external customer), and another internal
company that actually manufactures the item being resold. This Manufacturing company is a supplier to the Sales
company; it receives an ICPO from the Sales company, which is a “customer” of the Manufacturing company.
When this happens, the Manufacturing company generates a sales order. This company now can fulfill the
demand by manufacturing the item, and then sells/ships it to the Sales company, which in turn resells the item
to an end user (external customer).

In this scenario you set up the Sales company as the customer and the Manufacturing company as the supplier.
Within the customer company, you enter a standard sales order in Sales Order Entry and generate purchase order
suggestions. You then convert the purchase order suggestions into a new purchase order for purchase of the
manufactured item from the Manufacturing (supplier) company. Now in the Manufacturing (supplier) company,
a new sales order is created using the ICPO suggestions automatically received from the Sales (customer) company.
Using this sales order, the Manufacturing (supplier) company manufactures and fulfills the order as requested,
ships the completed quantity back the Sales (customer) company, and then generate an invoice for it once it has
been received.
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Inter-Company Setup

To set up inter-company trading, you need to create purchase terms, customer, supplier, and external company
records that define the relationship between the companies.

Purchase Terms

In each company, create identical purchase and selling terms using Purchase Terms Maintenance. Purchase terms
are assigned to the supplier record you define for the supplier company, They specify the frequency, number of
payments, and discounts applied to invoices generated by the Manufacturing (supplier) company to bill the Sales
(customer) company for items it receives from the supplier company.

Menu Path: Material Management > Purchase Management > Setup > Purchasing Terms

To set up inter-company purchase terms:

1. Click the Down Arrow next to the New button; select New Purchasing Term.

2. Enter a unique identifier for the purchase terms into the Code field.

3. In the Number of Payments field, specify how many payments can be made for any invoice assigned these
purchasing payment terms. The application uses the number of payments in conjunction with the Number
of Days field to create a default payment schedule for any invoices assigned these terms.

4. In the Terms Type drop-down list, select the type of terms being defined. Valid selections are Days, Days
of month, and End of x-Month + y Days.

5. In the Due section, define the specific discount parameters appropriate to the terms type you selected in
the Terms Type drop-down list.

For more information, review the Suppliers and Accounts
Payable chapter in the Application Guide or the Purchase
Terms topics in the application help.

6. Click the Discount Type drop-down list to select the discount terms type for an invoice.
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Available options: Days, Days of month, and End of x-Month + y Days

7. When you finish, click Save.

Supplier Maintenance

You create supplier records for the internal companies from whom the current company receives materials and
services. If the current company will purchase goods from other companies, you must create a supplier record
in this company. Continuing the previous example, you create supplier records for the Sales and Manufacturing
companies in both companies to establish the ICPO relationship.

Menu Path: Material Management > Purchase Management > Setup > Supplier

To create a supplier:

1. Click the Down Arrow next to the New button; select New Supplier.

2. In the Supplier field, enter an identifier for the partner company.

3. In the Name field, enter the name of the partner company. For example, in the Sales company, you would
enter the name of the manufacturing company when defining its supplier record.

4. Select the IC Trader check box to indicate this supplier’s transactions are available for inter-company trading.
This designates that the supplier identifier can selected on purchase order transactions moved between
multiple companies. This option is only available if you use the External System Integration tools in the Epicor
application.

5. Click the Group drop-down list and select Intercompany. This designates that the supplier record is being
used in multi-company ICPO processing.
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6. Click the Terms drop-down list to select the purchase terms you defined in Purchase Term Maintenance for
this multi-company relationship.

7. Click the FOB drop-down list to define the Free on Board (FOB) point for goods being shipped to the partner
company. It indicates the point at which title of the shipped goods changes from the supplier company to
the customer company.

8. In the remaining sheets, enter supplier information as required for the partner company.

9. When you finish, click Save.

Customer Maintenance

Create customer records in Customer Maintenance for the companies with whom the current company will do
trades. You must also create a customer record for the current company as well if the current company will
purchase goods from other companies. Continuing the Sales and Manufacturing companies scenario, you create
a customer record in the Sales company for both the partner Manufacturing company, as well as for the Sales
company itself. Conversely, in the Manufacturing company, you create a customer record for the partner Sales
company in the Sales company, as well as for the Manufacturing company itself.

Menu Path: Sales Management > Order Management > Setup > Customer
The CRM menu path is: Customer Relationship Management > Order Management > Setup > Customer

To enter a customer:

1. Click the Down Arrow next to the New button; select New Customer.

2. In the Customer field, enter an identifier for the partner company.

3. Enter the name of the partner company into the Name field. For example, in the Sales company, you would
enter the name of the manufacturing company when defining its customer record.
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4. Click the Type drop-down list and select Customer.

5. Select the IC Trader check box to indicate this customer’s transactions are available for inter-company
trading; this designates the customer identifier can selected on order transactions moved between multiple
companies. This option is only available if you use the External System Integration tools.

6. In the remaining sheets, enter customer information as required for the partner company.

7. When you finish, click Save.

External Company Setup

Once you have defined purchase terms, supplier records and customer records, you must complete setup of all
required external company records that support multi-company processing in the application. This section briefly
describes these programs.

You can establish either direct integration between companies
that reside on the same database or Sonic integration between
companies that reside on separate databases. Documenting
these setup methods is beyond the scope of this guide. To
learn how to establish direct or Sonic integrations, review the
Multi-Site Technical Reference Guide within the application
help.

• External Company Maintenance

Use External Company Maintenance to either establish direct relationships with companies within the same
database or create remote connections to companies on other databases. You create external company records
to pass data to and from the current company to an external company. In a multi-company environment, for
example, you can create an external company so that you can share global customer, part, supplier and
financial data with the external company.

You can define the specific types of interactions you want to occur between the two companies - like sending
customer data, supplier data, PO suggestions, and so on for each record. You also set up the Inter-Company
Trading functionality in this program, defining the suppliers and customers involved in this trading relationship.

Main Menu Path: System Management > External System Integration > Setup > External Company
Maintenance

• External System Maintenance

Use External System Maintenance to add or update the integration records you use to transfer data between
multiple companies within your database.

Menu Path: System Setup > External System Integration > External System Maintenance

• Integrated Table Workbench

Use Integrated Table Workbench when an incoming record is not complete or contains some other error.
Rather than update the record in the other system and re-run a process, you can reconcile the discrepancy
within the Integrated Table Workbench.

Menu Path: System Setup > External System Integration > Integrated Table Workbench

This program is not available in the Epicor Web Access.
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Inter-Company Purchase Order Processing

You now use Sales Order Entry and Purchase Order entry to create, generate, and modify inter-company purchase
orders and suggestions.

Sales (Customer) Company - Enter Sales Order

The Sales (customer) company sells an item to an external customer manufactured by the Manufacturing (supplier)
company. In the Sales company, you enter a standard sales order, designate the Buy To Order supplier, and
generate purchase order suggestions.

Menu Path: Sales Management > Order Management > General Operations > Order Entry
The CRM menu path is: Customer Relationship Management > Order Management > General Operations >
Order Entry

1. Use the Summary sheet to create a new order.

2. Use the Lines > Detail sheet to create a detail line for the part quantity that will be produced in the
Manufacturing company.

3. In the Releases > Detail sheet, select the Buy To Order check box.

4. Click the Supplier button to find and select the supplier record (defined in Supplier Maintenance) for the
company manufacturing the part quantity.
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5. When you finish, click Save.

For more information on entering a sales order, review
the Sales Order Processing chapter.

Sales (Customer) Company – Generate Purchase Order Suggestions

You next generate purchase order suggestions for the sales order and convert them into a new purchase order.
The Sales (customer) company can then purchase the part quantity from the Manufacturing (supplier) company.

Menu Path: Material Management > Purchase Management > General Operations > Generate Suggestions

1. Run the Generate PO Suggestions process to generate PO suggestion records.

2. Use the Processing Options to indicate how the purchase suggestions will generate. Available options:

• Regenerative - Remove all the current suggestions, recreate them, and add new suggestions. This
option takes more time to process.

• Net Change - Only generate suggestions for purchase requests not generated the last time this process
was run. The default option, this method requires less processing time.

3. Click the Processing icon on the standard toolbar.
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Sales (Customer) Company – Create Purchase Order from Purchase Order Suggestions

Once you have generated purchase order suggestions from the sales order, you convert them to a purchase order
you use to purchase the manufactured item from the Manufacturing (supplier) company. When you generate
the purchase order, the application also generates ICPO suggestion records and sends them to the Manufacturing
(supplier) company.

Menu Path: Material Management > Purchase Management > General Operations > New PO Suggestions

1. Click the Binocular Search to find the purchase order suggestions.

2. The supplier identifier and name of the Manufacturing (supplier) company display in the Supplier field.

3. Select the Buy check box to specify you want to create a purchase order for the purchase order suggestions.

4. From the Actions menu, select Generate Purchase Orders.
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5. When Purchase Order Suggestion displays, select Generate Orders for Current Buyer, then click  OK.

6. To the Continue with Generate? message, click Yes.

The resulting purchase order can be viewed and modified as necessary in Purchase Order Entry.

Manufacturing (Supplier) Company – Generate Sales Order from ICPOs

Now through the multi-company functionality, the inter-company purchase order is sent to the receiving
Manufacturing (supplier) company. In the Manufacturing company, you create a new sales order from the ICPO
suggestions. The Manufacturing company can now begin fulfilling the sales order, and can also handle future
changes requested by the Sales company.

To convert an ICPO suggestion into a sales order:

1. In the Manufacturing (supplier) company, navigate to Sales Order Entry. From the Actions menu, select
Incoming to Linked ICPO Suggestions.

2. When Incoming ICPO Suggestions program displays in the supplier company, review the suggestions.  

69Epicor ERP | 10.0.700

Purchasing | Chapter 1Epicor ERP Application User Guide - Part Two



3. To convert an ICPO suggestion into a sales order, select the Ready for Order check box.

4. To finish accepting and rejecting the ICPO suggestions, from the Actions menu, select Process All
Suggestions.

Manufacturing (Supplier) Company – Modify Inter-Company Purchase Orders

To make changes to the sales order and modify inter-company purchase orders as needed.

Menu Path: Sales Management > Order Management > General Operations > Order Entry
The CRM menu path is: Customer Relationship Management > Order Management > General Operations >
Order Entry

1. To make changes to the sales order, from the Actions menu, select Suggestions to Linked PO.
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2. When the Send Inter-Company PO Suggestions program displays, click the Sales Order button to find the
sales order linked to an ICPO.

3. You can make specific changes to the sales order. For example you can change the Order Quantity to
reflect a new demand requirement.

4. When you finish, click Save.

5. To  send the suggestion to the customer (Sales) company, from the Actions menu, select Send All
Suggestions.

The application sends the suggestions to the Sales (customer) company that originally sent the inter-company
purchase order. As the suggestions are sent for the sales order created from the original ICPO, the application
automatically updates the inter-company purchase order record with this information.
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Sales (Customer) Company – Accept Purchase Order Suggestions

After the Manufacturing company makes changes to the sales order generated from ICPO suggestions, the Sales
(customer) company can review the suggestions, accept them, or reply with further changes.

Menu Path: Material Management > Purchase Management > General Operations > Purchase Order Entry

1. In Purchase Order Entry, from the Actions menu, select Change PO Suggestions.

2. Click the Binocular search button to find the purchase order suggestion.

3. For each suggestion, you can make changes and then accept the suggestion. Available change options:

• Cancel - Ignores the suggestion.

• Expedite - Requests activity be initiated on the ICPO suggestion sooner than originally planned.

• Increase - Adds more quantity to the suggestion.

• Postpone - Delays the suggestion for a time.

• Reduce - Subtracts quantity from the suggestion.

4. Besides making changes to the overall suggestion, you can change or cancel a specific detail line. To do this
click the Edit PO Line button and make the changes needed in the window that displays.

5. Likewise, you can make changes to suggested release by clicking the Edit PO Release button.

If the related order release is not linked to a job record,
the application voids the order release. However, if the
related order release is linked to a job, the application sets
the order release quantity to zero, and creates a
manufacturing suggestion for the related job record.
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6. To complete the purchase order change, click the Accept button. You can also click the Actions menu and
select Accept.

The Manufacturing (supplier) company automatically receives the change and the application updates the linked
sales order with the new purchasing information.

Manufacturing (Supplier) Company - Process the Sales Order

Once demand for the sales order is fulfilled by the Manufacturing (supplier) company, you are ready to ship the
order to the Sales (customer) company.

Menu Path: Material Management > Shipping / Receiving > General Operations > Customer Shipment Entry

1. In Customer Shipment Entry, in the Pack ID field, enter the packing identifier number associated with
the shipment.

2. Record the shipment quantities in the Lines > Detail sheet.

3. To print a packing slip, shipping labels, or both documents, from the Actions menu, select Print.

4. After printing the packing slip or shipping labels, select the Shipped check box.

5. Click Save.

After you save the record, the application automatically creates and sends a shipment record to the Sales (customer)
company.
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Sales (Customer) Company - Receive Completed Items from Manufacturing (Supplier) Company

Within the Sales (customer) company, launch Receipt Entry to record the receipt of the quantity from the
Manufacturing (supplier) company.

Menu Path: Material Management > Shipping / Receiving > General Operations > Receipt Entry

1. From the Actions menu, select Add Intercompany Receipt.

2. When the Add Intercompany Receipt window displays, select the supplier and intercompany receipt. The
Epicor application retrieves the corresponding purchase order and automatically closes it.

Manufacturing (Supplier) Company – Invoice Items Sold to Sales (Customer) Company

Once the shipped items are received, the Manufacturing (supplier) company can generate an AR invoice and bill
the Sales (customer) company for the item.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry

To generate an AR invoice and bill the Sales (customer) company for the item:

1. In AR Invoice Entry, from the Actions menu, select Get > Shipments.
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2. The Get Shipments window appears. First, select the site from which you want to generate the invoices.
You can select the Current Site or All Sites.

3. Indicate the customer shipments for which you want to generate the invoices. You can generate invoices
for all customers or click the Customers button to select specific customers.

4. Click the Select All, Manual Selection, and Drop Shipments buttons to select the specific shipments
from which you will generate invoices.

5. Complete the invoice in AR Invoice Entry. Use this program to enter any final changes on the invoice.

6. To determine the taxes, from the Actions menu, highlight Group, and select Calculate All Taxes.

7. To post the invoice, from the Actions menu, highlight Group, and select Post.

The invoice is then posted by the Manufacturing (supplier) company. When the Sales (customer) company receives
the AR invoice, the Sales company pays the Manufacturing company for the purchased quantity.
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Buyer Workbench

The Buyer Workbench is a centralized tool you can use to both generate and manage request for quotes (RFQs)
and purchase orders (POs). Through this program, you can select a specific buyer and view a summary of the
RFQs and POs assigned to this buyer. The information includes the number of RFQ and purchase order records
open, overdue, scheduled for today, scheduled for this week, and scheduled for beyond this week (future).

The Buyer Workbench also displays the number of RFQs that have received responses from suppliers and are
ready for processing, as well as the number of purchase orders that require the current buyer’s approval.

Menu Path: Material Management > Supplier Relationship Management > General Operations > Buyer Workbench

To review the RFQs and POs for a specific buyer:

1. Click the Buyer button to find and select a specific buyer to review. Typically, you will select your buyer
record.

2. The current activity of the RFQs linked to this buyer display within the RFQ section.

3. The current activity of the POs linked to this buyer record display within the PO section.
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4. To review RFQ suggestions and generate request for quotes, click the RFQ’s sheet.

5. Click the RFQ Entry button to launch this entry program and create RFQ records.

6. Click the Supplier Response button to launch this program and enter the responses you have received on
RFQ records from suppliers.

7. The Overdue, Today, This Week, and Future sheets display the current RFQ records that fall within these
time frames.

8. Click the Suggestions sheet to evaluate and handle all RFQ suggestions you want to turn into RFQs.

9. Click the Ready sheet to indicate which RFQs can be turned into purchase orders.

10. To review and enter purchase orders, click the PO’s sheet.

11. The Open PO’s sheet displays all of the currently open purchase orders.

12. If you need to create a new PO or edit an existing one, click the PO Entry button.

13. The Late, Today, This Week, and Future sheets all display the current PO records that fall within these
time frames.
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14. Click the Web sheet to review all RFQs and POs you have received through the internet.

15. The Actions menu gives you immediate access to a number of purchasing programs you need.

16. You can launch Purchase Order Entry, RFQ Entry, Supplier Maintenance, and various
Suggestion programs through the Actions menu.
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Reports

This section describes some key purchasing reports you use to review prices of both manufactured and purchased
parts. You can run these reports whenever you need. You can also set up each report to generate and print
through a recurring, automatic schedule. Review the Automatic Data Processing chapter in the Epicor ERP
Implementation Guide for information on how to link a report to a recurring schedule.

Part Price History Report

Use this report to review pricing information for your purchased parts. This report displays its information in order
by part.

Menu Path: Material Management > Supplier Relationship Management > Reports > Part Price Report

To run this report:

1. To display current prices, select the Most Recent Prices Only check box.

2. If you want to view supplier part cross references on this report, select the Include Supplier’s Parts check
box.

3. If you want to view manufacturer part cross references on this report, select the Include Manufacturer’s
Parts check box.

4. Use the Filter sheet to limit this report to only display parts for specific suppliers and/or parts.

5. Click Print on the Standard toolbar.
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Supplier Price History Report

Use this report to review pricing information for your purchased parts. This report displays its information in order
by supplier.

Menu Path: Material Management > Supplier Relationship Management > Reports > Supplier Price Report

To run this report:

1. To display current prices, select the Most Recent Prices Only check box.

2. If you want to view supplier part cross references on this report, select the Include Supplier’s Parts check
box.

3. If you want to view manufacturer part cross references on this report, select the Include Manufacturer’s
Parts check box.

4. Use the Filter sheet to limit this report to only display parts for specific suppliers and/or parts.

5. Click Print on the Standard toolbar.
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Chapter 2: Quality Assurance

The Quality Assurance and the Enhanced Quality Assurance (EQA) modules tie together all quality functions, whether
scrapping end parts, rejecting raw materials, tracking first article inspections (where a first part is tested regularly), and
indicating when parts are not compliant. With the Enhanced Quality Assurance module license, you can also track
internal education and training for your employees.

The chapter begins with the setup records you need to define before you can use the quality functions - the inspectors
that conduct inspections and the reasons material requires inspection. If you use the Enhanced Quality Assurance
module, you can enter specific inspection data for purchase order receipts, customer returns, and jobs or operations.
To do this, you define the inspection attributes you want to track and the specifications for those attributes. You then
create inspection plans associated with a part revision, job, or operation. You can also apply skip lot control to those
suppliers that supply you with parts.

The second half of the chapter reviews the quality functions you use to process items that require inspection. First, use
the Nonconformance program to add non-conforming material found during job production. Then, the inspector uses
Inspection Processing to inspect this non-conforming material, in addition to the purchase order receipts that require
inspection. If you use the Enhanced Quality Assurance module, you also have access to Inspection Results Entry. Use
this program to enter specific inspection data. Then run the Inspection Data Tracker to view the inspection results.

Any job material, job assemblies, inventory, customer returns, or purchase order receipts that fail inspection are placed
on the Discrepant Material Report (DMR). The material review board then has the option to reject these parts or accept
parts and disposition to a job, rework, or inventory. At any time, a corrective action can be added to record what was
done with the material. This chapter concludes with key quality reports you use to monitor discrepant material.

In order to describe the entire business flow for this functionality, this chapter assumes you use both the Quality
Assurance and Enhanced Quality Assurance modules.

Setup

This section describes the primary records you need to create for both the Quality Assurance and Enhanced
Quality Assurance modules. These programs are contained within the Setup folder. Only the primary records are
described here. Some areas within the next Operations section may also document setup records if they are
required for a specific workflow.  

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review the application help for this
module; the Configuration topic details the options you define within Company Configuration. You can also
review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Inspector Maintenance

You use Inspector Maintenance to create inspector records. Inspectors are the people in your shop who inspect
material or parts for defections, ensuring all items in the production cycle meet your quality standards. These
records are used when you run Inspection Processing.

Menu Path: Production Management > Quality Assurance > Setup > Inspector

To add an inspector:
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1. Click the New button on the Standard toolbar.

2. Enter an Inspector ID. This value displays within other programs and reports.

3. Enter the Name of the inspector. This value displays on drop-down lists in other programs.

4. When you finish, click Save.

Reason Code Maintenance

Use Reason Code Maintenance to assign standard explanations for labor scrap and rework, inspection processing,
inventory adjustments, and Return Material Authorization (RMA) entries. You can create reason codes that match
your workflow needs.

Each reason code is assigned a reason type. Reason types are system-defined and cannot be changed. The
following reason types are used in manufacturing:

• Scrap: This code identifies a nonconformance quantity which can potentially be re-used.

• Quality Assurance: This code is used for inspection and corrective actions.

• DMR: This reason code is used for discrepant material review.

• Inventory Adjustments: Use this value to identify items being pulled out of inventory because they are
non-conforming materials.

• Rework: This code is used for items sent back to be re-worked after inspection or DMR.

Menu Path: Production Management > Quality Assurance > Setup > Reason Code

To add a reason code:
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1. Select the Reason Type this reason code is assigned from the drop-down list. In this example, you want to
add a reason code for DMR.

2. Click the Down Arrow next to the New button; select New Reason Code.

3. Enter a Reason Code. This value displays within other programs and reports.

4. Enter a Description of the reason code. This value displays on drop-down lists in other programs.

5. Depending on the reason type selected, other fields become available. For example, if you want this reason
code available for selection in Inspection Processing, select options in the Inspection section.

6. When you finish, click Save on the Standard toolbar.

Global Alert Maintenance

Use Global Alert Maintenance to both activate and adjust global alerts. Global alerts are messages automatically
sent out to pre-defined recipients when certain events occur within the database. Global alerts are an excellent
communication tool that helps individuals keep up-to-date on current business activity.

Events that trigger global alerts are pre-defined and cannot be deleted. However, you can activate/deactivate
pre-defined events and define the recipient of the alert if an alert is sent.

Although global alerts cannot be changed, you can create
custom global alerts through the Business Activity Manager.
For more information on creating custom alerts, review the
Business Activity Manager chapter in the Epicor ICE Tools User
Guide.
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Menu Path: Production Management > Quality Assurance > Setup > Global Alert

To activate a global alert:

1. Click on the ID button to initiate a search for a pre-defined global alert. 

2. In the Global Alerts Search window, select the pre-defined event you want to activate and click OK.
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3. The ID and Description fields populate and cannot be changed.

4. In order to use this alert, select the Active check box.

5. If you want a memo created when this event is triggered, select the Create Memo check box. The new
memo is assigned to the record (job, order, quote, and, so on) that caused the alert.

6. Select the Send Alert check box to send an email when this event is triggered. When selected, additional
fields you use to define the recipients who receive the alert become available.

7. The From Email Address and Label field values default from settings in the Company Configuration file;
if you need, you can edit these values.

8. If you are sending an alert, define recipient information in the Alert section such as To, CC, and Text.

9. When you finish, click Save on the Standard toolbar.

Inspection Attributes

Inspection attributes are quality elements you want reviewed during the inspection process. These attributes are
then assigned to specifications and used within inspection plans. You also assign a table field name to each
attribute in order to collect and analyze inspection data.

Menu Path: Production Management > Quality Assurance > Setup > Inspection Attribute

To create a new attribute:
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1. Click the New button on the Standard toolbar.

2. In the Attributes field, enter the identifier for the new inspection attribute.

3. Enter a concise Description.

4. Select an Attribute Type from the drop-down list. Attribute types available include:

• Numeric

• Check box

• Combo box

• Character

• Date

• Comments

The specifications you define within Specification Maintenance for an inspection attribute depend on the
attribute type. For example, if you select Numeric, you can specify minimum and maximum values. If you
select Combo box, minimum and maximum values are disabled; however, you can specify the list of values
you want to present to the user during inspection processing. For more information on specifications, review
the next Specification section.

5. Select the Table Field Name you want to assign to this attribute. This value determines where the data for
this attribute is stored within the inspection results table.

6. Once you assign this inspection attribute to a specification, the In Use icon becomes active and displays in
green.

7. When you finish, click Save.

Continue to add all the inspection attributes you need.

Specification

A specification ties together the inspection attributes you want. You use Specification Maintenance to store the
details, or characteristics, of the inspection attributes. Characteristics include information such as minimum and
maximum values, incremental and initial values, tool tips, a list of acceptable values, and so on. The inspection
attribute properties you define are used in the inspection plan. The next section, Inspection Plan, shows you how
to create these plans.

One specification can apply to many parts. For example, you have multiple parts in your database for steel bars.
You could attach the same specification to each part to save time on data entry.

Menu Path: Production Management > Quality Assurance > Setup > Specification
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To create a specification:

1. Click the New button on the Standard toolbar.

2. Within the Specification field, enter an identifier.

3. Enter the Description, or the explanation, for the new specification.

Add a Revision

Specifications are revision controlled, so you can create multiple versions of the same specification.

To add a revision:

1. Click the Down Arrow next to the New button; select New Specification Revision.

2. The Revision Detail sheet displays. In the Revision field, enter the revision identifier.

3. Enter the Description for the new revision.

4. Specify an Effective date; the date when this revision is available.

5. Optionally, find and select the Inspection Plan you want to assign to this specification revision. You can
attach an inspection plan to a specification. When you attach a specification to a part, operation, or RMA,
the inspection plan defined on the specification defaults; however, you can change this option.

6. Click Save on the Standard toolbar.

Assign Inspection Attributes

Now specify the inspection attributes you want to assign to this specification revision.
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Here’s how:

1. Click the Down Arrow next to the New button; select New Inspection Attribute.

2. The Revision > Inspection Attributes > Detail sheet displays. Click the Inspection Attribute button to
find and select an inspection attribute to add to this specification revision.

3. The Attribute Type for this inspection attribute defaults and cannot be changed.

4. The Description defined on the inspection attribute record defaults; if you need, you can change this value.

5. In the Screen Label field, enter the description you want to display on the Configurator input screen.

6. Enter the Minimum Value and the Maximum Value for this inspection attribute. These fields are not
available if the attribute’s type is Combo box.

7. In the Increment field, specify the increments used to record an inspection value. For example, if you set
the Maximum Value to 110, the Minimum Value to 100, and the Increment to 2, then the actual values of
100, 102, 104, and 106 are acceptable. These fields are not available if the attribute’s type is Combo box.

8. Enter the Initial Value to display when inspection data is added to the inspection plan. Typically, this value
is the expected value for this attribute.

9. If used, enter the Tool Tip you want the Configurator to display.

10. In the List Values field, enter a comma-delimited list of options that display within the inspection plan. This
field is available only if the attribute’s type is Combo box.

11. In the Pass List Values field, enter an (optional) listing of valid pass values for this inspection attribute. The
Epicor application uses these values for testing inspection results. It uses the values defined on this list to
determine if an inspection passes or fails. For example, if 2,4,6, and 8 are defined as pass values and the
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user selects 8 within Inspection Results Entry, the Epicor application designates 8 as a Pass value; other
recorded inspection values are considered Failure values.

12. When you finish, click Save on the Standard toolbar. Continue to add all inspection attributes to this
specification revision.

Approve Specification Revision

When the specification revision is ready, you need to approve the specification revision before you can use it.

Here’s how:

1. Navigate to the Revision > Detail sheet.

2. Select the Not Approved check box. This clears the specification for use, and the Approved icon displays.

3. Click Save on the Standard toolbar.

Inspection Plan

Inspection plans control the inspection process and are used to enter the results from inspecting those parts,
operations, and RMAs in which specifications and inspection plans are defined. Once you create an inspection
plan record in the Inspection Plan program, you can then launch the Configurator directly to design the entry
form that others will use to capture the inspection results.

Inspection plans are revision-controlled and can be used with multiple specifications; the Configurator amends
the input screen depending on the inspection attributes assigned to the current specification. For example, one
specification has three attributes and another specification has the same three attributes plus an additional
attribute. You could create an inspection plan that covers all four attributes; when the inspection plan for the
three attribute specification is called, the fourth attribute does not display during inspection results entry.

This section briefly reviews the Configurator Designer. For more
information on how to design an input screen, review the
Configurator chapter.

Menu Path: Production Management > Quality Assurance > Setup > Inspection Plan

To add an inspection plan:
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1. Click the New button on the Standard toolbar.

2. In the Inspection Plan field, enter an identifier for the inspection plan.

3. Enter a concise Description.

4. Select Inspection Plan from the Inspection Plan Type list.

Another inspection plan type is Calibration Plan.
Calibration inspection plan types are used to assist in
equipment maintenance. For more information on
Equipment Maintenance, review the chapter on
Maintenance Management.

5. Click Save.

Add a Revision

Inspection plans are revision controlled, so you can create multiple versions of the same inspection plan.

To add a revision:

1. Click the Down Arrow next to the New button; select New Inspection Plan Revision.

2. The Revision > Detail sheet displays. In the Revision field, enter a unique revision identifier.

3. Enter the Description, or explanation, that further defines this inspection plan revision.
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4. Specify an Effective date - the date when this revision is available.

5. Click Save on the Standard toolbar.

6. Notice the red No Plan icon. This indicates a plan has not yet been configured for this inspection plan
revision. Once you configure an inspection plan using the Configurator Designer, the icon changes to a
green Plan Exists icon. You will next configure the inspection plan.

Configure the Inspection Plan

Now you are ready to design the screens for inspection results entry. If you use the Enhanced Quality Assurance
module, you can create inputs in the Configurator using external sources; these values are the pre-defined
inspection attributes used during the inspection process.

To design the inspection results entry screen:

1. On the Revision > Detail sheet within Inspection Plan Maintenance, click the Configure Inspection
Plan button.

2. Configurator Entry displays. You first add a new configuration record; this links the inspection plan record
and the inspection plan results entry screen you are designing. Click the Down Arrow next to the
New button, and select New Configuration.
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3. Create a Configurator ID that identifies the inspection plan results screen you are configuring.

4. Enter a Description for the configurator record.

5. In the Configuration Type field, select Inspection Plan Configurator.

6. Click Save on the Standard toolbar.

7. From the Actions menu, select Configurator Designer.
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8. The Configurator Designer displays.

9. First, you need to add a new page. Click the Down Arrow next to the New button, then select New Page.

10. Navigate to the Design > Page Designer sheet.

11. In the Toolbox pane, select the control you want to add to the input page. In this example, you select the
Decimal control so you can reference the numeric Length inspection attribute.

12. Select the area on the page where you want the control to appear. Move and stretch the control so it displays
in the location and size you want.
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13. With the control selected, use the parameters located in the Input Properties pane to define how for the
controls placed on the input page should operate.

14. Enter a Label and (optionally) Summary Label for the input control you place on the page. Once you save
the input page, you cannot change the system assigned input name.

15. Select True in the External Reference parameter to bring in an inspection attribute’s characteristics.

16. Click the button to the right of the Attribute parameter to select an available inspection attribute. The
application filters the attributes available for selection by only displaying those attributes where the attribute
type matches the control added to the page.

17. Depending on how you want to leverage the inspection inputs, select True in the Use Minimum Value,
Use Maximum Value, Use Incremental Value, Use Initial Value, Use Tool Tip, and Use Label Name
parameters to determine what values are pulled in from the inspection attribute.

Depending on the selected attribute type, not all input parameters are available. For example, if you select
an inspection attribute that is a character attribute type, only the Use Tool Tip and Attribute parameters
are available for use.
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18. Click Save on the Standard toolbar. Continue to add pages and controls you want for this inspection plan
revision.

Test the Inputs

When finished adding pages and controls, and adjusting the inputs as needed, you are ready to test the inputs.

Here’s how:

1. From the Actions menu, select Test Inputs.
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2. The Test Inspection Plan window displays.

3. Enter the Specification ID you want to test.

4. From the Revision list, select the specification revision to test.

5. Click OK.  

6. The Test Inputs window displays.

7. Notice the inspection attribute characteristics you defined on the selected specification revision display. You
can now test the inputs. For example, the initial value of 36 displays in the Length input field.

8. If you attempt to put a value in the Length field outside the minimum or maximum values defined in the
specification for this inspection attribute and click Save, a message displays stating the inspection plan
failed. If the values are within the stated minimum or maximum values, displays that states the inspection
plan was true.

Continue to test the inputs and adjust the pages and controls as you need.

You can apply a Pass/Fail variable to all Configurator features.
The Pass/Fail variable is set automatically on the
minimum/maximum values set for the inspection attributes; if
the results are below or above these values, the inspection
fails. However, you can define rules to set the Pass/Fail variable
inspections to other controls as well. For more information
about this functionality, review the Configurator chapter.

Approve the Design

Once the design is complete and the configuration tested, you are ready to change the status of the design to
Approved.

Epicor ERP | 10.0.70096

Epicor ERP Application User Guide - Part TwoChapter 2 | Quality Assurance



To do this:

1. Navigate to the Configurator sheet.

2. Select the Approved check box. When the Description of Changes window displays, enter the change
explanation and click OK.

3. Click Save on the Standard toolbar.

4. Exit the Configurator Designer.

Approve the Inspection Plan Revision

Now you are ready to approve the inspection plan revision.

Here’s how:

1. In Inspection Plan Maintenance, notice the red No Plan icon is replaced by a green Plan Exists icon. This
indicates an approved inspection plan exists for this inspection plan revision.

2. Select the Not Approved check box. This clears the inspection plan for use, and the Approved icon displays.

3. Click Save on the Standard toolbar.
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Skip Lot Control Code

Use Skip Lot Control Code to create the frequency rules in which parts are inspected at the time of receipt. You
then assign these skip lot control codes at the part - supplier level.

For each skip lot control code, you define the number of lots (receipts) to inspect, the number of receipts to skip
between each receipt, and the number of cycles to process before moving to the next pre-determined skip lot
control code. In this example, you want to define a skip lot control code for new suppliers.

Menu Path: Production Management > Quality Assurance > Setup > Skip Lot Control Code

To create a skip lot control code:

1. Click the New button on the Standard toolbar.

2. Enter a unique identifier in the Skip Code field.

3. Enter a Description for the skip code.

4. Define the number of lots (receipts) to Inspect.

5. Define the number of lots (receipts) to Skip between each inspected receipt. If the receipt does not require
inspection, then the receipt is not placed in the inspection queue; rather, the receipt passes directly to stock,
to the job, or to an operation.

6. Indicate the number of inspect/skip cycles to process before moving to the next pre-defined skip lot code
in the Repeat field.

7. In the Minimum Cycles field, indicate the number of cycles to complete before the skip lot code can move
to a cycle that does not inspect as many lots. If this field is set to zero, the application ignores the check.

8. If you allow a quantity of inspected parts to fail inspection before the part moves to a more restrictive skip
lot control code cycle, where more lots are inspected, select the Use Maximum Reject check box.

9. If you selected the Use Maximum Reject check box, define the number of rejects to allow in the Maximum
Reject (all Cycles) field. If this field is set to zero, the application ignores the check.
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10. Use the Reject Count By list to determine the value added to the Reject Count field in the inspection table.
The options are Skip Lot or Quantity. If you select Skip Lot, then the Reject Count is increased by 1 if the
receipt inspected has a rejected quantity. If you select Quantity, then the Reject Count is increased by the
total failed quantity if the receipt inspected has a rejected quantity.

11. From the On Pass move to Skip code list, select the skip code the part quantity will use if both the number
of cycles is the same as the value defined in the Minimum Cycles field and the number of rejects is less than
or equal to the value defined in the Maximum Rejects (all Cycles) field. If you do not select a code from this
list, then the current cycle will start again.

12. From the On Failure move to Skip code list, select the skip code that parts will use if both the number of
cycles exceeds the value defined in the Minimum Cycles field and the number of rejects exceeds the value
defined in the Maximum Rejects (all Cycles) field. If you do not select a code from this list, then the current
cycle will start again.

13. When you finish, click Save.

Part Maintenance

You associate inspection plans and specifications to either parts or operations. Then, when inspecting a part
receipt or entering time against an operation that requires inspection, you have the option to enter inspection
data for that part or operation using Inspection Results Entry.

In this example, you use Part Maintenance to associate an inspection plan and specification to a part revision.
You can also define a different inspection plan and specification for customer returns of the same part revision.
In addition to defining inspection plans and specifications to part revisions, you can add suppliers to a part revision
and attach skip lot code logic.

You can also associate a part on a purchase order line to an
inspection plan and specification within Purchase Order Entry.
You associate inspection plans and specifications to operations
within Operation Entry, Job Entry, Quote Entry, and the
Engineering Workbench. When you associate inspection plans
and specifications to a part or operation, the Inspection
Required check box is automatically selected.

Menu Path: Production Management > Quality Assurance > Setup > Part

Check Out the Part Revision

You must check out the part revision before you can attach inspection plans and specifications to it.

Here’s how:
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1. Click the Part button and then find and select a part.  

2. In the Tree View, highlight the part revision for which you want to add an inspection plan and specification.
You can only attach inspection plans and specifications to part revisions.

For more information on how to add a revision, review
the Engineering chapter.

3. Now check out the revision. To do this, click the Actions menu.

4. Highlight the Revision sub-menu.

5. Select Check Out Revision.

6. The Part Revision Checkout window displays. In the Revisions grid, highlight the revision to check out.

7. Click the ECO button to find and select the ECO group you want to check out this revision.
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8. Click OK. The part revision status is set to Not Approved. Now you can add inspection plans and specifications
to it.

Add Inspection Plan and Specification to Part Revision

Now that the part revision is checked out, you can attach inspection plans and specifications to it.

Here’s how:

1. Click the Down Arrow next to the New button; select New Part Inspection Plan.

2. The Part > Revisions > Inspection > Detail sheet displays.

3. Click the Inspection Plan button to find and select an inspection plan. You do not specify the inspection
plan revision because the application always uses the latest revision.

4. Click the Specification ID button to find and select a specification. You do not specify the specification
revision because the application always uses the latest revision.

5. Optionally, define the minimum Sample Size and/or Sample Size % quantity to inspect. You can enter
values in both fields; the application determines the sample size to use during inspection results entry. For
example, you set the Sample Size to 10 and the Sample Size % to 15%. If the application finds that the
quantity available to inspect, based on the Sample Size % defined, is less than the Sample Size defined,
then the Sample Size value is used for the inspection.

6. If this inspection plan is the default for this part, select the Default check box. You can specify only one
inspection plan as the default.

7. Continue to add the needed inspection plans for this part revision. You can attach more than one inspection
plan to a part revision. For example, you need three inspections for one part revision - one visual inspection,
one purity inspection, and one microbial (pathogens) inspection. Then, in Inspection Results Entry, you can
enter inspection data for each inspection plan. The inspection plans you attach to a part all display on the
List sheet. When you finish, click Save on the Standard toolbar.
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Add RMA Inspection Plan and Specification to Part Revision

You can also add an RMA inspection plan and specification to part revisions. The RMA inspection plan and
specification specified in Part Maintenance is used when you enter inspection data while disposing an RMA.

For more information on how to process and disposition RMAs,
refer to the chapter on Customer Returns. You can only define
one RMA inspection plan and specification for a part revision.

Here’s how:

1. Select the Part > Revisions > Inspection > RMA tab.  

2. Click the Inspection Plan button to find and select an inspection plan to use when entering RMA inspection
data for this part revision.

3. Click the Specification ID button to find and select a specification to use when entering RMA inspection
data for this part revision.

4. Optionally, define the minimum Sample Size or Sample Size % quantity to inspect.

5. Click Save on the Standard toolbar.

Add Skip Lot Control to Suppliers

You can apply skip lot control codes to suppliers for a specific part revision.

To do this:
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1. Click the Down Arrow next to the New button; select New Part Inspection Supplier. 

2. The Part > Revisions > Inspection > Supplier > Detail sheet displays. Click the Supplier  button to find
and select the supplier you want to apply a skip lot control for this part revision.

3. Select the Skip Lot Controlled check box to include this supplier in the skip lot process. When you select
this check box, the Skip Lot Controlled icon turns green.

4. From the Skip Lot Code  list, select the code to apply to this supplier.

5. The Inspection Count, Skip Count, Repeat Cycles, and Reject Count fields are application-maintained
counters that display, respectively, the number of receipts, skipped lots, cycles, and rejected lots recorded
through the inspection process. However, you can adjust these fields to force further inspections.

For information on how to set up a skip lot control code,
review the previous Skip Lot Control Code section.

6. Select a Reject Count By method. This setting determines the value added to the Reject Count field in the
inspection table. The options are Skip Lot or Quantity. If you select Skip Lot, then the Reject Count is increased
by 1 if the receipt inspected has a rejected quantity. If you select Quantity, then the Reject Count is increased
by the total failed quantity if the receipt inspected has a rejected quantity.

7. Optionally, define the minimum Sample Size Quantity and/or Sample Size % to inspect. You can enter
values in both fields; the application determines the sample size to use during inspection results entry. For
example, you set the Sample Size to 10 and the Sample Size % to 15%. If the application finds that the
quantity available to inspect, based on the Sample Size % defined, is less than the Sample Size defined,
then the Sample Size value is used for the inspection.

8. To inspect all receipts for this part revision from this supplier, select the Force Inspect All Receipts check
box. When you select this check box, the Inspect All icon turns green.

9. When finished, click Save on the Standard toolbar. Continue to add the suppliers you want for this part
revision.
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Check In and Approve Part Revision

You must check in and approve the part revision before the inspection plans, specifications, suppliers, and RMA
details are applied to this part revision.

Here’s how to check in and approve the part revision:

1. In the Tree View, highlight the part revision you want to check in.

2. Click the Actions menu.

3. Highlight the Revision sub-menu.

4. Select Engineering Workbench.
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5. The Engineering Workbench displays. In the Tree View, highlight the part revision you want to approve
and check in.

6. Select the Not Approved check box. A green Approved icon now displays.

7. Now you are ready to check in the part revision. To do this, click the Actions menu, highlight the
Revision sub-menu, and Select Check In.
When the Description of Changes window displays, enter the change explanation and click OK. Click OK
again when the check in complete message displays.

8. Exit the Engineering Workbench.

9. In Part Maintenance, notice the part revision status is now set to Approved.

105Epicor ERP | 10.0.700

Quality Assurance | Chapter 2Epicor ERP Application User Guide - Part Two



Operations

This section details the operations you can run through the Quality Assurance and Enhanced Quality Assurance
modules. Each operation is described as a workflow to help guide you through the process from start to finish.
These programs are primarily found within the General Operations folder. If a unique setup record is required to
run the operation, this record is also described in this section.

Nonconformance

Use the Nonconformance program to add or update nonconformant materials during job production. Generally,
you enter nonconformance records because the material is bad, defective, suspect, or needs inspection. The
material can be an assembly, raw job material, scrap, items from a subcontractor, or parts from another source.
The information you enter is sent to an inspector, who then inspects the material and dispositions it.

For information on dispositioning material, review the next
Inspection Processing section.

When nonconformant materials are reported by employees through Time and Expense Entry, nonconformance
records are created. You can then review and edit these records in the Nonconformance program. For these
types of records, you can only modify the quantity and the reason fields in Nonconformance. All the other fields
are unavailable.

Menu Path: Production Management > Quality Assurance > General Operations > Nonconformance

Nonconformance - Material

To enter a nonconformance for material during job production:

1. Click the Down Arrow next to the New button; select New Material.
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2. Enter the Employee who discovered the nonconformance. You can do this by entering the employee
number directly or by clicking the search button to find and select it.

3. In the Job field, enter the job in which the non-conforming material was found.

4. Select the assembly on which the non-conforming material was found. You can enter this number directly,
select it from the list, or click the Assembly button to find and select it. If there is only one assembly on
the job, a 0 displays in this field.

5. Select the Material sequence from the assembly that is non-conforming.

6. The Part number, Description, and Revision of the part only display for your information; you cannot
change these values.

7. Enter the Quantity of the material that is non-conforming.

The quantity can be expressed as a whole or as a fraction
with decimals (if allowed). For more information on the
unit of measure functionality, review the Part Parameters
chapter in the Epicor ERP Implementation Guide. If
multiple units of measures are tracked for the part, the
quantity entered here cannot be greater than the on-hand
quantity for this part. For more information on how you
track multiple units of measure, review the Parts section
in the chapter concerning Inventory Management.

8. The default unit of measure for this part displays in the UOM field; if you need, change the unit of measure.

9. This Transaction displays the quantity of material for this nonconformance record. This value is based on
the unit of measure defined for this job material part within Job Entry.

10. The UOM code represents the unit of measure assigned to the job material part within Job Entry.
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11. Lot specifies the lot number of the part identified as non-conforming. This field is updated by the application;
if you need, change the lot.

12. The Serial Numbers button becomes active if the part is assigned a serial number. If a discrepancy exists
between the Quantity field and the number of serial numbers entered at the time of purchase order receipt,
and one of the warehouse sites is set to Full Serial Tracking, the application requires entry of additional serial
numbers.

13. Select the Reason the material is non-conforming.

14. Optionally, select the Operation Sequence in which the non-conforming material was found. You can
enter this number directly, select it from the list, or click the Operation Seq button to find and select it.

15. The Resource for the combination of job number and assembly displays in this field; if you need, change
the resource assigned.

16. The warehouse and bin associated with the job from which you will move the non-conforming material
defaults in the From Warehouse and Bin fields; if you need, change the warehouse and bin.

17. Select the warehouse and bin where the non-conforming material should go for inspection in the To
Warehouse and Bin fields.

18. When you finish, click Save on the Standard toolbar. The application automatically assigns a transaction
ID to the new nonconformance record.

Shop floor personnel can also report non-conforming
material when they enter time against an operation. These
records are accessed through the Nonconformance
program, however you can only modify the Quantity and
Reason values on these records. For more information,
review the chapter on Time Management.
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19. Use the other sheets to further specify the nonconformance records. Subcontract sheet to add, edit, or
delete open nonconformance records related to discrepant material from a subcontract operation.

• Use the Subcontract sheet to add, edit, or delete open nonconformance records related to discrepant
material from a subcontract operation.

• Use the Operation sheet to add, edit, or delete open nonconformance records related to discrepant job
assemblies.

• Use the Inventory sheet to add, edit, or delete open nonconformance records related to discrepant
material in inventory.

• Use the Other sheet to add, edit, or delete open nonconformance records that do not fit any of the
other types of nonconformance records.

Nonconformance – PO Receipts

You can view nonconformance records related to purchase order receipts in this program if the nonconformance
records are closed. The closed status indicates the PO receipt quantities have been inspected.

To view a purchase order receipt nonconformance:

1. Click Search on the Navigation toolbar. 
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2. In the Nonconformance Search window, filter the search to only retrieve closed nonconformance records
by selecting Closed in the Status field.

3. Click Search.

4. Select the purchase order receipt nonconformance you wish to view.

5. Click OK.

6. Notice the information on the PO Receipts sheet is for display only.

Nonconformance - RMA

You can view nonconformance records related to RMA receipts in this program if the nonconformance records
are closed. The closed status indicates the RMA receipt quantities are dispositioned.

To learn more about RMAs and how to disposition customer
returns, review the chapter on Customer Returns.

To view an RMA nonconformance:
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1. Click Search on the Navigation toolbar.

2. In the Nonconformance Search window, filter the search to only retrieve closed nonconformance records
by selecting Closed in the Status field.

3. Click Search.

4. Select the RMA receipt nonconformance you wish to view.

5. Click OK.
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6. Notice the information on the RMA sheet is only for your information; you cannot change these values.

7. Any pass or fail comments entered during RMA disposition or inspection display on the Comments sheet.

Inspection Processing

Use Inspection Processing Entry to inspect discrepant material found during job production or to inspect purchase
order receipts and customer returns.

You select the Inspection Required check box on a supplier record or a part class. Any material purchased from
that supplier or part class is automatically received into inspection; this stipulation cannot be changed during
purchase order entry or receipt entry. If the inspection check box is not set at the supplier or part class, however,
you can select this check box at purchase order entry or receipt entry.

For more information on setting up suppliers, read the Supplier
Maintenance section within the chapter on Purchasing. For
more information on part classes, read the Part Class section
within the Material Requirements Planning chapter.

Menu Path: Production Management > Quality Assurance > General Operations > Inspection Processing

Inspection Processing Entry - Materials

To inspect discrepant material:
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1. Click Search on the Navigation toolbar. 

2. In the Inspection Processing Search window, you can filter the search to only retrieve pending inspection
records for a specific inspector.

3. Further refine your search by selecting a Transaction Type.

4. Click Search.

5. Select the record you wish to inspect. In this example, you want to enter inspection disposition information
for a nonconformant component material found during production.

6. Click OK.
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7. Information about this record entered in the Nonconformance program displays at the top of the Materials
> Detail sheet; it cannot be changed.

8. The Inspector ID is the individual who inspected the material.

9. To verify the supplier or manufacturer part numbers are valid for your internal part number, click the Supplier
Parts button. Review the Part Cross References section in the Inventory Management chapter for more
information.

10. If you use the Enhanced Quality Assurance module, the Inspection Data button is available.

For more information on how to enter inspection data,
review the next Inspection Results section
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Enter Passed Quantity Data

1. Enter the quantity of the material that passed inspection in the Passed Quantity field.

2. Select the Request Move check box to indicate the passed quantity needs to be moved to another location.
This check box is available if you use the Advanced Material Management module. For more information
about this module, review application help.

3. If you want to print tags for items that passed inspection, click the Print Tags button and select the tags
you need.

4. In the Issue To section, select Stock to issue the material to stock, or select Job Material to issue the
material to a job.

5. If material that has passed inspection is related to a job, the Job, Assembly, and Material fields are available.

6. If you need to select locations different from the default warehouse/bin settings, specify a Warehouse and
Bin to move the passed quantity.
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Enter Failed Quantity Data

1. Enter the quantity of the material that failed inspection in the Failed Quantity field.

2. Select the Request Move check box to indicate the failed quantity needs to be moved to another location.
This check box is available if you use the Advanced Material Management module. For more information
about this module, review application help.

3. If you want to print tags for items that failed inspection, click the Print Tags button.

4. Select the Reason the quantity failed inspection.

5. The Warehouse drop-down list defines the warehouse into which the failed quantity will be moved.

6. The Bin defines the bin into which the failed quantity will be moved. If you do not know the bin number,
click the Bin button to find and select it.

When this inspection record is saved, the quantity for that bin is not updated. Instead, the bin information,
reason code, and failed quantity combine to create a DMR (Discrepant Material Report) record that you use
within DMR Processing.

7. Enter a DMR number for the failed quantity; optionally, leave this field set to 0 (zero) to cause the application
to automatically create a new DMR record for DMR Processing.

8. Select the Create Corrective Action check box to launch Corrective Actions when this inspection record
is saved. Use this functionality to create a corrective action record for the quantity of material that did not
pass inspection.

9. If you are failing a part quantity that uses serial numbers, you must click the Serial Numbers button to find
and select the serial number for each failed part.
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Complete Inspection Entry

1. Click Save on the Standard toolbar. If the application automatically assigns DMR numbers to failed quantities,
a message box displays the assigned DMR number. Click OK.

2. Use the Operations sheet to inspect nonconformant records related to discrepant job assemblies.

3. Use the Inventory sheet to inspect nonconformant records related to discrepant material in inventory.

Inspection Processing Entry – PO Receipts

To inspect purchase order receipts:
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1. Click Search on the Navigation toolbar to find and select a purchase order receipt requiring inspection. 

2. Information about this record previously entered in Receipt Entry displays at the top of the PO Receipts >
Detail sheet.

To learn more about entering purchase order receipts,
review the Shipping and Receiving chapter.

3. The Inspector ID displays the individual who inspected the material.

4. Enter the quantity of the material that passed inspection in the Passed Quantity field.

5. In the Received To section, select Stock to issue the material to stock, or select Job Material to issue the
material to a job. If this part is part of a subcontract, the Job SubContract option becomes available.

6. If the material has passed inspection related to a job, the Job, Assembly, and Sequence fields are available.

7. Enter the quantity of the material that failed inspection in the Failed Quantity field.

8. Select the Reason the quantity failed inspection.

9. Enter a DMR number for the failed quantity; optionally, leave this field set to 0 (zero) so the application
automatically creates a new DMR record for DMR Processing.

10. Click Save on the Standard toolbar. If the application automatically assigns DMR numbers for failed
quantities, a message displays indicating these numbers were assigned.
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Inspection Processing Entry – RMAs

Customer returns received into inspection are processed through the RMA Disposition program. You can also
have the Quality Assurance module licensed, you can also view the customer returns received in Inspection
Processing, and, optionally, disposition the returned material directly from the RMA’s sheet.

To learn more about RMAs and how to disposition customer
returns, read the Customer Returns chapter.

To view or disposition RMAs:

1. Click Search on the Navigation toolbar to find and select an RMA to view or disposition.

2. Information about this record entered in RMA Processing displays in a grid on the RMA’s sheet.

3. Click the RMA Disposition button to disposition the returned material.

Inspection Processing Entry – First Articles

A first article inspection is a quality assurance inspection on the first component or assembly run after a new
setup is complete. An engineer or job manager can define the sample size to be inspected within Job Entry. Once
a shop employee clocks into the operation, a new first article record is added to the First Article queue in Inspection
Processing. Additionally, the inspector can be notified through a global alert that a first article inspection is
created.

You can also manually enter first article records through Inspection Processing. This process is illustrated in the
following example.
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1. Click on the First Articles tab. 

2. Click the New button on the Standard toolbar.

3. The First Article window displays.

4. Enter the Job Number, Assembly, and Operation from which the first articles originate.

5. Notice the Part and Revision information for this first article display.

6. Optionally, click the Resource ID button to find and select the resource that will produce the first articles.

7. Specify the quantity of first articles planned to be inspected in the Expected Quantity field.

8. Click OK. When asked to confirm changes, click Yes.
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9. Now you are ready to process this first article inspection. Click Search on the Navigation toolbar to find
and select the first article record just created. 

10. Information about this record displays on the First Articles sheet.

11. The Inspector ID is the individual who inspected the material.

12. If you know the employee responsible for the articles in this inspection, you can enter it in the Employee
field; otherwise, click the Employee button to find and select the employee.

13. Enter the quantity inspected in the Quantity field.

14. Select the Status of this first article inspection. Available options:

• Approve – Indicates an approved operation status. Labor can now be posted against the operation.

• Provisional – Indicates an operation that can proceed, with an additional required inspection.

• Resubmit – Indicates the operation may continue, but another inspection is required.

• Waiting - Identifies a waiting status for an inspection. A new record is automatically set to Waiting.

15. Click Save.

Inspection Results

Use Inspection Results Entry to enter and gather inspection data for parts, operations, resources, equipment, and
fixed assets. You can access this program through other programs or from the Main Menu.

When you launch Inspection Results Entry from another program, data such as Part, Job, Quantity, and so on
automatically populates the results record. You can launch Inspection Results Entry from Time Entry, Report
Quantity (MES), End Activity (MES), RMA Disposition, and Inspection Processing – all types.
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Once the inspection quantity is established, you enter inspection results for each item using the configured screen
and rules created for the inspection plan and specification defined. From this test data, the application determines
- based on the rules - if the item has passed or failed. In some cases, the quantity passed and failed is returned
to the calling process.

Menu Path: Production Management > Quality Assurance > General Operations > Inspection Results Entry

While you can access Inspection Results Entry from the above path, the following example launches the program
from Inspection Processing Entry. To show this feature, a purchase order receipt is processed that requires
inspection. This receipt has a part revision with both an inspection plan and a specification.

To enter inspection results:

1. Navigate to Production Management > Quality Assurance > General Operations > Inspection
Processing

2. Click Search on the Navigation toolbar to find and select a purchase order receipt requiring inspection. 

3. Information about this record previously entered in Receipt Entry displays at the top of the PO Receipts >
Detail sheet.

4. From the Inspector ID list, select the individual that is inspecting the material.

5. Because the part revision on this purchase order has both an inspection plan and a specification, the
Inspection Data button is available. Click this button.
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6. The Inspection Results Entry program displays.

7. If you access Inspection Results Entry from the Main Menu, the NCM, Job, and Part fields are available
to search for the nonconformance, job, and part records you want to enter inspection data.

In this example, however, these fields are not available because you accessed this program from within
another process – inspection processing. Rather, they display the information from the process and cannot
be changed.

8. Whether the Enter Operation Information check box is selected or cleared depends on if you call Inspection
Results Entry from another program or from the Main Menu. If you launch Inspection Results Entry from
another program, the program either selects or clears this check box. When you call this program from the
Main Menu and define a nonconformance record or job, clearing this check box causes the inspection plan
for the job or assembly to be used instead of the inspection plan for the operation.

9. The Part Inspection Documents and Specification Documents indicators display in green once the
current part revision and specification have documents attached to them.

10. Use the Inspection Type list to define the type of inspection you are conducting. If you select a
nonconformance, job, or part record, the Inspection Type defaults to Part and cannot be changed; however,
you have other options as well. Options include:

• Part

• Resource

• Equipment

• Asset

11. The Quantity field displays the quantity from the nonconformance, RMA, job, or purchase order receipt.
This field works in a similar way as other fields in this program. If you launch Inspection Results Entry from
another program, the quantity value defaults and cannot be changed. If you access this program from the
Main Menu, this field is available.

12. If you launch Inspection Results Entry from another program and that job, operation, part, or nonconformance
has a plan, the Inspection Plan ID field displays this value by default.

13. If you launch Inspection Results Entry from another program, and that job, operation, part, or nonconformance
has an associated specification, that specification defaults in the Specification field.
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14. Click the Generate Test Set button to create sample test rows in the grid. The numbers of rows created
equals the value specified in the Quantity field.

Enter Inspection Results

To enter inspection results:

1. Navigate to the Inspection Sample Details sheet.

2. Highlight the row in the grid for which you want to enter inspection results.

All the rows initially display a Passed status.

3. Click the Enter Results button.

4. The configured screen designed for the inspection plan selected in Inspection Results Entry displays. This
configured screen also uses the specification selected in Inspection Results Entry.

5. In the input test fields, enter the inspection results.

6. Click Save on the Standard toolbar.

7. Continue to enter inspection results for all rows. When finished, Close the program.
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8. Depending on the entered results, in the Pass/Fail column, the Passed or Failed status displays.

9. Return to Inspection Results Entry. Notice the Passed Qty and Failed Qty fields update based on the
inspection results. In this example, three out of five inspected items failed inspection.

10. In the Reason field, select a reason code why the items failed inspection.

11. Complete the remaining required fields. When you finish, click Save on the Standard toolbar.

12. An application generated DMR Number displays.

13. Click OK.
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DMR Processing

Use DMR Processing to process job material, job assemblies, inventory, customer returns, or purchase order
receipts that fail inspection. These discrepant parts are placed on the Discrepant Material Report (DMR).

In this program, you decide how to deal with discrepant parts. You can accept them, deciding they can be used,
or you can reject them, sending them back to your supplier. You can create a debit memo request from the
supplier for the rejected parts.

Packing slips for DMR rejected parts are processed in
Miscellaneous Shipment Entry. This standardizes shipping
procedures and enables part tracking for quantities returned
to suppliers.

You can enter as many acceptances, rejections, and debit memo requests as necessary for a single DMR. For
example, you can accept a quantity into your stock, accept a quantity into a job material record, reject a quantity
and assign it an RMA number so you can return it to the supplier, and reject a quantity you will scrap. The rejected
and accepted quantity total must equal the discrepant quantity total on the DMR.

Menu Path: Production Management > Quality Assurance > General Operations > DMR Processing

DMR Processing - Header

To process a failed quantity:

1. Click the DMR Number button to find and select the DMR record you want to process. 

2. The Total Quantities section displays the accepted and rejected quantities. This must equal the failed
quantity when done.

3. The Open/Closed button indicates whether this DMR is complete and closed. A DMR is automatically closed
when the total accepted quantity plus the total rejected quantity equals the discrepant quantity on the DMR.
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4. If the DMR was created from a job material or job subcontract operation, the supplier from the purchase
order associated with the job material or subcontract operation displays in the Supplier section. Any debit
memos you request for this DMR is associated with this supplier. If you need, select a different supplier.

5. The Status section displays the current costs associated with the parts to be dispositioned.

6. You can use the user-defined Check Off fields to alert individuals when a DMR record is processed. To use
these fields, you must first activate the alert that corresponds to the check off field in Global Alerts.

For more information on Check Offs, review application
help.

7. If the discrepant parts are from inventory or a purchase order receipt, the Location section displays the
name of the warehouse and bin from which they came.

8. When you finish, click Save on the Standard toolbar.

DMR Processing - Accept

Depending on the transaction type, you can accept parts on the DMR (Discrepant Material Report) to a job
material sequence, to a job operation sequence, or into stock. In this example, you are accepting some parts on
the DMR to a job material sequence.

1. Click the Down Arrow next to the New button; select Accept – Job Material.

2. The Accept > Material > Detail sheet is available for data entry.

3. Use the Accept > Operation sheet to disposition accepted parts to the job from which they originally came.

4. Use the Accept > Stock sheet to disposition accepted parts into stock.

5. The Job linked to this material displays by default; if you need, change the job.

6. Enter the Quantity of this discrepant material you are accepting to the job. The DMR is closed when the
entire Accepted quantity plus the entire Rejected quantity equals the total discrepant quantity.
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7. Select the Reason for accepting the material to the job.

8. The Warehouse and Bin specifies the shop floor location where you are returning the discrepant material;
if you need, you can change these values.

9. The Issued Complete check box indicates whether the accepted quantity completes the amount to be used
for this material sequence. If the issue quantity to-date is less than the planned requirement, selecting this
check box will free any remaining allocation. This check box is automatically selected if the quantity entered
plus any previous quantity issued exceeds the estimated material or assembly pull quantity.

10. When you finish, click Save on the Standard toolbar.

DMR Processing - Reject

Use this sheet to enter rejected material information for a DMR (Discrepant Material Report) record.

1. Click the Down Arrow next to the New button; select New Reject Material.

2. Enter the Supplier RMA (return material authorization) number that the supplier has given you to attach
to this discrepant material.

3. Enter the Quantity of the discrepant material you are rejecting. The DMR is closed when the entire Accepted
quantity plus the entire Rejected quantity equals the DMR’s total discrepant quantity.

4. Select the Reason for rejecting the material. You can select a default system reason code or a reason code
you have created. For information on these codes, review the previous Reason Codes section.

5. If you are rejecting parts on the DMR that uses serial numbers, click the Serial Numbers button to find and
select the serial number for each rejected part.

6. Select a Resolution. Available options:

• Request Debit Memo – If you save this record using this option, the application requests a debit memo
from the supplier. This memo uses the rejected quantity and the cost per unit defined on the purchase
order. A debit transaction for the rejected material is added to the DMR record.

• Require Supplier Credit – If you save this record using this option, the application creates a credit note
for the supplier. This credit note uses the rejected quantity and the cost per unit defined on the purchase
order. A credit transaction for the rejected material is added to the DMR record.
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• No Further Action – If selected, you are accepting the write-off of the rejected materials and the rejected
materials are not returned to the supplier.

7. To indicate that goods will be returned to the supplier, select the Return to Supplier check box.

8. If the DMR originated with the inspection of a purchase order receipt, the packing slip and line number
default in the Pack/Line field; if need, you can change this value.

9. The PO Number and Unit Price information defaults from the packing slip selected in the Pack/Line field.

10. Optionally, enter additional information on the Reject > Comments sheet.

11. When you finish, click Save on the Standard toolbar.

DMR Processing – Debit/Credit

You can request a debit memo or require a supplier credit for both an accepted material and a rejected material.
In this example, the inspector fails the material received from a supplier because it is corroded. In DMR Processing,
you determine you can still use the material as long as you clean it. You accept the material, but you still request
a debit memo for the cost to clean the material.

1. Click the Down Arrow next to the New button; select New Debit Memo.

2. The Debit/Credit > Detail sheet displays.

3. The Part number for the DMR displays.

4. The Debit/Credit button indicates if this transaction is a debit memo or supplier credit.

5. If the Currency Management module is licensed, you can change the currency to use for this debit memo
by selecting a different currency in the Currency field.

6. Optionally, change the Exchange Rate for this transaction. The exchange rate currently listed in the Currency
Master file defaults.

129Epicor ERP | 10.0.700

Quality Assurance | Chapter 2Epicor ERP Application User Guide - Part Two



7. Select the Lock check box to lock the exchange rate for this transaction. If this check box is selected, the
exchange rate specified at the time of this entry is used for the debit memo, even if the actual market rates
change between now and the time the debit memo is created.

8. The Rate Group displays the rate group for the currency exchange rate.

9. Enter the Unit Cost. The unit cost from the packing slip defaults if a packing slip was specified on the Reject
sheet.

10. Specify the quantity for which you would like the amount in the Unit Cost field credited to you by the
supplier in the Quantity field.  

11. Select the Reason you are requesting the debit memo.

12. Once the debit memo or supplier credit is processed by accounts payable, the Invoice field is updated with
the invoice number.

13. When you finish, click Save on the Standard toolbar.

14. Notice on the Header sheet the Total Quantities section displays the parts on the DMR you accepted and
the parts on the DMR you rejected. The remaining parts on the DMR now should be 0 (zero).

15. Because the entire Accepted quantity plus the entire Rejected quantity equals the total discrepant quantity
on the DMR, the Open/Closed button now shows Closed. You can select the check box next to the
Open/Closed button to indicate this DMR is complete and closed. Now the information on this DMR cannot
be changed unless the DMR is reopened. A DMR is automatically closed when the total accepted quantity
plus the total rejected quantity equals the discrepant quantity on the DMR.

16. Use the History sheet to review the history of actions taken for a Discrepant Material Report record.
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Corrective Action

Use Corrective Action to specify what actions to take on nonconformant items. These items are specified in
nonconformance entries in the Nonconformance program.

A corrective action entry describes the action and contains information on the nonconformance entry, inspection
details, and the responsible employee. A corrective action entry also indicates the date on which the action must
occur.

Menu Path: Production Management > Quality Assurance > General Operations > Corrective Action

Corrective Action - Detail

To add a corrective action:

1. Click the New button on the Standard toolbar.

2. Enter a Description of the action that should be taken. In this example, you want to uncover the reason
why the steel you receive from this specific supplier is corroded.

3. Click the Non-Conf button to find and select the nonconformance record this corrective action is addressing.
To view the entire nonconformance record, click the Actions menu and select Non-Conformance.

You can also start a corrective action from DMR
Processing. When you do this, both the Nonconformance
record and DMR Number values default from DMR
Processing. You cannot change these values.

4. The DMR Number linked to this nonconformance record displays in this field.

5. Select the Department responsible for carrying out the corrective action.

Job departments are set up in Job Department
Maintenance. For more information on this program, read
application help.
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6. Click the Assigned To button to find and select the shop employee responsible for this corrective action.

7. Today’s date displays into the Date Opened field, but you can change this value if you need.

8. Select the date the corrective action is required in the Due Date field.

9. Use the Action Complete field to enter the date on which the action was finished.

10. Select the Root Cause for the corrective action.

Root causes and corrective actions are Quality Assurance
reason types and are respectively defined as Cause and
Corrective Action. Reason codes are maintained in Reason
Code Maintenance. For more information, read the
Reason Code Maintenance section earlier in this chapter.

11. Select the Corrective Action to correct the problem.

12. Use the Audit Information section to track the inspector or auditor assigned to review the corrective action
once complete.

13. When you finish, click Save.

14. An Action ID number is now assigned to this corrective action entry.

15. Use the Root Cause Investigation sheet to add comments to help with the investigation of the problem.

16. If you need, use the Action Comments sheet to enter information about the action or solution.

17. Use the Audit Comments sheet to enter comments that pertain to inspecting the part after the corrective
action takes place.
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Internal Employee Training

The Internal Employee Training features help you manage employee course training. Through these features you
can document and plan training courses. You can also manage course schedules, student demand, and expenses.

The employee training functionality requires the Enhanced
Quality Assurance license.

Training Course Maintenance

Use Training Course Maintenance to create and maintain courses for your organization. Each course can have
multiple revisions to create subject matter variations. You can also duplicate a course and use it as a template.

Menu Path: Production Management > Quality Assurance > Setup > Training Course

Create a New Course

To create a new course:

1. Click the Down Arrow next to the New button; select New Course.

2. Enter a Course ID code to uniquely identify the course.

3. Enter a Description of the course.

4. Click Save on the Standard toolbar.

Create a Course Revision

To create a course revision:

1. Click the Course ID button to search for and select a course for which to make a new revision.
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2. Click the Down Arrow next to the New button; Select New Revision.

3. The Revision > Detail sheet displays. In the Revision field, enter a revision identifier.

4. Enter a Description for the new revision.

5. Specify a Revision Date and Effective Date – the date when this revision is available.

6. Select the Course Duration; options include Hours, Days, Weeks, and Months.

7. Optionally enter the Training Expires in time frame.

8. Click Save on the Standard toolbar.

Duplicate an Existing Course

To duplicate an existing course:

1. Click the Course ID button to search for and select a course to duplicate.

2. From the Actions menu, select Duplicate.

3. The Duplicate Course window displays. In the New Course ID field, enter a unique identifier.
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4. Enter a Description of the course.

5. Enter a Revision identifier for the new course.

6. Enter or accept the default Description for the revision.

7. Click OK.

8. Click Save on the Standard toolbar

Training Course Schedule Maintenance

Use Training Course Schedule Maintenance to schedule course training sessions, add attendees for planned
training sessions, enter employee expenses, and record each employee’s final result from attended course training
sessions.

Menu Path: Production Management > Quality Assurance > General Operations > Training Course Schedule

To create a new course schedule:

1. Click the Course ID  button to search for and select a course.

2. Click the down arrow next to the New button; select New Course Schedule.

3. In the Course Dates section, define the course schedule including dates and the duration.
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4. Specify the Course Location of the training course session.

5. Select the Instructor for the training session; options include Employee, Supplier, or Customer.

6. Click the appropriate Employee, Supplier, or Customer button to select the instructor for the training
session.

7. Optionally enter the Max Attendees for the training session.

8. In the Course Cost field, define the expense per attendee for the duration of the training session.

9. Click Save on the Standard toolbar.

Employee Course Request

Submit course training needs or interests through Employee Course Request. Your employees use this program
to request to attend a specific training course. Once a training request is entered, it is automatically sent to
Employee Training Course Maintenance with a status of Requested. Management must approve all request
submissions.

Menu Path: Production Management > Quality Assurance > General Operations > Employee Course Request

To request to attend a training session:

1. Click New on the Standard toolbar.

2. Click the Course ID button to find and select a course session.

3. Click the Employee button to search for and select your employee identification code.

4. Click Save. Your request has been submitted for approval.

Employee Training Course Maintenance

Use Employee Training Course Maintenance to add a required training course, or courses, to an employee record,
approve employee requests for training, and update attendance and results of a completed course training
session.

An employee record for course training can include the following statuses:

• Requested – used for employee submissions requesting to attend a specific course training session.
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• Planned – used to identify the planned attendance of a specific course training session.

• Firm - used to identify approved attendance for a specific course training session.

• Attended – used for historical record of course training sessions completed per employee.

Menu Path: Production Management > Quality Assurance > General Operations > Employee Training Course

To approve an employee training request:

1. Click the Employee button to search for and select an employee.

2. In the Course ID field, the requested course displays.

3. The Course Status drop-down list displays the current state of the request. Available options:

• Requested - The request is placed by the employee.

• Planned - The course is tentatively scheduled to occur.

• Firm - The course is scheduled for this employee.

4. Click the Course Schedule button to search for and select the training session.

5. Click Save on the Standard toolbar.

Update Attendance and Results

To update attendance and results:
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1. Click the Employee button to search for and select an employee.

2. Select the course session your employee attended under the Firm node within the Tree View.

3. In the Course Dates section, update details of the session such as overall expenses, attendee results,
reimbursement requirements, and any additional comments.

4. Click Save on the Standard toolbar.

Reports

This section describes some key quality reports you use to monitor discrepant material. You can run these reports
whenever you need. You can also set up each report to generate and print through a recurring, automatic
schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information
on how you link a report to a recurring schedule.

Nonconformance Analysis

The Nonconformance Analysis Report lists all nonconformance entries, separated by defective units, material
issues, and scrapped materials. Cost totals also display on this report.

Main Menu Path: Production Management > Quality Assurance > Reports > Nonconformance Analysis

Menu Path: Production Management > Quality Assurance > Reports > Nonconformance Analysis

To generate this report:
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1. Use the From and To fields to specify the date range of nonconformance records on the report.

2. Select the nonconformance types you would like to see on the report. The only RMA records retrieved are
those defined as being in nonconformance because they failed during disposition processing.

3. If you want to include the comments added during nonconformance entry, select the Print Comments check
box.

4. Use the Filter sheet to filter the report by Parts, Employees, and/or Resources.

5. Select how you would like the report organized in the Sort By field.

6. Click Print on the Standard toolbar to run the report.

Inspection Pending

The Inspection Pending Report lists all items you have received to inspection including those received through
Receipt Entry or Return Material Authorization. The report also indicates if a variance exists between the purchase
order cost and the invoice cost for the receipt.

Menu Path: Production Management > Quality Assurance > Reports > Inspection Pending

To generate this report:
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1. Use the Report Options section to indicate those items you want to review on the report.

2. Select an As of Date. All items sent to Inspection on or before this date display on the report.

3. If you want to include inspection activity closed since the As of Date, select the Show Periods Closed
Activity check box.

4. Select the Page Break Between Sections check box to start a new report page for each section (based
on the chosen Report Options).

5. Select the Page Break Between PO Inspectors check box to start a new report page for each Inspector’s
items.

6. Click Print on the Standard toolbar to run the report.

Open DMR Status Report

The Open DMR Status Report includes basic information about all open Discrepant Material Reports (DMR), as
well as a transaction history section. This report includes subtotals for each DMR and a total value of all open
DMRs.

Menu Path: Production Management > Quality Assurance > Reports > Open DMR Status

To generate this report:
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1. Use the Cut Off Date to define the open DMRs to include on the report. Any DMRs still open as of this
date will print.

2. To indicate a new report page should print for each new DMR, select the New Page per DMR check box.

3. Select the Show Period’s Closed Activity to print all DMR activity closed since the Cut Off Date.

4. You can Sort By either DMR number or part number.

5. Click Print on the Standard toolbar to run the report.
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Chapter 3: Inventory Management

The Inventory Management module is part of the core functionality of the application. It contains all of the information
related to an item including costs, quantities, and on-hand requirements.

Before you begin using this module, you must define inventory information for part records. Additionally, you must
define the part’s unit of measure codes for inventory, selling, and purchasing transactions. You can also track part
records using lots or serial numbers; this module contains the functionality to set up these tracking functions. You also
define the sites that manufacture part quantities, as well as the countries of origin for the manufactured and purchased
parts.

The primary function of this module is to manage the flow of materials from incoming purchase orders, through
manufacturing, and lastly, shipping to the customer. These items can be received to stock or directly to the job, and
then shipped from stock or from inventory. Inventory transactions are made in the same way regardless of the
manufacturing environment - make-to-order (MTO) or make-to-stock (MTS). These transactions result in costs that are
posted to the general ledger.

To complete the Inventory functionality, a thorough set of tools is available to assist you during both cycle counting
and physical inventory counting. Use these tools to make sure the part quantities available within your warehouses are
accurate and up-to-date.

Setup

This section describes the primary records you need to create for the Inventory Management module. These
programs are contained within the Setup folder for this module. Only the primary records are described here.
Some areas within the next Operations section may also document setup records if they are required for a specific
workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration.

Parts

You store information on each part you manufacture or purchase within Part Maintenance records. This information
includes general information such as part number and description. It also contains more specific inventory
information such as unit of measure, non-stock status, weight, and warehouse information (primary warehouse
and bin, and minimum, maximum, and safety stock quantities).

Many fields in the part master record impact multiple areas of your Epicor application. Some of these fields have
already been discussed in previous chapters of this guide. For example, the Engineering chapter reviews basic
part information on the Part and Site sheets of Part Maintenance, while the Epicor ERP Implementation Guide
describes additional programs used to configure part records. This section of the guide focuses on part fields and
features that affect inventory.

Menu Path:  Material Management > Inventory Management > Setup > Part

Part Inventory Details

The fields below describe part details that directly relate to the Inventory Management module.

Epicor ERP | 10.0.700142

Epicor ERP Application User Guide - Part TwoChapter 3 | Inventory Management



1. Select the UOM Class you need for this part record. A Unit of Measure Class defines the combination of
unit of measure values valid for the part and the factors required to convert part quantities to the base unit
of measure. When a new part is assigned to a UOM Class and it is used in a part transaction, you cannot
change the UOM Class. For more information on creating UOM Classes, review the Epicor ERP Implementation
Guide.

2. Click the Primary UOMs drop-down lists to select the unit of measure values you use for storing (Inventory),
sales orders (Sales), and purchase orders (Purchasing):

• Inventory – Typically this value is the smallest unit of measure in which you stock the part. The value
you select is the default UOM for all inventory related transactions. The first value that displays is the
code selected as the Base UOM within the UOM Class.

• Sales – Defines the primary sales and quotes UOM for the part. This unit of measure value is the default
for all sales orders and quotes created for this part. The first value that displays is the code selected as
the Default UOM within the UOM Class.

• Purchasing – Defines the primary purchasing UOM for the part. This unit of measure value is the default
for all purchase orders created for this part. The first value that displays is the code selected as the Default
UOM within the UOM Class.

3. If required by Intrastat reporting, select the Country of Origin for this part. This value defines the country
from which this part is created. Some European countries require you report this code to Intrastat authorities
when parts arrive from other European Union (EU) countries. If you need, you can define all the countries
of origin you need for this part within the Reporting >Country of Origin sheet. Use this sheet to indicate
the relative value and quantity percentage breakdown for each country. Review the following Part
Maintenance – Country of Origin section for more information.
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4. Enter the Unit Net Weight for an inventory unit of this part. After you define this numeric value, select the
weight unit of measure you need, like kilograms, pounds, ounce, and so on. This value is multiplied against
line quantities to calculate the Total Net Weight value on the invoice’s Intrastat Data sheet.

5. Enter the Unit Net Volume for an inventory unit of this part. After you define this numeric value, select
the volume unit of measure you need, like cubic centimeters, square inches, and so on. This value is used
to determine the volume of the part quantity on the Fulfillment Workbench. For more information about
the Fulfillment Workbench, review the Sales Order Processing chapter.

6. If you want to track this part by lot, select the Track Lots check box. Each time you enter an inventory
transaction for this part, you must also enter a lot number reference. You can define the lot numbers available
for this part through the Lots sheets. Review the following Part Maintenance – Lots section for more
information.

7. Select the Track Multiple UOMs check box to indicate the application can record inventory balances for
the current part using multiple units of measure. If this check box is clear, the application only stores inventory
balances using a base unit of measure. This check box is not available if the part is serial tracked.

Before you select the Track Multiple UOMs check box,
verify you need to store this part using multiple unit of
measure values. After you select this check box, you can
only clear this check box if no inventory balances exist for
the part.

8. If you want, select the Track Serial Numbers check box to indicate serial numbers are tracked for this part.
Parts assigned serial numbers can be tracked individually by order, job, inventory, and return material
authorization (RMA)/discrepant material report (DMR).

9. Select the Costing Method you want to use for calculating the cost of this part. The selected costing method
determines which calculation the application uses whenever it retrieves a unit cost (the usage cost of one
part) for this part record. The costing method defined within the Company Configuration program displays
by default, but you can override this value on individual part records (and also Part-Site records). Available
methods:

• Average Cost – Calculates a weighted average of all receipt costs for this part.

• FIFO – An abbreviation for First In First Out. This method assumes the next quantity to be issued or
shipped from stock is the oldest quantity stored within the warehouse. As long as a quantity remains
from the original received quantity, the application uses this cost value until the entire quantity from the
original receipt is consumed.

• Last Cost – Calculates the most recent receipt cost for this part.

• Lot Average Cost – Calculates an average cost of all parts in a lot. This value is the total cost divided
by the total quantity for all parts within a lot.

• Lot FIFO – Determines the cost of all parts in a lot by using the FIFO costing method described above.

• Standard Cost – Calculates a set cost you establish and enter for this part. You define and update the
standard cost for each part within the Costing Workbench.

For more information on Costing Methods, review the
Job Costing Technical Reference Guide. This guide is
available within application help. Using the application
help table of contents, navigate to the Job Management
> Working With node to display this guide.
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10. Select the Non-Stock Item check box to indicate this part is not normally stocked in inventory. Both purchased
and manufactured parts can be either stocked or non-stocked. If you enter non-stocked parts in your part
records, their default descriptions are supplied (just like stocked items) when you enter their part numbers
on an order or a job.

If a part is not defined as non-stock, then all requirements come from stock and the part is controlled through
minimum, maximum, and safety stock settings.

If a manufactured part is non-stocked, then each time a
sales order creates a requirement for this part, the part is
listed in manufacturing suggestions and is produced and
shipped from the job. If a purchased part is non-stocked,
then each time a job creates a requirement for this part,
the part is listed in purchasing suggestions and is
purchased and received directly to the job.

11. Selecting the Track Serial Numbers check box activates the S/N Format button. Click this button to define
how serial numbers are tracked for this selected part.

Serial Number Format

The fields below describe how to format a serial number through the Part Maintenance program

1. When you chose to track serial numbers for a part and press the S/N Format button, The Serial Number
Format window displays.

2. Indicate the Base Number Structure you want the serial numbers for this part to use. Available options:

• Numeric Only – Serial numbers generate only using numeric characters.

• Alphanumeric – Serial numbers generate using both alphabetic and numeric characters.

• Serial Mask – Serial numbers are created using a serial mask. Serial masks are created using Serial Mask
Maintenance; this program is described within the Epicor ERP Implementation Guide.
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3. If you select either the Numeric Only or Alphanumeric options, the Prefix field activates. Depending on your
selection, use this field to enter either a numeric or alphanumeric set of characters. This value is used as the
starting characters for each generated serial number.

4. If you select the Numeric Only option, the fields within the Numeric Only Options section activate. Use these
fields to define the Number of Digits available for each serial number and indicate if these numbers can
use Leading Zeros.

5. If you select the Serial Mask option, the Serial Mask button activates. Use this button to find and select a
serial mask; this mask is used to define how serial numbers generate for this part.

6. The Serial Mask Type options indicate whether this serial mask is a Validation or a Generation type. The
type selected defined on the serial mask record displays; you cannot change this value.

7. If the serial mask is a Generation type, the Mask Prefix field is available. Enter the value you want in this
field; all serial numbers for this part start with this value.

8. If the serial mask is a Generation type, the Mask Suffix field is available. Enter the value you want in this
field; all serial numbers for this part end with this value.

9. Optionally, select the Use Serial Mask Starting Sequence check box. This indicates you want to use the
starting sequence defined on the serial mask record.

10. However, if you clear the Use Serial Mask, the Starting Sequence field activates. Use this field to enter the
starting sequence value you want for serial numbers generated through this mask.

11. When you finish defining the serial number structure, click OK.

12. Click Close to exit the window. As activity is placed against this part record, serial numbers generate for
the part quantities. You use the Serial Matching and Serial Number Tracker programs to both review and
fine-tune this activity. These programs are explored within the Serial Number Tools section later in this
chapter.

Multiple Units of Measure

Use the UOMs sheet to view unit of measure (UOM) information, and enter conversion factor, net volume, and
product code information for the current part. Leverage the Detail sheet to view the details for each assigned
UOM code.

For more information about this functionality, review the Epicor
ERP Implementation Guide reference.

To use this functionality:
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1. The UOM Code and Description fields display the identifier and concise explanation for the UOM code.

2. Use the Conversion Factor value to calculate the conversion between the UOM code and the Base UOM
code for the UOM Class selected for the current part. This field is available if the Part Specific check box is
selected for the UOM code within UOM Class Maintenance. In this case, the Part Specific check box is
selected on this Part Maintenance > UOMs sheet and cannot be changed.

3. The Track on Hand check box indicates if the application tracks inventory balances within the current UOM
code. Depending on whether the Track Multiple UOMs check box is selected on the Part > Detail sheet,
different options are available:

• If the Track Multiple UOMs check box is cleared, this check box is not available. This indicates the
inventory balances for the part are only tracked using the Primary UOM – Inventory value assigned to
the part.

• If the Track Multiple UOMs check box is selected, this check box is available. If you then select this
check box on this sheet, it indicates this UOM code can be used when placing orders and storing inventory.
If you clear this check box, you cannot use this UOM for orders or inventory.

4. Enter the Unit Net Volume for an inventory unit of this current part when it is selected on the Fulfillment
Workbench. After you define this numeric value, select the Volume UOM from the drop-down list that
represents the unit of measure for the volume of this part. The default value is defined within Company
Configuration. 

This value is multiplied against the Primary UOMs – Inventory unit of measure to calculate the volume for
the part quantity within the Fulfillment Workbench. For example, if you select Feet for the part’s Primary
UOMs – Inventory field, enter 50.50 in the Unit Net Volume field, and select Cubic Inches as the Volume
UOM, then one foot unit of this item equals 50.5 cubic inches.

5. The Product Codes section displays the specific codes you want to use with this unit of measure. Product
codes are unique registered numbers that identify a specific part and a UOM. An example of a product code
is the standard UPC-12 barcode found on most consumer items purchased in the US and Canada. You can
also enter EAN-13, EAN-14, EAN-8, and GTIN-14 product codes. Each product code is used in different
regions of the world, but all are similar to the UPC code. Instead of entering an actual part number within
a Part field, you can instead enter or scan these codes into the application.
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If you enter or scan one of the codes in a part field, the application replaces it with the internal part number
and the correct UOM. You can also print the appropriate product code on transaction documents, such as
a Picklist document.

6. Use the List sheet to navigate and select all the unit of measure records available for the current part.

7. When you finish, click Save on the Standard toolbar.

Lot Tracking

When a part is enabled for Lot Tracking, you can create and define lot details for each lot used to track the part.
You first define the attributes of the lot; these values indicate what additional inputs are required when a new
lot is created or used for the current part. You then define the parameters you want if you want to automatically
generate lot numbers. With these values in place, you can then create as many lot numbers you need for the
current part.

This section details the process you follow for creating and assigning lot numbers to the current part.

Lot Attributes

Lot attributes store number and date information you can track at the lot level. They define requirements needed
before a lot is used for tracking. You can display them on specific reports, labels, and search programs.

The default lot attributes are defined with Company Configuration, but if you need, you can override these values
on a specific part record. Select the attributes you want to use with each lot number generated for the current
part.

To define lot attributes for the current part:

1. Navigate to the Lots > Attributes sheet.

2. Select the Batch check box to indicate a batch number is required.

3. Select the MFG Batch check box to indicate a manufacturing batch number is required.

4. Select the MFG Lot check box to indicate a manufacturer’s lot number is required.

5. Select the Heat Number check box to indicate aheat number is required.

6. Select the Firmware check box to indicate a firmware number is required.
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7. Select the Best Before Date to indicate this date is required.

8. Select the Original Mfg Date to indicate an original manufacturing date is required.

9. Select the Cure Date to indicate a cure date is required.

10. Select the Expire Date to indicate an expiration date is required.

11. When you finish defining lot attributes, click Save on the Standard toolbar.

Lot Generation Parameters

Leverage the Lots > Generate sheet to define the parameters you want to use for generating lot number strings
for the specified part. When you use the Next Lot button for this part within various programs, the lot number
is generated using the parameters you define on this sheet.

To define automatic lot number parameters:

1. Navigate to the Lots > Generate sheet.

2. Use the Prefix field to define the characters or numbers to assign as leading characters for the lot numbers.
Enter any alphanumeric characters you need.

3. Click the Trailing Date String drop-down list to select the structure you want. This string is added to the
end of each generated lot number. A number of options are available like date, month, date/month/year,
and so on. You can also select formats that separate these values with hyphens.

4. The Non Part Specific check box indicates how the sequential lot number is assigned during lot number
generation. Selecting or clearing this check box activates different related fields; the next steps explain these
options.

5. Clear the Non Part Specific check box to indicate the next lot number is generated on a part-specific basis.
Enter a numeric value within the Next Number field. When the application generates a new lot number
for this part, the next number available from this starting value is used for the lot number.
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6. Select the Non Part Specific check box to activate the Global Lot Sequence drop-down list. When the
application generates a new lot number for this part, the next sequence number available within this code
you selected from the drop-down list is used for the lot number.

You create sequence records within Global Lot Sequence
Maintenance. To navigate to this program: Material
Management > Inventory Management > Setup > Global
Lot Sequence

7. Optionally, you can limit the Number Of Digits available for the serialized integer section of the lot number.
Enter a numeric value in this field.

8. Select the Leading Zeroes check box to indicate you want additional zeros added in front of the trailing
date string.

9. The Next generated lot will be field displays the format structure you defined.

10. When you finish, click Save on the Standard toolbar.

Sites

The Site > Detail sheet (and subordinate sheets) contain default warehouse, warehouse bin and inventory
information for each part in a specified site.

Using the Warehouses > Detail or Warehouses > Bin Information sheets, you can define Initial / Minimum,
Threshold / Safety, Maximum and Replenish / Kanban used by the Replenishment Workbench, and in Kanban
processing at the warehouse (or warehouse bin) levels. You use the Cycle Count sheet to define cycle counting
parameters for each part-site record.

To add a new site to the current part:
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1. Click the Down Arrow next to the New button; select New Site.

2. The Sites > Detail sheet displays.

3. Select the Site you need from the drop-down list.

4. Select the Primary Warehouse you use to store this part from the drop-down list.

5. If you need, select the Costing Method you use for the parts manufactured in this site. The available costing
methods are explored in the previous Part Inventory Details section.

6. Enter the Min On-Hand value for this part-site record. This value indicates the smallest quantity that needs
to be available within this site.

7. Enter the Max On-Hand value for this part-site record. This value indicates the largest quantity that can be
stored within this site.

8. Enter the Safety Stock you need for this part. This quantity provides a value to help prevent unforeseen
issues with the inventory quantity. The Time Phased Material Requirements report notifies you when a part
quantity is forecasted to go below this number.

9. You can optionally specify buyer, minimum order quantity, lead time, forecast time, supplier, Generate PO
suggestions, Buy To Order, and Drop Ship Item overrides within the Purchasing section. These parameters
apply when you purchase the part for the specified site and override the same parameters defined at the
part level for the site within Site Configuration Control.

10. If you select the Allow Consumption of Minimum Qty check box on the site record, you can define
Urgent Planning options. These options are an alternate set of values available when you generate PO
suggestions. If the projected On-Hand Quantity falls below the Safety Stock quantity during the lead time
date range (MRP Scheduled Start Date + Lead Time), the Urgent Planning values are used instead to calculate
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the PO suggestion quantities. Through these parameters, you can define the specific quantities, lead times,
and suppliers to use for immediate supply needs.

11. You can add additional warehouses to this part-site record. To do this, click the Down Arrow next to the
New button; select New Warehouse.

12. The Warehouses > Detail sheet displays.

13. Notice you can select a different Warehouse on this sheet.

14. You can also specify the Replenishment Type and bin replenishment parameters (Initial / Minimum,
Threshold / Safety, Maximum and Replenish / Kanban quantities) for this warehouse. If you specify a
Kanban-related Replenishment type, you also designate the supply warehouse/bin, site and PO/line material
source for the part in the designated warehouse.
These values override the values you defined on the sites > Detail sheet. Use these fields if you need to
define these values at the warehouse level.
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15. You can also define warehouse bins for this current warehouse. To do this, click the Down Arrow next to
the New button; select New Warehouse Bin.

16. The Bin Information > Detail sheet displays.

17. Notice you can select a Bin linked to the current warehouse on this sheet.

18. You can also specify the Replenishment Type and associated bin replenishment parameters (Initial /
Minimum, Threshold / Safety, Maximum and Replenish / Kanban quantities) for this warehouse bin.
If you specify a Kanban-related Replenishment type, you also designate the supply warehouse/bin, site
and PO/line material source for the part in the designated warehouse bin. These values override the values
you defined on the Warehouses > Detail sheet. Use these fields if you need to define these values at the
bin level.

19. Continue to add the sites you need and define the inventory requirements for all levels within the bin. When
you finish, click Save on the Standard toolbar.

Country of Origin

Use the Country of Origin functionality to designate the countries in which the current part was manufactured.
You also indicate how much of the part was created within a country based on either the quantity or the value
of its raw materials.

Some European countries require you report the countries of origin and percentage breakdowns when part
quantities are received from other European Union countries. Typically this information is required to print on
the product labels. The information you enter in this sheet are the default values for the part, but you can override
these default values on a specific shipment.

To add a Country of Origin to the current part:
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1. Click the Down Arrow next to the New button; select New Country of Origin.

2. The Country of Origin > Detail sheet displays.

3. Select the Country of Origin you need for this part. You create these records within Country Maintenance.

4. Enter the Quantity Percent value for this country of origin. This value indicate show much of the part is
manufactured or gathered within this country. For example, you manufacture breaded shrimp. You purchase
the breading from France. By weight, the breading makes up about 60% of the product, while the shrimp
makes up 40%. You enter 60 within the Quantity Percent field.

5. Enter the Value Percent you need for this country of origin. This percentage indicates how much of the
value of the product is created within the current country of origin. Using the breaded shrimp example, the
shrimp represents 90% of the final value of the product, while the breading represents 10%. You enter
10% in this field.

If you are creating multiple countries of origin, the
quantity and value percentages must total 100%. If these
values do not total 100%, an error message displays.

6. Select the Primary check box to indicate this country is the main source for this part. You can only select
one country of origin as the primary source.

Part Class

Part Class Maintenance categorizes and organizes your parts. Part classes are primarily used for reporting purposes.
They also hold information about groups of parts you use within inventory. For example, Is inspection necessary
for these parts when they are received?, Can purchase order requisitions be entered?, Which buyer is responsible
for this part?, or What action should be taken when there is negative inventory?

Typically, part classes are created when you first implement
the application. Usually these codes are determined by
individuals representing accounting, purchasing, and
manufacturing personnel.

Menu Path: Material Management > Inventory Management > Setup > Part Class

To create a new part class:
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1. Click New on the Standard toolbar.

2. Enter a Part Class code and a Description.

3. Select a Buyer for this part class.

4. Click the Approved Suppliers button to find and select which suppliers can sell you parts through this part
class.

5. Select the Negative Quantity Action the application should do when transactions against this class cause
the on-hand quantity of any parts linked to this class to result in a negative quantity. Available options:

• Warn - A warning message displays, but processing can continue

• Stop - An error message displays, and processing cannot continue

• None - No messages display

6. The Site sheet establishes planning parameters for a specified part class and Site combination. These
parameters apply to all parts linked to the current part class. You can override these parameters within
part-Site details within Part Maintenance.

7. Access the GL Control sheets to determine the accounts and journal codes used to post transactions against
the current warehouse. You can associate one or more GL controls with a warehouse; however, each control
linked to the warehouse must belong to a different control type.

8. When you finish creating your part class, click Save.

Part Cross References and Approved Supplier Sourcing

Use the Part Cross References functionality to create relationships between different part numbers defined for
the same product. Customers, suppliers, and internal users may use different part numbers to identify the same
part. You can define part cross references as you need for all of these situations. This section first describes the
different use cases for this functionality and then describes how to implement this feature set.
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Supply Side Cross Reference

Suppliers often use different part numbers for the parts you purchase. These parts may also be produced through
another manufacturer who then provides the supplier (usually a distributor) with these materials; these parts can
also use different part numbers.

To accommodate this business need, you can control parts by linking unique part numbers for suppliers and their
qualified manufacturers – using the same part record. You can then create RFQs, supplier price lists, and purchase
orders that use these unique identifiers – while at the same time you place these transactions against the same
part record.

To leverage this functionality, you must first create a list of potential manufacturers, the life cycle for each part,
and the qualified manufacturer records. You can then link them when you create supplier part records.

Demand Side Cross Reference

Customers often use different part numbers for the same parts you sell to them. Your customers may also have
specific serial format requirements for these parts. To accommodate this business need, you can control parts by
linking together unique part numbers for customers, for serial tracked parts, and optionally assign alternate serial
masks. You can then create sales orders using the customer part. When you create a job for this customer part,
you can then apply the alternate serial mask format to the manufactured parts.

To leverage this functionality, you must create customer parts.

Internal Cross Reference

Internal users may need to create their own identifiers for parts in order to simplify data entry or create variations
in the part. To accommodate this business need, you can control parts by linking unique part numbers for internal
use, for serial tracked parts, and optionally assign alternate serial masks. When you create a job for the Internal
Part Cross Reference, the alternate serial mask format is applied to the manufactured parts.

To leverage this functionality, you must create internal part cross references.

Internal Part Cross References

Use Internal Part Cross Reference Maintenance to create cross references for a specific part number. These values
are primarily used in Part fields as shortcuts for data entry. For example, you can create an internal cross reference
of EPR-100 for an internal part number of EPRD-100-SL-MRP. When users enter sales orders for this part, they
can enter EPR-100 and the application automatically replaces it with the normal internal part number.

You can also create alternate serial number masks for use during Job Entry. When the cross reference populates
the job, the alternate serial mask is used.

Menu Path: Material Management > Inventory Management > Setup > Internal Part Cross Reference

To use this program:
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1. Click the Part Number button to find and select the part number you want to cross reference. You can
also enter the part number directly.

2. The Description from the part record displays.

3. If the Serial Tracked check box is selected, it indicates that this part number is recorded on transactions
using serial numbers.

4. To create a new cross reference, click New on the Standard toolbar.

5. Enter the Internal Cross Reference you want for the part number.

6. Now enter the Description you want to display when this internal cross reference is selected.

7. If the part and Site records are serial number controlled and the format is a serial mask, you can optionally
select an alternate serial mask for this internal cross reference. Either enter the mask directly or click the
Serial Masks button to find and select the mask you want.

8. The Serial Number Format from the mask displays in this field.

9. If you need, enter a different Mask Prefix value.

10. Optionally, you can also enter a different Mask Suffix value.

11. Continue to add the internal part cross references you need. When you finish, click Save.

Internal Side Use Case

You first create a job by entering an Internal Part number linked to a serial tracked part. An alternate mask is
also linked to that part. When serial numbers are created for this job, the alternate mask format is applied to
them.
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Demand Side Use Case

You first create a job by entering a customer part number linked to a serial tracked part. An alternate mask is
also linked to that part. When serial numbers are created for this job, the alternate mask format is applied to
them.

Part Cross References and Approved Supplier Sourcing in Action

You can now use the part cross references within specific programs that are key to maintaining your supply chain.
This section describes where you use part cross references and approved supplier sourcing. The following example
demonstrates a Supply Side use case scenario.

RFQ Entry

When you create a detail line on a new Request for Quote (RFQ), you can select a specific manufacturer’s part
number to include with it.

Menu Path: Material Management > Supplier Relationship Management > General Operations > RFQ Entry

To select a part cross reference for an RFQ:

1. Create a new RFQ on the Detail sheet.

For more information on creating an RFQ, review RFQ
Entry in the Purchasing chapter.

2. After creating the RFQ, click the Down Arrow next to the New button; select New Line.

3. Click the Part button to find and select a part that has part cross references.

4. The part cross references display within the Manufacturer’s Parts to be Quoted grid. All the cross references
available for the current part display on this grid.

5. The Manufacturer identifier and Name values display within their respective columns.

6. The Manufacturer’s Part Number displays within its own column.
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7. If you want to keep this part number on this RFQ detail line, select the Include check box. If you want to
remove a cross reference part number from this RFQ detail line, clear the Include check box.

8. When you finish, click Save on the Standard toolbar.

Supplier Response and / or Supplier Price List

When a supplier responds to a quote or sends pricing for a part, you can record the pricing values. Suppliers
frequently include their supplier part values as they also need to map these numbers to their Qualified Manufacturer
or Manufacturer’s Parts records.

The following steps describe this process:

1. Enter the supplier pricing and create a new supplier part.

2. Enter the supplier part number and then select the Qualified Manufacturing/Manufacturing part values
to link them together. You can do this task from within both the Supplier Price List and the Approved
Supplier Maintenance programs. Approved Supplier Maintenance is discussed in the next section.

3. Select this supplier within Purchase Order Entry.

4. When you select the manufacturer’s part cross reference number, the supplier’s part number displays as
well.

Within Purchase Order Entry, you can select Qualified
Manufacturing/Manufacturing parts even if you have not
defined supplier parts.

Approved Supplier Maintenance

In addition to the Supplier Price List, supplier parts can also be maintained from within Approved Supplier
Maintenance. A supplier can be defined as a distributor for a qualified manufacturer. Each qualified manufacturer
can then be linked to a part cross reference number.

You can launch this program from several locations. During this example, you launch Approved Supplier
Maintenance within Part Maintenance.

Here’s how:
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1. Select the part record you want to update on the Part > Detail sheet.

2. From the Actions menu, select Approved Suppliers.

3. The Approved Supplier Maintenance window displays.

4. Because you launched this program within Part Maintenance, the Part Number and Description
automatically display.

5. Review the Type value. In order to use part cross referencing, this drop-down list must display the Part
option.
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6. Click the Supplier button to find and select the specific supplier you want to approve.

7. Optionally, enter a new Supplier Part. This value is the identifier used by the supplier. Click the Down
Arrow next to the New button; select New Supplier Part.

8. On the Supplier Parts > Detail sheet, select the Default for Purchases check box when you want the
current supplier part to be the default option. Only one supplier part can be selected as the default supplier
part value.

9. Now select the manufacturer you want linked to this supplier part. To do this, click the Manufacturer
drop-down list to select an option.

10. The part cross references available for the selected manufacturer display on the Manufacturer’s Part
drop-down list. Select the part number you want associated with the current supplier part.

11. The Life Cycle Status and Market Availability fields display the values you entered within Qualified
Manufacturer Maintenance. These values display for your information; you cannot edit them.

12. Continue to add the supplier parts you need for the current approved supplier. When you finish, click Save
on the Standard toolbar.

Now when you use this approved supplier within Purchase Order Entry and select the manufacturer’s part cross
reference number, the supplier’s part number displays as well.

Manufacturers and Lifecycle Statuses

You also create two types of records that are later used to define qualified manufacturers. These records are
manufacturers and lifecycle statuses.

Manufacturers

Use Manufacturer Maintenance to create manufacturer records. Only create manufacturer records for organizations
who do not directly supply materials to your company. You later use these records to create part cross references
for qualified manufacturers.

Menu Path: Material Management > Purchase Management > Setup > Manufacturer

To create a new record:
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1. Click New on the Standard toolbar.

2. Enter the Manufacturer identifier you need. This value displays within other programs and reports.

3. Enter the Name of the manufacturer. This value displays on drop-down lists in other programs.

4. If you no longer want this manufacturer to be available within other programs, select the Inactive check
box. This record will not display on drop-down lists throughout the application. This check box is available
only if this manufacturer is not selected as a qualified manufacturer.

5. When you finish, click Save.

Lifecycle Statuses

You create lifecycle status codes within Life Cycle Status Maintenance. A lifecycle status code defines the point
at which a manufacturer’s part is at its useful period. For example, lifecycle codes within the electronics
manufacturing industry include Introduction, New Product, Rapid Growth, Maturity, Saturation, Not Recommended,
Phase Out, and so on.

Menu Path: Material Management > Purchase Management > Setup > Lifecycle

To create a new lifecycle status:

1. Click New on the Standard toolbar.

2. Enter the Life Cycle Status identifier. This value displays within other programs and reports. In this example,
you enter Maturity.

3. Enter the Description you want for this lifecycle status. In this example, you enter Maturity.

4. One lifecycle status must be selected as the Default. Select this check box to assign the current lifecycle
status as the default. This lifecycle status automatically displays on the Life Cycle Status drop-down list
within Qualified Manufacturer Maintenance.
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5. Select the Inactive check box to prevent this lifecycle status from being selected within Qualified Manufacturer
Maintenance. The status no longer displays on the Life Cycle Status drop-down list.

6. When you finish, click Save.

Qualified Manufacturers

Use Qualified Manufacturer Maintenance to link a manufacturer with a specific internal part. You can indicate
that multiple manufacturers are qualified for a part. You can also define one or more cross-reference part numbers
for each manufacturer.

Typically you use these records for organizations which do not directly supply part quantities to your company.
While your engineers design products, they often test a variety of manufacturer’s parts for form, fit, and function.
Qualified manufacturer parts are verified to have equal form, fit, or function possibilities and are interchangeable
within a specific area within a product design.

Menu Path: Material Management > Purchase Management > Setup > Qualified Manufacturer

To create a new qualified manufacturer record:

1. Click the Part Number button to find and select the internal part number you need.

2. After you select the part, its Description displays in the accompanying field. You cannot change this value.

3. Click the Down Arrow next to the New button; select New Qualified Manufacturer.
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4. Click the Manufacturer button to find and select the manufacturer you want to link, or qualify, with the
selected part. Users can now search for this identifier within RFQs and purchase orders.

5. The Name of the manufacturer displays for your information.

6. Optionally you can now add one or more manufacturer’s parts qualified for this manufacturer. To do this,
click the Down Arrow next to the New button.

7. Select New Qualified Manufacturer Part.

8. The Manufacture Part > Detail sheet displays.

9. Enter the Manufacturer’s Part number used by this manufacturer to define this internal part.
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10. Select the Life Cycle Status for this part. The default status displays automatically, but you can click the
drop-down list to select a different status.

11. Use the Market Availability field, enter either how long this product is available or how long it typically
takes to purchase the material in the marketplace. This value is for your information and is not used in any
calculations.

12. Continue to add any additional manufacturer’s part numbers you need. When you finish, click Save on the
Standard toolbar.

Operations

This section describes the operations available in the Inventory module. Each operation is described as a workflow
to help guide you through the process from start to finish. These programs are primarily found within the General
Operations folder for this module. If a unique setup record is required to run the operation, this record is also
described in this section.

Print the Job Pick List

To begin issuing materials to a job, you first print the Job Pick list. The Job Pick List displays the material needed
and includes the warehouse and bin where the material quantity is located. This list assists you in locating and
physically pulling the part quantities you need from inventory. In case you need to update the warehouse or bin
information, you can record the actual warehouse and bin from where you pulled the material quantity directly
on the report.

Menu Path: Material Management > Inventory Management > Reports > Job Pick List

1. Select the Include Purchased Materials check box to indicate you want this information to display on the
report.

2. Select the Print Bar Codes check box to cause the report to display bar codes as well.
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3. Select the Filter > Job sheet to select materials for a specific job to display on the report.

4. Click the Job button to find and select a job to print.

5. Use the Assembly sheet to select materials for a specific assembly to display on the report.

6. Click Print on the Standard toolbar.

Issue Material from Inventory

One of the main transactions you do within inventory is issue materials and assemblies to jobs. Once a job is
created (refer to the Job Management chapter), you need to satisfy the demand for material requirements. You
order purchased materials and then receive either to the job or to stock - or as a miscellaneous item. Once
received, then all materials (purchased or manufactured) are issued to the demand source individually (by part
number) or through a mass issue based on the job pick list.

Mass Issue Material

Use the Mass Issue functionality to quickly issue all planned materials to a job, instead of issuing each material
individually. When you issue transactions generated in this way, you reduce inventory quantities and post material
costs to jobs.

Run this program if your material estimates are fairly accurate.
This program works best with any job material that you do not
lot or serial track.

Menu Path: Material Management > Inventory Management > General Operations > Mass Issue to Mfg

To mass issue job material:
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1. In the Job field, enter the job number.

2. If the Tree View on the left indicates this job includes subassemblies, you may choose to issue for the top
level assembly or all subassemblies. Select the Include Subassemblies check box to issue all material for
this job.

3. Click the Issue button and the Issue > List sheet displays.

4. The Sort column displays the related assemblies and operation numbers for each grid line. You can use it
to sort and group related assemblies by operation number. Click the Sort column header to select a specific
grouping of operations for related assemblies for issuance of materials.

5. Click the Issue All button

6. Click OK. This issues all material from the primary bin and warehouse.

7. Click Save on the Standard toolbar.

By scrolling to the right, you can view the warehouse and
bin as well as the quantity being issued. The warehouse,
bin, or the quantities can be changed if necessary.
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Issue Job Material

Job material can be issued individually using the Issue Material program. This issue method is preferred for lot or
serial tracked parts. You can also issue an assembly from inventory to a job using the Issue Assembly program.
This program is discussed in the next section.

When you issue material to a job, two events occur. First, the Issued Quantity and Total Cost values on the job
material or assembly record update with the issued quantity and the Extended Cost. The Extended Cost is
calculated by multiplying the issued quantity against the costing method used for the part – either Average,
Standard, Last, or FIFO. Second, the current On-Hand Quantity and Allocated Quantity values for the part are
reduced by the issued quantity.

Menu Path: Material Management > Inventory Management > General Operations > Issue Material

To issue job material individually:

1. In the Job field, enter the job number.

2. Click the Assembly drop-down list to select the correct assembly level.

3. Click the Mtl drop-down list to select the correct material.

4. Enter the Quantity to be issued.

5. If the item being issued is lot controlled, in the Lot field, enter a lot number.

6. If the part is serial tracked, you can click the Serial Numbers button to select the serial numbers used with
the issued quantity.

7. Click OK to complete the transaction.

8. Notice the material issued and the quantity now display in the Tree View.
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Issue Assemblies

Assemblies are issued when the job assembly is specified as a pull quantity from stock. Because the demand is
for a sub-assembly part, a pull quantity is different than a typical material requirement. Some of the quantity is
manufactured through a job, while the rest of the quantity is pulled from stock. This stock quantity may be the
result of overproduction on another job.

Menu Path: Material Management > Inventory Management > General Operations > Issue Assembly

To issue assemblies:

1. Click the Job button to find and select the job to which you are going to issue the assembly. You can also
enter the job number directly.

2. Enter the Quantity to issue.

3. If the part is lot tracked, you can click the Lot Number button to find and select the lot you need.

4. If the part is serial tracked, you can click the Serial Numbers button to select the serial numbers used with
the issued quantity.

5. Click OK to complete the transaction.

6. The Issued Complete check box is now selected, indicating the issue is complete.

After you issue an assembly to a job and select another assembly to issue to the same job, the Work List in the
program’s Tree View clears information from the previous assembly and replaces it with the new assembly.

If you would like to view all of your issue transactions for all assemblies in the Work List at the same time, click
the Job button to launch Job Search. From the search results, pull in all the job assemblies that you would like
to issue. All selected assemblies display in the Work List; you can then navigate among them to enter the issue
transactions.
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Issue Miscellaneous Materials

You can use the Issue Miscellaneous Material program to issue miscellaneous parts from inventory. For example,
you would do this if a manager needs to take a sample item to a trade show.

When you issue miscellaneous parts, a transaction history
record is created with the transaction type of STK-UKN. For
more information on transaction codes, review the Transaction
Types topic within application help.

Menu Path: Material Management > Inventory Management > General Operations > Issue Miscellaneous
Material

To issue miscellaneous material:

1. Click the Part button to find and select the part number you need. You can also enter the part number
directly.

2. Enter the Quantity you want to issue.

3. In the Reference field, enter a comment. The information you enter in this field is recorded in the part
transaction history file.

4. Select a Reason code for this miscellaneous issue. The reason code defines the offsetting general ledger
controls affected by this transaction.

5. Enter the Warehouse and Bin from which you issued the part. The part’s default warehouse and bin display,
but if you need, you can override these options.

6. If the part is lot tracked, you can click the Lot Number button to find and select the lot you need.

7. If the part is serial tracked, you can click the Serial Numbers button to select the serial numbers used with
the issued quantity.

8. When you finish, click OK.
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Receive Material into Inventory

Materials can also be received into inventory. For example, manufactured jobs can be received into inventory, or
materials can be returned to stock if a customer cancels an order where the material has already been issued to
the job.

Return Material

Use the Return Material program as needed to return material from a job to inventory.

Menu Path: Material Management > Inventory Management > General Operations > Return Material

To return issued material from a job:

1. In the Job field, enter the job number containing material to be returned.

2. Click the Assembly drop-down list to select the correct assembly level.

3. Click the Mtl drop-down list to select the correct material operation.

4. The default from Warehouse and Bin for the issued material displays by default. If you need, however, you
can select a different warehouse and bin.

5. Enter the Date for the material return.

6. Select the Part you need to return to inventory.

7. Enter the Quantity you need to return to inventory.

8. Optionally, enter a Reference for the return. The information you enter in this field is recorded in the part
transaction history file.

171Epicor ERP | 10.0.700

Inventory Management | Chapter 3Epicor ERP Application User Guide - Part Two



9. The default Warehouse and Bin for the returned quantity displays by default. If you need, however, you
can select a different warehouse and bin.

10. If the part is lot tracked, you can click the Lot Number button to find and select the lot you need.

11. If the part is serial tracked, you can click the Serial Numbers button to select the serial numbers used with
the received quantity.

12. Click OK to complete the transaction.

Return Miscellaneous Material

Use the Return Miscellaneous Material program to return items to inventory that have been removed through
the Issue Miscellaneous Materials program. Building on the previous example, the manager returns from the
trade show and uses the Return Miscellaneous Materials program to return the sample item back into inventory.

Menu Path: Material Management > Inventory Management > General Operations > Return Miscellaneous
Material

To return miscellaneous material:

1. Click the Part button to find and select the part number you need. You can also enter the part number
directly.

2. Enter the Quantity you need to return to inventory.

3. Optionally, enter a Reference for the return. The information you enter in this field is recorded in the part
transaction history file.

4. Select a Reason code for the returned item. The reason code defines the offsetting general ledger controls
affected by this transaction.

5. The default Warehouse and Bin for the returned quantity displays by default. If you need, however, you
can select a different warehouse and bin.

6. If the part is lot tracked, you can click the Lot Number button to find and select the lot you need.

7. If the part is serial tracked, you can click the Serial Numbers button to select the serial numbers used with
the received quantity.

8. When you finish, click OK.
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Job Receipt to Inventory

Use the Job Receipt to Inventory program to enter the receipt of manufactured parts into inventory.

When you receive manufactured parts to inventory, several inventory transactions run. The part’s On-Hand
Quantity in the part record updates. The Average, FIFO, and Last cost values also update. Additionally, a transaction
history record is created for the part with the job reference.

You do not have to receive parts to inventory before you ship them; for example, you can ship directly out of
Work in Process (WIP). Only receive items to inventory if you are building standard products or if you have overruns
or spare parts you are not able to ship right away.

Menu Path: Material Management > Inventory Management > General Operations > Job Receipt to Inventory

To receive job material into inventory:

1. In the From Job field, enter the number of the job you want to receive.

2. If the job has more than one assembly, select the assembly you want to receive against in the Assembly
field. If the job only has one assembly, this field displays a zero (0) and you cannot select it.

3. Enter the Quantity to receive.

4. The Site, the Warehouse, and the Bin values for the part display by default, but if you need, you can
change these values.

5. If the part is lot tracked, you can use the Lot and the Next Lot buttons to define which lot is receiving the
parts.

6. If the part is serial tracked, you can click the Serial Numbers button to define the serial numbers used with
the received quantity.

7. When you finish, click OK.

173Epicor ERP | 10.0.700

Inventory Management | Chapter 3Epicor ERP Application User Guide - Part Two



Replenishment Workbench

The Replenishment Workbench contains methods which facilitate material replentishment for supply chain and
distribution business flows. The Automatic, Manual, and Managed methods track stock-to-stock supply between
specific warehouses and bins.

To determine replenishment requirements, the Automatic and Manual replenishment methods use parameters
you define at the part warehouse or bin levels. The Automatic method continually monitors inventory balance
levels, automatically generating move requests when inventory quantities change in warehouse and bin locations.
Through the Manual method, you view proposed move requests and manually generate the actual move requests.

However, through the Managed method, you create "on-the-fly" move requests for parts without replenishment
parameters, or parts linked to part classes or product codes that have no parameters. You can view these
replenishment move requests in the Replenishment Workbench > Moves sheet, the Material Request Queue, or
in the Material Queue Manager, located on the Advanced Material Management General Operations menu.

Use the Replenishment Workbench to distribute Manual and Managed move requests. You also leverage this
program to review previously generated move requests. This program can be used with Kanban processing to
complete a supply-to-replenish synchronized flow.

You can also view move requests in the Material Request Queue
and the Material Queue Manager. These programs are located
in the Advanced Material Management module in the General
Operations folder.

Menu Path: Material Management > Inventory Management > General Operations > Replenishment Workbench

Manual Replenishment

To generate manual replenishment move requests:

1. Navigate to the Manual sheet.
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2. Click the To Warehouse drop-down list to select  the warehouse for which replenishment move requests
will be manually generated.

3. To perform bin level replenishment for the specified warehouse, use the To Bin Type, the To Zone, and
the To Bin Range fields to specify the destination warehouse zone, bin types and warehouse bins for which
replenishment calculations are being performed. To perform warehouse level replenishment only for the
specified warehouse, leave these fields blank.

4. Optionally, select the Include Auto Replenishment check box to specify Automatic replenishment requests
generated by the Epicor application should also display in the Replenishment Moves grid.

5. Optionally, select the Include Supplier Managed check box to specify if supplier-managed bins should
also be included as a source of supply for replenishment materials.

6. Click the Mode drop-down list to select the type of replenishment quantity calculation (Fill to Maximum
or Use Replenishment Quantity) that should be performed when generating manual replenishment move
requests.

7. Select the Include Above Maximum, the Include Above Minimum, the Include Above Threshold, and
the Include Below Threshold check boxes as needed to view replenishment move requests candidates
based on various processing parameters. The application compares the calculated inventory balances for
parts in the destination warehouse (or warehouse bin) to replenishment parameters you have defined at
the part warehouse or part warehouse bin levels.

8. Click Retrieve to select and display replenishment move transaction request candidates that match the
specified warehouse and type criteria.

9. To calculate the available supply inventory quantity for display in the Avail field, use the Select check box
to indicate for which rows you want to calculate the replenishment transactions. After you select the rows,
click the Calculate Available button.

10. Using the Move Qty field, review the proposed move quantities for each of the proposed replenishment
move requests. You can override the move quantity for each transaction row as needed.

11. Click the Select All button to indicate move requests need to generate for all the current transaction rows.

12. Click the Generate Moves button to generate actual replenishment move requests for the replenishment
transaction rows selected in the Replenishment Moves grid.

Managed Replenishment

To perform Managed material replenishment:
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1. Navigate to the Managed > Criteria sheet.

2. Click the To Warehouse drop-down list to select the warehouse for which replenishment move requests
are being created.

3. To  perform bin level replenishment for the specified warehouse, use the To Bin Type, the To Zone, and
the To Bin Range fields to specify the destination warehouse zone, bin types and warehouse bins for which
replenishment calculations are being performed. To perform warehouse level replenishment only for the
specified warehouse, leave these fields blank.

4. Optionally, select the Include Supplier Managed check box to specify if supplier-managed bins should
also be included as a source of supply for replenishment materials.

5. In the Part Filter field, indicate if you want to filter search results by part number, part class, or part group;
depending on your selection, specify the part class or product class, or use the Filter sheet to select the
specific part numbers being filtered.

6. Click Retrieve to select and display part and inventory balance information for the specified warehouse,
type and filtering criteria.

7. To calculate the available supply inventory quantity for display in the Avail field, use the Select check box
to indicate for which rows you want to calculate the replenishment transactions. After you select the rows,
click the Calculate Available button.

8. Enter the Move Qty for each selected transaction row. This value defines the quantity that will be replenished.

9. Click the Select All button to indicate move requests need to generate for all the current transaction rows.

10. To create move requests for the selected transaction rows, click the Generate Moves button.
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Move Replenishments

Use the Moves sheet to review move requests generated or created for warehouses and bins. You first select the
warehouse that will receive the material quantities, and then you specify type of move requests (Automatic,
Manual, or Managed) to review.

The features on the Move sheet are similar to the options on
the Material Request Queue. This program is available in the
Advanced Material Management module.

To view replenishment move requests:

1. Navigate to the Moves sheet.

2. Click the To Warehouse drop-down list to select the warehouse for which you want to review move
requests.

3. Use the Auto, Manual and Managed check boxes to select the type of replenishment move requests being
retrieved.

4. Click Retrieve to retrieve and display all replenishment move requests matching the specified criteria.

5. To select specific transaction rows for processing, click the Select check box on each row.

6. Click the Select All button to process all the transaction rows on the grid.

7. Use the buttons at the bottom of the Moves sheet to assign employees and warehouse teams, set priority
levels, and place selected transactions on hold.

8. To view a report of the transactions, select one or multiple rows on the grid. Then click the Print button to
generate the Replenishment Moves report.
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Serial Number Tools

If you use serial tracking for your parts, tools are available which help you leverage the serial number functionality.
This section describes two key tools – Serial Matching and the Serial Number Tracker.

Serial Matching

You use the Serial Matching program to link child serial numbers to parent serial numbers for a specific job or
an individual serial number. If a serial number is entered in the Top Serial sheet and it has a job number associated
with it, this process operates in job mode, restricting the serial number selection to available numbers on the
selected job. If a job number does not exist for the serial number, the process runs in serial number mode; you
can match serial numbers with any available related numbers.

Menu Path: Material Management > Inventory Management > General Operations > Serial Matching

To use serial matching:

1. Click the Job button to find and select a specific job number. You can also enter the job number directly.
If you manually enter a job number, this number is validated to make sure it uses a serial tracked part. Notice
that if you select a job and assembly first, you can only use the Serial Number Search to locate serial
numbers available on the selected job.

2. Click the Assembly button to find and select the assembly which contains the serial number you want to
match. You can also enter the assembly number directly.

3. The Part Number field displays the part identifier for the serial tracked part.

4. The Revision field displays the revision level for the serial tracked part.

5. The Description field displays the concise explanation of the serial tracked part.

6. The Status field displays the current state of the serial tracked part. Some status examples include consumed,
wip, and inventory.

7. The Quantity field displays the quantity being consumed or manufactured on a selected job.

8. The Date Created field displays the date on which the current serial number was created.

9. If the Fully Matched check box is selected, it indicates all the child serial numbers are completely paired to
a parent serial number.

10. Use the Matching Details sheet to manually match child serial numbers to parent serial numbers.
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11. Use the Available to Match sheet to finalize matching child and parent serial numbers while within Job
mode.

12. When you finish, click Save on the Standard toolbar.

Serial Number Tracker

Use the Serial Number Tracker to review database information on a specific serial number. The information in
this tracker is read-only, so all users can leverage this tool to review serial number information.

Menu Path: Material Management > Inventory Management > General Operations > Serial Number Tracker

To use this tracker:

1. Click the Serial Number button to find and select the serial number you need.

2. The Part and the Description fields display the identifier and name of the part being serial tracked.

3. This section displays current warehouse information. The Status, the Bin location, and the Serial Mask
ID display.

4. The Receiving section displays information about the purchased part shipment. The Supplier ID, the
Supplier Name, and the Packaging Slip/Line number display.

5. The Shipping section displays information about the shipments to customers. The Sold To ID, the Ship
To Name, the Sold To Name, and the Packing Slip/Line number display.

6. The bottom section displays internal information about the serial tracked part. The Job/Assembly/Mtl,
Non-Conformance ID, DMR/Action, and other fields display in this section.
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7. The Transactions sheet displays all the part transactions run against this serial tracked part. To display this
information, you must click the Retrieve button on this sheet.

8. The Lower Level Serials sheet displays all the child serial numbered parts used on lower level assemblies
for manufacturing the current parent serial number. To see these serial numbers, click the Retrieve button
on this sheet.

9. The Where Used sheet displays all the records that currently use the serial number. To display this
information, click the Retrieve button on this sheet.
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10. The One Time Ship To sheet displays the temporary one time ship to address (if any) entered for this serial
number into the Serial Number Maintenance > One Time Ship To sheet. Use this functionality when you
need to ship serialized part quantities to a unique location requested by the customer.

Cycle and Physical Counting

The Epicor application contains a full range of tools to help you conduct inventory counts. You can count all
items every time you do a physical inventory (full physical) count. You can also periodically count various items;
this count is referred to as a cycle count.

Regardless of the count method you use, leverage this functionality to analyze variances, suggest recounts, and
post the count results. You can create and scan audit ID labels during the count so that you can easily recount
or audit the results. You can also create virtual tags by part, location, lot number, and serial number for all the
items included in the count.

You use the counting functionality to automatically generate counts and schedule them whenever you need.

ABC Code Hierarchy

You use ABC codes to classify your inventory and also control discrepancy tolerances. You can define overall
tolerances for each ABC code, but then override these values on related records through an increasingly specific
hierarchy. As the records in this hierarchy grow more specific, the tolerance values on the specific record override
the values defined in the previous record. Use this hierarchy to strategically define the tolerances you need within
specific areas of your inventory.

The following list describes the ABC code hierarchy order, from most specific to least specific:

1. Part-Warehouse Records – You assign parts directly to a specific warehouse in Part Maintenance. You
can then define tolerances for each part–warehouse record; these values override the tolerances defined in
part-site records.

2. Part-Site Records – You assign parts directly to a specific site in Part Maintenance. You can then define
tolerances for each part–site record; these values override the tolerances defined in warehouse records.

3. Warehouses – You can define tolerances for a specific warehouse through Warehouse Maintenance. These
values override the tolerances defined in site configurations.
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4. Site Configurations – You can define tolerance parameters for a specific site using Site Configuration
Control. These values override the tolerances defined at the ABC code level.

5. ABC Codes – These records define the least specific level in the parameter hierarchy.

The following sections describe the tolerance values available within each record of the hierarchy.

Part – Warehouse Records

You can also use Part Maintenance to define the cycle and physical inventory counting methods used with a
specific warehouse which stocks the current part. You define these values on the sheets under the Cycle
Count/Physical Inventory tab located under the Sites - Warehouses tab. The values you define in these sheets
override the values defined for the part-site record which contains the warehouse.

Menu Path: Material Management > Inventory Management > Setup > Part

To define cycle and physical inventory for a specific warehouse on a part-site record:

1. On the Part > Detail sheet, click the Part button to find and select the part record you need to modify.
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2. From the Part > Sites > Detail sheet, select the Site from the tree view to select the part-site record you
need to modify.

3. Navigate to the Warehouses > Cycle Count sheet.

4. Select the Manual ABC Code check box to indicate you want to manually control the ABC code for this
part within this warehouse. The Calculate ABC Code program then cannot automatically change the ABC
code for this part–warehouse record. For more information on this program, review the Calculate ABC
Codes section later in this chapter.

5. If the Manual ABC Code check box is selected, the ABC Code button activates. Click this button to find
and select the ABC Code you want to manually control.

6. If the Manual ABC Code check box is clear (not selected), the Min ABC button activates. Click this button
to find and select the first ABC Code you want automatically controlled for this part-warehouse record
through the Calculate ABC Codes program. This code and all other subsequent ABC codes are automatically
calculated by this process.

7. Select the Override Frequency check box to define a different count frequency for this part-warehouse
record than what is defined within the main ABC code or the site configuration record.

8. If you select the Override Frequency check box, you activate the Count Frequency field. Enter the count
interval you want for this part-warehouse record; use a numeric value that reflects a number of months.

9. The Last Cycle Count field displays the most recent date a cycle count was run against the parts stocked
within this warehouse.

10. If you want this part-warehouse to use a threshold value for generating inventory quantity adjustments,
select the Calculate Qty Adj check box. This activates the Quantity Adjustment Tolerance field; enter
a value that defines the threshold at which a quantity discrepancy is posted as an adjustment to inventory.
The default value is zero, which indicates all quantity adjustments are posted.

11. Select the Calculate Percent check box to indicate you want the application to use the percentage defined
in the Percent Tolerance field to control discrepancy tolerances in cycle or physical counts for this
part-warehouse record. If you enter a zero percentage, you indicate any percentage variance is considered
out of tolerance. A percentage higher than zero indicates a percentage difference between the count
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quantity and the frozen quantity, by more than this value, is considered out of tolerance. However, if the
quantity variance is below this Percent Tolerance, it is not included on count variance reports.

12. Select the Calculate Quantity check box to indicate the value in the Quantity Tolerance field is used to
control quantity discrepancy tolerances in cycle or physical counts for this part-warehouse record. If a count
variance for a part within this warehouse is within this quantity tolerance value, the part is not included on
count variance reports.

13. Select the Calculate Value check box to indicate the amount in the Value Tolerance field is used to control
value discrepancy tolerances in cycle or physical counts for the current part-warehouse record. If a count
variance calculated for the part in this warehouse is within the monetary value tolerance, the part is not
included on count variance reports.

14. When you finish, click Save on the Standard toolbar.

Part – Site Records

You use Part Maintenance to define the cycle and physical inventory counting methods used with a specific part
within a site. You define these values on the sheets under the Cycle Count/Physical Inventory tab located under
the sites tab. The values you define in these sheets override the values defined for the warehouse that stores the
part.

Menu Path: Material Management > Inventory Management > Setup > Part

To define cycle and physical inventory counting for a specific part-site record:

1. On the Part > Detail sheet, click the Part button to find and select the part you need.
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2. On the Part > Sites > Detail sheet, chose the Site from the tree view to select the part-site record you
need to modify.

3. Navigate to the Cycle Count sheet.

4. If you need, enter a Quantity Adjustment Tolerance value. This value defines the threshold at which a
quantity discrepancy is posted as an adjustment to inventory. The default value is zero, which indicates all
quantity adjustments are posted.

Typically, you use this value to control the count discrepancy of parts counted by weight on a scale. In this
situation, count results often vary based on humidity. If a difference exists between the frozen quantity and
the counted quantity but fall within this tolerance value, no inventory adjustment is created. The part is now
assigned a status that indicates no quantity adjustments were posted.

5. Select the Calculate Percent check box to indicate you want the application to use the percentage defined
in the Percent Tolerance field to control discrepancy tolerances in cycle or physical counts for this part-site
record. If you enter a zero percentage, you indicate any percentage variance is considered out of tolerance.
A percentage higher than zero indicates a percentage difference between the count quantity and the frozen
quantity, by more than this value, is considered out of tolerance. If the quantity variance is below this Percent
Tolerance, however, it is not included on count variance reports.

6. Select the Calculate Quantity check box to indicate the value in the Quantity Tolerance field is used to
control quantity discrepancy tolerances in cycle or physical counts for this part-site record. If a count variance
for a part within this site’s warehouses is within this quantity tolerance value, the part is not included on
count variance reports.

7. Select the Calculate Value check box to indicate the amount in the Value Tolerance field is used to control
value discrepancy tolerances in cycle or physical counts for the current part-site record. If a count variance
for a part within this site’s warehouses is within this monetary tolerance value, the part is not included on
count variance reports.

8. When you finish, click Save on the Standard toolbar.

Warehouses

You use Warehouse Maintenance to define the cycle and physical inventory counting methods used with a
selected warehouse. You define these values on the sheets under the Cycle Count/Physical Inventory tab. The
values you define in Warehouse Maintenance override the values defined for the site which contains the warehouse.

Menu Path: Material Management > Inventory Management > Setup > Warehouse

To define cycle and physical inventory counting for a specific warehouse:
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1. On the Warehouse Detail sheet, click the Warehouse button to find and select the warehouse you need.

2. Navigate to the Cycle Count Detail sheet to define the cycle count method for the current warehouse. The
options you select on this sheet indicate how continuous inventory counting occurs within this warehouse.

3. Select the Cycle Count Method used for this warehouse. Available options:

• Use Site Setting – Uses the cycle count method specified for the site within Site Configuration Control.
For more information about this option, review the previous sites section.

• Repetitive – Divides selected count items equally among the number of count days in the month. All
items that meet the selection criteria, regardless of the total number of selected items, are included. As
long as items are not removed from the list of those being counted, all items are counted according to
the specified cycle interval.

• Random – Uses an algorithm to randomly select the parts being counted based on the selection
parameters defined for a specific ABC code. Parts are selected randomly and then divided equally based
on the number of count cycles available in each month.

4. Select the Exclude Zero QOH check box to indicate parts with zero perpetual on-hand quantities in all bin
locations are not included during either cycle or physical counting for the current warehouse.

5. Select the Exclude Negative QOH check box to indicate parts with a negative perpetual on-hand quantity
in all bin locations are not included during either cycle or physical counting for the current warehouse.
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6. You use the ABC Code sheet to specify ABC code count intervals and quantity/percent tolerances for the
current warehouse. To modify an ABC code, click the Down Arrow next to the New button; select New
ABC Code.

7. Click the ABC Code button to find and select the ABC code you need.

8. Select the Exclude from Cycle Count check box to indicate parts containing this ABC code can only be
counted during physical inventory and cannot be included during cycle counting within this warehouse. The
value you select in this field overrides the Exclude from Cycle Count option selected on either the site
configuration or the main ABC code record.

9. Select the Override Stock Valuation check box to indicate a valuation percentage is used with this ABC
code within the current warehouse. Selecting this check box activates the Stock Valuation Percent field;
enter the percentage you need in this field.

10. Select the Override Count Frequency check box to define a specific count frequency for this ABC code
within this warehouse. If you select this check box, you activate the Count Frequency field. Enter the count
interval you want using a number of months value.

11. Select the Calculate Percent check box to indicate you want the application to use the percentage defined
in the Percent Tolerance field to control discrepancy tolerances in cycle or physical counts for this warehouse.
If you enter a zero percentage, you indicate any percentage variance is considered out of tolerance. A
percentage higher than zero indicates a percentage difference between the count quantity and the frozen
quantity, by more than this value, is considered out of tolerance. If the quantity variance is below this Percent
Tolerance, however, it is not included on count variance reports.

12. Select the Calculate Quantity check box to indicate the value in the Quantity Tolerance field is used to
control quantity discrepancy tolerances in cycle or physical counts for this ABC code within the current
warehouse. If a count variance for a part within this warehouse is within this quantity tolerance value, the
part is not included on count variance reports.

13. Select the Calculate Value check box to indicate the amount in the Value Tolerance field is used to control
value discrepancy tolerances in cycle or physical counts for this ABC code within the current warehouse. If
a count variance calculated for the part in this warehouse is within the monetary value tolerance, the part
is not included on count variance reports.

14. Continue to define the ABC code values you need for this warehouse. When you finish, click Save on the
Standard toolbar.
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Sites

You can define cycle and physical count values for a site within Site Configuration Control. You first indicate the
cycle count method you want the site to use. You then select a specific ABC code and define the values you
want to use for the specific ABC code within the site. The values you define in Site Configuration Control override
the values defined for the main ABC code record.

Menu Path: System Setup > Company/Site Maintenance > Site Configuration

This program is not available in the Epicor Web Access.

To define cycle and physical inventory counting for a specific site:

1. On the Summary sheet, click the Site button to find and select the site you need to configure. You can
also enter the site record directly.

2. Navigate to the Modules > Inventory Management > Cycle Count > Detail sheet.

3. Select the Cycle Count Selection Method used for this site. Available options:

• Repetitive – Divides selected count items equally among the number of count days in the month. All
items that meet the selection criteria, regardless of the total number of selected items, are included. As
long as items are not removed from the list of those being counted, all items are counted according to
the specified cycle count frequency.

• Random – Uses an algorithm to randomly select the parts being counted based on the selection
parameters defined for a specific ABC code. Parts are selected randomly and then divided equally based
on the number of count cycles available in each month.

4. Click the Cycle Count Calendar button to find and select a production calendar. The cycle count frequency
follows the work days defined within the selected production calendar.
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5. The Description text for the selected production calendar displays in this field.

6. You are now ready to define how ABC codes are used within this site. To do this, click the Down Arrow
next to the New button; select New ABC Code.

7. Click the ABC Code button to find and select the ABC code. You can also enter the code directly.

8. Select the Exclude from Cycle Count check box to indicate parts containing this ABC code can only be
counted during a physical inventory and cannot be included during cycle counting within this site. The value
you select in this field overrides the Exclude from Cycle Count value selected on the main ABC code record.

9. Select the Override Stock Valuation check box to indicate that you need to use a different Stock Valuation
Percent for this site than what is defined within the main ABC code. Selecting this check box activates the
Percent field; enter the percentage you need in this field.

10. Select the Override Count Frequency check box to define a different count frequency for this site than
what is defined within the main ABC code. If you select this check box, you activate the Count Frequency
field. Enter the count interval you want using a number of months value.

11. Select the Calculate Percent check box to indicate you want the application to use the percentage defined
in the Percent Tolerance field to control discrepancy tolerances in cycle or physical counts for this site. If
you enter a zero percentage, you indicate any percentage variance is considered out of tolerance. A
percentage higher than zero indicates a percentage difference between the count quantity and the frozen
quantity, by more than this value, is considered out of tolerance. However, if the quantity variance is below
this Percent Tolerance, it is not included on count variance reports.

12. Select the Calculate Quantity check box to indicate the value within the Quantity Tolerance field is used
to control quantity discrepancy tolerances in cycle or physical counts for this ABC code within the current
site. If a count variance for a part within this site is within this quantity tolerance value, the part is not
included on count variance reports.

13. Select the Calculate Value check box to indicate the value amount within the Value Tolerance field is
used to control value discrepancy tolerances in cycle or physical counts for this ABC code within the current
site. If a count variance calculated for the part in this site is within the monetary value tolerance, the part is
not included on count variance reports.
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ABC Codes

You define the overall parameters used by an ABC code within ABC Code Maintenance. These values are always
used by the company unless overridden by another record that has more precedence within the hierarchy. The
values you define within the ABC code are then used to count the part quantities during either cycle or physical
counting.

Menu Path: Material Management > Inventory Management > Setup > ABC Code

To create a new ABC code:

1. Click New on the Standard toolbar.

2. Enter the ABC Code value you need.

3. Select the Exclude from Cycle Count check box to indicate that parts assigned to this ABC code are not
included during a cycle count.

4. In the Stock Valuation Percent field, enter the ABC code to automatically assign to a part–warehouse
record. This value is used by the Calculate ABC Codes program to rank the parts based on both usage
percentage and monetary value. This program calculates the Total Value of the parts; this amount can
include items like current usage, On-Hand Quantity, and projected usage. Parts that fall within the percentage
value you define in this field are assigned to this ABC code.

When the Calculate ABC Codes program runs, it determines the total stock valuation and then ranks parts
by both percentage of usage and monetary value. For example, if 80.0 is entered into this field for ABC
Code A, the Calculate ABC Codes program assigns Code A to inventory items that represent 80% of the
value of the total inventory in this warehouse. If 95.0 is entered into this field for ABC Code B, the Calculate
ABC Codes program assigns Code B to inventory items that represent the next 15% of the value of the
total inventory in this warehouse. Enter 100.0 for ABC Code C to assign that code to inventory items that
represent the remaining 5% of the value of the total inventory in this warehouse.

5. Enter the Count Frequency value you need for this ABC code. A required field, use this value to indicate
how often parts with this ABC classification are counted on a daily basis. For example, if you count inventory
items on the basis of ABC classification, and Class A items require counting every 60 days, enter 60 into
this field. When you select parts for counting in cycle processing, the application selects all class A items
that have not been counted within the last 60 days for counting.
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6. Select the Calculate Percent check box to indicate you want the application to use the percentage entered
in the Percent Tolerance field to control discrepancy tolerances in cycle or physical counts for this ABC
code. If you enter a zero percentage, you indicate that any percentage variance is considered out of tolerance.
A percentage higher than zero indicates that a percentage difference between the count quantity and the
frozen quantity, by more than this value, is considered out of tolerance. If the quantity variance is below
this Percent Tolerance, however, it is not included on count variance reports.

If any one of these tolerance values is exceeded, the part
is automatically included on a count variance report. For
example, the frozen quantity for Widget A is 100. If the
Percent Tolerance for this part is defined as 2% and the
Quantity Tolerance is set to 5, a count of 105 causes it to
appear on a count variance report. Even though the 105
value is within tolerance for the quantity, it is not within
tolerance for the percentage.

7. Select the Calculate Quantity check box to indicate the value in the Quantity Tolerance field is used to
control quantity discrepancy tolerances in cycle or physical counts for this ABC code. If a count variance for
a part within this warehouse is within this quantity tolerance value, the part is not included on count variance
reports.

8. Select the Calculate Value check box to indicate the value amount in the Value Tolerance field is used
to control value discrepancy tolerances in cycle or physical counts for this ABC code. If a count variance
calculated for the part in this warehouse is within the monetary value tolerance, the part is not included on
count variance reports.

9. When you finish, click Save.

Calculate ABC Codes

You use the Calculate ABC Code process to automatically run stock valuation calculations, produce a report that
displays suggested ABC code assignments, and optionally assign ABC codes to part records in the warehouses
linked to selected sites. You normally run this process before you process cycle and physical inventory counts. If
you do not use cycle counting for inventory count processing, you do not need to run this process.

Because this program is a process, you can assign it to a
schedule. The process then runs automatically each time the
application launches the schedule. For more information, review
the Automatic Scheduling section in the Epicor ERP
Implementation Guide reference.

Menu Path: Material Management > Inventory Management > General Operations > Calculate ABC Codes

To run this process:
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1. Click the Historical Usage From drop-down list to find and select the date from which historical usage for
this part evaluates.

2. Select the Include Projected Usage check box to indicate whether estimated future usage of the part
should be included during the ABC code calculation.

3. If the Include Projected Usage check box is selected, the Projected Usage Through field activates. Select
the last date on which the estimated future use of the part is evaluated.

4. Select Include Current On-hand check box to indicate the value of the on-hand quantity for the part is
included in the Total Value when calculating the Stock Valuation Percentage. You define the Stock Valuation
Percent value on each ABC code within ABC Code Maintenance; for more information, review the previous
section.

5. Select the Update ABC Codes check box to indicate all ABC codes are refreshed within the database. If
you clear this check box, the ABC codes are still calculated, but they print on reports as proposed, instead
of final, values.

6. Select the Warehouse stock valuation % option to calculate the Stock Valuation Percent values against
the Total Value of the parts in the warehouse; this amount can include items like current usage, On-Hand
Quantity, and projected usage.7

7. Select the Site stock valuation % option to calculate the Stock Valuation Percent values against the
Total Value of the parts in the site; this amount can include items like usage, On-Hand Quantity, and
projected usage. You define this value on each ABC code within ABC Code Maintenance.

8. Use the Filter sheet to limit the process to only calculate ABC codes within a specific site.

9. When you are ready to run the process, click the Process button on the Standard toolbar. The report that
results is sorted first by site and then by warehouse. It displays the options you selected within the process
program.
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Initialize Last Cycle Count Date

You run the Initialize Last Cycle Count Date process to automatically define last cycle count dates for all parts
assigned to an ABC code. The process assigns dates to all parts which do not have a last cycle count date.

Use the process when you are first implementing the cycle count functionality. You first define the ABC code
hierarchy and then run the Calculate ABC Code process. You then run the Initialize Last Cycle Count Date process.

Menu Path: Material Management > Inventory Management > General Operations > Initialize Last Cycle Count
Date

To run this process:

1. Verify the Schedule drop-down list displays the Now option.

2. If you want, click the Filter tab to limit this process to only generate Last Cycle Count Date values for a
selected warehouse or warehouses.

3. When you are ready, click Process on the Standard toolbar.

Cycle Count Schedule Maintenance

Use Cycle Count Schedule Maintenance to both create and update cycle count schedules. This workflow includes
selecting the parts being cycle counted for a specific warehouse in a designated time period and year; the period
and year is based on the selected production calendar.

After specifying a cycle period, year, and production calendar, the program creates a default cycle schedule; the
default cycle count dates can then be modified as you need. The individual cycles within the master periodic
schedule are independent of each other, but multiple cycles can be conducted concurrently as necessary. After
you modify the generated cycle count schedule as you need, select the actual parts being counted by running
the Perform Part Selection option from the Actions menu.

Before using this program, you must define cycle periods in the Cycle Count Period Definition program, and
define count parameters at the part/warehouse, warehouse, part/Site, Site configuration, and ABC code levels.

Menu Path: Material Management > Inventory Management > General Operations > Cycle Count Schedule
Maintenance

Create New Cycle Count Schedule

To create a new schedule:
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1. Click New on the Standard toolbar.

2. Click the Warehouse drop-down list to define the specific warehouse you want to schedule. Warehouses
available within the current site display on this list.

3. Click the Year drop-down list to define the year during which this count schedule is run. This value must
be either the current or a future year.

4. Click the Cycle Period drop-down list to define the specific cycle period during which this cycle schedule
runs.

5. The first and last date for the selected cycle period display respectively in the Period Start and Period End
fields.

6. Click the Calendar button to find and select the production calendar you use with this cycle count schedule.

7. Select the Exclude On Hold check box to indicate any parts currently designated as on hold are not included
with the current cycle count schedule.

8. Select the Exclude Zero QOH check box to indicate parts with zero perpetual on-hand quantities in all bin
locations are not included with the current cycle count schedule.

9. Select the Exclude Negative QOH check box to indicate parts with a negative perpetual on-hand quantity
in all bin locations are not included with the current cycle count schedule.

10. Select the Exclude Parts Without Activity check box to indicate any parts which did not have activity since
the last cycle count are not included with the current cycle count schedule. This check box is available if the
Random Cycle Count Method is selected on either the warehouse or its site configuration.

11. Click Save.

Epicor ERP | 10.0.700194

Epicor ERP Application User Guide - Part TwoChapter 3 | Inventory Management



Create New Cycle

The Cycles sheet displays the count cycles created for the current period/year schedule. You can only change the
Cycle Date on this sheet; the other values are calculated and maintained by the application.

To create a new cycle for the current cycle count schedule:

1. Click the Down Arrow next to the New button; select New Cycle.

2. The Cycle Sequence field indicates the number of the cycle within the current schedule.

3. If you need, you can modify the Cycle Date. You can select any date within the current period and year of
the cycle schedule. Cycle Date values do not need to be sequential with previous cycles.

4. Use the ABC Qtys sheet to display the number of parts selected for each ABC code within the current
schedule.

5. Continue to add the cycles you need. When you finish, click Save on the Standard toolbar.

6. When you are ready to select parts for the current schedule, from the Actions menu, select Perform Part
Selection. The parts selected for the current cycle are included in this schedule. You can now generate tags
for these parts within Country Entry; this program is explored in a later section.

You should only run Perform Part Selection close to the
beginning of the month within the schedule. This ensures
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that the part selection is accurate. You must run this
process to display cycles within Cycle Count Maintenance.

Cycle Count Part Selection Update

You run the Cycle Count Part Selection Update process to add or remove parts from a specific cycle. You can
also move parts to a different cycle. If you remove all the parts from a cycle, the cycle itself is automatically
cancelled from the cycle schedule.

Notice you cannot run this process after the count tags are generated for the cycle.

Menu Path: Material Management > Inventory Management > General Operations > Cycle Count Part Selection
Update

To update parts within a count cycle:
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1. Click the Cycle button to find and select the cycle you want to update.

2. The Warehouse, Cycle Period, Cycle Number, and other fields display information about the selected
cycle.

3. The Parts Selected grid displays all the current parts included within this cycle record.

4. To add a part to this grid, click New on the Standard toolbar. A new row displays in the Part Selected grid;
use this row to select the part you want to add.

5. To select an individual part within this grid, choose its Selected check box.

6. If you want to delete the Selected parts from the grid, click the Remove Selected button.

7. You can select all of the parts on this grid by clicking the Select All button.

8. To clear all of the Selected check boxes on the grid, click the Deselect All button.

9. To move the selected parts into a different count cycle, click the Move Selected button.

10. The Cycle Part Selection Move Part window displays.
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11. All the current cycles display within the Cycles grid.

12. Highlight the cycle into which you want to move the selected parts.

13. Click OK.

14. The selected parts are moved into the selected cycle. When you return to the Cycle Count Part Selection
Update window, the selected parts no longer display in the Parts Selected grid.

15. Continue to make the changes you need. When you finish, click Save on the Standard toolbar.

Initialize Physical Inventory

Run the Initialize Physical Inventory process to select parts for a physical inventory count. You can run this program
for all warehouses or selected warehouses. After the process generates, each warehouse you select has its own
warehouse count control record. This record is defined as being for physical inventory and all the parts stocked
in the warehouse are assigned to it. Each record also has a single “cycle” scheduled from the Start Date you
entered for the process.

Before you run this process, be sure to generate the Cycle Count Schedule report. Generate this report for all
warehouses to determine which warehouses have cycle count processes you need to close. It is recommended
you close all cycle count processes before you initialize physical inventory for all the warehouses at once.

Menu Path: Material Management > Inventory Management > General Operations > Initialize Physical Inventory

To run this process:
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1. Select the Start Date you want for this process. Each warehouse record you generate is scheduled from
this Start Date value.

2. Select the Include Zero QOH check box to indicate you want to include parts which currently have a zero
Quantity On-Hand value. These parts are added to the warehouse count control record.

3. Click the Filter tab to select one warehouse or a range of warehouses.

4. When you are ready, click Submit on the Standard toolbar.

Count Cycle Maintenance

You use Count Cycle Maintenance to process both count cycles and physical inventory cycles.

Menu Path: Material Management > Inventory Management > General Operations > Count Cycle Maintenance

To use this program:

1. Click the Cycle button to find and select the count cycles or physical inventory cycles you need.

2. Information about the selected cycle displays. The Warehouse field indicates the specific warehouse inside
which the count is to be done.

3. The Year and Cycle Period fields indicate the period/year for the current cycle record.
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4. The Cycle Number field displays the number identifier for the cycle.

5. The Cycle Date field displays the current date. This value indicates the day during which the cycle is run.

6. The Cycle Status field indicates whether the cycle is scheduled.

Count Cycle Maintenance Actions Menu

Once the cycles are created and the parts are assigned to each cycle, use this program to generate tags, print
tags, void tags, and other tag functions.

1. You are now ready to run the tag functionality. To do this, click the Actions menu.

2. Select Generate Tags to create the count tags for a specific cycle within a warehouse. This program
generates the tag numbers for all parts assigned to the cycle. Before you can run this program, either the
Part Selection Process (found within Cycle Count Schedule Maintenance) or the Initialize Physical
Inventory process must be run.

3. Select Print Tags to print copies of the generated tags. The tags are printed in tag order number. When
the tags are printed, this window saves these default settings. They cannot be updated, so if you need to
reprint the tags, the original settings are used again.

4. Run Reprint Tags to reprint all or some selected tags which were previously printed. You can filter the tags
to reprint by sheet or by tag numbers.

5. Select Void Tags by Part to void cycle count tags for a specific part. The process voids all tags for the
selected part and indicates the part is voided for this cycle. It then moves the part to the next scheduled
cycle for the warehouse. This option is not available for a physical inventory cycle.

6. Choose Void Blank Tags to void all unused, blank cycle tags or specific blank cycle count tags. Only blank
tags that have an Open status or are assigned to a part, but not completed or posted, can be voided.

7. When you select Start Count Sequence, you freeze the pre-count inventory quantities and in preparation
for the physical count. You must generate the tags for this cycle before you run this process. This program
sets the count status to Started and records the date/time.
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8. Launch Reverse Start Count to undo a start count sequence you generated. As long as the cycle count
status has not progressed beyond Started, you can use this command. It clears the frozen quantity and cost
values from the tag records and resets the cycle status back to Tags Generated.

9. Select Print Unreturned/Voided Tags Report to generate a tag report. Any current unreturned and voided
tags display on this report.

10. Run Count Variance Calculation/Report to generate this variance report. This report displays variances
between the frozen On-Hand Quantity and the quantity counted for items within a specific count cycle.

11. Select Generate Recount Tags to create new tags for parts selected as out of tolerance by the Count
Variance Calculation report.

12. Run Print Count Parts Not Posted Report to generate this count report. This report displays any parts for
a specific cycle which are not complete yet. It also identifies the possible reason so the user can correct the
problem and post the count results.

13. Select Post Counts to record the count adjustments to inventory. The parts included in the post process
are defined as complete for the cycle. The transaction date defaults to the current date. A part is ready for
posting when all of its open tags have count data, it is processed by the variance report, and the final count
of the part is either within tolerance or a Cycle Discrepancy Reason (CDR) is entered for the part. You
review CDRs later in this chapter.

14. Select Print Inventory Movement to print a report of inventory movements.

15. Select Cancel Cycle to cancel and close a physical inventory or cycle count sequence if tags have been
generated but not posted.

Count Tag Entry

Use Count Tag Entry to record the results of the cycle or physical inventory count. To begin, you first select the
cycle you want to use for count entry. Only cycles that have started their count sequences are available, and you
can only select tags open for the selected cycle.

Menu Path: Material Management > Inventory Management > General Operations > Count Tag Entry

To enter count tag results:
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1. Click the Cycle button to find and select the cycle you need.

2. Information about the selected cycle displays in the Warehouse, Cycle Period, Year, and other related
fields.

3. Click the Tag button to find and select the specific tag against which you are entering the count results.

4. You can also use the Navigation toolbar to move through all the available cycles.

5. Information about the Part, the Bin, and the Unit of Measure displays.

6. If the part is lot tracked, its Lot Number displays in this field.

7. If the part is serial tracked, its number displays within the Serial Number field.

8. In the Counted Qty field, enter the quantity which was counted.

9. Select the Returned check box to indicate this quantity was returned to inventory from another source, like
the shop floor or a returned shipment.

10. If you need, click the UOM Worksheet button to select a different unit of measure for the part quantity.
Only valid UOMs can be selected and saved to the count tag.

11. In the Counted By field, enter the initials of the person who counted the part quantity.

12. Enter the Counted Date and the Counted Time in their respective fields.

13. In the Note field, enter any additional information you want saved with the count tag.

14. The Activity grid displays the part quantity changes which occurred during the count cycle.
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15. The Activity Before Count field display the part quantity total before the count cycle began.

16. The Related Tags grid displays any tags generated for the same part.

17. Continue to update the count tags you need. When you finish, click Save on the Standard toolbar.

Count Discrepancy Reason Code Entry

Use Count Discrepancy Reason Code Entry to enter the count discrepancy codes for parts which have count
variances. Any inventory adjustments for parts out of tolerance are not posted until a count discrepancy reason
(CDR) is defined within this program.

Menu Path: Material Management > Inventory Management > General Operations > Count Discrepancy Reason

To enter a CDR:

1. Click the Cycle button.

2. Information about the selected cycle displays in the Warehouse, the Cycle Period, the Year, and other
fields. You cannot edit this information.

3. The Parts Selected grid displays all the parts included in the cycle count. Scroll through the rows on this
grid until you find one that has its Reason Code field activated. This part quantity has a count discrepancy.

4. Click the drop-down list to select the Reason Code which explains the discrepancy.

5. Continue to define reason codes for other parts which have a discrepancy. When you finish, click Save on
the Standard toolbar.

You create reason codes within Reason Code
Maintenance. You indicate which reason codes are count
discrepancy reasons by selecting the CDR check box on
the new Reason Code record.
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Cycle Count Tracker

Use the Cycle Count Tracker to view information related to scheduled cycle count or physical inventory count
sequences. Many of the sheets available in the Cycle Count Tracker are read-only versions of sheets that display
in Cycle Count Schedule Maintenance.

Menu Path: Material Management > Inventory Management > General Operations > Cycle Count Tracker

To use this tracker:

1. Click the Schedule button to find and select the schedule you want to review.

2. The Warehouse field displays the warehouse for which the count is scheduled.

3. The Year and the Cycle Period fields indicate when the count is scheduled to be carried out.

4. The Period Start and the Period End fields define the days on which the count is active.

5. The Calendar field displays the production calendar used for the schedule.

6. The Exclude check boxes indicate which parts are not included in the count.

7. If the Full Physical check box is selected, this indicates the count is for a physical inventory count sequence.

8. If the Parts Selected check box is selected, this indicates the part selection process is run against the current
cycle count sequence.
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9. The ABC Qtys sheet displays the number of parts selected for a cycle count. Physical inventory counts do
not display on this sheet because they include all parts in a warehouse, not just parts assigned to an ABC
code.

10. The Cycles sheet displays more detailed information about the cycle counts and physical inventory counts
scheduled for the current period.
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11. The Parts sheet displays cycle count information on each part for a currently selected cycle count.

12. The Tags sheet displays tag information for a currently selected cycle and part.
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Reports

This section describes some key inventory reports you use to monitor inventory quantities. You can run these
reports whenever you need. You can also set up each report to generate and print through a recurring, automatic
schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information
on how you link a report to a recurring schedule.

Stock Status Report

The Stock Status Report produces a list of the current quantities and extended costs of all parts in the part master
file.

Menu Path: Material Management > Inventory Management > Reports > Stock Status

To generate this report:

1. Use the Selection sheet to choose the specific parameters for this report.

2. Use the Filter Summary section to filter the report by Warehouse and/or Part Class.
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3. Click Print on the Standard toolbar to run the report.

Material Transaction Detail

The Material Transaction Detail Report produces a list of all inventory transactions created through receipt, issue,
shipping, and adjustment processing.

This report includes corresponding legal numbers for part
transactions. The legal number is a tracking number required
by some countries.

Menu Path: Material Management > Inventory Management > Reports > Material Transaction Detail

To generate this report:

1. Use the Selection sheet to choose the specific parameters for this report.
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2. Use the Filter Summary section to filter the report by Part, Warehouse, and/or Transaction Type.

3. Click Print on the Standard toolbar to run the report.

Part Cycle Count Status Report

The Part Cycle Count Status report either lists parts overdue for their cycle count or parts not counted since a
user-specified date. This report is especially useful if you use the Random method for cycle counting. Use it to
decide whether to add or delete parts which were selected through the Cycle Count Part Selection Process.

Menu Path: Material Management > Inventory Management > Reports > Part Cycle Count Status

To generate this report:

1. Use the Due Date On or Before field to select the main date for the report. This date defines the cutoff
date for the report; all parts overdue or not counted by this date are included on this report.

2. Select the Overdue Parts Only check box to limit this report to only display parts which are overdue. Parts
which are not yet counted do not display on this report.

3. Use the Filter sheet to limit this report to only display parts for specific warehouses and/or ABC codes.

4. Click Print on the Standard toolbar to run the report.

Time Phased Material Requirements Report

The Time Phased Material Requirements report pulls together data from purchase orders, sales orders, and
inventory records to project future inventory balances. The report analyzes planned receipts and requirements
for each selected part class and then provides the results.

Menu Path: Material Management > Inventory Management > Reports > Time Phased Mtl. Requirements

Within the Report Options section, select the job details that you want to include on the report. Available options:

209Epicor ERP | 10.0.700

Inventory Management | Chapter 3Epicor ERP Application User Guide - Part Two



1. Part Types – Select the types of parts you want to review.  You can print Purchased parts,Manufactured
parts , or Both purchased and manufactured parts.

2. Stock Types – Select the types of stock items you want to review. You can display Stocked items,
Non-Stocked items, or Both stocked and non-stocked items.

3. Ignore If not needed by – This date field is available when you select the Exceptions Only check box.
Any parts with a Suggested Order Date on or before the date you enter here do not display on this report.

4. Exceptions Only – Select this check box to only display parts whose inventory quantities are either above
or below defined quantity levels. This option activates the other exception options on this sheet.

5. Below Reorder – Select this check box to indicate parts whose projected on-hand quantity is below the
suggested reorder quantity print on the report.

6. Below Minimum – Select this check box to indicate parts whose projected on-hand quantity falls below
their Minimum Quantity values print on the report. You define this value through Part Maintenance.

7. Below Safety – Select this check box to indicate parts whose on-hand quantity falls below their Safety values
print on the report. You define these values through Part Maintenance.

8. Below Zero – Select this check box to indicate parts whose on-hand quantity is projected to fall below zero
print on the report.

9. Over Maximum – Select this check box to indicate parts whose on-hand quantity is projected to become
higher than their Maximum Quantity values print on the report. You define this value through Part
Maintenance.

10. Suggestions have impact on balance – Select this check box to indicate purchasing and manufacturing
suggestions print on the report.

11. Filter Tabs – Use the filters to select which part classes print on the report. You can also limit the results to
only display project balances up to a specific date.
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12. When you are ready to run this report, click Print on the Standard toolbar.
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Chapter 4: Shipping and Receiving

You use the shipping and receiving processes to record incoming and outgoing part quantities. The Shipping and
Receiving module contains programs that perform transactions such as shipments against a sales order, subcontract
parts sent to a supplier, raw material received from a purchase order, received to a job, received into inventory, or
inventory parts that fill a sales order from stock.

You can ship parts from a job or from inventory. You can optionally ship part quantities using either base legal numbers
or modify these numbers to generate Serial Shipment Container Codes (SSCC). When you set up the format you want
for either legal numbers or SSCC numbers, these values automatically generate on your shipments. Use these numbers
to track the progress of your shipped items.

This module also contains functionality to combine shipments from one or more suppliers that can be shipped in one
or more containers. For your subcontract workflow, you can ship WIP parts directly from a job to a subcontract supplier.
Later, you use Receipt Entry to enter the receipt of all inventory materials, non-inventory materials, and subcontract
parts.

Various pack out methods are available. Standard Pack Out is a method of shipping that uses a barcode scanner to
record and track the packing flow. Use Master Pack Shipment Entry to combine separate pack IDs (master packs) into
one master pack group to ship as one shipment. Phantom pack out functionality is available when you are using a
manifest interface and provides the ability to generate multiple carrier labels for a single pack ID.  

To complete this functionality, you can use the Data Collection module to process different transactions in the application
by entering and updating records through a handheld device.  

Setup

This section describes the primary records you need to create for the Shipping and Receiving module. These
programs are contained within the Setup folder for this module; only the primary records are described here.
Some areas within the next Operations section may also document setup records if they are required for a specific
workflow.  

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration. You can also review the
Company Configuration chapter in the Epicor ERP Implementation Guide.

Carrier Codes

Use Carrier Maintenance to set up the standard freight carriers your company uses. Once you have entered the
carriers used by your company, you can link these carriers to Ship Via codes on both customer and sales order
records. On each carrier code, you can also identify a Standard Alpha Carrier Code (SCAC). These codes identify
transportation companies.

Menu Path: Material Management > Shipping / Receiving > Setup > Carrier

To add a carrier code:
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1. Click New on the Standard toolbar.

2. In the Carrier field, enter the Carrier ID.

3. In the Description field, enter a description for the carrier.

4. In the SCAC field, enter the Standard Alpha Carrier Code (SCAC). The SCAC is a unique code, typically two
to four alphabetic letters used to identify transportation companies. These codes were developed by the
National Motor Freight Traffic Association to help the transportation industry computerize data and records.

5. Select the Active check box.  

6. Click Save.

Ship Via

Use Ship Via Maintenance to identify the different methods you use to ship products to subcontractors or
customers. These shipping methods are called Ship Via Codes and are mandatory when you enter a sales order.

Menu Path: Material Management > Shipping / Receiving > Setup > Ship Via

To add a ship via:

1. Click the New button on the Standard toolbar.

2. Enter a unique Code for the Ship Via.
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3. Enter a Description for this shipping method. You use the description to select a shipping method on
orders, packing slips, and invoices. The description also prints on various documents, such as packing slips.

4. Optionally, enter the Web Description. This value is the text for the ship via method that displays in Customer
Connect.

5. If you need, enter an SCAC code. This value defaults from the Carrier Code, but can be changed on the
Ship Via record.

6. Optionally, select the Carrier you want from the drop-down list.

7. You can define one Ship Via code as the System Default. Select this check box to indicate the current
shipping method is the default ship via for the company.

8. Enter the Intrastat Code for this method of transportation. When you post an invoice, the Intrastat ship
via code you enter in this field is included in the transaction details.

9. Optionally, enter the Tracking Website information.

10. When you finish, click Save.

Packaging Codes

Use Packaging Code Maintenance to set up packing methods for shipments. These methods define the dimensions
of an item you will ship. You can also use these codes to identify a unique Extension Digit for Serial Shipment
Container Codes (SSCC) generation. Extension Digits identify the type of package shipped. A default extension
digit can be generated by the SSCC code, but you can define a more specific extension digit value that matches
the package type through this maintenance program.

Menu Path: Material Management > Shipping / Receiving > Setup > Packaging Code

To add a packaging code:

1. Click the New button on the Standard toolbar.

2. Enter a Packaging Code and Description.
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3. Select the appropriate Unit of Measure (UOM) code for the package type.

4. Define the Length, Width and Height for the package.

5. Enter the Extension Digit for the package type. This value overrides the default value generated by the
SSCC code and is used as the first digit of the SSCC code when you ship this package type. In this example,
the Extension Digit for Pallet is 0.

6. Click Save.

Supplier Shipment Classes

Use Supplier Shipment Class Maintenance to set up the characteristics of common containers you use to ship.
This includes volume and default cost information. You can then use the shipment container class when you add
container shipments.

Menu Path: Material Management > Shipping / Receiving > Setup > Supplier Shipment Class

1. Click the New button on the Standard toolbar.

2. Enter a Shipment Class.

3. Enter a Description.

4. Use the Loading Port to specify the port where the goods are loaded on the vessel. Use the Country
Maintenance program to create a new location; for more information, review application help.

5. The Discharge Port specifies the first location where the goods are unloaded.

6. Select the appropriate Ship Via and FOB for the shipment class.

7. In the Shipping Days field, enter the number of days it takes for the goods to arrive at its destination.
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8. Enter the Carrier and Contact information.

9. Enter the Uplift percent. The value entered here specifies the percentage added to the shipment upon
receipt, as part of landed costs.

10. Optionally, enter the Volume and Weight of the container.

11. If you wish, enter the Number of Containers and the Number of Packages in the shipment. These fields
are for informational purposes only.

12. Click Save.

Work Station Maintenance

Use Work Station Maintenance to set up work stations. These work stations are also called packing stations and
these records establish the scale and manifest interface for each pack station.

Menu Path: Material Management > Shipping / Receiving > Setup > Workstation

1. In the Station ID field, enter a unique identifier for this work station.

2. In the Station Type field, select Pack.

3. Enter a Description for the work station.

4. Select the Warehouse and Bin where the work station is located.

5. Select the Weight Input option to specify how you want the weight determined. Available options:

• Prompt for Weight

• Get Weight from Part Configuration

• Get Weight from Scale

6. In the Manifest section, select the Enabled check box. This value is required in order to use the Tracking
Details fields for phantom packs in Customer Shipment Entry.
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7. In the Web Service URL field, enter the web site for the Pack Out manifest information. In this example,
no manifest system is available for connection, so the Web Service URL is set to http://localhost.

8. The Manifest/Weight Capture Point specifies the basis by which the weight is acquired. Available options:

• Pack

• Master Pack

9. Specify the Weight and Size Units of Measure (UOM). These fields are used as the default UOM for the
manifest weight and size.

10. If the work station is connected to a printer or a scale, you can configure these connections on the
Devices sheet.

11. Click Save.

Operations

This section details the operations available in the Shipping and Receiving module. Each operation is described
as a workflow to help guide you through the process from start to finish. These programs are primarily found
within the General Operations folder for this module. If a unique setup record is required to run the operation,
this record is also described in this section.

Ship Items to Customers

You can ship parts from a job or from inventory. When shipping from inventory, you first run the Scheduled
Shipments report to determine what shipments are scheduled for today’s date. Once you know the shipments
to process, use the Sales Order Pick List and complete the shipment.

Scheduled Shipments Report

The Scheduled Shipments Report lists all the outstanding order releases. It displays them in order by Due Date,
Order Number, Order Line, and Order Release.

Menu Path: Material Management > Shipping / Receiving > Reports > Scheduled Shipments
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1. Select the appropriate parameters for the report you wish to review or print. Report options include a Due
On or Before date and an option to Include Site to Site Shipments.

2. The Dynamic check box is used in conjunction with the Due On or Before field. When this check box is
selected, you select an option from the Due On or Before drop-down list rather than defining a specific
date. This option dynamically changes the date printed on the report.

For example, if the Today option is selected in the Due On or Before field, the date is replaced each time
the report prints with today’s date.

Additional scheduling options for all reports are available
in the application. These options enable you to establish
a dynamic recurring schedule when running a specific
report. For example, list outstanding order releases every
Monday. You can review this feature in the Automatic
Data Processing chapter of the Epicor ERP Implementation
Guide.

3. You can optionally limit the report results. By default, all records are included unless you define a specific
range of records to display on the Filter sheet. These fields indicate whether all or just some customers and
parts print on the report.

4. Click Print on the Standard toolbar.
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Sales Order Pick List Report

Once you have verified the parts are available to ship, use the Sales Order Pick List to assist with the picking and
packing process.

Menu Path: Material Management > Shipping / Receiving > Reports > Sales Order Pick List

1. Select the appropriate parameters for the report you wish to review or print. Use the From and To fields to
define a date range for the pick list.

2. Select the New Page Per Order check box to cause the report to print separate orders on different pages.

3. Select the Print Barcodes check box to display barcodes on the pick list.

4. Select the Print Kit Components check box to display sales kit component parts on the pick list.

To learn more about Sales Kits, review the Sales Order
Processing chapter.

5. Set a filter to indicate the records to include on the report. Filters are available for orders and parts on the
Filter sheet.

6. Click Print on the Standard toolbar.

Inquiries in the application are available that display a
part’s on-hand quantity and availability. These inquiry
programs, called Trackers or Dashboards, are reviewed in
the Epicor Environment chapter.

Ship Parts to a Customer

Once the parts have been picked, you use Customer Shipment Entry to enter customer shipments and update
sales orders. You can ship parts from inventory or directly from a job.
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To do this, you create pack records. A pack record can contain one or more detail lines that define the shipping
quantities sent out with each pack record. Because of this, you can ship multiple orders for the same customer
or ship-to location through the same pack record. When the pack record is ready to ship, it goes to a Staging
Area where users group the items into logical shipment stages. As each stage is shipped, the user confirms the
shipment was sent.

You receive warning messages if you attempt to enter
shipments for customers that are on credit hold. For additional
information on customer credit checking, refer to
the Customers and Accounts Receivable chapter.

Menu Path: Material Management > Shipping / Receiving > General Operations > Customer Shipment Entry

To create a new customer shipment:

1. Click the New button on the Standard toolbar.
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2. Select the Header > Detail sheet. From the Ship Via   drop-down list, select how this pack record is shipped
to the customer. In the Ship Date field, enter the date on which this pack record is shipped. By default, the
current date displays.

3. You are now ready to add detail lines to the pack record. Click the Down Arrow next to the New button;
select New Line.

4. The Lines > Customer Shipment Entry > Detail sheet displays. Enter the Order Number that you are
shipping. You can also search for sales orders by clicking on the Order Number button.
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If you are shipping the parts from a job, enter the Job
Number. You can enter a job number instead of a sales
order number. If you do not know the job number, click
the Job Number button to access the Job Search window
and browse for the desired job.

5. Click the Line/Rel button to search for the line to ship.

6. If you are shipping From Inventory, enter the quantity to ship in Our Ship Qty field.

7. The Warehouse defaults to the primary warehouse, but this value can be changed if necessary. Enter the
Bin from which you are picking the items.

8. If you are shipping From Manufacturing, enter the quantity to ship within the Our Job Ship Quantity
field.

9. Within the Job field, enter or find and select the specific job that is manufacturing the ship quantity.

10. If you need, define the Warehouse and the Bin that receives the manufactured items.

11. Notice if you have satisfied the detail line’s order quantity, the Shipped Complete check box is automatically
selected.

12. If you are shipping a sales kit and you can ship individual component parts from it, click the Sales Kit
Component Issue tab. Use this sheet to select the specific compound parts and quantities that you ship
with this pack record.

13. If your company ships to a distribution center instead of directly to a customer, you need to specify the final
destination of the order. To do this, click the Mark For tab and define the Mark For Customer and Ship
To Address. You can also enter One Time Mark For information, if needed. This information defaults from
the sales order, but you can override these values on each customer shipment.

You can only ship component parts if the Must Ship Kit
Complete check box is clear on the parent part record.
To learn more about this check box, review the Parent
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Part - Sales Parameters section within the Sales Order
Processing chapter.

14. If you have the Package Management license enabled, you have the ability to use the Pack Out sheet.
Use this sheet to select multiple lines from different sales orders and then package them together onto a
single pack record. The Pack Out functionality is discussed later in this chapter.
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15. Select the Summary sheet to review the pack record. Notice the customer listed on the selected order
displays within the Ship To and Sold To fields. In the Stage drop-down list, you can enter a new staging
area, or select an existing stage for this pack record.

16. Review the detail lines within the Shipment Lines grid.

17. To load the outstanding quantity from the order release into the pack record’s detail lines, click the Ship
All button.

When selected on the Lines > Customer Shipment Entry
> Detail sheet, the Shipped Complete check box indicates
that all outstanding quantities on the order release is
fulfilled. The pack record is only considered fully shipped,
however, when the Shipped check box is selected on the
Header sheet.

18. Click the Actions menu, and select Print to print the packaging slips that will accompany the shipment.

19. To complete the shipping transaction, click Save.

Serial Shipment Container Codes

You can ship customer shipments and master packs using Serial Shipment Container Codes (SSCC). You use
these codes to both improve the speed and reduce the costs of shipments.

Users can then scan and process products rapidly through distribution centers and other receiving locations. The
SSCC code identifies specific information about cartons, pallets, trailers, or other containers and electronically
exchanges information about the current state of a shipment. You can track these shipments throughout your
supply chain flow using the SSCC code assigned to the shipment. This data exchange and tracking process is an
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application of the GS1 System (originally called the EAN.UCC System). You use this application to optionally
define customer and package type specific SSCC codes.

The primary reason you use SSCC codes is to speed your
products through the shipping and receiving process. The
Electronic Data Interchange (EDI) Advance Ship Notice (ASN)
can be used with SSCC codes.

The graphic below shows the basic structure of the SSCC code and where you define the segments in the
application.

• Extension Digit = This value is the default Extension Digit defined in Legal Number Maintenance. It is the
first character of the SSCC code. As described previously, this value is also defined in packaging codes; these
values override the default value assigned on the legal number.

• UCC/EAN Company Prefix = Contains the default Prefix value defined in Legal Number Maintenance. This
value identifies your company.

• Serial Reference Number = This value is the Start Sequence/End Sequence defined in Legal Number
Maintenance. These values define the specific number for the shipment.

• Check Digit = This value is calculated by the application to confirm the number generated is correct.

You first define the Document Types you wish to assign to legal numbers. You next set up the legal numbers
you need to generate the SSCC codes during shipment processing. You can use these codes on packing slips
and master packs.

Document Types

Use Transaction Document Type Maintenance to define the document types assigned to legal numbers. A
document type links a system transaction to a unique legal number that generates when the transaction prints.
When you use SSCC codes, you need to set up a document type for packing slips or master packs, and then link
them to legal numbers.

Menu Path: Financial Management > General Ledger > Setup > Transaction Document Type

1. Click the New button on the Standard toolbar.

2. Enter a Document Type code.
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3. Enter a Description.

4. Select the appropriate System Transaction from the drop-down list. In this example, you select Packing
Slips.

5. If you want this transaction type to be the system default, select the Default for System Transaction
check box. This transaction type then defaults on all transactions, but you can change this value if you need.

6. Click Save.

Legal Numbers

Legal numbers can be a base tracking value you attach to a shipment. They can also be set up to generate unique
SSCC codes. Your shipments must either use the base legal number or the generated SSCC codes. Use Legal
Number Maintenance to set up legal numbers for packing slips or master packs. If you wish, you can then leverage
this program to define the structure and number of digits your company uses for SSCC. When you finish defining
the legal numbers and add these SSCC generation parameters, you then apply these codes in the Shipping /
Receiving module.

You cannot switch a shipment to use an SSCC code later. If a
shipment starts using a legal number, it uses this number during
the life of the shipment.

Menu Path: Financial Management > General Ledger > Setup > Legal Number

To enter a legal number:

1. Click the Down arrow next to the New button;  select New Legal Number.
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2. Enter a Legal Number code.

3. Enter a Description for the code.

4. Select the appropriate Number Type for the SSCC code. Valid options for SSCC are Packing Slips and
Master Pack. In this example, Packing Slips is selected.

5. Select the Generate SSCC check box. This indicates you wish to use SSCC codes with this legal number.
When selected, the Default Prefix field becomes available.

6. Enter the Default Prefix for the code generation. Use this field to enter your company’s assigned GS1 or
UCC prefix. The SSCC Company Prefix is an eight digit code used as part of the generated SSCC code.

7. If you want the SSCC code to appear on the invoice after it is created, select the Display Number After
Generation check box.

8. Enter the Extension Digit. This single digit acts as the first character of the SSCC code and can also be
used to identify the type of package shipped in Packaging Code Maintenance. If a packing code uses a
different extension digit, however, this default value is overridden. For details, review the previous Packaging
Codes section.

You can also create and assign customer specific SSCC
codes. To do this, you create a unique legal number and
document type for packing slips or master packs and then
assign to a specific customer in Customer Maintenance.
For more information on Customer Maintenance, read
the Customers and Accounts Receivable chapter.
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9. Now define the serial reference start and end sequence. Click the Down Arrow next to the New button;
select New Default Sequence.

10. Enter the Start Sequence and End Sequence numbers. The application uses these numbers to generate
the serial number portion of the SSCC code.
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11. You now must link the document type you previously created to the legal number. Click the Document
Type tab.

12. Select the appropriate Document Type from the Available Document Type list.

13. Click the Right Arrow button to move the document type to the Assigned Document Type list.

14. Click Save on the Standard toolbar.

Customer Shipment with SSCC Generation

Now that you have set up a legal number to generate SSCC codes, you can begin using them on shipments. You
generate unique SSCC codes for shipments within Customer Shipment Entry.

Menu Path: Material Management > Shipping / Receiving > General Operations > Customer Shipment Entry
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1. Click the Down Arrow next to the New button; select New Pack.

2. From the Document Type drop-down list, select the type linked to the SSCC legal number. In this example,
you select Packing Slip.

3. Select the Header > Detail sheet. From the Ship Via drop-down list, select how this pack record is shipped
to the customer.

4. In the Ship Date field, enter the date on which this pack record is shipped. By default, the current date
displays.
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5. Select Pallet (PLT) in the Packaging Type field.

6. You are now ready to add detail lines to the pack record. Click the Down Arrow next to the New button;
select New Line.

7. The Lines > Customer Shipment Entry > Detail sheet displays. Enter the Order Number for the sales
order you are shipping.

8. Enter the sales order line and release number you are shipping in the Line/Rel field.

9. Click Save.

10. Select the Summary sheet.
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11. Now you are ready to generate an SSCC code. Click the Actions menu. Highlight the Legal Number
submenu and select Assign Legal Number.

12. A message displays with the SSCC code generated for this shipment. Click OK.

13. Notice the Legal Number field also displays the assigned SSCC code.

Combine Shipments

Use Container Landed Cost Entry to combine shipments of one or more suppliers. The combined shipment may
then be shipped into one or more containers. Landed costs (duties, indirect costs, and uplift percentages) are
defined for each shipment and applied to the part unit cost when received.

Menu Path: Material Management > Shipping / Receiving > General Operations > Container Landed Cost Entry

To create a combined shipment using landed costs:
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1. Click the Down Arrow next to the New button; select New Shipment.

2. A Shipment ID number displays on the Header > Detail sheet.

3. Enter your shipment information, including the Description.

4. Enter the Shipment Class.

5. Enter your Volume and Weight unit of measures.
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6. Use the Indirect Costs sheet to apply any miscellaneous charges or credits to the shipment, if necessary.

7. Click the Down Arrow next to the New button;  select New Shipment Line for each shipment you wish
to combine.

8. Search for or enter a Purchase Order and select the Lines you wish to combine into the shipment.
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9. Enter additional line detail information, including the Volume and Weight unit of measure.

10. Continue to use the Actions menu to add shipment lines for each purchase order release you wish to include
on the shipment.
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11. When you finish, navigate to the Landed Costs sheet to enter landed cost information for the shipment.
Landed costs - including duties, indirect costs, and uplift costs - can be defined for each shipment and are
applied to the part unit cost when the shipment is received.

12. Select a Disburse Method, including indirect cost method, quantity, value, volume, weight, and manual.

13. After entering your values, click the Disburse button.
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14. Navigate to the Header > Detail sheet.

15. Click the Status drop-down list and select Shipped.

16. Click Save on the Standard toolbar.

Ship Subcontract Items from a Job

Use Subcontractor Shipment Entry to ship WIP parts directly from a job to a subcontract supplier. For example,
you send out parts to be painted by your supplier.

Menu Path: Material Management > Shipping / Receiving > General Operations > Subcontractor Shipment
Entry

To enter subcontract shipment:
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1. Click New on the Standard toolbar.

2. Enter or search for the Supplier ID to whom you are shipping the materials.

3. Select a Ship Via code.

4. Select the Lines sheet.

5. Click the Down Arrow next to the New button;  select New Line.

6. Enter the Job number and the Asm/Opr (assembly and operation) from which the subcontract WIP parts
are shipped.

7. Click Save.
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8. To print the packing label or packing list, click the Actions menu and select Close.

9. Now click the Actions menu again and select Print.

10. Select the Pack List check box.

11. Click OK.
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12. Enter your report details and based on your desired results.

You can also process miscellaneous shipments with
Miscellaneous Shipment Entry. Users can ship non-billable
parts to customers through this process; inventory
transactions for the shipment are not created.

13. Click Print, Print Preview or Generate Only.

Miscellaneous Shipment

Use Miscellaneous Shipment Entry to process shipments for miscellaneous (non-billable) material. You can also
use this program to enter and print packs for the return of discrepant parts to a supplier from a Discrepant
Material Report (DMR) record. For more information on the Discrepant Material Report, review the Quality
Assurance chapter.

Menu Path: Material Management > Shipping / Receiving > General Operations > Miscellaneous Shipment
Entry

1. Click the New button on the Standard toolbar. The Pack ID will remain zero until you first save the record.
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2. Enter the Name of the customer to whom the shipment is being sent. You can enter this name directly, or
click Name to access the Ship To Search window and browse for a customer ship to or supplier purchase
point to whom the shipment is sent.

3. Enter the Address, City, State, Postal Code, and Country for the shipment.

4. Select the appropriate Ship Via.

5. Select the package Type and Classification for the shipment.

6. Click Save.

7. The Pack ID is assigned.

8. Click the Down Arrow next to the New button; select New Line.
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9. On the Lines > Detail sheet, enter the Part for this miscellaneous shipment line. This part does not have
to be from the Part master table. In this example, the part number is not from the part master file.

If a part number from the Part master is entered, it will
not be invoiced, the entered line quantity will not be
relieved from inventory, and a Part transaction record will
not be created.

10. Enter a Description for the part number.

11. Enter the Quantity for the shipment line.

12. Click Save.

13. Click the Actions menu and select Print to print the Packing Label and Pick List.

14. To close the shipment, click the Actions menu and select Close.

Standard Pack Out

Pack Out is a method of shipping that optionally uses a barcode scanner to record and track the packing flow.
An example of a standard pack out system is a typical grocery store checkout process, where items are scanned
during the purchase phase and then moved down the conveyor into the bagging area. This methodology provides
a fast and accurate system of tracking carton contents when using a bar code scanner or hand-held scanning
device.
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During the following example, you will ship a sales order using standard pack out functionality. In addition to
the Standard Pack Out, you can also process a Master Pack Shipment and a Phantom Pack Shipment. You use
the Master Pack to combine separate pack IDs into one master package group shipped as one shipment. A
Phantom Pack is a pack whose contents are not defined at the part level; for example, the ID, weight, and recipient
for a case are important, but the contents are unimportant.

You use the Customer Shipment Entry > Pack Out sheet to create, pack, and unpack Pack IDs using a bar code
scanner. The fields are automatically enabled and disabled, so you can easily scan data in the fields and only
minimally use your mouse.

Before you process a pack out shipment, you must first create a sales order. Review the Sales Order Processing
chapter for information on using Sales Order Entry.

Menu Path: Material Management > Shipping / Receiving > General Operations > Customer Shipment Entry

1. Select the PackOut sheet.

2. Click the New button.

3. Enter or scan the Order Number for which you want to ship.

4. Select the Packaging Type for the shipment.

5. In the Part field, enter or scan in the part number for the shipment. In this example, part DCD-300-OR is
entered.

6. Notice the Match Found icon displays. Enter the shipment quantity in the Qty field.
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7. To print the packing list and shipping labels, click the Actions menu and select Print.

8. When you complete the shipment, click the Actions menu and select Close.
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9. Click Save on the Standard toolbar.

Master Pack Out

The Master Pack Out workflow contains functionality you leverage to combine several shipments into one large
shipment. These large shipments are called master packs. Utilize this functionality to improve the efficiency of
your shipments, as you both reduce the number of shipments and organize how part quantities reach your
customers.

Master Pack Shipment Entry

Use Master Pack Shipment Entry to combine separate pack IDs (master packs) into one master pack group to
ship as one shipment. You can select the shipment type for the master pack, but the pack is then restricted to
only shipments of that type.

In addition, all pack IDs must have the same ship-to address as the first pack ID added to the group.

Menu Path: Material Management > Shipping / Receiving > General Operations > Master Pack Shipment Entry

To create a new master pack:

1. Click the Down Arrow next to the New button;  select New Master Pack.

2. The Shipment Type defaults to Sales Order.

3. In the Stage field, select Staging Area 1.

4. Enter a Ship Via method for the shipment.

5. If you want to define the type of package used for the shipment, select a packaging Type. In this example,
CRTN (Carton) is selected.

6. The Length, Width, and Height default from the package type you select.

245Epicor ERP | 10.0.700

Shipping and Receiving | Chapter 4Epicor ERP Application User Guide - Part Two



7. Now add separate packs to the master pack. Click the Down Arrow next to the New button; select New
Pack.

8. On the Lines > Detail sheet, enter the first Pack ID you want to include in this master pack.

9. Click Save.

10. To enter additional packs to the master pack, click the Down Arrow next to the New button;  select New
Pack.
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11.  Add each new pack ID and click Save. To print the master packing slip and labels, click the Actions menu
and select Print Pack.

12. Click the Print button to generate the packing slips and labels.
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13. From the Actions menu, select Stage.

14. Navigate to the Summary sheet. The Pack ID field displays the Master Pack ID number. Record the Master
Pack ID number ________.

15. Click Save and exit Master Pack Shipment.

Stage Ship Confirm

Use the Stage Ship Confirm program to confirm shipments of staged pack IDs or master packs. You can then
filter these staged pack IDs by stage number, shipping status, shipment type, and ship via method. Lastly, you
can confirm the selected stage of each pack ID.

Menu Path: Material Management > Shipping / Receiving > General Operations > Stage Ship Confirm Entry

1. Click the Search button on the Navigation toolbar to search for and select the Master Pack created in the
previous workshop.

Epicor ERP | 10.0.700248

Epicor ERP Application User Guide - Part TwoChapter 4 | Shipping and Receiving



2. In the Date Shift field, verify Today defaults.

3. Click Select All.

4. Click the Actions menu and select Ship Confirm.

5. The Ship Status check box is selected indicating the package has been shipped.

6. Click Save and exit Stage Ship Confirm.

Phantom Pack Out

Phantom pack out functionality provides the ability to ship all items on an order, or multiple orders, under a single
pack ID. When you create a pack ID, the number of cartons you need is determined. Any cartons with tracking
numbers, size and weight, and freighted costs are sent to the shipping manifest process. Required shipping labels
are then generated for each physical box.

Phantom Pack out is particularly useful when you do not want or need to take the time to record the contents
of each box as a separate Pack ID. Use this feature to quickly complete shipments and generate shipping labels
that will go to the same ship-to location. Since the contents of each box in the shipment are not recorded, you
cannot always use phantom pack out for international shipments.

For a pack to be marked as a phantom pack, it must meet the following requirements:

• Work stations must be manifest enabled.

• The status of the pack must be Closed.

• It cannot be a master pack, or be assigned to a master pack.

• Contents of the entire Pack ID, and not each individual phantom pack, are moved to the manifest system.

To enable the manifest workstation on your client machine:

1. From the Main Menu, click the Options menu and select Change Workstation.

2. Select the appropriate workstation from the list.

3. Click OK.

Customer Shipment Entry

Menu Path: Material Management > Shipping / Receiving > General Operations > Customer Shipment Entry
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1. Click the New button on the Standard toolbar.

2. Select the Header > Detail sheet.

3. From the Ship Via drop-down list, select how this pack record is shipped tothe customer.

4. In the Ship Date field, enter the date on which this pack record is shipped. By default, the current date
displays.

5. Enter the Stage for the shipment.
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6. You are now ready to add detail lines to the pack record. Click the Down Arrow next to the New button;
select New Line.

7. The Lines > Customer Shipment Entry > Detail sheet displays. Enter the Order Number you are shipping.
You can also search for sales orders by clicking on the Order Number button.

8. Click the Line/Rel button to search for the line to ship. Continue adding additional lines to the shipment
as required.
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9. Click the Actions menu and select Close.

10. Select the Manifest Info > Tracking Details sheet.

11. Select the Phantom Pack check box.

12. Enter the Number of Cases to Create.

13. If you select a Package Code, the manifest will use the default Length, Width and Height defined for the
specified Package. If you do not select a package code, you can manually enter the Length, Width, and
Height after you create the cases.
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14. Click the Create Cases button.

15. The case information generates in the grid. If you have not selected a default package code, you can enter
the dimensions of the cases in the grid.

16. If you have a scale configured for this workstation, you can calculate the weight value for each case. To do
this, click the Actions menu and select Get Case Weight.

17. Click the Actions menu and select Print to print the packing slips and shipping labels for the cases.  

18. Click the Actions menu and select Stage.

19. The Status on the shipment changes to Staged.

Stage Ship Confirm

Menu Path: Material Management > Shipping / Receiving > General Operations > Stage Ship Confirm Entry
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1. Click the Search button on the Navigation toolbar to search for and select the appropriate Master Pack
ID.

2. The Stage Ship Confirm Search window displays various fields you can use to filter the records. In this
example, only one Master Pack record was retrieved, so you do not need to select any filters. In some
situations, however, you may need to filter the stages to find the ones you need.

3. Select the master pack record you wish to confirm.

4. Click OK.

5. Click the Actions menu and select Ship Confirm.

6. Notice the Ship Status check box is selected and the Ship Date is added to the pack ID. These values
indicate the shipment is confirmed.

Handheld Customer Shipment Entry

If you use the Data Collection module, you can process different transactions in the application by entering and
updating records through a handheld device. Leverage the handheld version of Customer Shipment Entry to scan
or enter packing slip information.

To learn more about the Packout and Handheld functionality,
refer to the Epicor ERP Packout and Handheld courses.
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Menu Path: Material Management > Data Collection > Handheld > Shipping & Receiving > Customer Mass
Shipment

This program is not available in the Epicor Web Access.

1. Enter or scan the Order number for the shipment.

2. Either click the Process button or press <F2> on the keyboard to continue.

3. The customer shipment line item information displays.

4. Either click the Edit button or press <F3> if you need to update the packing line item information.

5. In the Edit Packing Line window, enter any changes to the shipment, such as quantity, warehouse, and
bin information.

6. Either click the Ship Complete button or press <F6> to ship the line item complete.
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7. If you have updated the shipment quantity, either click Save or press <F2>.

8. Either click the Print button or press <F6> to print the packing slip or labels.

9. In the Print Packing Slip window, either click the Print button or press <F2>.

10. In the Customer Shipment window, either click the Ship button or press <F2>.
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Receive Materials

Receipt Entry is used to enter the receipt of all inventory materials, non-inventory materials, and subcontract
parts.

Receipt line items are either Purchase Order Receipts (recorded against a purchase order – described next) or
Miscellaneous Receipts (material received not associated with a purchase order). Receipt information updates
the purchase order, if there is one, and creates transactions to update inventory or job quantities and costs.

Receipts of parts returned by the customer are handled through
the RMA Processing program. This process is discussed in the
Customer Returns chapter.

You can also receive parts to inspection in this program. If you do, you need to use Inspection Processing found
in the Quality Assurance module to complete this process. For more information on this process, review the
Quality Assurance chapter.

Receive Materials Directly to a Job

Menu Path: Material Management > Shipping / Receiving > General Operations > Receipt Entry

1. Enter the purchase order number that you are receiving in the PO field.

2. Enter your supplier’s packing slip identification number in the Packing Slip field.

3. The application displays the Arrived Lines for this receipt. Purchase order line items display as arrived until
they have been received for the packing slip specified.

4. Select the Received All check box to receive all the lines in the Arrived Lines grid. Notice the icon changes
from Arrived to All Received when the lines are received.  

5. On the Job Material > Detail sheet, notice this purchase order was originally set up directly to a job. The
job number, assembly, and operation numbers automatically display, and the material is shown as being
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issued to the job complete. These parts still need to be delivered physically to the job in process or to the
work in process staging area.

6. Select the Inspection Required check box to indicate the parts specified on this receipt must be inspected
when they arrive at your location. If this check box is selected on either the part class or supplier record
involved with the receipt, this check box is automatically selected and cannot be changed.
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7. Click the Actions menu and select Print Tags. You can print one tag for the entire receipt quantity, or a
tag for each container.

8. To generate the tags, click Print on the Standard toolbar.

Receive Materials from a Combined Shipment

Menu Path: Material Management > Shipping / Receiving > General Operations > Container Receipt Entry
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1. Enter the shipment number that you are receiving in the Shipment ID field.

2. The application displays the Arrived Lines for this receipt.

3. To receive the line, on the Stock > Detail sheet, select the Line Received check box.

4. Notice the icon changes from Arrived to Received when the line is received.
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5. Click Save on the Standard toolbar.

Drop Shipments

Drop shipping is a supply chain management technique in which the seller does not keep goods in stock, but
instead transfers customer orders and shipment details to a third party (such as a manufacturer or wholesaler),
who then ships the goods directly to the customer. The seller makes their profit on the difference between the
wholesale and retail price.

Drop shipments are directly shipped by your suppliers to your customers. These goods are never physically received
into or shipped from your physical inventory because your supplier directly ships the goods. Because of this, the
application prevents drop shipment transactions from being processed using the standard receiving or shipment
programs.

You use Drop Shipment Entry to mark a drop shipped sales order release as shipped and mark the linked PO
release as received. Once the drop shipment transaction is selected as received/shipped in Drop Shipment Entry,
you can create a customer invoice for the drop shipped item using AR Invoice Entry, and enter a supplier invoice
received for the purchased item into AP Invoice Entry. You do this in the same way as you process invoices for
regular customer shipments and received purchases. Read the Customers and Accounts Receivable chapter for
more information on AR Invoicing and the Suppliers and Accounts Payable chapter for information on AP Invoicing.

Menu Path: Material Management > Shipping / Receiving > General Operations > Drop Shipment Entry

To add a drop shipment entry:

1. Click the Down Arrow next to the New button; select New Drop Shipment.

2. In the PO field, enter the PO number that you plan to drop ship to your customer. You can also click the
PO button to search for and select your purchase order.

3. In the Packing Slip field, specify the packing slip identifier for the drop shipment entry. The application
uses this to create a shipment record for drop ship sales orders, and a receipt record for drop ship PO releases.

When the sales order was entered, the Drop Ship check
box was selected indicating this order is being drop
shipped by your supplier to your customer. For more
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information on sales order entry, read the Sales Order
Processing chapter.

4. Select the appropriate Ship Via.

5. The Customer Ship To information defaults in from the purchase order; if you need, however, you can
change this value.

6. Click Mass Drop Shipment to process a mass drop shipment transaction for the selected pending PO and
drop shipment lines.

7. Click Get All to select all pending PO and drop ship lines that have not yet been processed.

8. Click Clear All to remove all selected pending PO and drop ship lines not yet processed from this window.

9. Click Update to process and update the selected pending PO and drop shipment lines.

10. Use the Pending PO Lines sheet to view all pending drop shipment PO release lines for the purchase order
number specified in the PO field. Double-click a specific pending PO Line record to process or edit a pending
drop ship line.

11. The Drop Ship Lines > Detail sheet displays the first line as Complete.

12. Click Save.
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13. The Tree View now displays Drop Ship Lines (2) and Pending PO Lines (1). Double-click the second PO Line
to process the drop shipment for this line.

14. The Drop Ship Lines > Detail sheet displays the second line as Complete.

15. Click Save.
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16. Once the goods have been hipped and received to your customer, click the Summary sheet and select the
Received/Shipped check box to indicate the shipment can be invoiced in Accounts Receivable and Accounts
Payable.

Transfer Orders

Transfer orders are orders you create to move inventory from one Site to another. You use Transfer Order Entry
to create the order to move the part quantities, transfer the inventory from one Site, and then receive the inventory
 into another Site.

Transfer Order Entry

Menu Path: Material Management > Inventory Management > General Operations > Transfer Order Entry

To create a new transfer order:

1. Click the New button on the Standard toolbar.

2. The To Site defaults from the Site you are currently logged in to. In this example, you are logged in to the
Main Site.

3. Select the From Site. This value is the Site from which you are transferring the inventory.
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4. Select the appropriate Ship Via code.

5. Click Save.

6. The Transfer Order Number is assigned.

7. Click the Down Arrow next to the New button; select New Line.

8. On the Line > Detail sheet, enter the Part Number for the transfer order.

9. Enter the Quantity.

10. Enter a Need By and Ship By date.

11. Select the Shipping Warehouse and Shipping Bin locations.

12. Click Save.

If you are using Material Requirements Planning (MRP),
you can use the Transfer Order Workbench to work with
transfer order suggestions that were created by the
Process MRP program. For more information on MRP,
review the Material Requirements Planning chapter.

Transfer Order Shipment Entry

Use Transfer Order Shipment Entry to enter the shipment of an inter-Site transfer. If your Site record is set up for
direct shipping, you can also use the Direct Shipment functionality to ship parts to another Site without using an
existing transfer order.

Menu Path: Material Management > Shipping / Receiving > General Operations > Transfer Order Shipment
Entry
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1. Click the New button to create a new Pack ID for the shipment.

2. Select a Ship Via for the shipment.

3. Optionally enter the Tracking Number and Weight.

4. Select the appropriate Package Type and Package Classification.

5. Click Save.

6. Click the Down Arrow next to the New button; select New Line.

7. On the Lines > Detail sheet, select or enter the Transfer Order Number for the shipment.
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8. Select the transfer order Line.

9. Enter the shipment Quantity.

10. You can optionally change the default Warehouse and Bin from which the inventory is being shipped.

11. Click Save.

12. On the Summary sheet, select the Shipped check box to complete the shipment.

13. If your Site is configured to allow shipments without a transfer order, you can use the Direct Shipment
option. This option is found on the Actions menu.

Receive Transfer Order

Use Receive Transfer Order to process a receipt of a transfer order shipment. In order to receive the transfer order
shipment, you must first change sites to the plant receiving the goods.

Menu Path: Material Management > Shipping / Receiving > General Operations > Receive Transfer Order

To receive a transfer order:
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1. In this example, you will receive the goods in the Rockford Plant. You select this plant on the Tree View
on the Main Menu. You can also use the Change Plant button.

2. Click the Pack ID button to search for and select the pack ID for the transfer order shipment.

3. In the Transfer Order Search window, select the Pack ID you are receiving.
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4. Click OK.

5. Click the Actions menu and select Receive All.

6. Click Save.

7. The Received Lines sheet now displays the completed receipt.

Bill of Lading

A bill of lading is a shipping document carriers use to identify cargo. These documents can be created automatically
from existing pack IDs or they can be created manually. You use the Bill of Lading program to enter and update
these records.

Menu Path: Material Management > Shipping / Receiving > General Operations > Bill of Lading Entry

1. Click the New button on the Standard toolbar.

2. If you have a Pack ID or Master Pack ID already created, you can click the Actions menu and select Link
Pack / MP to default in the bill of lading information. In this example, you create a manual bill of lading
that is not linked to a Pack ID or Master Pack record.
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3. Use the Generate option to select the packs to include for creating bills of lading.

4. In the ID... field, enter the Customer/Supplier ID.

5. Select the appropriate Ship To location.

6. Click the Down Arrow next to the New button; select New Line.

7. On the Summary > Lines sheet, enter the Number of Packages for the bill of lading.

If you have a linked pack ID, all of the bill of lading line
information defaults from the pack record.

8. Select the appropriate package Classification.
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9. Select the Packaging Code.

10. Enter the Weight and Weight Unit of Measure for the line item.

11. The Rate specifies the amount per package that you pay to ship this line.

12. Click Save.

13. To print the bill of lading, click the Actions menu and select Print BOL Form.
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Chapter 5: Customer Returns

You enter customer returns through Return Material Authorization (RMA) processing. The RMA record is the document
used to control the returned parts. It identifies the customer, items returned, notes about the returned items, and the
status and disposition of each item.

In general, a return goes through the following processes:

• Customer service creates an RMA.

• Receiving is given the items against the RMA.

• Inspection looks over the items and determines what should be done. For example, can the items be returned for
rework, scrapped, or returned to stock?

• If necessary, order processing is alerted to create a new requirement.

• Accounting is alerted to issue credit as needed.

Other modules interface with RMA processing - Quality Assurance, Enhanced Quality Assurance, General Ledger, and
Accounts Receivable. Depending on which modules you have licensed, additional processing options may be available.

Setup

You may need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration. You can also review the
Company Configuration chapter in the Epicor ERP Implementation Guide.

Operations

This section details the operations available when processing return material authorizations. Each operation is
described as a workflow to help guide you through the process from start to finish. These programs are primarily
found within the General Operations folder for this module. If a unique setup record is required to run the
operation, this record is also described in this section.

Return Material Authorization (RMA) Processing

RMA Processing is used to control and track the return of items from the customer. You enter information about
the return quantity and that information is passed along to different groups that need to take action - such as
inspection, billing, and order processing.

The application does not automatically create credit or shipping transactions or rework jobs based on these
returns. Return material authorization processing just provides the communication vehicle to make sure the
necessary actions are taken for customer returns. Based on the reason for the return and the customer needs,
you enter or change jobs, create credit transactions in Accounts Receivable, or reship part quantities as you need.

Menu Path: Sales Management > Order Management > General Operations > RMA Processing
The CRM menu path is: Customer Relationship Management > Order Management > General Operations >
RMA Processing
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RMA Summary

You use the Return Material Authorization Summary sheet to enter return authorization heading information
such as RMA number, date, and customer. You also use this sheet to create a new return or to change an existing
return.

To create a new RMA entry:

1. Click the New button.

2. The RMA number defaults in as zero; however, the application assigns the next number to the RMA after
you save the entry.

3. Enter the date the RMA is issued in the RMA Date field.

4. Enter the Customer ID for the customer requesting the return.

5. By default, the Primary Billing Contact displays in the Contact drop-down list. If you need, you can select
a different contact from this list.

6. If alternate bill to locations are available on this customer record, you can select an alternate billing location
from the Bill-To drop-down list. If no alternate bill-to locations are available, the Same As Sold To option
displays.

7. If known, you can enter a Debit Memo identifier as well.

8. Click Save on the Standard toolbar.

RMA Line

Once the RMA header is defined, you can then add detail lines to the RMA. RMA lines are added on the Details
sheet.

To add RMA lines:
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1. Click the Down Arrow next to the New button; select New Line.

2. You can now enter line information on the Detail sheet. In the Order/Line/Rel field, enter the sales order
and line reference for this return. You can enter this number directly, or, you can click the Order/Line
button to find and select it.

You do not have to reference a sales order, but if you do
reference one, it must be a valid order for the customer
specified on the header of the RMA.

3. Enter the Part number and Revision for the part being returned. You can also click the Part/Rev button
to access search to find and select the part number. The part does not have to exist in your part master file;
however, if you entered a sales order and line reference in the Order/Line/Rel field, the part and revision
from the sales order display as the default.

4. Select the Reason why the customer is returning the material.

Reason codes are defined in Reason Code Maintenance.
For more information, review the topics for this program
within application help.

5. The Ship To Contact group box populates with the information from a linked sales order. If you need, you
can change this contact information.

6. If you are receiving a part quantity that uses serial numbers, you must click the Serial Numbers button to
find and select the serial number for each returned part quantity.

7. Enter the Quantity of the part being returned.

8. Click Save on the Standard toolbar.
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Print RMA

RMA Processing provides the communication tools to ensure the necessary actions are taken for customer returns.
Based on the reason for the return and customer needs, you can enter or change jobs, create credit transactions
in the Accounts Receivable module, or re-ship parts as necessary.

When you finish entering RMA lines, you are ready to print the RMA.

To print RMAs:

1. Click the Actions menu and select Print RMA Form.

2. The RMA Processing – RMA Form window displays.

3. Click Print on the Standard toolbar.

Receive an RMA

You handle RMA receipts within RMA Processing. The receipt details track the returned part receipts and the
status of each return.

To initiate a receipt of items on an RMA:
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1. Click the Down Arrow next to the New button; select New Receipt.

2. The Receipts > Detail sheet displays. The current date displays in the Date field, but if you need, you can
change this value.

3. The Part Number from the RMA detail line displays.

4. You enter the Quantity returned through this receipt. This value can be whole or in decimals, depending
on if decimal places are available with the selected unit of measure code.

5. The Unit of Measure drop-down list displays all the unit of measure codes available for the current company.
Select the unit of measure code that best reflects the unit through which the quantity was returned.

6. Select the Request Move check box to indicate this returned material quantity must be moved to another
location. This check box is available if you use the Advanced Material Management module.

7. Review the This Receipt value to see the quantity defined for the selected RMA detail line. The unit of
measure code for the RMA detail line quantity also displays. You cannot change these values.

8. The Warehouse drop-down list defines the warehouse into which you are receiving this returned part
quantity.

9. The Bin field defines the bin into which you are receiving the returned part quantity. If you do not know
the bin, click the Bin button to find and select it.

If you use the Quality Assurance module, you can receive
these items into an Inspection location.

10. Use the Lot field to specify the lot of the part quantity being returned. If you track lots for the selected part,
you must enter a lot for it. If you do not know the lot reference, click the Lot button to find and select the
lot record. You activate lot functionality for a specific part record within Part Maintenance.

11. If you are receiving a part quantity that uses serial numbers, you must click the Serial Numbers button to
find and select the serial number for each returned part quantity.

12. To complete the transaction, click Save on the Standard toolbar.
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13. You can optionally view all receipts for an RMA by selecting the Receipts > List sheet.

Request a Credit for Returned Material

Once material has been received, a Credit Request can be initiated through RMA Processing. This record is only
a request for credit. The actual credit memo is generated though Invoice Entry; to do this, you use the Get RMA
Credits command found under the Actions menu.

1. Within RMA processing, click the Summary tab, and select the Credits tab.

2. Click the Add Credit Memo button to initiate the request for credit.
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3. The AR Invoice Maintenance window displays with credit information that defaults from the RMA. Because
you entered a sales order number on the RMA, the application looks up the pricing from the order referenced
and applies that information to the credit memo.

Refer to the Customers and Accounts Receivable chapter
for additional information on creating credit memos.

4. Click Save on the Standard toolbar and close AR Invoice Maintenance.

5. A new line displays within the RMA Credit Requests grid.

6. Within RMA Processing, click Save.

This process generates a request for credit that is either approved or denied by your accounts receivable department
through AR Invoice Entry. The RMA number is referenced on the invoice (credit memo) when it is posted.

RMA Disposition

Once RMA materials are received into an inspection location, you must disposition them. The inspector reviews
the RMA receipts and determines whether to disposition the material quantity back to inventory, to a job (for
repair), or reject it.

For information on DMR Processing, refer to this section within
the Quality Assurance chapter.
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If the Quality Assurance module is implemented, an RMA disposition typically occurs using Inspection Processing
from this module. The disposition process is very similar, except failed items flow into DMR Processing (Discrepant
Material Report). If you are not using the Quality Assurance module, then you must use RMA Disposition in the
Order Management module.

Menu Path: Sales Management > Order Management > General Operations > RMA Dispositions
The CRM menu path is: Customer Relationship Management > Order Management > General Operations >
RMA Dispositions

To disposition the material on an RMA:

1. Click Search on the Standard toolbar to launch a search for RMA receipts.  

2. Select the RMA to disposition and click OK.
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3. Click the New button.

4. Enter your disposition for the item in the Dispose To field. In this example, you are dispositioning the item
back to stock.

5. Enter the Quantity being dispositioned.

6. The Unit of Measure drop-down list displays all the unit of measure codes available for the current company.
Select the unit of measure code that best reflects the unit by which the quantity was returned.

7. Indicate who inspected the returned quantity by selecting this person from the Inspected By drop-down
list.

8. Select the Warehouse and Bin location which is receiving the returned part quantity.

9. If you are using the Enhanced Quality Assurance module, the Inspection Data button is available. Click
this button to enter inspection results for RMA materials.

For more information on how to enter inspection results
and other programs in the Enhanced Quality Assurance
module, review the Quality Assurance chapter.

10. Optionally, enter any comments related to the disposition on the Comment sheet.

11. Click Save.
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Reports

This section describes a key report you use to monitor open return material authorizations. You can run this
report whenever you need. You can also set up this report to generate and print through a recurring, automatic
schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information
on how you link a report to a recurring schedule.

Open RMA Report

The Open RMA report lists information for all RMAs that have an Open status. The information on this report
includes the date and number of the RMA, the customer address, the part’s line item information, and the reason
for its return.

Menu Path: Sales Management > Order Management > Reports > Open RMA
The CRM menu path is: Customer Relationship Management > Order Management > Reports > Open RMA

1. In the Report Options section, enter a From Date and To Date.

2. You can optionally apply a filter based on specific customers and/or parts on the Filter > Customer sheet
or Filter > Part sheet respectively.  
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3. To apply a filter on a specific customer, for example, click the Customer button, and select a customer from
the search window that displays.

4. When you have selected the customers you want displayed on the report, click OK.

5. When you finish, click Print.
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Chapter 6: Asset Management

Use the Asset Management functionality to accurately process your company’s assets. Within the application, assets
are resources owned by a company that hold value and can be converted to cash. Leverage setup programs within the
module to create, organize, and define asset depreciation parameters. Various depreciation methods and conventions
are available, including user-defined formulas that calculate depreciation through a method specifically targeted to
your business and legal requirements.

With the Fixed Asset Mass Changes program, you can efficiently modify characteristics for a group of assets. Three key
programs are available to help you record activities relating to your assets – Asset Addition Entry, Asset Disposal Entry,
and Asset Impairment Entry. Each activity is a separate transaction type.

The Asset Management module supports multi-currency for asset addition transactions. Asset purchases are recorded
in the transactional currency of the Accounts Payable invoice, in addition to the company and reporting currencies.
The company currency is used for miscellaneous and transfer additions from inventory.

After you enter and post asset activities, view activity details in the Asset Tracker. The Asset Tracker displays transactions
and the associated cost and status summaries. Using this information, your company can accurately calculate and
report asset costs.

Finally, Asset Management provides tools for financial reporting. The Asset Overview Report tracks the status of your
fixed assets and their depreciation, addition, disposal, and cost information. You can print physical labels for assets
using the Asset Labels Report. To report on depreciation for an asset during a fiscal year and period time range, view
the Asset Depreciation Report.

Setup

This section describes the primary records you need to create for the Asset Management module. These programs
are contained within the Setup folder for the module. Only the primary records are described here. Some areas
within the next Operations section may also document setup records if they are required for a specific workflow.
For more information on setting up this module, review the Company Configuration chapter in the Epicor ERP
Implementation Guide.

Asset Register Maintenance

Use Asset Register Maintenance to create, edit, and delete asset registers. An asset register represents a financial
view of an asset. A financial view is defined by a group of parameters that control all valuations of the asset and
when valuations are recognized. Optionally, you can also link an asset register to a General Ledger book.

You create an asset register that contains parameters for depreciation conventions, depreciation methods,
production units, estimated life, asset calendar, and so on. Most parameters are specific to an asset and are
defined as properties of the asset. Only one asset calendar can be selected per asset register. All assets included
in the register use the same asset calendar.

You should link an asset to at least one asset register, but each asset may be linked to multiple registers. All
activities controlled by parameters (depreciation, disposal) and amounts that result from these activities are
recorded, maintained, and reported per asset register.

The GL book linked to an asset register is added to record all
asset activities. If an asset is included in multiple registers,
different depreciation parameters in the asset registers can
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affect the values posted in depreciation and disposal
transactions.

Menu Path: Financial Management > Asset Management > Setup > Asset Register

To create an asset register:

1. Click New on the Standard toolbar.

2. Enter the Asset Register identifier you need.

3. Enter the Description for this asset register.

4. If necessary, select the GL Book for this register.

5. The fiscal Calendar defaults from the selected book; if you need, you can change this value.

For more information on how to set up GL books and
fiscal calendars, review the General Ledger chapter of the
Epicor ERP Implementation Guide.

6. Click Save.

Asset Class Maintenance

Use Asset Class Maintenance to enter asset class records. You leverage asset classes when you want to group
assets together on reports to see assets divided by General Ledger divisions and departments. Asset classes are
optional, but highly recommended. They prevent the need to have a group code for all possible division/department
and asset type combinations.

Menu Path: Financial Management > Asset Management > Setup > Asset Class

To create an asset class:
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1. Click New on the Standard toolbar.

2. Enter the asset Class identifier you need.

3. Enter a Description for this asset class.

4. Click Save.

5. You are now ready to select the GL control type and code for the asset class. Click the Down Arrow next
to the New button; select New GL Control.

6. The GL Control > Detail  sheet displays.

7. Click the Type button to find and select the GL Control Type.

8. Click the Control button to find and select the Control Code.

9. Click Save on the Standard toolbar.

Asset Group Maintenance

Use Asset Group Maintenance to enter asset groups. You can select GL controls that define the accounts associated
with the group. The GL Controls are used for the journals to post depreciation, asset additions, asset disposals,
and asset impairments. Examples of group codes are Site and machinery, office equipment, motor vehicle leased,
and motor vehicle owned.
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Main Menu Path: Financial Management > Asset Management > Setup > Asset Group

To create an asset group:

1. Click New on the Standard toolbar.

2. Enter the asset Group Code identifier.

3. Enter a Description for the asset group.

4. If necessary, select a category for the group from the Report Category drop down list. This is typically used
for the Asset Annual Schedule report to group categories together.

5. Click Save.

6. You are now ready to select the GL control type and code for the asset group. Click the Down Arrow next
to the New button; select New GL Control.

7. The GL Control > Detail sheet displays.

8. Click the Type button to find and select the GL Control Type.

9. Click the Control button to find and select the Control Code.

10. Click Save on the Standard toolbar.
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Spread Code Maintenance

Spread codes distribute asset depreciation costs per the days during which you want to charge depreciation.
These codes define the time period that serve as the basis for depreciation processing. Spread Codes can distribute
values per fiscal years (Year Type) or per fiscal periods (Period Type).

In a Period Type scenario, a company is closed two weeks in August and another two weeks in December. Fewer
working days in these months means less use of the assets, and because of this, less depreciation. The spread
codes for these fiscal periods should declare fewer days than spread codes for other fiscal periods. You can define
the number of days per period that you want to charge depreciation.

Use Spread Code Maintenance to establish spread codes and spread values for asset depreciation. Spread values
can be created manually or be automatically generated. From the Actions menu you can also import spread
values from another file or export spread values to a location outside of the Epicor application.

Menu Path: Financial Management > Asset Management > Setup > Spread Code

To create a spread code and values:

1. Click New on the Standard toolbar.

2. Enter the Code identifier you need.

3. Enter a Description for the spread code.

4. Select the Spread Code Type (Period or Year) from the drop-down list.  

5. Select the fiscal calendar from the Calendar drop-down list.  

6. Click Save. You are now ready to create spread code values.

7. You create spread code values manually or automatically generate them. To manually create a spread code,
click the Down Arrow next to the New button; select New Spread Value.
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8. In the Values grid, select the fiscal information.

9. In the Value field, enter your spread value. The value could be the number of days, annual charge, period
charge, or any value that is used to calculate the fiscal period’s depreciation amount.

10. To automatically generate spread values, from the Actions menu, select Generate.

11. The Generate Values window displays.

12. Click the Fiscal Year / Suffix button to find and select the appropriate value. You can also enter the value
directly. The generated values are placed in the selected fiscal year.

13. Now click the Assign Values drop-down list to define how these values generate. The available options
are Number of Days, Prorate Amount, and Do not Assign.

14. If you want to remove any previous values for the selected period, select the Override existing values check
box. You then generate completely new values for this period.

15. Click the Generate button to generate the spread values based on the parameters selected.

16. In the Values grid, verify the spread values were generated.
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Notice the spread value you manually created for Fiscal Period 1. This value was not altered because the
Override existing values check box was not selected when you automatically generated spread values.

17. Click Save.

Depreciation Method Maintenance

Use Depreciation Method Maintenance to specify depreciation methods for assets. Several methods are available
for you to calculate depreciation. These methods are based on either the passage of time or the level of activity
(or use) of the asset. If you need, you can also define custom formulas to calculate depreciation.

Menu Path: Financial Management > Asset Management > Setup > Depreciation Method

To enter a depreciation method:
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1. Click New on the Standard toolbar.

2. In the Method field, enter an identifier for the depreciation method.

3. Enter a Description for the depreciation method.

4. Click the Depreciation Charge Basis drop-down list to select the charge to expense or charge against revenue
basis in compensation for depreciation. Available options:

• Annual - Calculates the depreciation amount the asset receives for the year and (either prorating equally
or using a spread code) distributes the value per each period.

• Period - Calculates the depreciation amount per each individual period.

Depending on the option you select, the Annual Charge or the Period Charge section activates.

5. Select the calculation you want from the Calculation Method drop-down list. The available options are:

The formulas listed here are for Annual methods. For
Period methods, only the Use Fixed Value, the Use Spread
Code, and the User Formula methods are available

• Rate Straight Line - This depreciation method uses an annual depreciation charge basis. It calculates
the annual charge using a percentage value. The period charge is calculated by prorating the annual
charge equally (each period receives an equal charge).

• Life Straight Line - This depreciation method uses an annual depreciation charge basis. It calculates
the annual charge using the estimated usability, or life span, of an asset. The period charge is calculated
by prorating the annual charge equally (each period receives an equal charge).

• Sum of Years Digits - This depreciation method uses an annual depreciation charge basis. The annual
charge is calculated by subtracting the Residual Value from the Asset Cost and multiplying this result
against the Year Number divided by the Sum Years digits. The year number represents the number of
years remaining for depreciation. The sum of years digits represents the total of all year numbers over

Epicor ERP | 10.0.700290

Epicor ERP Application User Guide - Part TwoChapter 6 | Asset Management



which the asset is depreciated. The period charge is calculated by prorating the annual charge equally
(each period receives an equal charge).

• Declining Balance - This depreciation method uses an annual depreciation charge basis. The book value
at the end of year becomes the book value at the beginning of next year. The asset is depreciated until
the book value equals the residual value. The period charge is calculated by prorating the annual charge
equally (each period receives an equal charge).

• Declining Balance to Straight Line - This depreciation method uses both the Declining Balance and
Rate Straight-Line methods. The Declining Balance method is used until the calculated amount generated
through the Rate Straight-Line method is more than the calculated amount generated through the
Declining Balance method. When this happens, the Rate Straight-Line method is used.

• Use Fixed Value - This method calculates either by year or by period, depending on the Depreciation
Charge Basis you select. You set the fixed values within Asset Maintenance on the Register > Detail
sheet.

For more information, review the next Depreciation
Method - User Formula section.

• Use Spread Code - This method calculates depreciation by using the spread codes selected on the asset
record in Asset Maintenance. You define these spread codes on the Register > Detail sheet.

• User Formula - You can define your own custom formula for depreciation.

6. An asset register can switch to an alternate depreciation method once and cannot switch back to the original
method. Click the Switch to Alternate Method drop-down list to define when this switch can occur.
Available options are Never, On Greater Expense, and On Book Value Reaching % of Asset Cost.

7. If you select either On Greater Expense or On Book Value Reaching % of Asset Cost, select which
Method to which the asset register will switch.

8. Click Save.

Depreciation Method – User Formula

To create a custom formula for the depreciation of an asset:

As an alternative, you can also select a pre-defined formula,
select the User Formula option, adjust the formula, and save
it as a new custom formula.
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1. Click New on the Standard toolbar.

2. In the Method field, enter an identifier for  your custom depreciation method.

3. Enter a Description for the depreciation method.

4. Click the Depreciation Charge Basis drop-down list to select the expense against revenue basis in
compensation for depreciation. Available options:

• Annual - Calculates the depreciation amount the asset receives for the year and (either prorating equally
or using a spread code) distributes the value per each period.

• Period - Calculates the depreciation amount per each individual period.

Depending on the option you select, the Annual Charge or the Period Charge section activates.

5. From the Calculation Method field, select User Formula.

6. In the activated Charge section, right-click the Formula field, highlight Formula Variables, and select the
parameters you want for your formula. For example, Estimated Life, Asset Cost, Residual Value, Depreciation
Rate, and so on.
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7. In the activated Charge section, right-click the Formula field, highlight Operators, and select the math
operator for your formula. For example, +, -, *, and so on.

8. When you finish selecting the parameters, the custom formula displays in the Formula field.

9. Click the Check Syntax button. To the Syntax is correct message that displays, click OK.

10. Click Save.

Asset Maintenance

Use Asset Maintenance to enter and update records for fixed assets. You can organize assets by group, class,
and project. You can also import, export, and duplicate assets.

Specify an asset register for each asset. Identify the depreciation, cost information, annual charges, period charges,
and prorate options for the asset. Many depreciation methods are available. You can also establish parent/child
relationships between assets. If you would like, you can add a photo of the asset to the record.

Menu Path: Financial Management > Asset Management > Setup > Asset

To create an asset:
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1. Click New on the Standard toolbar.

2. Enter the Asset Number identifier.  

3. Enter a Description for the asset.

4. The status icon displays the asset’s status. In this example, the icon displays NEW.

5. Select the Asset Group for the asset.

6. Click the Acquired drop-down list to select the date you gained the asset. The date also displays in the
Placed in Service field.

7. If you need, click the Place in Service drop-down list to select a different date. This date serves as the first
date of depreciation.

8. Optionally, select an Asset Class. Asset classes are valuable to group assets together for reporting purposes.

9. Optionally, enter the cost amount in the Replacement (replacement value of the asset) field.

10. Click Save.

11. If you need, use the References, Parent / Child, and Additional sheets to define additional details of the
asset record. Use the Additional sheet to enter calibration, insurance, or lease information, or to add a photo
of the asset.

Asset Maintenance - Register

You can link an asset to an asset register to control all valuations of the asset and also to control when valuations
are recognized.

To link an asset register to the asset:
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1. Click the Down Arrow next to the New button; select New Asset Register.

2. Click the Register button to find and select the asset register.

3. Click the Method button to find and select the depreciation method to use for the asset.

4. Select the depreciation Convention you want to use with this asset register. These conventions define how
the depreciation amount for the first year is adjusted. Available conventions:

• Half-year - The asset was placed in service at the midpoint of the fiscal year.

• Mid-month - The asset was placed in service in the middle of the fiscal period.

• Quarter - Each quarter is one fourth the total number of periods.

• Mid-quarter - The asset was placed in service in the middle of the quarter. This convention is applicable
for a year that has a number of periods divisible by four and the quotient from this division is a whole
non-zero number.

• Full-month - The asset was placed in service during the first half of the fiscal period and the application
assumes it was acquired at the beginning of the period; otherwise, the application assumes the first day
of the next period.

• Entire-Month - The default option, this convention indicates that regardless of what day the asset was
placed in service, a full period’s depreciation is calculated against the asset.

• Next Month - Depreciation begins in the period after the asset was placed in service.

• Service Date - This convention is used to calculate depreciation for the first period. The days remaining
in the period are divided by the total days in the period to calculate the depreciation amount.

• Acquisition Date - The acquisition date is used to calculate depreciation for the first period. The days
remaining in the period are divided by the total days in the period to calculate the depreciation amount.

5. Optionally, enter the cost amount in the Residual (scrap value of the asset) field.

6. In the Useful Life field, enter the number of years or periods you estimate for the life of your asset.
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7. Select one of the following depreciation options for the period of disposal from the Depreciation on
Disposal field

• Pro-rated to disposal date - Calculate depreciation based on depreciation convention

• Full Month - Always apply full month of depreciation

• None - Do not depreciate asset at all

8. Click Save on the Standard toolbar.

Asset Maintenance – Import

Use the Import option to import an external file to create asset or asset addition records. This functionality is
useful if you have an asset group from an external system that you wish to bring into the application. The file
you import must be a comma delimited file (csv) and follow the import file template. Refer to the application
help to view the template details.

To import an external csv file:

1. From the Actions menu, select Import.

2. The Import Asset Group window displays. Click the Input File Name button to find and select the csv
file you want to import.

3. Click Import. The Import Successful message displays.

If an error occurs during the import process, a message
displays saying some of the assets were not imported.
Refer to the error details that display in the Error Log field.

Asset Maintenance – Export

Use the Export command to export detailed asset records to an external file. The file you export is saved as a
comma delimited file (csv) and can be updated by using Excel.
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To export an external csv file:

1. From the Actions menu, select Export.

2. The Export Asset Group window displays. Click the Output File Name button to find and select the
directory where you want to add your file; enter a file name.

3. Click OK. The Export Successful message displays.

Asset Mass Changes

Use Asset Mass Changes to issue mass changes to asset records. You can change an asset’s main attributes, such
as Asset Group or Asset Class, as well as depreciation parameters for a group of assets. The mass update occurs
only for values in the default register, and other registers are not affected.

You can select the assets to modify and specify the values assigned to those assets. If a field is left empty within
the program, the field will not assign a value to selected assets. Because of this, you cannot assign an empty
value to an asset using Asset Mass Changes.

If you change the Asset Class or Asset Group for an asset that has posted activities, you may need to create
manual GL Journal entries to move asset costs.

Menu Path: Financial Management > Asset Management > Setup > Asset Mass Changes

To issue a mass change to a group of assets:

1. Select the Asset Status. The statuses available are New, Active, Disposed, and Inactive.

2. If you want to process all child assets for the selected asset even if they do not match the selection criteria,
select the Include Child Assets check box.
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3. Select a Schedule option for the process. If you select a schedule other than Now, this process can run
through a recurring schedule. For more information, review the Automatic Data Processing chapter in the
Epicor ERP Implementation Guide.

4. You are now ready to define specific Filter criteria. You can filter by Asset, Asset Group, or Asset Class.

5. Click the Assets button to find and select an asset.

6. To select fields for replacement, navigate to the Field Selection sheet.

7. Click the Right Arrow button to move fields to the Replace list.
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8. To define replacement data, navigate to the Replace sheet and enter applicable replacement information.
The Annual Fix Charge field is open for data entry because it was the field you selected to replace.

9. Click the Generate Only button.

Operations

This section details the operations available within the Asset Management module. Each operation is described
as a workflow to help guide you through the process from start to finish. These programs are primarily found
within the General Operations folder for this module. If a unique setup record is required to run the operation,
this record is also described in this section.

AP Invoice Entry

Use AP Invoice Entry to record the purchase of an asset. After you create an AP invoice entry group and an invoice,
you can add asset lines.

For more information on creating an AP invoice, review the
Suppliers and Accounts Payable chapter.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry

To create an AP invoice group, invoice, and asset line:
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1. Click New on the Standard toolbar.

2. Enter a Group identifier.

3. Accept the current date as the default or enter an Apply Date.

4. Click Save.

5. Click the Down Arrow next to the New button; select New Invoice.
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6. Click the Ref PO button to find and select the purchase order you used to buy the asset.

7. Click the Supplier button to find and select the company from which you purchased the asset.

8. In the Invoice field, enter a number for the invoice.

9. Select the Invoice Date and Apply Date. These values define when the invoice was created and the date
on which you want the asset to be recorded.

10. Select the Terms for which you purchased the asset.

11. If you purchased this asset using a Letter of Credit with your bank, click the Letter of Credit button to find
and select this record.

12. Use fields in the Currency section to select the currency through which you purchased the asset.

13. Click Save.
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14. Click the Down Arrow next to the New button; select New Asset Line.

15. Enter a Description for the asset you purchased.

16. In the Supplier Quantity field, enter the quantity of the asset you purchased.

17. Enter the Unit Cost of the asset.

18. If you need, enter a different Ext. Amount for the asset. This value defines the total cost of the asset.

19. When you finish, click Save.
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Asset Addition Entry

Use Asset Addition Entry to enter cost or depreciation additions to assets. You can also add an asset addition
from an AP invoice line item. You can also add an asset addition from an AP invoice line item or use an asset
addition to add grant value to an asset. When you finish, indicate the asset addition as available to post.

An asset addition must not be entered earlier than the acquisition date of an asset.

Menu Path: Financial Management > Asset Management > General Operations > Asset Addition Entry

To enter an asset addition:

1. Select the Asset Number for which you want to enter the addition.

2. Details from the selected asset display in the Description, Asset Group, Asset Class, and other fields.

3. Click the Down Arrow next to the New button; select New Addition.
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4. Select the Addition Type. Depending on the Addition Type you select, several fields activate.

5. Enter the Addition Cost and the Grant Increase amounts.

6. When you finish, select the Ready To Post check box.

7. Click Save on the Standard toolbar.

8. You can use the Misc. Addition section to transfer assets depreciated in a sister company. When an addition
is entered, you can manually specify accumulated depreciation for the previous year and current year. These
values are specific to the asset register and need to be specified per asset register associated with the asset.

9. If you need, select the Inter-Group check box for a Miscellaneous addition type. The Misc. Addition grid
populates all asset registers in which the asset is included. An inter-group addition brings in the cost and
the accumulated depreciation for previous and current years from an addition from another company into
the system.

An inter-group addition is not posted; it is used only to
update the asset master and make the asset available for
further depreciation.

Asset Addition Entry - AP Invoice Line

To enter an asset addition from an AP Invoice line item:
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1. Select the Asset Number for which you want to enter the addition.

2. Details from the selected asset display in the Description, Asset Group, Asset Class, and other fields.

3. Click the Down Arrow next to the New button; select New Addition.

4. Click the Addition Type drop-down list and select Purchase.  A Purchase addition uses the AP interface.

5. Enter an Apply Date.

6. Enter the Addition Cost amount.
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7. Select the Acquisition check box.

8. Click the Supplier button to find and select the supplier of this asset.

9. Click the Invoice button to find and select the correct invoice.

10. Enter the Line where the asset was created.

11. When you finish, select the Ready To Post check box.

12. Click Save on the Standard toolbar.

Asset Depreciation Calculation

Use the Asset Depreciation Calculation program to calculate the depreciation of assets for the current year,
current period, or for an asset’s useful life. This program can be run as many times a month as you need. To get
an accurate calculation, you must post additions, impairments, and disposals before you run this program.

Through this calculation, depreciation charges are determined for all registers in which an asset is included. This
calculation uses the asset calendar linked to the register.

Menu Path: Financial Management > Asset Management > General Operations > Asset Depreciation Calculation

To run the asset depreciation calculation:

1. Select the Calculate Option you need with the asset. Available options: Current Period, Current Year, and
Asset’s Useful Life.

2. Select the Include Child Assets check box to include all assets linked to a parent asset in the calculation.

3. Select the Include Assets Marked for Automatic Recalculation check box to add assets selected for
recalculation in the calculation.
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4. Use the sheets on the Filter tab to narrow processing by Asset Group, Asset Class, Individual Asset, Asset
Register, or by Depreciation Method.

5. Click the Submit button to run the process. View the depreciation results in the Asset Tracker.

Asset Disposal Entry

Use Asset Disposal Entry to enter cost or depreciation disposals to fixed assets. This program is useful for recording
new asset disposal activity, as well as adjusting, deleting, and viewing unposted asset disposal activities.

You can dispose an asset in full or partially. Before you can record a disposal of an asset that is not fully depreciated,
you must calculate the depreciation for the period when the asset is being disposed.

When a partial disposal is created, the system suggests the amount of accumulated depreciation to use in
determining the net book value of the partially disposed asset, organized by asset register. You can then adjust
this amount manually, affecting the net book value for both the disposal and the disposal gain or loss.

Menu Path: Financial Management > Asset Management > General Operations > Asset Disposal Entry

To enter an asset disposal:

1. Select the Asset Number for which you want to enter the disposal.
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2. The information for the asset displays in the Description, Asset Group, Asset Class, and other fields.

3. Click the Down Arrow next to the New button; select New Disposal.

4. Select the Disposal Type. Depending on the disposal type you select, various fields open for data entry and
selection. Available options:

• Miscellaneous- Does not use an interface to other module to record a miscellaneous disposal.

• Transfer - Uses the Inventory interface to record a transfer of the asset to stock.

• Sale - Uses the AR interface to record a sale of an asset in the AR module.

5. Enter a Description for the disposal.

6. Enter the Disposal Cost you need. This value defines the cost added to the asset as a result of this disposal.

7. Enter the Proceeds value. This field defines the sales amount of the disposal.

8. Select the Ready To Post check box.

9. When you finish, click Save on the Standard toolbar.

Asset Impairment Entry

Use Asset Impairment Entry to enter impairments on a specific asset. An impaired asset is an asset whose market
value fell below its carrying amount and is not expected to recover; the asset’s market value is less than the book
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value of the asset. Future cash flows generated from the asset are less than the net difference of the market
value and the book value of the asset.

You must record the value of the asset in the books by debiting a loss account, and this loss account displays as
an expense in the income statement – crediting the respective asset account.

You can create asset impairments for assets not fully disposed with a status New or Active. By default, the
impairment cost is entered using the company’s base currency, which is the transactional currency for this
transaction. Amounts in reporting currencies are derived using conversions on the Apply Date; however, you can
override these converted values manually. Any unposted impairment can be adjusted or deleted.

Menu Path: Financial Management > Asset Management > General Operations > Asset Impairment Entry

To enter an asset impairment:

1. Select the Asset Number for which you want to enter the impairment.

2. The information for the asset displays in the Description, Asset Group, Asset Class, and other fields.

3. Click the Down Arrow next to the New button; select New Impairment.

4. Enter a Description for the impairment.

5. Enter the Impairment Cost.
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6. Click Save on the Standard toolbar.

7. Select the Ready To Post check box to indicate this impairment will be included in the asset posting process;
click Save again.

Asset Posting Process

Use Asset Posting Process to post asset activities. The posting transactions that generate are based on the fiscal
period and year you enter. This program can be run as many times as you need within a single period. This process
posts the calculated depreciation for each new calculated depreciation record. The posting program also posts
the net change (if any) between what was previously posted and what will now calculate.

To determine how the asset transactions are grouped in the GL Journal, select one of the following grouping
options:

• Post Additions – All asset transactions that have the same Apply Date are posted using a single GL Journal.

• By Activity Type – All asset transactions of the same type are posted using a single GL Journal.

• By Activity Type and Apply Date – Each asset transaction is posted using a separate GL Journal.

To post an asset addition, the following conditions must be true:

• The asset must be active, and must be assigned to an asset group.

• The GL accounts of the assigned asset group must be valid. If you use an asset class, then the account
combinations from the   class must be valid.

• The Ready to Post check box must be selected for the asset in Asset Addition Entry.

• The Addition Added Date must be in an open fiscal period.

If a disposal is selected and unposted depreciations are available for the same period, the application will post
depreciation for that asset as well, even if the depreciation was not specifically selected.

Menu Path: Financial Management > Asset Management > General Operations > Asset Posting Process

To post asset activities:

1. Select the Starting Date and Ending Date for the process. Typically, these values define the current fiscal
period.
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2. Click the Group Activities drop-down list to select how you want to organize the asset activities. You can
group activities by Activity Type, Apply Date, or both.

3. Select the Include Child Assets check box to process child assets linked to the asset or asset group.

4. Use the Asset Activities section to select the type of activities you would like to post. Available options:

• Post Additions - Posts all new assets acquired during the selected period.

• Post Disposals - Posts all assets you are removing during the selected period.

• Post Impairments - Posts all market value asset changes that occurred during the selected period.

• Post Depreciations - Post depreciation entries calculated for the selected period.

5. Use the Filter > Asset Group and Filter > Individual Assets sheets to narrow posting by Asset Group or
by Individual Asset.

6. Click the Submit button on the Standard toolbar.

Close Asset Period/Year

Use the Close Asset Period / Year program to close asset periods and years for a specified asset register. The
Close Asset Period / Year program is similar to the Close Fiscal Period / Year program found in the General Ledger
module.

Menu Path: Financial Management > Asset Management > General Operations > Close Asset Period / Year

To close asset periods and the year:
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1. Select the Asset Register in which the asset period is found.

2. The associated Fiscal Calendar and current year display. These values are based on the current date and
on the start and end dates of the year. If you need, you can enter a different Fiscal Year/Suffix.

3. Select the Fixed Asset Closed Period check box for all the periods you want to close. You can only close
periods that do not have unposted asset activities.

When you select this check box, the application verifies no unposted activity records are available for this
period. However, if unposted activities exist, the application displays an error message informing you unposted
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activities are present, and you cannot select this check box. The period following the last closed period
becomes the current asset period.

4. Click Save on the Standard toolbar.

5. Once all periods are closed in the selected year, you can close the asset fiscal year. To do this, from the
Actions menu, select Asset Year End Process.

This process is required to designate the next fiscal year
as the current fiscal year. You need to run this process
because most of the values shown in the Asset Tracker
display at the end of the current fiscal year.

6. The Asset Year End Process window displays. Click the Process button.

The Asset Year End Process summarizes all costs of the asset.

Reports

This section describes some key reports you use to review asset transactions. You can run these reports whenever
you need. You can also set up each report to generate and print through a recurring automatic schedule. Review
the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information on how you link
a report to a recurring schedule.

Asset Depreciation Report

Use the Asset Depreciation report to view depreciation for an asset register during a fiscal year and period time
range. You can filter by asset or asset group.

Menu Path: Financial Management > Asset Management > Reports > Asset Depreciation

To set up and run this report:
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1. Select the Asset Register you need.

2. Optionally, use the Fiscal Year and From Period fields to enter the fiscal year and period you want on the
report. By default, the fields display the current period for the fiscal calendar associated with the selected
asset register.

3. Select the Include Child Assets check box to indicate all assets linked to a parent asset display on the
report.

4. To only display the main information on the report, select the Print Summary check box.

5. If you need, use the Filter sheet to limit the report to individual assets or asset groups.

6. Click Print on the Standard toolbar.

Asset Depreciation Forecast Report

Use the Asset Depreciation Forecast Report to view the full year depreciation value forecast. The forecast displays
regardless of whether depreciation has been posted or not.

Menu Path: Financial Management > Asset Management > Reports > Asset Depreciation Forecast

To set up and run this report:
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1. Enter the Start Year of the forecast report.

2. Select how many Years you want projected in the report. Five years is the maximum.

3. Select the Asset Register you need.

4. If you need, use the Filter sheet to limit the report to individual assets and asset groups.

5. Click Print on the Standard toolbar.

Asset Labels Report

Use the Asset Labels report to print an asset label that includes the asset code, asset description, asset tag, and
location details.

Menu Path: Financial Management > Asset Management > Reports > Asset Labels

To set up and run this report:
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1. In the Status section, select the types of assets you want to include in the report by selecting the related
check boxes.

2. Select the Acquired From and the Acquired To dates you need. Labels will print for all assets added to
your data on or between these dates.

3. If you need, use the Filter sheet to limit the report to individual assets, asset groups, warehouses, or locations.

4. Click Print on the Standard toolbar.

Asset Overview Report

Use the Asset Overview report to view the status of your fixed assets including depreciation, activities, and cost
information.

Menu Path: Financial Management > Asset Management > Reports > Asset Overview

To set up and run this report:
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1. Select the Asset Register you need.

2. Select the Print Summary check box to include only primary information on the report.

3. Select the check boxes to print all Additions, Impairments, and Disposals that occurred for the selected
asset register.

4. Select the Print Costs check box to include the costs of each asset assigned to the selected asset register.

5. Select the Print Unposted Depreciations and the Print Depreciation Details check boxes to include the
depreciation information you need.

6. To organize the report to print each asset on a separate page, select the Print one Asset per Page check
box.

7. If you need, use the Filter sheet to limit the report to individual assets and asset groups.

8. Click Print on the Standard toolbar.

Asset Annual Schedule Report

Use the Asset Annual Schedule report to view a total change in asset cost and depreciation per transaction type
for a given fiscal year. The report is based on asset transactions, such as additions, impairments, disposals, and
depreciations.

Menu Path: Financial Management > Asset Management > Reports > Asset Annual Schedule
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1. Select the Asset Register you need.

2. Change the Fiscal Year from the default if necessary for your report.

3. Select the ending date for transactions to be included in your report in the Cut-Off Date field.

4. Select the Print Details check box to include all individual transaction details on the report.

5. If you need, use the Filter sheet to limit the report to individual assets and asset groups.

6. Use the Summary Fields sheet to select specific fields for your report.

7. Click Print on the Standard toolbar.
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Chapter 7: Customers and Accounts Receivable

The Accounts Receivable functionality uses billing parameters defined on customer records, the pricing system, and
invoice records to calculate how much your company charges customers. The Accounts Receivable module is also used
to receive customer payments, track sales information both internal (work force commissions and sales) and external
(customer sales trends), provide credit hold functionality against the customer base, and track current outstanding
debts owed to your company.

You set up billing information through two maintenance programs – Payment Terms Maintenance and Customer
Maintenance. Use Payment Terms Maintenance to define the various pay agreements you have with your customers.
Customer Maintenance defines the billing parameters specific to each customer, like billing address, discount percentages,
salespeople and other details.

AR Invoice Entry is the tool where this billing and pricing information comes together. Use this program to calculate
how much you charge customers for the part quantities sold to them. When you receive payment from your customer,
you then use Cash Receipts Entry to process the amounts placed against these open invoices.

Two key reports are available to help you assess your company’s incoming amounts. The AR Aged Receivables Report
displays each customer’s open invoices by sorting them into aging columns. The Sales Gross Margin Report prints
information on invoices created during a selected date range.

When you leverage this set of financial tools, you accurately calculate the income coming into your company.

Setup

This section describes the primary records you need to create for the Accounts Receivable module. These programs
are contained within the Setup folder for this module. Only the primary records are described here. Some areas
within the next Operations section may also document setup records if they are required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration. You can also review the
Company Configuration chapter in the Epicor ERP Implementation Guide.

Payment Terms

Payment terms define the pay agreements you have with your customers. Terms details include payment schedules
and discounts for early payment of invoices. Payment schedules can be based on a number of days, a day of the
month, or both. Discounts for early payments can apply to partial or full payments and determine whether
percentages apply to payment or invoice amounts.

Terms associated with a customer in Customer Maintenance apply to that customer’s invoices. Cash Receipt
Entry displays discount dates that apply to AR invoices, and the Discount Analysis report displays information
about discount amounts.

Menu Path: Financial Management > Accounts Receivable > Setup > Terms

To create terms applied to AR invoices:
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1. Click the New button on the Standard toolbar.

2. In the Code field, enter the unique identifier used for the term.

3. In the Description field, enter a concise explanation for the payment term. This description is printed on
the order acknowledgment, and AR invoice.

4. Use the Number of Payments field to define how many payments can be made against an invoice during
a payment cycle. If this number is more than one, any invoice assigned these terms is paid through multiple
payments.

5. Use the Terms Type field to select the method the application uses to calculate the time span for discounts
on invoices that use the current terms code. Terms type options include the following:

• Days - The overall terms period is defined by a number of days after the Invoice Date.

• Days of Month - The overall terms period is defined by a specific day each month. If an Invoice Date
falls within a certain date range in a previous month, however, the final due date for the invoice is
automatically moved to the next month.

• End of X-Month(s) + Y Day(s) - The overall terms period is defined by a number of months plus an
optional number of days into the last month past the Invoice Date.

6. If you want these terms to be the default on new customer records, select the System Default check box.

7. Your selected option in the Terms Type field determines the available fields in the Due area. Based on the
terms type, the following fields are available:

• Number of Months and Due on Day define a schedule based on payments after the specified number
of months plus the specified number of days.

• Number of Days defines a schedule based on periodic payments. The application adds the number of
days entered in this field to the invoice date to obtain the due date.

• Due on Day and Minimum Days define a schedule based on monthly payments. The application uses
the minimum days setting to move a billing to the next month when the invoice date occurs close to the
due on day.
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8. Use the Discount Type field to select the discount schedule associated with the term. Discounts can be
applied based on a number of days, a day of the month, or both (End of X Month(s) plus Y day(s)).

9. Select Apply Discount When Paid in Full to limit application of discounts to invoices paid in full.

10. Use the Discounts > Detail sheet to define discount terms.

11. When you finish, click Save.

You can now assign these payment terms to a specific customer record.

Recurring Cycle Maintenance

Use Recurring Cycle Maintenance to set up recurring cycles that define how recurring invoices will be generated
and their billing cycles. You can create a recurring cycle and attach it to a recurring source invoice. A recurring
source invoice is an invoice that is also used as a template from which recurring invoices will be generated.

Menu Path: Financial Management > Accounts Receivable > Setup > Recurring Cycle

To create a recurring cycle:

1. Click the New button on the Standard toolbar.

2. Enter a unique identifier in the Cycle Code field.
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3. Enter a Description of the cycle code.

4. In the Module field select a module in the Epicor application for which the recurring cycle will be available.
Options include:

• AP

• AR

• Both

5. Select the Copy Latest Invoice check box to have details copied from the latest posted recurring invoice
from a recurring series. Leave the check box clear to copy details from the recurring source invoice.

6. Use the Interval field to indicate the length of time to use with the Modifier.

7. Use the Modifier field to indicate how often the Interval will be applied to create recurring invoices. Options
include:

• Days

• Weeks

• Months

8. In the Billing Day field, specify the day of the week or month on which the recurring invoices will be
generated.

This value is populated dynamically based on the Modifier field.

9. In the Duration field, specify how many times the recurring invoice will be created.

This value includes the recurring source invoice. Once the duration is reached for a recurring invoice, the
Inactive option will be set on the recurring source invoice.

If the Maximum Value check box is selected, the
Duration field is disabled and a Maximum Value entry will
be required on the recurring source invoice.

10. Click Save.

Finance/Late Charges

Use Finance/Late Charge Maintenance to define the settings used to calculate customer finance charges and
interest charges on overdue invoices.

Menu Path: Financial Management > Accounts Receivable > Setup > Finance/Late Charge

To define interest and finance charges applied to overdue items:
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1. Click the New button on the Standard toolbar.

2. Enter a unique Charge ID.

3. Enter a Description of the charge identifier.

4. Enter an Invoice Line Description of the invoice line.

5. In the Payment Process Days field, enter the grace period - the number of days between the overdue date
and the date interest charges begin to accrue.

6. Enter or search for a Tax Category for the product. The tax category description defaults from the tax
category record.

7. If necessary, use the Misc Charge field to apply a finance charge to the interest invoice. Typically, these
charges add an invoice or handling fee to the invoice.

8. Use the Terms field to indicate the term assigned to the invoice. Terms are defined using Terms Maintenance.

9. From the Default Invoice Document Type field, you can select a default document type for the invoice.

10. In the Included Invoices area, select the type or types of invoices to which the interest applies. Typically,
interest applies to open invoices.

11. Use fields in the Limits area to define the general minimum and maximum charge amount limits that affect
invoice generation.

12. Use fields in the Lowest Amount to Charge area to define the minimum amount limit per customer and
per invoice required to generate invoices.

13. Click Save.
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National Accounts

You can define customer hierarchy or parent/child relationships by using National Accounts. With National
Accounts, you can accept payments made by one customer on behalf of another related customer, allow credit
checking hierarchy against a related group of customers, and allow reporting hierarchy for a related group of
customers to determine how receivables and other financial data is reported and viewed. To use national accounts,
relationship classes are defined and customers are assigned to a specific relationship class.

Relationship Class

Relationship classes are used to set up national account relationships. You can define classes for credit sharing,
reporting, and payer bill-to relationships.

Menu Path: Financial Management > Accounts Receivable > Setup > Relationship Class

To create a relationship class:

1. Click the New button on the Standard toolbar.

2. Enter a Relationship Class Code as a unique identifier for the class.

3. Enter a concise Description that identifies the relationship code.

4. Select the Tiered check box if the relationship class is part of a tiered hierarchy. A tiered hierarchy includes
one or more child customers to a single parent customer.
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5. To create a new level tier, click the Down Arrow next to the New button and select New Level.

6. The Tier Level defaults to “Level” plus the level number.

7. Enter a Label for the Tier Level.

8. Click Save.

National Account Relationship

Now you can create a national account relationship by assigning a customer to a relationship class:

Menu Path: Financial Management > Accounts Receivable > Setup > National Account Relationship

1. Click the New button on the Standard toolbar.
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2. Enter or find and select the Relationship Class you want for this relationship.

3. Enter or find and select the Customer to assign to this Relationship Class.

4. Click Save on the Standard toolbar.

5. The Tiered check box defaults to the setting of the Relationship Class Code.

6. The Tier Level identifies the tier hierarchy of the selected customer. For example, a 1 specifies a top level
tier.

7. If the relationship is tiered, enter or find and select the Child Customer to be added to the national account
relationship.

8. Click the Add Child button to add the child customer to the national account relationship as a child of the
selected customer.

9. If this is a non-tiered relationship, enter the Child Customer to be added to the national account relationship.

10. Click the Add Child button to link the child customer to the national account relationship.

11. Click Save.

Customers

You enter a customer’s billing information directly within the customer record. Use this functionality to define
the customer’s billing address, primary salesperson, payment terms, and other information.

Menu Path: Financial Management > Accounts Receivable > Setup > Customer
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Customer Maintenance – Billing Detail - Billing Information

You enter each customer’s billing information on the Billing > Detail sheet. Here is what you do:

1. After you find and select the customer record you want to view, click the Billing > Detail sheet.

2. The Group field is an optional value. You can use customer groups to divide your customer base using
specific criteria, such as Automotive, Aerospace, and Injection Molding. Customer groups may contain their
own sales categories and price lists. If you need, select a group from the list.

3. Use the Payment Method field to select the default method used by the customer for paying invoices.

4. When selected, the Allow As Alternate Bill To check box indicates this customer can be selected as an
Alternate Bill To location on another customer record. You use this functionality when you need to bill a
different customer, like a leasing company, for the goods and services purchased by another customer. To
learn more, read the Customer Maintenance – Alternate Bill To section later in this chapter.

5. Enter or search for a Tax Liability to specify the liability a company needs to handle when trading with
customers and suppliers. The final taxes and rates used in a transaction are determined by the combination
of the tax liability and the product tax category.

6. Use the Tax ID and Tax Exempt fields to indicate if this customer is exempt from taxes. If this customer is
exempt, enter the tax identifier in the Tax ID field, and the reason for their exempt status in the Tax Exempt
field.

7. Use the Tax Rounding Rule field to determine the rounding method for this customer. This field is only
enabled when the Customer Specific Tax Rules check box is selected in Company Configuration. Rounding
methods include: Use rounding rules from Currency, Round Up, Round Down, and Round to Nearest.
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Continue on to the Customer Maintenance - Billing Detail - Billing Terms topic to complete the remaining
information required on the Billing > Detail sheet.

Customer Maintenance – Billing Detail - Billing Terms

Here is what you do to enter the remaining information on the Billing > Detail sheet:

1. Select a Terms option that applies to this customer. The term selected determines the default payment
schedule and discount terms applied to this customer’s invoices.

2. Two Term Type frequency options are available:

• Weekly – Select this option to bill the customer every week. This option is the default.

• Monthly – Select this option to bill the customer once a month.

Within AR Invoice Entry, the Billing Day is used by the Get
Shipments function to determine which shipments to pull
in for billing. All shipments that happen on or before this
date are automatically pulled into AR Invoice Entry. The
default value is All Days, which indicates every packing
slip assigned to this customer is pulled in. To learn more
about this function, read the AR Invoice Entry - Get
Shipments section later in this chapter.

3. The Billing Day defines the day of the week or month on which this customer can be billed. Select a day
from this list if you ship product every day, but only invoice customers on a specific day of the week or
month.
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4. Use the Discount% field to define the default percentage applied to all purchases made by this customer.
If you need, you can change this amount on each detail line.

5. Use the Discount Method field to select how the discount is issued to the customer. This method is used
when you apply order valued based discounts to the customer’s sales orders; it affects the discount percentage
given to this customer. Available options:

• Min – The default order discount percent is the minimum discount this customer can receive.

• Max – The default order discount percent is the maximum discount this customer can receive.

• Add – The default option, this customer receives the order valued based discount and the default order
discount.

6. Rebates may be processed as a credit memo within AR Invoice Entry, or as an invoice payment within AP
Invoice Entry. To pay through AP Invoices, a supplier record is defined for the customer and then linked to
that customer using the Rebate Supplier field.

7. Use the Finance/Late Charge field to select the charge code that applies to this customer for invoices not
paid on time.

8. Select a Reminder Group if you want to apply group settings for reminder (dunning) letters to this customer.
The group defines reminder letter sequences and intervals and defaults for the application of finance charges.
Reminder letters function in conjunction with processes that generate finance charges, interest invoices,
and late payment fees.  

9. The Consolidate Sales Orders check box determines how the Get Shipments process creates invoices from
sales orders. When selected, this check box indicates this customer can have multiple orders placed together
on the same AR invoice. If you clear this check box, however, separate invoices are created for each order
placed by this customer.

10. The Combine Packing Slips check box determines how the Get Shipments process creates invoices from
packing slips. When selected, this check box indicates all packing slips created for the same order and fiscal
period are billed on a single AR invoice. If you clear this check box, however, each packing slip creates a
separate invoice.

For more information about the Get Shipments
functionality, review the AR Invoice Entry – Get Shipments
section found later in this chapter.

11. Select the Finance Charges check box to indicate this customer pays a penalty on any overdue balance.

12. Select the Credit Card Order check box to determine whether this order will be the default for orders
entered for this customer. This can be overridden later on.

13. If necessary, select the Auto Invoice / ERS Order check box for invoices to be automatically generated and
posted by the system when the pack is shipped.

14. If necessary select the Order "Invoice when Complete" default check box if the customer wants every
order to be invoiced by default when the entire order is shipped.

15. When you finish, click Save on the Standard toolbar.
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Customer Maintenance – Bill To

Use the Bill To sheet to enter the customer’s billing address. This value defines the address to which invoices and
statements are sent.

To enter a billing address:

1. If you want to copy the main customer address into this sheet, click the Copy Customer Address button.

2. If you wish to enter a new billing address, click the Clear Bill To Address button.

3. Enter the different address in the Name, Address, City, State, Postal Code, and Country fields.

4. Enter the Phone and Fax numbers for this billing address.

5. When you finish, click Save on the Standard toolbar.

Customer Maintenance – National Account

In payer bill-to relationships, a payer customer pays for a bill-to customer that receives invoices. National accounts
of this type can allow multiple payers, cross-account payers, and third-party payers. A company setting determines
the non-tiered relationship class used to define accounts for payer bill-to relationships.

Customers that belong to national accounts based on the class receive and pay invoices based on the relationship.
A customer in such an account can be defined as a child or a parent customer. By default, parent customers act
as the payers for their children. The application assumes the customer pays for its own expenses.

Options in this sheet override defaults set by the national account. You can define settings that allow child
customers to pay their parent’s invoices and allow a customer to pay invoices for all customers in the same
account.

To define this customer as a bill-to in a national account relationship:
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1. Select the Override Payer Bill-To Relationship Class check box to allow the customer to pay for parents
or grandparents in the account’s hierarchy.

2. To specify the name of the national account that applies to the customer, enter or search for the Payer Bill
To record.

3. Select the Across National Account check box to allow the customer to accept payments for any other
customer within the account.

Customer Maintenance – Price Lists

Price lists define prices for your parts. Use this feature to set up price lists to reflect seasonal price changes or
special price breaks you set up for specific customers or ship to locations. When you create an order, the price
lists assigned to this customer are used to calculate the total cost on the sales order.

To learn more about price lists, read the Pricing and Discounting
section in Chapter 5: Sales Order Processing.

You use the Price Lists sheet within Customer Maintenance to define which price list has precedence over other
price lists. To do this:

1. Click the Price Lists tab.

2. The price lists that you have created for this customer display in the Customer Price List grid. The top price
list is used before the second price list, the second before the third, and so on.

3. To change the position of a price list, highlight it.
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4. To indicate this price list has more precedence, click the Move Up button.

5. To indicate this price list has less precedence, click the Move Down button.

6. When you finish, click Save on the Standard toolbar.

Customer Maintenance – Credit Detail

Use the Credit Detail sheet to enter and update the current customer’s credit information. You can define the
credit limits you want to place on the current customer. You can also define other credit options - including
placing this customer on and off credit hold. The main features of this sheet include the following:

1. The Invoice Credit, Order Credit, Payment Credit, and Credit Total fields break out this customer’s
current credit situation.

2. The Open Invoices, Open Orders, and Open Payment Inst fields indicate the amounts this customer has
yet to pay.

3. Use the Credit Limit field to enter the total amount of credit available to this customer. When the customer
goes over this limit, various programs and reports alerts you this customer is over the credit limit.

If you want to give this customer unlimited credit, leave
the Credit Limit field as 0. Do not enter a large number
or all 9’s to indicate unlimited credit, as you slow down
the application because it must now perform unnecessary
calculations.

4. The PI Credit Limit field displays the maximum credit this customer may have for non-traditional payments
like post-dated checks, bank drafts, promissory notes, and other payment instruments.
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5. The Review Date field reminds you when another credit check on this customer should be done.

6. Select the Include Open Order check box to indicate the application uses open sales order amounts to
determine the customer’s current credit rating.

7. Select the Include Payment Inst check box to indicate the application also uses non-traditional payment
information (post-dated checks, bank drafts, and so on) when it calculates the customer’s current credit.

8. The Credit Hold check box is the key field on this sheet. When selected, this check box indicates this
customer cannot receive any more credit from your company. If you attempt to create a sales order or a
packing slip for a customer on credit hold, a warning message displays stating this customer is over the
credit limit. For new customers, this check box is automatically selected. You must clear this check box before
you enter transactions for a new customer.

9. When you finish, click Save on the Standard toolbar.

Customer Maintenance – National Account Credit

Use the National Account Credit sheet to define settings for a customer in a credit-sharing national account.

In credit sharing, a child customer can access its own credit, the credit of its parent, and the credit available in
one or more credit pools associated with the national account. A company setting determines the relationship
class used to define a credit-sharing account. Customers that belong to national accounts based on the class can
share credit.

Settings in this sheet further define how credit is distributed. You can limit the use of parent credit by children
and allow the use of the customer’s credit by other customers in the same account. You can also define the order
in which the customer uses its own credit, the credit of its parent, and credit contained in the national account
pool or pools.

To check credit for a customer in a national account relationship:
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1. Select the Use Parent’s Credit check box to use credit from the parent.

2. Define the Max Percentage to Use when the parent’s credit is used. The default is100 percent.

3. Select the Share Credit check box to allow the sharing of credit among customers in the national account.

4. Define the Percentage Shared among customers in the relationship. This field is available when credit is
shared. The default is 100 percent.

5. In the Credit Preferences section, move entries from the Available List to the Selected Preferences List to
set the order in which the credit checking process applies available credit.

6. Click Save on the Standard toolbar to apply the specified settings.

Customer Maintenance – Alternate Bill To

Use the Alternate Bill To Addresses sheet to indicate which alternate customers may receive this customer’s billing.
You use this functionality when another customer (the Bill To Customer) is charged for the payment instead of
the customer who received the shipment (the Sold To Customer). This situation happens when the Bill To customer
is a leasing company or a head office instead of the receiving customer.

You use this sheet to link a different customer record as a bill to location. This alternate record handles all aspects
of financial transactions with this company - including credit limits and AR accounts.

To define an alternate bill-to:
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1. Click the Down Arrow next to the New button; select New Alternate Bill To.

2. The Billing > Alternates> Detail sheet displays.

3. In the Customer field, enter or search for the customer that is an alternate Bill To Customer. You can only
select customers that are defined as Alternate Bill To Customers. You define this by selecting the Allow As
Alternate Bill To check box on the Billing > Detail sheet.

4. The alternate bill to location’s contact information displays within the Name, Address, Phone, and Fax
fields.

5. If this alternate bill to location is the default used on all billing records for this customer, select the Default
Bill To check box. Only one Bill To Customer can be selected as the default on each customer record.

6. If you want all invoices sent to this alternate Bill To Customer, select the Invoice Address check box.

7. When you finish, click Save on the Standard toolbar.

Customer Maintenance – Document Types

If your application is set up for legal numbers functionality, use the Document Types sheet to associate a legal
number sequence to external documents sent to specific customers. Legal numbers are created through two
methods - as a generated legal number or as a generated Serial Shipment Container Code (SSCC). Both legal
numbers and SSCC numbers are attached to shipments. The generated sequence number results from the
document type linked to a number in Legal Number Maintenance. This association determines the legal number
sequence or SSCC number sequence applied to the customer’s invoices, credit memos, and other documents.
For more information on legal numbers and SSCC numbers, read Chapter 18: Shipping and Receiving.

If your company does not use legal numbers, you do not need to set up any information on the Document Types
sheet.

To apply legal number sequences:
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1. Click the Down Arrow next to the New button; select New Document Type.

2. In the Invoice Type field, use the drop-down list to select the type of document to which the numbering
sequence applies.

3. In the corresponding Transaction Document Type field, use the drop-down list to select the document
type associated with the legal number sequence.

4. When you finish, click Save.

Customer Maintenance – Banks Detail

Use the Banks sheet to define the bank accounts from which customer payments are withdrawn. You can also
select the method used to withdraw payments from the account. Definition of at least one account is required
to handle receivable payment instruments.

To define a bank account:
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1. Click the Down Arrow next to the New button; select New Bank.

2. Use the Bank field to create a bank identifier used in application processes.

3. Select the Primary Bank check box to designate this as the default bank for the customer. You can override
this default account for specific receipts.

4. Use the Bank Name, Bank Account, and Bank Identifier fields to provide information used in the selection
of accounts in other programs.
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5. If needed, use the Bank/Branch field to associate a bank branch with the account.

6. Enter the account number in the IBAN Account Code field.

7. Use Payment Method to select the default payment method used to withdraw payments from the account.
To handle transfers electronically, select a method that uses an electronic bank interface.

8. If needed, use the Agreement Reference and Agreement Expires fields to enter information about the
agreement between the company and the bank.

9. Use fields in the Bank Mailing Address area to update address details.

10. Click Save on the Standard toolbar.

Operations

This section details the operations available in the Accounts Receivable module. Each operation is described as
a workflow to help guide you through the process from start to finish. These programs are primarily found within
the General Operations folder for this module. If a unique setup record is required to run the operation, this
record is also described in this section.

Customer Reminders

Reminder letters prompt customers to pay past-due invoices. Customers can belong to reminder groups; these
groups determine the messages in the letters, and, optionally, the finance charges applied when they generate.

A .rpt file, included with the application, provides most of the content you need for these letters. The letter
template includes the customer's name, address, contact, company signature, and company contact. It also
includes information about the overdue invoices that caused the customer to receive this letter. You can print or
fax letters, or send them by e-mail.

Reminder Group Maintenance

Use Reminder Group Maintenance to define sequences of reminder letters and the message for each letter defined
in the sequence. Sequences can be based on aging brackets or on intervals between letters. You can associate
finance charges with each letter in a sequence.

Menu Path: Financial Management > Accounts Receivable > Setup > Reminder Group

To define a reminder group:
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1. Click the New button on the Standard toolbar.

2. Enter the Group ID.

3. Enter the group Description.

4. Select the Due Date or Last Reminder option to define whether the sequence is based on aging brackets
or the interval between reminders.

5. Click the Down Arrow next to the New button;  select New Reminder Sequence.

6. The Sequence > Detail sheet displays.

7. The sequence number displays in the Sequence field.

8. In the Days To Reminder field, define when the reminder generates. If you previously selected the Due
Date, this value defines the number of days after the due date. If you previously selected Last Reminder,
this value sets the number of days after the last reminder.

9. Enter the reminder Message that you want printed on the reminder letter form.

10. Click Save.
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Reminder Letter Generation

Use Reminder Letter Generation to select the customers and the invoices used in the generation process. Posting
the letters applies charges connected with the overdue amounts. Depending on the company setting, you can
either print reminder letters and include finance charges on subsequent invoices or generate finance-charge
invoices that include the reminder message.

Menu Path: Financial Management > Accounts Receivable > General Operations > Reminder Letters Generation

To generate reminder letters:

1. Click the Actions menu, highlight the Get submenu and select Customers.

2. The Search Form window displays.

3. Click Search.

4. Select a customer from the Search Results grid.

5. Click OK.
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6. Click the Actions menu, highlight the Customers submenu and select Generate Letters.

7. The Set Age date window displays.

8. Enter the As of Date.

9. Click OK.

10. The Reminder Letters sheet displays the reminders that generated.

Letters of Credit

You use letters of credit in situations when you do not want the risk of offering credit to a customer. Instead,
the customer sets up an agreement with a bank where the bank is held liable to pay for specific goods up to a
certain value using some condition – usually a confirmed receipt such as a bill of lading. You are then assured
your organization will be paid, as you then place the AR invoice amounts against credit available at the bank.
The letter becomes its own independent line of credit between the customer and the bank.
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Create Letters of Credit

You use Letter of Credit Entry to enter and manage all of the letters of credit your organization has with specific
customers.

Menu Path: Financial Management > Accounts Receivable > General Operations > Letter of Credit Entry

To enter a letter of credit for a customer:

1. Click the New button on the Standard toolbar.  

2. Enter the number for the letter of credit within the LC/ECG Reference field.

3. Next, enter a concise Description for the letter of credit. This value displays on various reports and trackers.

4. Click the Customer button to find and select the customer with whom you have set up a letter of credit.

5. If you will send AR invoices directly to a bank or to a different customer organization, select the Bill To
Customer location you need from this drop-down list.

6. Click the Type drop-down list to select the kind of letter of credit for this customer. Available options:

• Letter of Credit – A pool of credit guaranteed by the customer’s bank. This credit is usually paid directly
by the local representing bank.

• Export Credit Guarantee – A pool of credit for exported goods guaranteed by the government.

7. Enter the name of the bank backing the credit within the Guarantor Name field.

8. When you expect all shipments to this customer to ship complete through this letter of credit, select the
Ship Complete check box.
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9. Use the Value and Currency fields to enter the amount of credit available in the local currency on this letter
of credit or export credit guarantee.

10. The Lock, Exchange Rate, and Base Value fields indicate the amount of credit available based on the
exchange rate and whether the rate is locked for the letter of credit. These values display for your information.

11. The Terms fields displays the AR payment terms you have agreed upon with the selected customer for using
with the letter of credit.

12. The Issue Date, Valid From Date, and Valid To Date fields define the time period during which this letter
of credit is active. If you need, you can change these date values.

13. If you must stop placing transactions against this letter of credit, select the Inactive check box. Indicate why
the letter of credit is closed from the Inactive Reason drop-down list.

14. You use the Additional Data sheet to enter optional receiving information like Free On Board, Place of
Loading, and so on.

15. Use the Comments sheet to enter additional text you want to include about the letter of credit.

16. When you finish, click Save.

Closing Letters of Credit

Use the Letter of Credit Closing Process to close any open letters of credit that no longer have open orders or
invoices placed against them and are past their Valid To Date.

Menu Path: Financial Management > Accounts Receivable > General Operations > Letter of Credit Closing
Process

To close any current open letters of credit:
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1. Click the Schedule drop-down list to indicate when you want the process to run. In this example, you select
Now, indicating the process runs immediately. If you select a different schedule, you can set up this process
to run using a regular, automatic schedule.

2. When you select a schedule other than Now, the Recurring check box activates. Select this check box to
indicate the process runs automatically. For more information, review the Automatic Data Processing chapter
within the Epicor ERP Implementation Guide.

3. If you only want to close letters of credit with specific customers, click the Filter tab; find and select the
customers you wish to include in the process.

4. The Customer(s) section indicates if all or some customers are selected.

5. When you are ready to run the process, click the Submit button.

Any letters of credit that no longer have open orders or invoices placed against them and are past their Valid To
Date are closed.

AR Invoice Entry

Use Accounts Receivable Entry to bill customers for products and services a company sells. Revenue and the
corresponding AR values for shipped products do not update the general ledger (GL) until an invoice is created
and posted.

Before you can create or generate AR invoices, you need to set up entry groups, sometimes called batches. Entry
groups define the default transaction dates and apply dates for all invoices created within the group.

When you finish defining your group, you can then enter invoices within the group. You can create several types
of AR invoices:

• Miscellaneous Invoice – A regular invoice that may or may not be linked to a sales order. Unless you use
Advanced or Deposit Billing, you usually select this invoice type for manually created invoices. A miscellaneous
invoice can also be created for tax purposes only or be designated as a recurring source invoice to use as a
template for other recurring invoices.

• Shipment – Invoices generated by the Get Shipments program. These invoices are linked to a customer’s
packing slips.

• Advanced Billing – Also called Progress payments, these records are customer payments you request when
you have not sent out a shipment. You choose whether the billing amounts credit sales or deferred revenue
accounts.

• Deposit Billing – A customer down payment or prepayment. You receive deposit billings as prepayments
against a sales order.

• Credit Memo – A transaction that reduces, or credits, a customer’s receivable balance. Credit memos do not
have to be linked to a sales order.
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• Advanced Billing Credit Memo – A credit memo created to reduce an Advanced Billing invoice.

• Deposit Billing Credit Memo – A credit memo created to reduce a Deposit Billing invoice.

When you finish entering each invoice’s header, you then finish the invoices by adding detail lines, miscellaneous
charges, commission information, and other details. You complete the invoicing process by posting the entry
group to the General Ledger. These invoices are then committed to the financial records for the fiscal period.

AR Invoice Entry – Groups

You begin the AR Invoice Entry process by creating an entry group. You can then create or generate invoices
that are processed through this entry group.

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry

To create a new entry group:

1. Click the New button on the Standard toolbar.

2. In the Group field, enter the identifier for the entry group. Entry groups can use any combination of letters
or numbers.

Some users enter specific numbers to easily find invoices
during an audit, while others use the employee name or
a date to organize the groups. After you post the group,
you may reuse this identifier.

3. Define the Invoice Date for the group. This value is the default date that is used for all invoices within this
entry group.
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4. Define the Apply Date for the group. This value is the date when you post journals created from the
transaction.

5. The Base Total field displays the total amount due from invoices contained within this group in the company’s
main, or base, currency.

6. Once invoices are created for the group, they will display in the Invoices grid.

7. When you finish, click Save.

You are now ready to add invoices to your new entry group.

AR Invoice Entry – Header

You create invoices by first selecting the invoice type from the New menu. You then enter the invoice’s main
information on the Header sheet. Here’s how:

1. Click the Down Arrow next to the New button; select New Miscellaneous Invoice (or whatever invoice
type you need).

2. Invoice numbers are auto-assigned by the application. The Invoice field displays the next available invoice
number, and the following field displays the invoice type.

Depending upon the invoice type, you enter different
values on the Header sheet. This example creates a
Miscellaneous invoice.
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3. Select the Document Type from the drop-down list to identify the document type for the invoice transaction.
The default comes from Customer Maintenance.

4. AR Invoices may be set up to automatically print using the Business Process Management (BPM) Designer.
Once defined, the Auto-Print Ready field flags the invoice for automatic printing or print preview. To learn
how to create and activate BPM events, read the Epicor ICE Tools User Guide or application help.

If you want to manually assign a legal number to this
invoice, click the Actions menu and select Legal Numbers
> Assign Legal Number. Legal numbers can also be
generated at the time the external document is printed.
A legal number specifies a unique identifier for the
transaction.

5. When the Ready To Calculate check box is selected, sales taxes are calculated against the AR invoice when
it is saved. This check box can be automatically selected by default through the Company Configuration
program.

6. When the Use Alt Bill to for Taxes check box is selected, an alternative Bill to address is used for this
invoice for tax purposes.

7. If this invoice is for payment on a sales order, enter or search for and select the Sales Order.

Continue on to the AR Invoice Entry - Header (Continued) topic to complete the remainder of the Header fields.
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AR Invoice Entry – Header (Continued)

1. Notice the Fiscal Year, Period, Shipment Date, Invoice Date, and Apply Date values. These dates are
determined by the defaults and linking set up in the Invoice Dates Set Up section of Company Configuration.
If you need, you can change the Invoice Date and Shipment Date values.

2. To prevent this invoice from being posted, select the Hold Invoice check box. This indicates the invoice
cannot be posted until you clear this check box.

3. From the Sold To field, enter or select the customer who purchased the goods or services. If you want to
use this location as the address on the invoice, select the Print Sold To Address check box. If this check
box is clear, the customer’s Bill To location is used on the invoice’s address.

4. The Bill To section displays the billing address for the selected customer.

5. The Line Amounts field displays the subtotal of the line amounts from this invoice. This amount is the total
from the current invoice’s detail lines.

6. The Less Adv. Billed field displays the amount, if any, that this customer has paid through advanced billings.

7. The Tax field displays the total amount of sales tax owed on this invoice.

8. The Less Prepaid Deposits and Less Cash Deposits fields display deposit amounts subtracted from the
Invoice Total amount.

9. The Rounding field displays the rounding value for the invoice.
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10. The Total field displays the amount this customer owes on the invoice. This amount is calculated by adding
together the line amounts and the tax, and then subtracting the advanced billing and deposit amounts.

11. The PO field displays the customer’s purchase order linked to this invoice. The PO from the sales order is
shown, but you can change this value.

12. The Terms field defines the conditions under which this customer pays on the invoice. The value selected
on the customer record displays, but you can select a different terms record from the drop-down list.

13. The Payment Method field defines the type of payment method used by this customer. For example,
payment methods can be Check or Electronic and Payment Instruments payment methods typically are
Generated or Received types.

14. To designate this invoice as a recurring source invoice, select the Recurring  check box and select a Cycle
Code to define how recurring invoices will be generated and their billing cycles.

You can update some of the fields brought in from the cycle code in the Header > Recurring sheet.

15. When you finish, click Save.

AR Invoice Entry – Line

AR invoice lines detail the specific part, quantity, and price for each item sold to the customer. Use the Line >
Detail sheet to both create and edit invoice lines for the current invoice.

To add a new detail line:

1. Click the Down Arrow next to the New button; select New Line.
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2. The Line > Detail sheet displays. The sales order selected on the header appears in the Sales Order field.

3. If this line is created for a sales order, enter or search for and select the SO Line/Rel identifier to define the
sales order line and release that is associated with it.

4. Information from this detail line displays. The middle section of this sheet displays the Part/Rev, Description,
Group, Customer Part, and PO information. If you need, you can change these values.

5. The Quantity field displays the number of items this customer is purchasing. If you need, you can change
this value.

6. The Unit Price field displays the price per unit at which you sell this part.

7. The Price Per field displays the part quantity that is used to multiply against the unit price. Available options:
Each, 100, 1000.

8. The Discount % field indicates the discount rate multiplied against the detail line; the Discount Amount
field indicates the amount that is subtracted from this line’s Total.
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9. The Extended Price field displays the total extended gross price for the line. This amount is calculated by
multiplying the Quantity against the Unit Price.

10. The Less Discount field displays the Discount Amount calculated for this line. This amount is subtracted
from the line Total.

11. The Miscellaneous field displays the total amount of miscellaneous charges placed against this invoice line.
This amount is added to the line Total.

To learn how to add miscellaneous charges to a detail
line, read the AR Invoice Entry – Miscellaneous Charges
section later in this chapter.

12. The Less Advance Billed field displays the total advanced billing amount that is reducing this invoice line
Total.

13. The Tax field displays the total sales tax amount that is levied against this invoice line.

14. The Total field displays the final line amount charged to this customer. This value is calculated by adding
the Extended Price, Miscellaneous, and Tax amounts, and then subtracting the Less Discount and Less
Advance Billed amounts.

You can quickly review and edit an invoice’s primary
information on the Summary sheet. This sheet displays
both invoice header and detail line information. You can
then use this sheet to edit some items on the invoice.
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15. If a tax liability has been identified for the invoice line, select a Tax Liability option from the drop-down
list.

16. If the line is explicitly exempt from taxes, enter a reason for the exemption within the Tax Exempt field.
This prevents AR Invoice Entry from calculating taxes against the line.

17. If the salespeople selected on the Commission sheet receive commission from this detail line, select the
Commissionable check box.

18. When you finish, click Save on the Standard toolbar.

AR Invoice Entry – Miscellaneous Charge

Use the Miscellaneous Charge sheet to create or edit miscellaneous charges added to the detail line’s total
amount. Miscellaneous charges are always linked to specific detail lines. Miscellaneous charges are created
through Miscellaneous Charge Maintenance. To learn about this program, review its topics within application
help.

To add a miscellaneous charge to an invoice:

1. Click the Down Arrow next to the New button; select New Line Misc Charge.

2. The Line > Misc Charge sheet displays. Click the Charge field and select a charge from the drop-down
list.

3. In the Amount field, enter the charge amount. Some miscellaneous charges have a default amount, but if
you need, you can change this value.

4. When you finish, click Save on the Standard toolbar.

The miscellaneous charge is now added to the total price of the line. You can view this additional price on the
Miscellaneous field within the Line > Detail sheet.
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AR Invoice Entry – Credit Memo

You create credit memos through AR Invoice Entry.

A credit memo is a transaction that reduces, or credits, the balance that a customer owes your company. A credit
memo can be an amount you apply to the customer’s overall balance; you can also apply a credit against a specific
sales order detail line.

To do this:

1. Click the Down Arrow next to the New button; select New Credit Memo.

2. The Header > Detail sheet displays. Notice the Credit Memo graphic displays.
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3. To link a sales order to the credit memo, enter or find and select the Sales Order.

4. If you wish to link this credit memo to a specific invoice, enter or find and select the Ref. Invoice.

5. The Fiscal Year, Period, Shipment Date, Invoice Date, and Apply Date values display, determined by
the defaults and linking set up in the Invoice Dates Set Up section of Company Configuration. If you need,
you can change the Invoice Date and Shipment Date values.

6. In the Sold To area, enter or find and select the Sold To Customer you need.

7. If you need, you can select different payment terms from the Terms drop-down list.

8. To finish the credit memo, you must add at least one detail line to it. Click the Down Arrow next to the
New button, and select New Line. Follow the steps in the AR Invoice Entry – Line section to add a detail
line.

9. After you finish entering the line information, click Save on the Standard toolbar.

AR Invoice Entry – Adjust Sales Accounts on Miscellaneous Invoice Lines

The sales of products or services often need to be placed within different sales accounts. AR Invoice Entry contains
the functionality to override the default sales account within each AR invoice miscellaneous line. If it is necessary
to record the sale of the goods or services within a different account, select the sales account you require.

To update the default sales account on a miscellaneous AR invoice line:
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1. Select the Group > Detail sheet.

2. From the Invoices grid, select the invoice for which you want to adjust the account.

355Epicor ERP | 10.0.700

Customers and Accounts Receivable | Chapter 7Epicor ERP Application User Guide - Part Two



3. Select the Line > Detail sheet.

4. At the bottom of the sheet, the GL Account fields populate with the default book and sales account.

5. Change the account in the Account field as necessary.

6. Click Save on the Standard toolbar.

AR Invoice Entry – Get Shipments

The Get Shipments program is a key feature within AR Invoice Entry. You use this program to create invoices
directly from packing slips. When you run this program, one or multiple invoices are created for each customer
that has packing slips selected as shipped. You select this check box within Customer Shipment Entry.

You define how Get Shipments generates invoices within Customer Maintenance. If the Consolidated Invoice or
Combine Packing Slip check box is selected on the customer record, a single invoice may be created that contains
multiple packing slips. If these check boxes are clear, however, one invoice is created for each packing slip. The
application also uses the customer’s Billing Frequency settings to decide whether to generate an invoice during
each Get Shipments session.

To generate invoices, these packing slips must also have a
Shipment Date either equal or before the entry group’s Invoice
Date. To learn more about entering packing slips, review the
Shipping and Receiving chapter.

To run this program:
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1. Click the Actions menu, highlight the Get submenu, and select Shipments.

2. The Get Shipments window displays.

3. Notice you can filter the packing slips so they are only pulled from the Current Site or All Sites.

4. To only pull packing slips for a specific customer, click the Customers button, and then find and select the
customer you want.

5. To review the packing slips, click the Manual Selection button.

6. The Packing Slip Browse window displays.

7. Select the packing slips you wish to invoice. You are now ready to generate the invoices.

8. Click OK.

9. Select Yes to the confirmation message that displays.
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The invoices are created within the group. The Shipment type is displayed on all invoices generated through this
process. The packing slip information is placed in corresponding areas within the new invoices. Header information
is placed on the invoice header; all packing slip detail lines become detail lines on the new AR invoices.

Within Customer Shipment Entry, these packing slips also have
their Invoiced check boxes selected. You can no longer make
changes to these packing slips. If you delete the invoice,
however, its corresponding packing slip is reset to Not Invoiced
and then you can make changes to it.

AR Invoice Entry – Get Recurring Invoices

Use commands in AR Invoice Entry to re-create invoices automatically based on specific parameters. If you have
invoices for the same products or services which occur on a specific schedule, you can create new invoices based
on a recurring source invoice. This functionality is only used for Miscellaneous Invoices.

To designate an invoice as a recurring source invoice, select the Recurring  check box and select a Cycle Code
in AR Invoice Entry to define how recurring invoices will be generated and their billing cycles.

You can also use the Generate Recurring Invoices process to generate AR recurring invoices from a recurring
source invoice. Using this process is helpful if you have a high volume of recurring invoices.

1. From the Actions menu, select Get > Recurring Invoices.

2. The Get Recurring Invoices window displays.

3. You can filter for which Cycle Codes and Customers you want to generate invoices.
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4. Click Manual Selection to select from a list of all recurring source invoices available.

5. The Invoice Browse window displays with a list of invoices.

6. Select the invoices you want from the Invoices grid.

7. Click OK.

8. Click Yes in the confirmation window to the message that displays.

New invoices are created from the selected recurring source invoices. Each new invoice is a copy of the recurring
source invoice, including comments, charges, commissions, GL accounts, and other information.

If necessary, you can change the data that pulls from the recurring source invoice into the recurring invoice.
If the Copy Latest Invoice option is selected on the recurring source invoice, the details will be copied from
the latest posted recurring invoice for that recurring series of the recurring source invoice.

AR Invoice Entry – Cancel Invoices

Use commands in AR Invoice Entry to cancel invoices that contain errors. When you cancel an invoice, the
application creates a credit memo that reverses the invoice’s lines and taxes.

To cancel an invoice:

1. Click the Actions menu and select Create Cancellation Invoice.
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2. The Create Cancellation Invoice window displays.

3. Enter or find and select the Legal Number to specify the invoice to cancel. The legal number is the unique
number assigned to identify this transaction. If legal numbers are not implemented, the application selects
the invoice number entered in this field.

4. Use the Invoice Date field to specify a date for the new credit memo.

5. In the Document Type field, use the drop-down list to select the document type for the credit memo.

6. Click OK.

7. Click Yes to the confirmation message.

AR Invoice Entry – Correction Invoices

To correct an invoice or credit memo, create a correction invoice:

1. Click the Actions menu and select Create Correction Invoice.
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2. The Create Correction Invoice window displays.

3. Enter or find and select the Legal Number to specify the invoice for correction. The legal number is the
unique number assigned to identify this transaction. If legal numbers are not implemented, the application
selects the invoice number entered in this field.

4. If necessary, use the Invoice Date field to set the date on the correction invoice.

5. In the Document Type field, use the drop-down list to select the correction invoice document type (for
example, Accounts Receivable Invoice, or Credit Memo).

6. Click OK.

7. Click Yes to the confirmation message.

AR Invoice Entry – Copy Invoices

To copy an invoice or credit memo:

1. Click the Actions menu and select Copy Invoice Lines.
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2. The Copy Invoice Lines window displays.

3. Enter or find and select the Legal Number to select the invoice that contains the error.

4. Select the Reverse Sign check box to create the selected item or items as an adjusting entry.

5. Select the lines included in the adjustment from the Invoice Lines grid.

6. Click OK.

7. Click Yes to the confirmation message.

The application adds the lines to the selected invoice. Taxes on the line are recalculated based on effective rates.

AR Invoice Entry – Get Deposit Payments

You can convert a deposit payment entered in Cash Receipts Entry to deposit invoices. A deposit invoice is created
based on the payment and is completely paid at the time of creation. When you enter a deposit invoice manually,
the invoice must be linked to a sales order. A deposit payment you convert to a deposit invoice does not have
to be linked to a sales order.

To convert a deposit payment to a deposit invoice:
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1. Click the Actions menu, highlight the Get submenu and select Deposit Payment.

2. The Get Deposit Payments window displays.

3. Click Manual Selection.

4. The Deposit Payments Browse window displays.

5. Select a check number from the Deposit Payments grid.

6. Click OK.

7. Select Yes to the Are you sure? message.

The invoice now displays in the Invoices grid.

AR Invoice Entry – Print a Selected Invoice

To print a hard copy of the selected invoice by using a command on the Actions menu:
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1. Navigate to the Group > Detail sheet.

2. Select an invoice you wish to print from the Invoices grid.

3. Click the Actions menu, highlight the Invoice submenu, and select Print Invoice.
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4. The Print Invoice window displays. Notice the selected invoice’s number appears in the title bar.

5. Select the Assign Legal Number check box to generate a legal number for the printed document.

6. Optionally, you can change the printing options. Options include Transactions, Document Types, and
Print Status.

7. Click Print. The selected invoice is sent to your printer.

AR Invoice Entry – Print Multiple Invoices

To print all invoices currently in a group, use a command on the Actions menu:

1. Click the Actions menu, highlight the Group submenu, and select Print Invoices.
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2. The Print Group window displays. Notice the selected group’s number appears in the title bar.

3. To generate a legal number for the printed document, select the Assign Legal Number check box.

4. If necessary you can change your printing options. Options include Transactions, Document Types, Print
Status, Range Filters, and Invoice Status.

5. Click Print. The group’s invoices are all sent to your printer.

AR Invoice Entry – Post Invoices

To complete the AR Invoice Entry process, you post the group’s invoices to the AR Accounts within your General
Ledger. When an entry group is posted, the transactions update each customer’s accounts receivable information.

After you post the invoices, you can no longer delete them. A limited number of fields can be updated via Posted
Invoice Update. If you post an invoice in error, you can enter an offsetting transaction.

To post an invoice group:

1. Click the Actions menu, highlight the Group submenu, and select Post.

A message may display indicating the Ready To Calculate
field should be enabled. For more information, review
this topic within application help.
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2. The AR Invoice Post Process window displays.

3. Click the Submit button on the toolbar. If the application could not post any invoices, an error message
displays.

4. You can view the errors on the Posting Log sheet. To display this sheet, click the Group tab and the Posting
Log tab. Correct the posting errors on the invoices. After you correct the errors, post the group again.

Void Pre Numbered Forms

A folio is a set of preprinted documents or checks that use numbers defined in Legal Number Maintenance. If
necessary, you can use the Pre Printed Forms program to void specific numbers applied to the documents or
checks. Voiding the folio allows the continued use of the sequence that contains the number.

Menu Path: Financial Management > Accounts Receivable > General Operations > Void Legal Numbers

To void numbers in pre-printed folios:

1. Enter or search for the Legal Number that identifies the sequence that contains the spoiled numbers.

2. You can select Prefix and Site identifiers to select the correct sequence.
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3. Use the From Legal Number and To Legal Number fields to specify the numbers included in the void.

4. Enter a Reason to describe why you are voiding the folio.

5. Click Void and click OK to any confirmation message that displays.

Payment Instruments

Payment instruments are financial transaction methods used in different localities. Examples of payment instruments
include Promissory Notes and Post-Dated Checks. You run the Payment Instrument functionality to track each
instrument, from initial generation or receipt to clearance or settlement.

Payment Instrument Type Maintenance

Use Payment Instrument Type Maintenance to define payment instrument types and some available default
behavior. Examples of common types are promissory notes and future dated checks. Payment Instrument Type
Maintenance has group panes for both Accounts Receivable and Accounts Payable. The applicable pane is enabled
based on your selection in the Use In field on the Detail sheet.

Menu Path: Financial Management > Accounts Receivable > Setup > Payment Instrument Type

To create a payment instrument type:

1. Click New on the Standard toolbar.

2. Enter the payment instrument Type.

3. Enter the payment instrument Description.

4. In the Use In field, select AR for this example.
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5. This enables the Accounts Receivable pane.

6. If AP is selected, the Accounts Payable pane is enabled instead.

Refer to the Accounts Payable chapter for additional
information on Payment Instrument Payables.

7. In the Initiation field, select an appropriate initiation option.

8. Select the Customer Bank Required check box if customer bank details are required.

9. In the Company Bank ID field, select a bank account.

10. In the First GL Update Stage field, select the stage that updates the GL.

11. Click Save.

Payment Instrument Status Maintenance

Use Payment Instrument Status Maintenance to define the statuses available for each of the payment instrument
predefined stages.

Menu Path: Financial Management > Accounts Receivable > Setup > Payment Instrument Status

To enter a payment instrument status code:

1. Click New on the Standard toolbar.

2. Enter the Status identifier.

3. Enter the status Description.

4. In the Use In field, select AR.

5. In the Stage field, select an option depending on which stage the payment instrument is in.

6. Click Save.
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7. Click the Down Arrow next to the New button; select New GL Control.

8. Select the GL Control > Detail sheet.

9. Find and select an applicable payment instrument Type.

10. Find and select an applicable Control.

11. Click Save.

Payment Instrument Batch Generation

Use Payment Instrument Batch Generation to generate a batch of payment instruments, or a single payment
instrument. You can create a payment instrument for each customer/invoice due date combination within an
entry group. You can also print and post the batch of payment instruments generated.

Batch Payment Instrument

Menu Path: Financial Management > Accounts Receivable > General Operations > Payment Instrument Batch
Generation

To create a batch of payment instruments:

1. Click the Group button to find and select the entry group from which you want to create payment
instruments.
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2. Click the Actions menu and select Batch Generate Payment Instruments.

3. The Batch Generate Payment Instruments window displays.

4. Select the invoice Cut Off Date.

5. Select the PI Status.

6. If the batch is for a specific payment method, select the Filter sheet.

7. Click the Payment Method button to select a payment method.

8. Click OK.

9. Click the Actions menu and select Post.

10. Select Yes to the confirmation message that displays.
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Single Payment Instrument

Menu Path: Financial Management > Accounts Receivable > General Operations > Payment Instrument Batch
Generation

To create a single payment instrument:

1. Click the Group button to find and select the entry group from which you want to create payment
instruments.

2. Click the Actions menu and select Generate Single Payment Instrument.

3. The Single Generate Payment Instruments window displays.

4. Click the Customer button to select a customer.

5. The open invoices not associated with other payment instruments display in the Invoices grid.

6. Select the PI Status and PI Type.
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7. Select one or more invoices from the Invoices grid.

8. Click OK.

9. Click the Actions menu and select Post.

10. Select Yes to the confirmation message that displays.

Payment Instrument Receivables Entry

You can use Payment Instrument Receivables Entry to track repayment of instruments used to pay customer
invoices. Use this program to track and control credit control for promissory notes, post-dated checks, and other
future-dated payment instruments. Receivable instruments result in the deposit of funds allocated to AR invoices.

Menu Path: Financial Management > Accounts Receivable > General Operations > Payment Instrument

Payment Instruments - Group

To create a payment instrument group:

1. Click New on the Standard toolbar.

2. In the Group field, enter the identifier for the payment instrument group.

3. Use the PI Status drop-down list to specify the appropriate AR payment instrument status to apply to the
group.

4. If necessary, change the Transaction Date field to set the transaction date for payment instruments that
belong to the group.
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5. When you finish, click Save.

Payment Instruments - Header

Use the Header sheet to define a payment instrument. Fields on the sheet define the customer, bank accounts,
and currency for the transaction.

To create an instrument:

1. Click the Down Arrow next to the New button; select New Payment Instrument.

2. In the Type field, select one of the instrument types created in Payment Instrument Type Maintenance.

3. Enter the Payment Instrument ID and Description to identify the payment instrument.  

4. Use the Transaction Date field to change the transaction date for the instrument.

5. Use the Issue Date field to change the issue date for the instrument.

6. Enter the Amount paid on the payment instrument.

7. Enter or find and select the customer’s identifier in the Cust ID field.

8. Change the instrument’s due date, if needed. The application uses the entry in the Due Date field and the
terms associated with the selected customer to determine the payment schedule.

9. Use the Currency field to change the currency applied to instrument amounts. This field is only enabled if
the company bank account is not defined. Otherwise, the bank account currency displays.

10. Select a different Bank Account in the Company’s Bank Info area if needed. This entry determines the
account to which payments are deposited.
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11. Enter or find and select a Bank in the Customer’s Bank Info area if needed. By default, the field displays
the bank associated with the selected supplier. This entry determines the account from which payments are
withdrawn.

12. You can use the Info sheet to supply a customer or company address specific to the instrument. Default
information in this sheet originates in Customer Maintenance and Company Maintenance.

13. When you finish, click Save.

Payment Instruments – Bank Fees

Use the Bank Fee sheet to enter bank fees that apply to the instrument.

To enter bank fees:

1. Click the Down Arrow next to the New button; select New Bank Fee.

2. Enter the Bank Fee that applies to the instrument.

3. Enter the Bank Fee Amount in the currency of the payment instrument.

4. In the GL Account fields, enter the appropriate GL Book and Account information.

5. When you finish, click Save.

Payment Instruments – Invoice Selection

Use the Invoice Selection sheet to select the invoices to which the instrument amount is allocated. You can
allocate the amount of the instrument to one or more invoices. You can also use the Allocate and Detail sheets
to adjust and review invoice information.

To do this:
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1. Select the invoices in the Invoices grid to which the payment applies.

2. You can select all the invoices by clicking the Select All button.

3. The Unapplied Amount field displays the payment instrument amount that has not been distributed. This
field recalculates automatically.

4. The Amount Selected field displays the total amount on the selected invoices.

5. After selecting the invoices, click Apply, which applies the instrument amount to all the selected invoices.

6. Click the Allocate tab to view the selected invoices. You can use this sheet to delete selected invoices or
make amount adjustments.

7. Select an invoice from the Invoices grid for which you want to make additional adjustments.

8. If needed, enter a new amount in the Transaction Amount field of an invoice.
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9. Click the Detail tab. You can use this sheet to view additional invoice information.

10. If needed, enter a new amount in the Amount to A/R field to adjust the invoice.

11. When you finish, click Save.

Payment Instruments Status Change

Use Payment Instruments Status Change to change the status of a payment instrument. Movement between
statuses may require a general ledger (GL) journal entry to move the balance if either of the associated stages
has a Posted status and the old and new posting codes are different. As a result, the document type may need
to change and a legal number may need to be created for the change of status.

Details of the reversals are as follows:

• Portfolio to Apply to Bank - Add bank information and payment method.

• Apply to Bank to Portfolio - If the company bank is not defined for the payment instrument type, then
additionally clear the  bank number.

• Portfolio to Unapproved - Ensure any selected options against the invoice showing portfolio items are
reverted.

• Portfolio to Cancelled - Ensure all invoice references are also reversed.

The following status changes must be made through other processes:

• Unapproved to Portfolio - Enter all AR allocations using the entry process.

• Portfolio to Apply to Bank - Add bank information and option for batch reference.

• Any status going to Settled - Use Bank Reconciliation.

Menu Path: Financial Management > Accounts Receivable > General Operations > Payment Instrument Status
Change

To change a payment instrument status:
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1. Click New on the Standard toolbar.

2. Enter an identifier in the Group ID field.

3. Select a Transaction Date.

4. Select a new Status you want to assign.

If you select an Apply to Bank status, you must also make
selections the Bank Account  and Payment Method
drop-down lists.

5. Click the Actions menu and click Select Payment Instruments.

6. The Select Payment Instruments window displays.

7. Make sure the correct Payment Instrument Type is selected.

8. Select the appropriate parameters and filters (Customer Groups, Currency Groups, and Payment
Instrument Status) so the correct payment instruments will display.
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9. Click OK.

10. The payment instruments associated with the entry group display in the Payment Instruments grid.

11. If necessary, select any payment instrument record in the grid and click the Payment Instrument sheet to
view the details.

12. Select the Allocation sheet to select the invoices you want allocated towards the payment instruments in
your entry group.

13. Click the Actions menu and select Post Group. The group posts.

Cash Receipt Entry

You enter customer payments, customer credits, and miscellaneous cash amounts through Cash Receipt Entry.
This process is similar to the AR Invoice Entry process. You create entry groups, enter cash receipts, and post
these transactions to your General Ledger.

You can enter these cash receipt transaction types:

• Invoice Payments - These transactions are entered with basic check information. They include detail lines
that describe how the check is used against the customer's outstanding invoices. These transactions debit the
Cash account and credit the Accounts Receivable account.

• Deposit Payments - These transactions track down payments made against specific sales orders (allocated)
or not linked to a sales order (unallocated). They debit the Cash account and credit the account number you
enter, which is normally a Prepayments liability account.

• Miscellaneous Payments - These transactions track miscellaneous cash received from sources other than
customers; they do not change customer AR balances. They debit the Cash account and credit the account
number you select.
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• Debit Notes - Enter these transactions when a customer requires a payment or invoice deduction. These
transactions create open receivable amounts. Debit notes can be applied as unallocated amounts on a payment.
They can also be linked directly to an invoice, reducing the invoice's total amount due.

You can also create Unapplied Receipts. By selecting the On Account check box, these transactions are
automatically created when you enter a customer payment that is not applied to a specific open invoice or credit
memo.

You can use Apply Credit Memos to assign this amount to
another invoice. You can also use AR Write Off and
Adjustment to adjust the balance. For more information, refer
to the Apply Credit Memo and AR Write Off and Adjustment
topics in the Application Help.

When cash receipts post, they update invoice balances, create GL entries, and update Bank Reconciliation deposit
information.

Cash Receipt Entry - Groups

You begin the Cash Receipt Entry process by creating entry groups. You can then enter the cash receipts that
are processed through this entry group. Entry groups are also called batches.

Menu Path: Financial Management > Accounts Receivable > General Operations > Cash Receipt Entry

To create a new entry group:

1. Click New on the Standard toolbar.

2. In the Group field, enter the identifier for the entry group. Entry groups can use any combination of letters
or numbers.

Some people use specific numbers to make it easy to find
cash receipts during an audit. Others use the employee
name or a date to organize the groups. After you post
the group, you can then reuse this identifier.
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3. Now select the Bank Account you need from the drop-down list. The cash receipts for the group are
deposited within this bank account.

4. The Transaction Apply Date defines the date placed on the cash receipts within the group. The current
date displays by default; if you need, select a different date.

5. When you finish, click Save.

Cash Receipt Entry – Invoice Payments

Typically, you use Cash Receipt Entry to enter customer payments made against specific invoices. You do this by
entering payment information and then selecting the invoices against which this payment is made.

To do this:

1. Click the Down Arrow next to the New button; select New Invoice Payment.

2. In the Check field, enter the number that identifies the check. You can enter the number from the check
or any other reference number.

3. In the Receipt Amount field, enter the amount of the payment.

4. In the Receipt Currency fields enter the currency of the payment.

5. Use the Settlement Currency field to enter the currency of the invoice. The company must be configured
to use currency settlements in order for you to use this field.

6. In the Customer ID field, enter or search for and select the customer who is making the invoice payment.
If the customer’s remittance advice details have given you a number for a paid invoice, enter this number.

7. The Unapplied field displays the current amount not yet applied against an open invoice. You select which
invoices are paid or partially paid through this payment on the Invoice Selection sheet.

8. If you want the program to create a new unapplied entry against the customer for any remaining unapplied
amount, select the On Account check box. If this check box is clear, you cannot enter other payments until
you have allocated the entire Unapplied Amount.
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9. When you finish, click Save.

Cash Receipt Entry – Header Currency

Use the Header Currency sheet when a settlement requires overrides to exchange rates or amounts. You can
override default rates when the bank account currency differs from either the settlement currency, the receipt
currency, or both currencies. Using the currency settlement feature, you can settle an invoice in one currency
paid in a second currency with the payment deposited in a third currency.

To define currency settlement exchange rates and amounts:

1. Use the Settlement Currency field to select a currency for the invoice settlement.

2. Use the Settlement Exchange Rate field (USD -> CAD in this example) to override the default exchange
rate between the bank currency and the settlement currency.

3. The Settlement Amount field displays the value of the payment using the target, or settlement currency.
This value is calculated using the currency selected on the invoice, the rate type, and the active exchange
rate. You can change the amount if you changed the settlement currency in this sheet and the settlement
currency differs from the bank account and the receipt currencies.

4. The Bank Amount field is used to change the amount deposited to the account. You can change the
amount when the amount of the receipt differs from the bank amount. Differences result when the currency
of the receipt differs from the currency of the bank account. 

5. The Bank Receipt Exchange Rate field overrides the bank base rate. You can change the rate when the
currency of the receipt differs from the bank account currency. The rate group selected on the A/R Receipt
> Header sheet and the entry date for the receipt determine the bank base rate.

6. Click Save on the Standard toolbar.

Cash Receipt Entry – Invoice Selection

Use the Invoice Selection sheet to select the open invoices against which this customer’s payment is applied.
When you select a customer on the A/R Receipt > Header sheet, the customer’s open invoices display on this
sheet when the Auto Retrieve option in the Actions menu is enabled.

You can apply this payment against one or multiple invoices.

To do this:
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1. Click the Invoice Selection tab.

2. The customer’s open invoices display within the Invoices grid.

3. If the Auto Retrieve option in the Actions menu is not enabled, click the Retrieve button to retrieve the
customer's open invoices.

4. You can also enter or search for an invoice from the Invoice Number or Legal Number fields.

5. In the Invoices grid, select one or multiple invoices by selecting the Selected check box for each invoice.

6. The steps of this procedure reflect the manual method of invoice selection. For automatic alternatives, you
can use the Automatic Selection button to automatically select the open invoices for a customer until the
receipt amount is allocated, starting with the oldest invoice first.

7. Another method of invoice selection is to use the Select and Apply button to perform automatic allocation
of the payment amount, where the system selects the invoices for allocation using the existing sorting order
and allocation is performed until the Unapplied field value is equal to zero.

8. Enter a payment amount to be allocated against each selected invoice in the Allocated amount field in
the grid.

9. Any applicable discount resulting from the invoice's discount terms displays in the Discount field in the grid
for each invoice. If you do not want a discount applied, you can enter zero or also adjust the amount.

10. If the payment date is beyond discount periods of the terms that apply to the selected invoice, you can force
application of the nearest period's payment discount by clicking Force Discount.

11. If you want to undo your selections, click the Clear All button.

12. Click Apply to confirm that all invoices are applied to the check. The application applies payment amounts
to the selected invoices and moves the invoices to the Allocate sheet.

13. The Unapplied field displays the current amount of the payment not yet placed against an invoice.

14. Click Save on the Standard toolbar.
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Cash Receipt Entry – Allocate

Use the Allocate sheet to modify the amounts paid on the invoices previously selected on the Invoice Selection
sheet. You can also use this sheet to link a payment to a new or existing AR invoice.

For invoices that reflect discounts, a company setting determines how the allocation applies the credit. The
allocation process can charge the credit back to the defined discount accounts or to the selected invoices.

To use these features:

1. Click the Allocate tab.

2. The Check and Settlement Amount values from the A/R Receipt > Header sheet display. If you need,
you can modify these values.

3. If you want the program to create a new unapplied entry against the customer for any remaining unapplied
amount, select the On Account check box. If this check box is clear, you cannot enter other payments until
you have allocated the entire unapplied amount.

4. The Unapplied amount field displays the current payment amount that has not yet been placed against an
invoice.

5. The invoices you selected on the Invoice Selection sheet display within the Invoices grid.

6. If you wish to update the payment placed against this invoice, enter a new amount within the Cust Amount
column.
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7. To allocate amounts to a new or existing invoice, add a detail line to this sheet. To do this, click the Down
Arrow next to the New button; select New Line.

8. A new line displays on the Invoices grid.

9. Enter the invoice number in the Invoice column.

10. Alternately, you can right-click the Invoice column to display its Open With context menu.

11. Select Invoice Search program to find and select the invoice you want to make the payment against.

12. When you finish, click Save on the Standard toolbar.

Cash Receipt Entry – Unallocated Deposit Payments

You can use Cash Receipts Entry to enter customer deposits, or prepayments. You can create deposit payments
as allocated deposits (linked to sales orders), or as unallocated deposits (not linked to sales orders). You can then
convert deposit payments to deposit invoices. Deposit payments you convert to deposit invoices do not have to
be linked to sales orders. Allocated deposits are processed and closed if the full amount has been allocated once
you process a shipment invoice for the linked sales order.

To enter an unallocated deposit payment:

Unallocated deposits can only be created if the Company
Configuration setting for Invoice Deposit Tax treatment is set
to Reverse tax by invoice match.

385Epicor ERP | 10.0.700

Customers and Accounts Receivable | Chapter 7Epicor ERP Application User Guide - Part Two



1. Click the Down Arrow next to the New button; select New Deposit Payment.

2. The Deposit sheet displays.

3. In the Check field, enter the number that identifies the check.

4. Enter the value of the deposit payment in the Amount field.

5. In the Cust ID field, enter or find and select a customer.

6. Enter the Account number that is credited with this deposit amount.

7. Click Save.

Cash Receipt Entry – Allocated Deposit Payments

To enter an allocated deposit payment:

1. Click the Down Arrow next to the New button; select New Deposit Payment.

2. The Deposit sheet displays.

3. In the Sales Order field, enter or find and select the sales order.
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4. In the Check field, enter the number that identifies the check.

5. Enter the value of the deposit payment in the Amount field.

6. When you select the sales order, the Cust ID, Customer Name, Bill To Name, and Sold To Name default
from the order.

7. The Credit GL Account field displays the general ledger book and account number credited with this deposit
amount. A required field, the default is first the customer's GL Control, then the Prepayments account
defined within the Company Configuration program. If you need, however, you can change this account.

To learn more about the Company Configuration
program, review this program’s topics within application
help or review the Company Configuration chapter in the
Epicor ERP Implementation Guide.

8. The Order Value field displays the total amount that needs to be paid on this sales order.

9. When you finish, click Save.

Cash Receipt Entry – Miscellaneous Payments

You can also enter miscellaneous payments through Cash Receipt Entry. These transactions track miscellaneous
cash received from sources other than customers.

You can also enter sales taxes levied against the miscellaneous payment. Both functions are available on the
Miscellaneous sheet.

To enter miscellaneous payments:

1. Click the Down Arrow next to the New button; select New Misc Payment.

2. The Miscellaneous sheet displays.

3. In the Check field, enter a number that identifies the miscellaneous payment.

4. In the Amount field, enter the amount you received.
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5. The Tax Liability field displays the sales tax locality for your company. If you need, select a different liability
from the drop-down list.

6. The Credit GL Account field displays the general ledger book and account number credited with this
miscellaneous payment amount. You can select the book and account number from the drop-down list.

7. When you finish, click Save.

Cash Receipt Entry – Miscellaneous Tax

You are now ready to enter a miscellaneous tax against this miscellaneous payment. To do this:

1. Click the Down Arrow next to the New button; select New Miscellaneous Tax.

2. A new line displays within the Miscellaneous Payment Tax List grid.

3. Click in the Tax ID field, and select a sales tax from the drop-down list.

4. Select the Manual check box if this is a manually entered tax.

5. The percentage used to tax this payment displays within the Percent field.

6. The Taxable Amt field displays the amount you need to tax.

7. The Tax Amt field displays the amount subtracted from this miscellaneous payment.

8. The total tax displays within the Tax field.

9. The Amount Less Tax displays the amount you have received from this miscellaneous payment after the
sales tax is subtracted from the payment.

10. Repeat these steps to add the sales taxes you need. When you finish, click Save.
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Cash Receipt Entry – Post Receipts

To complete the Cash Receipt Entry process, you post the group’s receipts to the AR accounts within your General
Ledger. When an entry group is posted, all of the transactions update your cash receipts information.

When you finish entering cash receipts, you can select the Group sheet to verify you have correctly entered the
cash receipts. You can also view the grand total of the receipts that you record within this group.

To post a cash receipts group:

1. Click the Actions menu and select Post.

2. The Cash Receipt Post Process window displays.

3. Click the Submit button.

4. If any errors occur, they display on the Posting Log sheet. To display this sheet, click the Group tab and
the Posting Log tab. When you correct the errors, post the group again.

After you post the cash receipts, you can no longer edit
or delete them. If you post a receipt in error, you must
enter a Reverse Cash Receipt transaction. To learn more
about the Reverse Cash Receipt program, refer to this
program's topics within application help.
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AR Adjustments

Use AR Write Off and Adjustment to adjust an amount against an open invoice or credit memo. The amounts
you enter through this program increase or decrease the invoice balance. They also create General Ledger entries.

Menu Path: Financial Management > Accounts Receivable > General Operations > Write Off and Adjustment

To use this program:

1. Enter the invoice number directly, or click the Invoice button to find and select it.

2. The invoice’s information, such as Legal Number, Customer, Invoice Date, Amount and Rate, display
in these fields.

3. If necessary, select the Copy Rate check box for the invoice adjustment to use the original invoice exchange
rate. This provides the ability to write off an invoice with a zero gain/loss adjustment.

4. The Date field displays the date on which the adjustment transaction occurs.

5. In the Adjustment field, enter the amount by which you change the invoice amount. This amount can be
either a positive or a negative value, but the adjusted amount cannot exceed the original invoice total.

6. After you enter the Adjustment value, the New Balance field displays what the updated amount is on the
invoice or credit memo.

7. The Fiscal Year and Period fields display the period that contains this date.

8. In the GL Account fields select the general ledger book and account number to be debited with the
adjustment amount.

9. Use the Description field to enter a brief explanation for the adjustment.
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10. If you need to enter a longer explanation for the adjustment, use the Comment field.

11. Select the Taxable Adjustment check box if you want to apply a prorated taxable adjustment to all taxes.

12. When you finish, click Save on the Standard toolbar.

13. The AR Invoice Adjustment Process window displays.

14. Click the Submit.

The invoice or credit memo amount is now changed to reflect the positive or negative adjustment.

Reverse Cash Receipt

Use Reverse Cash Receipt to create a receipt that contains a reversing entry. This negative receipt updates the
balances of allocated invoices. A reversal allows the application of new cash receipts to invoices for which the
original receipt applied. It also reverses journals in books affected by posting of the original receipt.

This process does not apply to miscellaneous cash receipts or deposits applied to an invoice.

Menu Path: Financial Management > Accounts Receivable > General Operations > Reverse Cash Receipt

To reverse a cash receipt:

1. Click the Binoculars button to open the Cash Receipt Search window. Select the receipt you need. You
can use customer, check number, and bank account as search criteria.

2. The details from the selected cash receipt display in the program.
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3. Select a reversal date in the Reverse Date field.

4. The reversal process determines whether unapplied cash exists for the receipt. If so, the Unapplied graphic
appears beside the Unapplied field.

5. Click Reverse.

Reports

This section describes some key reports you use to view information about Accounts Receivable. You can run
these reports whenever you need. You can also set up each report to generate and print through a recurring,
automatic schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for
information on how you link a report to a recurring schedule. 

Aged Receivables Report

The AR Aged Receivables Report displays each customer’s open invoices – sorting them into aging columns. You
can create whatever aging format you need, and then select the format you want on this report.

To learn more about creating aging formats, review the Aging
Report Format Maintenance topic within application help.

Menu Path: Financial Management > Accounts Receivable > Reports > Aged Receivables

To set up and run this report:

1. In the Select By area, indicate how you want this report to select the invoices. Available options:

• Apply Date – Invoices display based on their apply dates.

Epicor ERP | 10.0.700392

Epicor ERP Application User Guide - Part TwoChapter 7 | Customers and Accounts Receivable



• Invoice Date – Invoices display based on their invoice dates - either on or before the Aged As Of date.

2. In the Age By area, define the date from which the aging is based:

• Due Date – Compares the payment Due Date with the Aged As Of date to determine into which aging
column the invoice is placed. This value is the default.

• Invoice Date – Compares the Invoice Date with the Aged As Of date to determine into which aging
column the invoice is placed.

3. The Aged As Of date displays the date used to calculate the aging. The current date displays by default,
but if you need, you can change this date. When you generate this report, its aging columns calculate in
increments based on both the selected aging method and this date.

4. If you need, select the Summary Only check box. When selected, only the totals per customer display on
the report.

5. If you want to run the report for a different reporting currency, select a Target Currency from the drop-down
list.

6. Notice the Filter Summary section. You can filter the records displayed on the report by GL Controls and
Customers. To do this, click the Filter tab and select the GL controls and customers you want to use.

7. You can display the invoices by Sold To location or Bill To location. If you select the Sold To option, the
invoices are shown using the customer location that purchased the shipment. If you select the Bill To location,
the invoices are shown using the customer location paying for the shipment. You can also use the GL Control
and Customer filters to limit the locations displayed on the report.

393Epicor ERP | 10.0.700

Customers and Accounts Receivable | Chapter 7Epicor ERP Application User Guide - Part Two



8. The Aging field defines the aging method used for this report. The method selected within Company
Configuration displays by default, but if you need, you can select a different method.

To learn more about the Company Configuration
program, review this program’s topics within application
help. You can also review the Company Configuration
chapter in the Epicor ERP Implementation User Guide.

9. When you finish, click Print on the Standard toolbar.  

Sales Gross Margin Report

The Sales Gross Margin Report prints Cost of Sales (COS) on invoices created during a selected date range. COS
is the cost of producing the products you sell.

Only amounts from Shipment invoices calculate and display
on this report. You create these invoices through the Get
Shipments program. To learn about this function, review the
AR Invoice Entry - Get Shipments section found earlier in this
chapter.

Menu Path: Financial Management > Accounts Receivable > Reports > Sales Gross Margin

To set up and run this report:

1. In the From field, enter the first date on which this report starts.

2. In the To field, enter the last date used on this report. All invoice lines created on this date back to the From
date displays on this report.
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3. Use the options in the Sort By section to define how this report is organized. Available options include:

• Customer Group – Invoices are sorted first by Customer Group, then by Customer, and lastly by Part.
This option is the default.

• Product Group – Invoices are sorted first by Product Group, then by Part, and lastly by Customer.

4. The Use options define how order based pricing and discounts are calculated for the prices. The Use methods
are:

• List Price – This method displays each item’s price before any order based pricing or discounts are
subtracted from the price.

• Unit Price – This method displays each item’s price after order based pricing is subtracted from the list
price. This price, however, does not include any discounts that can be subtracted from the price.

• Net Price – This method displays each item’s price after both order based pricing and discounts are
subtracted from the original price.

To learn more about how the application handles prices,
review the Pricing and Discounting section within the
Sales Order Processing chapter.

5. If you want, select the Summary Only check box. This option causes the report to only display total amounts.
If this check box is clear, all the invoice details display.

6. If you want to run the report for a different reporting currency, select a Target Currency from the drop-down
list.

7. Notice the Filter Summary section. You can filter the records by Customer Groups, Product Groups,
Customers, and Parts. To do this, click the Filters tab to select the records you want to use on the report.

8. You can display cost information by Sold To location or Bill To location. If you select the Sold To option,
the costs are shown using the customer location that received the shipment. If you select the Bill To location,
the costs are shown using the customer location paying for the shipment. You can also use this report’s
filters to limit the locations that display on the report.

9. When you finish, click Print on the Standard toolbar.
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Chapter 8: Suppliers and Accounts Payable

The Accounts Payable functionality uses billing parameters defined on supplier records and AP invoices to calculate
how much your company owes suppliers.

You set up billing information through two maintenance programs – Purchase Terms Maintenance and Supplier
Maintenance. Use Purchase Terms Maintenance to define the various pay agreements you have with your suppliers.
Supplier Maintenance defines the billing parameters specific to each supplier, like sales tax, payment terms, AP accounts,
and other details.

In the European Union, Value Added Tax (VAT) is assessed on the amount, or value, added to goods and services. Use
Tax Type Maintenance to specify tax types and rate codes to support sales and purchases. Use Tax Liability Maintenance
to enter the locality that will receive a tax amount from an invoice and Product Tax Category Maintenance to classify
different products and services based on taxes.

AP Invoice Entry is the program where you record the amounts you owe suppliers, and the dates on which these
amounts are due. Use this program to create invoices that have a variety of detail lines - Receipt Line, Miscellaneous
Line, Advanced Billing Line, and so on. You then use AP Payment Entry to pay these invoices. You can either pay
suppliers through a check or an electronic payment. When you post these payments to your General Ledger, you
complete the payment cycle.

Additional payment functionality is also available. You can create logged AP invoices you save within an expense
account for accrual purposes. These invoices stay in this account until approved and paid. You can also track payment
instruments you need to apply to supplier invoices at a later date. Use this functionality to track and credit control
promissory notes, post dated checks, and other future-dated payment instruments. Two key reports can help you
review your payments. The AP Aged Payables Report displays open AP invoices by sorting them into aging columns.
The Received Not Invoiced Report displays shipments sent to you, but you currently have not yet created invoices for
these shipments.

When you fully leverage this set of financial tools, you accurately calculate the expenses for the materials and services
used by your company.

Setup

This section describes the primary records you need to create for the Accounts Payable module. These programs
are contained within the Setup folder for this module. Only the primary records are described here. Some areas
within the next Operations section may also document setup records if they are required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration. You can also review the
Company Configuration chapter in the Epicor ERP Implementation Guide.
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Purchasing Terms

Purchasing Terms Maintenance defines terms that govern the frequency, number of payments, and discounts
that apply to supplier invoices. The supplier’s terms apply to payments the company sends to the supplier.
Optionally, you can calculate the best discount for a specific term.

Menu Path: Financial Management > Accounts Payable > Setup > Purchasing Terms

To create terms applied to AP invoices:

1. Click New on the Standard toolbar.

2. In the Code field, enter the unique identifier for the term.

3. Enter a Description for the payment term. This description is printed on AP invoices and other external
documents.

4. Enter the Number of Payments that can be made against an invoice during a payment cycle. If this number
is more than one, any invoice assigned these terms is paid through multiple payments.

5. Click the Terms Type drop-down list to select the billing schedule associated with the term. Schedule
options include Days, Day of Month, and End of X Month(s) plus Y day(s).

6. If you want these terms to be the default on new supplier records, select the System Default check box.

7. What you select in the Terms Type field determines which fields are available in the Due area. Based on
the terms type, the following fields are available:

• Number of Days - This value defines a schedule based on periodic payments. The application adds the
number of days entered in this field to the invoice date to obtain the due date.

• Due on Day and Minimum Days - These values define a schedule based on monthly payments. The
application uses the Minimum Days value to move a billing to the next month when the invoice date
occurs close to the Due on Day value and the Day value identifies the day of the month for which the
payment is due.
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• Number of Months and Due on Day - These values define a schedule based on payments after the
specified Number of Months plus the specified number of days (Due on Day). When a payment passes
this date threshold, the application considers it as late.

8. Click the Discount Type drop-down list to select the discount schedule associated with the term. Discounts
can be applied based on a number of days, a day of the month, or both (End of X Month(s) plus Y day(s)).

9. Select the Apply Discount When Paid in Full check box to only calculate discounts against invoices that
are fully paid.

10. Use the Discounts sheet to define discount terms.

11. When you finish, click Save.

Recurring Cycle Maintenance

Use Recurring Cycle Maintenance to set up recurring cycles that define how recurring invoices will be generated
and their billing cycles. You can create a recurring cycle and attach it to a recurring source invoice. A recurring
source invoice is an invoice that is also used as a template from which recurring invoices will be generated.

Menu Path: Financial Management > Accounts Receivable > Setup > Recurring Cycle

To create a recurring cycle:

1. Click the New button on the Standard toolbar.

2. Enter a unique identifier in the Cycle Code field.

3. Enter a Description of the cycle code.

4. In the Module field select a module in the Epicor application for which the recurring cycle will be available.
Options include:

• AP

• AR

• Both
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5. Use the Interval field to indicate the length of time to use with the Modifier.

6. Use the Modifier field to indicate how often the Interval will be applied to create recurring invoices. Options
include:

• Days

• Weeks

• Months

7. In the Billing Day field, specify the day of the week or month on which the recurring invoices will be
generated.

This value is populated dynamically based on the Modifier field.

8. In the Duration field, specify how many times the recurring invoice will be created.

This value includes the recurring source invoice. Once the duration is reached for a recurring invoice, the
Inactive option will be set on the recurring source invoice.

If the Maximum Value check box is selected, the
Duration field is disabled and a Maximum Value entry will
be required on the recurring source invoice.

9. Click Save.

Supplier Maintenance

Supplier Maintenance defines payment terms, sales tax, and other supplier-related settings.

You can also use Supplier Maintenance to enable EFT processing for AP payments to the supplier. This involves
specifying bank account and payment method information for each bank to which you send EFT payments for
the supplier.

Menu Path: Financial Management > Accounts Payable > Setup > Supplier
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Supplier Maintenance - Language, Tax and General Information

You enter the language, tax, billing and credit information for each supplier on the Supplier > Detail sheet. To
enter supplier name, language and tax information:

1. Click New on the Standard toolbar.

2. In the Supplier field, enter a unique identifier for the supplier.

3. In the Name field, enter the supplier’s name. This value helps users select the correct supplier when they
enter a transaction.

4. Click the Currency drop-down list to select the default currency for the supplier. This currency defines the
amounts calculated on purchase orders, invoices, and other transactions linked to this supplier.

5. Click the Language drop-down to select the language used by the supplier. This value determines the
language used on reports and documents sent to the supplier.

6. In the Tax Liability field, enter your company’s tax liability when trading with this supplier. The final taxes
and rates used in a transaction are calculated by combining the tax liability and the supplier’s tax exemptions.

7. The Tax Authority field specifies the geographical area associated with the supplier.

8. In the Tax ID field, enter the supplier's tax identifier. This number either prints on the supplier’s 1099 forms
in the United States or is used for the VAT number in Europe.

9. Select the Hold Payments check box to stop payments to this supplier. This supplier is no longer available
during check processing in Payment Entry.
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Enter General Supplier Information

To enter general information for the supplier:

1. Optionally, in the Supplier Information section, use the Acct Ref field to enter the reference number for
the company’s account with the supplier.

2. In the Country Entry field, enter the Intrastat code for the area or city used as the entry point for goods
shipped from this supplier. You can also leave this field blank to use the value for Border Crossing defined
in the Country record.

3. Enter the production calendar used by the supplier in the Calendar field. The selected calendar indicates
the work schedule for the supplier’s company.

4. If necessary, use the Group field to link the supplier to a group code. Groups divide your supplier base
through any criteria you need; you can then sort suppliers by group on various reports. You create groups
through Supplier Group Maintenance.

5. The Terms field specifies the payment terms used by the supplier. The term you define indicates the default
payment schedule and discount terms applied to this supplier’s invoices. Refer to the Purchasing Terms
section earlier in this chapter for additional information about these records.

6. Click the FOB drop-down list to select the free on board location for this supplier. This location indicates
the point at which title of the shipped goods changes from the supplier to your company.

7. In the Minimum Order Value field, enter the lowest total quantity amount allowed on purchase orders
placed with this supplier. Enter a value in this field to prevent purchase orders with small amounts from
being created for this supplier.
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8. Click the Payment Method drop-down list to select the default method for remitting payment to this
supplier. For more information about payments, review the Payment Entry sections found later in this chapter.

9. Select the Labels check box to indicate you print shipping labels for this supplier.

10. Select the 1099’s check box to indicate you print 1099 forms for this supplier.

11. When you select the One Invoice per Check option, this supplier only allows one invoice to be paid with
each check. Used during Payment Entry, this option prevents you from selecting multiple invoices on a check.

12. When you finish, click Save.

Supplier Maintenance - RoHS, GL Control and Tax Exemptions

To enter RoHS, GL control and tax exemption information for the supplier:

1. Use the Supplier > RoHS sheet to associate RoHS substance and restriction types with the supplier.

2. Click the Down Arrow next to the New button; select New GL Control.
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3. Use the GL Controls > Detail sheet to select controls that define the accounts to which this supplier’s
transactions post.

4. Click the Down Arrow next to the New button; select New Tax Exempt.

5. Use the Tax Exemptions > Detail sheet to define supplier-granted tax exemptions. This sheet determines
exempt tax categories and tax rates and the periods when the exemptions apply.

For more information on RoHS, GL Controls, and Tax
Exemptions, review the Epicor ERP Implementation Guide.

Supplier Maintenance - Banks

Use the Banks > Detail sheet to define the bank accounts to which supplier payments are deposited. You can
also select the method used to remit payments to the account. You must define at least one account in order to
use payment instruments for each supplier bank.

To add a bank to a supplier record:
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1. Click the Down Arrow next to the New button; select New Bank.

2. The Banks > Detail sheet displays. In the Bank field, enter the unique identifier for the bank.

3. Use the Bank Name, Bank Account, and Bank Identifier fields to give users additional information when
they select accounts in Payment Entry and other programs.

4. Select the Primary Bank check box if this is the primary bank for this supplier. When selected, this check
box indicates that this bank account is the default for all payments sent to this supplier. If you need, you
can override this default account on specific payments.

5. If you need, enter the Bank/Branch associated with the current bank.

6. In the IBAN Account Code field, enter the account number for the bank.

7. Click the Payment Method drop-down list to select the default payment method used to remit deposits
to this account. You can select a payment method that differs from the one selected on the Detail sheet.
However to process EFT transactions for this supplier, select a method that uses an electronic bank interface.

8. Use the fields in the Pay To Information section to enter the information to be printed on remittance
records.

9. When you finish, click Save on the Standard toolbar.
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Operations

This section details the operations available in the Accounts Payable module. Each operation is described as a
workflow to help guide you through the process from start to finish. These programs are primarily found within
the General Operations folder for this module. If a unique setup record is required to run the operation, this
record is also described in this section.

Logged AP Invoices

Logged invoices are a category of AP invoices you create to both record and post to a suspense account. These
invoices remain in this account until you approve and pay them. You create these invoices within Logged AP
Invoice Entry. You later validate these invoices within Logged AP Invoice Approve and Void Entry; you also cancel
a logged AP invoice within this program.

Logged AP Invoice Entry

Use Logged AP Invoice Entry to record and post invoices to a suspense account. You can also use the program
to process debit memos.

When you log an invoice, you can:

• Post the invoice to a supplier account, using the receipt date.

• Post the net amount of the invoice to a logged invoice suspense account.

• Recover applicable taxes for the month the invoice is received.

The Invoice Logging section on the Company Configuration >
Finance > Accounts Payable sheet controls how the application
processes logged invoices.

Menu Path: Financial Management > Accounts Payable > General Operations > Logged Invoice Entry

Logged AP Invoice Entry - Group

You begin the logging process by creating entry groups; groups are used to batch logged invoices. The group
provides the default Apply Date placed on each invoice created within the group; it can be changed on individual
invoices.

To create a new entry group:

1. Click New on the Standard toolbar.
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2. In the Group field, enter the identifier for the entry group. Entry groups can use any combination of letters
or numbers.

3. Click the Apply Date drop-down list to define the default fiscal period to which group invoice transactions
post. The company’s default fiscal calendar determines the values available in the Fiscal Year and Period
fields.

4. When you finish, click Save.

Logged AP Invoice Entry - Header

Use the Header sheet to create an invoice that belongs to the group. To create an invoice:

1. Click the Down Arrow next to the New button; select New Logged Invoice.

2. The Header > Header sheet displays for data entry.

3. Click the Ref PO button to find and select the purchase order you want to associate with the invoice. When
you link a purchase order to an invoice, it helps identify the supplier associated with the PO.

4. For an invoice not linked to a purchase order, enter the supplier’s identifier in the Supplier field. After you
enter this value, the program displays both the supplier’s name and address linked to this record.

5. Use the Invoice field to identify the invoice you want to log.

6. Click the Invoice Date drop-down list to define the entry date for the invoice.

7. Click the Apply Date drop-down list to define the fiscal period in which the invoice posts.   The company’s
default fiscal calendar determines the values available in the Fiscal Year and Period fields.

8. In the Description field, enter the invoice information. This information helps other users identify the invoice
while they process it.
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9. In the Amount field, enter the total value of the invoice.

10. If you need, change the Terms field to reset the Due Date for the invoice. The terms defined on the selected
supplier record display in this field by default. The application uses both the Terms and Invoice Date to
calculate the calendar value to display in the Due Date field. For more information, review the previous
Purchasing Terms section.

11. The Legal Number provides a unique identifier for transactions. These identifiers have controls to prevent
gaps in sequence and provide an additional tracking method. Legal numbers are always shown on external
documents such as packing slips and AP invoices..

You define how legal numbers are generated in External
Company Maintenance.

12. If you need, select the Currency and Rate Type you want to use with this logged invoice. The amount
values on this invoice automatically update to display using the new currency. The Rate Type determines
the conversion rule used to calculate the values from the source (original) currency to the new (target)
currency.

13. Select the supplier's Bank. The default comes from Supplier Maintenance.

14. When you finish, click Save on the Standard toolbar.

Logged AP Invoice Entry – Tax

Use the Tax sheet to define tax information for a logged invoice.

To define a tax line for an invoice:

1. Select the Header > Tax sheet.

2. Select a Tax Liability for this invoice. The tax liability is the region or locality that will receive a tax amount
from this invoice.

3. Click the Tax Point drop-down list to define the date for the tax calculation on the current invoice.
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4. Click the Tax Rate Date drop-down list to define the date to determine the effective tax rate. The rate
defined for this date is then calculated against the current logged invoice.

5. To add a new invoice tax, or adjust an existing one, click the Down Arrow next to the New button; select
New Logged Invoice Tax.

6. In the invoice tax line, specify the applicable tax type in the Tax ID field and the applicable rate in the Rate
Code field.

7. If necessary, select the Manual check box. You can now directly enter the tax information by using the
Percent, Tax Amount, and Taxable Amt fields. The tax amount is calculated using these amounts.

8. When you finish, click Save on the Standard toolbar.

Logged AP Invoice Entry – Post Invoices

To finish the Logged AP Invoice Entry process, you must post the logged invoices. Based on the Account Option
setting defined for the company in the Company Configuration > Finance > Accounts Payable sheet, logged
invoices for the group post to a specified General Ledger account; the group and invoice no longer display in the
Group and Header sheets, and in the Logged AP Invoices tree view.

To post an entry group:

1. From the Actions menu, select Group > Post.

2. The assigned group displays in the Group field in the Logged AP Invoice Post Process dialog box.

3. Click Submit to post the group. The application displays an error message if the group contains invalid
entries.

If posting errors occur, select the Group > Posting Log
sheet to review an error log. Use this log to locate the
errors. You can re-post the group after correcting them.
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Approve or Void a Logged AP Invoice

When you are ready to validate your logged AP invoices, you must launch the approval program. You can then
approve as many logged AP invoices as you need.

You can skip this step if the Auto Approve Logged Invoice
check box is selected for the associated company in the
Company Configuration > Finance > Accounts Payable sheet.

Menu Path: Financial Management > Accounts Payable > General Operations > Logged Invoice Approve and
Void Entry

Approve a Logged AP Invoice

To approve a logged AP invoice:

1. Click the Invoice button to find and select the invoice number you want to approve. You can also enter
the invoice number directly.

2. The invoice header details, such as Invoice Date and Apply Date display. Review the information.

3. Select the Approved check box.

4. The  Approved By and Date fields populate with your user name and today’s date.

5. Click Save on the Standard toolbar.

6. The Approved icon displays.
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Void a Logged AP Invoice

You can also use Logged Invoice Approve and Void Entry as needed to void a logged AP invoice you previously
posted.

To void a logged AP invoice:

1. Click the Invoice button to find and select the invoice number you want to approve. You can also enter
the invoice number directly.

2. Enter the Reason why you need to void the logged AP invoice.

3. Click the Void button. To the confirmation message, click OK.

4. The Logged AP Invoice Void Post Process window displays.

5. Click Submit.

The  selected logged AP invoice is now void.
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Letters of Credit

Letters of Credit are a standard way to provide credit in some countries, and these items are also used in
international trade to cover credit risks. You agree with a bank that the bank will be held liable to pay for specific
goods up to a certain value using some condition - usually a confirmed receipt such as a bill of lading. The supplier
is then assured they will be paid, as the supplier places the AP invoice amounts against the bank. The letter
becomes its own independent line of credit between your organization and the bank.

Create Letters of Credit

You enter the details about a letter of credit within Letter of Credit Entry.

Menu Path: Financial Management > Accounts Payable > General Operations > Letter of Credit Entry

To enter a letter of credit to a supplier:

1. Click New on the Standard toolbar.

2. In the LC Reference field, enter the number for the letter of credit.

3. Next, enter a Description for the letter of credit. This text displays on various reports and trackers.

4. Click the Supplier button to find and select the supplier with whom you have set up a letter of credit.

5. Click the Bank drop-down list to select the bank with whom you established this letter of credit. You defined
these accounts within Bank Account Maintenance; for more information on this program, review application
help.

6. Select the Ship Complete check box to indicate the goods or services received through this letter of credit
must be shipped complete. This value displays for your information on other records.

7. In the Value field, enter the amount of credit available with this letter.

8. The Currency, Lock, Exchange Rate, and Bank Value fields indicate the amount of credit available using
the currency exchange rate at the selected bank. These values only display for your information.
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9. The Terms fields displays the AP payment terms selected for this specific letter of credit.

10. The Issue Date, Valid From Date, and Valid To Date fields define the time period during which this letter
of credit is active. If you need, you can change these date values.

11. If you must stop placing transactions against this letter of credit, select the Inactive check box. Indicate why
the letter of credit is closed from the Inactive Reason drop-down list.

12. You use the Additional Data sheet to enter optional receiving information like Free On Board, Place of
Loading, and so on.

13. When you finish click Save.

AP Invoice Entry

AP Invoice Entry records payments to your suppliers. The invoices you enter here update open purchase orders,
shipping receipts, and General Ledger accounts.

All invoices are created and posted through entry groups. After you define an entry group, you can use this
program to create both invoices and debit memos. An invoice tracks payments made against a linked receipt,
purchase order, or other AP financial transaction. A debit memo reduces the payable balance of the corresponding
supplier.

Invoices can have one or more detail lines, and each line can have a different type. Available line types:

• Receipt Line – Use this type for lines linked to receipts. These receipts are created through the
Shipping/Receiving module.

• Miscellaneous Line – Use this type for miscellaneous expenses or as a recurring source invoice to use as a
template for other recurring invoices; this line type is not linked to purchase orders or job records.

• Job Miscellaneous Line– Use this type to record miscellaneous charges for materials used on specific jobs.

• Advanced Billing Line – Use this type when you make an advance payment against a purchase order line
before you receive a shipment from the supplier.

• Unreceived Billing Line – Use this type when you make a payment against a shipment that is sent out, but
is not yet received by your company.

Menu Path: Financial Management > Accounts Payable > General Operations > Invoice Entry
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AP Invoice Entry - Group

You begin the AP Invoice Entry process by creating entry groups. You then add invoices for processing through
this entry group. These groups define the default fiscal year and period used on each invoice. Entry groups are
sometimes referred to as batches.

To create a new entry group:

1. Click New on the Standard toolbar.

2. In the Group field, enter the identifier for the entry group. Entry groups can use any combination of letters
or numbers.

3. Click the Apply Date drop-down list to define the default fiscal period to which group transactions post.
The company’s default fiscal calendar determines the values that display in the Fiscal Year and Period fields.

4. When you finish, click Save.
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AP Invoice Entry - Header

You use the Header sheet to enter the main information on each invoice.

To create a new invoice:

1. Click the Down Arrow next to the New button; select New Invoice.

2. The Header > Detail sheet displays. In the Ref PO field, enter any purchase order number you want to
associate with this invoice. This association identifies the supplier linked to the PO.

3. For a miscellaneous line invoice not linked to a purchase order or job record, enter the supplier’s identifier
in the Supplier field. The program automatically displays the supplier name and address linked to this
identifier.

4. In the Invoice field, enter the invoice number.

5. Click the Invoice Date drop-down list to select the entry date for the invoice.

6. The Apply Date field determines the fiscal period in which the invoice posts. The company’s default fiscal
calendar determines the values that display in the Fiscal Year and Period fields.

7. Use the Description field to enter invoice information. This information helps other users identify the invoice
while they process it.

8. Enter the total value of the invoice in the Amount field.

Epicor ERP | 10.0.700414

Epicor ERP Application User Guide - Part TwoChapter 8 | Suppliers and Accounts Payable



9. If you need, change the Terms field to reset the Due Date for the invoice. The terms defined on the selected
supplier record display in this field by default. The application uses both the Terms and Invoice Date to
calculate the calendar value to display in the Due Date field. For more information, review the previous
Purchasing Terms topic.

10. Use the Payment Method field to select the default method for remitting payment to this supplier. For
more information about payments, review the Payment Entry topics found later in this chapter.

11. To designate this invoice as a recurring source invoice, select the Recurring check box and select a Cycle
Code to define how recurring invoices will be generated and their billing cycles. For more information about
cycle codes, refer to the previous Recurring Cycle Maintenance topic.

You can update some of the fields brought in from the
cycle code in the Header > Recurring sheet.

12. Select the Hold Invoice check box to block posting of the invoice. Select this check box when the invoice
is disputed or when you need supervisor approval.

13. Select the Hold Payments check box to block payment for this invoice. When you activate this option, you
cannot select this invoice within Payment Entry.

14. If you need, select the Currency and Rate Type you want to use with this invoice. The amount values on
this invoice automatically update to display using the new currency. The Rate Type determines the conversion
rule used to calculate the values from the source (original) currency to the new (target) currency.

15. Select the supplier's Bank. The default comes from Supplier Maintenance.

16. When you finish, click Save on the Standard toolbar.
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AP Invoice Entry – Detail - Receipt Line

After the invoice header information is complete, add detail lines to it. These detail lines can be different line
types – depending on the reason for the payment. This example shows you how to enter a Receipt Line type.

To add a detail line to an invoice:

1. Click the Down Arrow next to the New button; select New Receipt Line.

2. The AP Invoice Add Receipt Billing Lines window displays. All detail lines from the PO selected on the
header display within the AP Invoice Uninvoiced Receipt Lines grid.
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3. To select all the detail lines within the purchase order, click the Select All button. The detail lines move
down to the AP Invoice Selected Receipts grid.

4. To generate the detail lines, click the Create Lines button.
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5. The Lines > Detail sheet displays. All of the information on this sheet is pulled in from the selected PO
detail line. The Receipt Information section displays information from the packing slip detail line that
generated the receipt.

6. The PO Information section displays details from the purchase order used as the source for this payment
transaction.

7. The Line Type field displays the type of the invoice line. This example displays Receipt of Goods, which
indicates this line is a Receipt Line type.

8. The Part and Description fields display the part for which your company is being billed.

9. If necessary, click the Tax Category drop-down list to select a category that applies to this part. Tax categories
divide taxes into groups that apply to different products.

10. In the Tax Exempt field, enter a code if the line is tax-exempt. Leave this field blank if tax applies to the
line.

11. If necessary, use the Supplier Qty field to change the number of parts you want to bill through this line.
By default, the field displays the number received on the PO line.

12. If you need, use the Unit Cost and the Cost Per fields to recalculate charges for the line. By default, these
fields display values from the PO line.

13. Optionally, enter a line discount in the Ref Disc Amt (Reference Discount Amount) field. Use this field to
enter any additional information you need about the discount; this value does not change any calculations.

14. The Ext Amount (Extended Amount) field displays the line charge with discounts before any miscellaneous
charges and other expenses are applied against this amount.
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15. If necessary, use the Misc Charges field to modify the line charge amount defined on the Miscellaneous
Charges sheet.

16. The Total field displays the line charge. The application adds the Extended Amount and the Miscellaneous
Charges together and subtracts any advance payments made against the line. This value is displays the Less
Adv. Pay (Less Advanced Pay) field.

To learn how to add miscellaneous charges, review the
AP Invoice Entry - Miscellaneous Charges section found
later in this chapter.

17. When you finish, click Save on the Standard toolbar.

AP Invoice Entry – Detail - Miscellaneous Line

This example shows you how to enter a Miscellaneous Line type. Typically, miscellaneous line invoices are created
to account for miscellaneous expenses that are not linked to any purchase order or job records. You can also
define a miscellaneous line invoice as a recurring source invoice to use as a template for other recurring invoices.

The Recurring check box must be selected and a Cycle Code
set on the Header sheet for an invoice with a miscellaneous
line to be designated as a recurring source invoice.

1. Click the Down Arrow next to the New button; select New Misc Line.

2. The Lines > Detail sheet displays.
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3. Make an entry in the Description field in the Invoice Information pane.

4. Enter a quantity into the Supplier Qty field.

5. Enter the unit cost into Unit Cost field.

6. The Ext Amount (Extended Amount) field displays the extended line charge with discounts before any
miscellaneous charges and other expenses are applied against this amount.

7. If necessary, use the Misc Charges sheet to modify the line charge amount (if any) defined on the
Miscellaneous Charges sheet.

8. The Total field displays the line charge. The application adds the Extended Amount and the Miscellaneous
Charges together.

To learn how to add miscellaneous charges, review the
AP Invoice Entry - Miscellaneous Charges topic found later
in this chapter.

9. When you finish, click Save on the Standard toolbar.

AP Invoice Entry - Recurring Invoices

You can also use the Generate Recurring Invoices process to generate AP recurring invoices from a recurring
source invoice. Using this process is helpful if you have a high volume of recurring invoices.

1. From the Actions menu, select Get > Recurring Invoices.
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2. The Get Recurring Invoices window displays. Here you can filter for which suppliers and from which cycles
you want to generate invoices.

3. Click Manual Selection to select from a list of all recurring source invoices available.

4. The Source Recurring Invoices Browse window displays.

5. Select the source recurring invoices you wish to use for generation of recurring invoices.

6. Click OK.

New invoices are created from the selected recurring source invoices. Each new invoice is a copy of the recurring
source invoice, including comments, charges, commissions, GL accounts, and other information.

If necessary, you can change the data that pulls from the recurring source invoice into the recurring invoice.
If the Copy Latest Invoice option is selected on the recurring source invoice, the details will be copied from
the latest posted recurring invoice for that recurring series of the recurring source invoice.
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AP Invoice Entry – Assets

You can use invoice entry to record the purchase of an asset. To do this, you enter an asset line. The application
considers an asset a purchased item and not a part record.

To enter an asset line:

1. Click the Down Arrow next to the New button; select New Asset Line.

2. In the Description field in the Invoice Information pane, specify the asset you need to define.

3. Select a Tax Category. Tax categories divide taxes into groups that apply to different products and items.
Be sure to choose a tax category that applies to this asset.

4. In the Supplier Qty field, enter the quantity of the asset.

5. Specify the Unit Cost. This value defines how much each unit of the asset is worth.

6. Click Save on the Standard toolbar.

For more information about assets, review the Asset
Management chapter.
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AP Invoice Entry – Miscellaneous Charges

Use the Lines > Miscellaneous Charges sheet to add miscellaneous charges to an invoice line. You can select and
edit charges specifically for this invoice line; you can also pull in miscellaneous charges from a purchase order
line and then apply them to the current invoice line.

To add miscellaneous charges to a line:

1. Click the Down Arrow next to the New button; select New Line Charge.

2. A new row displays on the Line Miscellaneous Charges grid.

3. In the Misc Charge field, select the type of charge defined by the row. Typically, charges apply expedite
fees and freight charges.

You create miscellaneous charges within Purchasing
Miscellaneous Charge/Credit Maintenance. For more
information, review this program’s topics within
application help.

4. If you need, enter or change the charge amount in the Charge Amount field. The field displays the amount
for the selected charge if an amount is defined.

5. The Line PO Charges grid displays miscellaneous charges linked to the purchase order detail line.

6. You can select charges in the list and click Add PO Misc Charge to Invoice Line to move it to the Line
Miscellaneous Charges grid.

7. Continue to add the miscellaneous charges you need. When you finish, click Save on the Standard toolbar.
The miscellaneous charges are added to the total cost of the detail line.

You can also add miscellaneous charges at the header level of the invoice by selecting New Header Charge from
the New menu. You add header miscellaneous charges using the same process as described above.
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AP Invoice Entry – Tax

The Tax sheet applies invoicing, withholding taxes and self-assessment taxes related to the invoice. Through
withholding, the company keeps a portion of the invoiced amount in order to pay the supplier’s tax liability.
Through self assessment (sometimes called reversed charge), the company calculates the taxes owed on relevant
transactions and reports the tax to the tax authorities.

Line-level taxes in AP Invoice Entry are totaled and displayed on the invoice header. You can change tax totals
at the header level.

To apply tax manually to an invoice header:

1. Click the Down Arrow next to the New button; select New Header Tax Code.

2. The Header > Tax sheet displays.

3. If you need, change the Tax Liability field. The default Tax Liability is pulled from the supplier record. Tax
liability determines whether the application calculates taxes per document or per line.

4. Enter the date the tax is reported in the Tax Point field.

5. In the Tax Rate Date field, enter the date used to determine the effective tax rate. The rate defined for this
date is then calculated against the current invoice.

6. In the invoice tax line, specify the applicable tax type in the Tax Type field and the applicable rate in the
Rate Code field. The application calculates the tax amounts based on the selected Rate Code and Rate
Date.

7. If you need, select the Manual Tax Calculation check box. You can now directly enter the tax information
by using the Percent, Taxable Amount and Tax Amount fields. The tax amount is calculated using these
amounts.

Taxes that are marked as Manual Tax Calculation are
excluded from further updates by automatic recalculations.

8. When you finish, click Save on the Standard toolbar.

Epicor ERP | 10.0.700424

Epicor ERP Application User Guide - Part TwoChapter 8 | Suppliers and Accounts Payable



AP Invoice Entry – Debit Memo

A debit memo reduces the payable balance on a specific AP invoice. To create a debit memo:

1. Click the Down Arrow next to the New button; select New Debit Memo.

2. Navigate to the Header > Detail sheet. Notice the Debit Memo icon displays on this sheet.

3. By default, the last supplier for whom you entered an invoice displays. If you need, change the supplier in
the Supplier field.

4. Use the Invoice field to identify the debit memo.

5. Click the Invoice Date drop-down list to define the entry date for the invoice.

6. The Apply Date field determines the fiscal period to which this debit memo posts. The company’s default
fiscal calendar determines the values displayed in the Fiscal Year and Period fields.

7. Use the Ref Invoice to apply the debit memo against a specific invoice.

8. Enter the total value of the debit memo in the Amount field.

9. Click the Payment Method drop-down list to select the method used by the supplier to reimburse the
debit memo amount.
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10. Select the Hold Invoice check box to prevent this debit memo from posting. Select this check box when
the invoice is disputed or when you need supervisor approval.

11. Select the Hold Payments check box to indicate that payments cannot be made against the invoice
referenced by this debit memo. Because of this, the invoice cannot be selected within Payment Entry.

12. If you need, select the Currency and Rate Type you want to use with this debit memo. The amount values
in this debit memo automatically update to display using the new currency. The Rate Type determines the
conversion rule used to calculate the values from the source (original) currency to the new (target) currency.

13. When you finish, click Save on the Standard toolbar.

If a legal number applies to the debit memo, the application asks you to enter it. Enter this number and click OK.
You can also add detail lines to this debit memo; these lines can be Miscellaneous, Job Miscellaneous, and
Advanced Billing line types. To learn how to do this, review the previous AP Invoice Entry – Detail Lines section.

AP Invoice Entry – Tax Connect

You can automatically generate use tax amounts through the Avalara
®
 (Tax Connect) functionality. These taxes

are automatically captured whenever taxes are calculated through Avalara. For example, you can set up Avalara
to capture use tax amounts (a consumption tax levied in the United States) on transactions. For information on
setting up taxes, review the Global Tax Engine chapter in the Epicor ERP Implementation Guide.

This section describes how you activate the Tax Connect functionality on a specific AP invoice.

To enter an invoice with use tax calculation:
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1. Click the Down Arrow next to the New button; select New Invoice.

2. Select a Supplier for the item requiring the use tax. You can also select the Ref PO to create an invoice
linked to a purchase order. If you use Avalara, be sure to select a Tax Liability enabled for use with Tax
Connect and Accounts Payable. This activates Avalara; the application will now calculate applicable use
taxes against your invoice amounts.

3. In the Invoice field, enter the invoice identifier.

4. Click the Invoice Date drop-down list to define the entry date for the invoice. By default, the current system
date displays in this field.

5. Enter the invoice Amount.

6. Select a Payment Method. A payment method indicates whether the supplier is paid manually through a
check or electronically through a file.

7. Select the Ready to Calculate  check box to indicate you want to calculate taxes after you save the invoice.

8. Click Save on the Standard toolbar.
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9. You are now ready to define the use tax needed on this invoice. Click the Down Arrow next to the
New button. Select New Misc Line to create a general invoice line.

10. To create a line for an invoice linked to a receipt, select New Receipt Line.

11. The Lines > Detail sheet displays.

12. Select a Part for the line.

13. Select a Tax Category. Tax categories divide taxes into groups that apply to different products and items.
Tax categories are required for the automatic tax calculations to run. Be sure to choose a tax category that
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applies to the current part. If you run Avalara, be sure to select a tax category enabled for use tax calculations;
if you do not, use taxes will not be generated against the invoice line.

14. Enter the Supplier Quantity.

15. Enter the Unit Cost for the item; the use tax is calculated based on this item’s cost per unit.

16. Click Save on the Standard toolbar.

Enable Tax Connect, Calculate and View Invoice Use Tax

You are now ready to define the use tax needed on this invoice. To enable Tax Connect, then calculate and view
use tax for the invoice:

1. From the Actions menu, select Tax Connect > Tax Connect Enabled.

2. The status bar displays the Tax Connect On status.

3. From the Actions menu, select Invoice > Calculate Tax. The use tax amounts are calculated against the
item defined on the detail line.

429Epicor ERP | 10.0.700

Suppliers and Accounts Payable | Chapter 8Epicor ERP Application User Guide - Part Two



4. From the Actions menu, select Tax Connect > View Tax Connect Results.

5. The Tax Connect Results window displays.

6. The calculated use tax amount displays in the Total Tax field.

AP Invoice Entry – Print Group Edit List

You can print a Group Edit List to ensure the invoices within the active group are correct before you post them.

Here’s how:

1. From the Actions menu, select Group > Print Group Edit List.
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2. The Invoice Entry - Group Edit List window displays. Select the report settings you need.

3. Click Print on the Standard toolbar.

AP Invoice Entry – Post Invoices

To finish the AP Invoice Entry process, you must post the invoices to the AP accounts within the General Ledger.
When an entry group is posted, transactions update the AP information for each supplier referenced within the
group.

Once you post the invoices, you can no longer edit or delete
them. You can place a posted invoice on hold. If you post an
invoice in error, you can enter offsetting transactions. You can
also use Invoice Adjustment to write it off, or create and apply
debit memo to close the invoice. If you need to adjust the
amount of the invoices, you can create a correction invoice.

To post an entry group:

1. From the Actions menu, select Group > Post.

2. The application alerts you if the invoices contain variances. Click Yes to open the AP Invoice Post Process
dialog box.
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Invoices with variances are not posted; you must correct
them to remove variance before they will post.

3. Click Submit to post the group. The application displays an error message if the group contains invalid
entries.

If posting errors occur, select the Group > Posting Log
sheet to review an error log. Use this log to locate the
errors. You can re-post the group after correcting them.

Adjustments

Use AP Adjustment Entry to change amounts for any open invoice or debit memo. You can increase or decrease
the invoice balance on the selected invoice or debit memo. When you adjust an AP invoice, you must also select
the book and GL account to which you want the adjustment to post. You can add as many adjustments as you
need against each invoice.

Before you adjust an invoice, consider the following:

• You cannot increase an invoice balance above its original invoice amount. If an additional amount is necessary,
you can use a correction invoice to make up for the difference.

• If you adjust an invoice balance down to $0.00, that invoice closes. Once an invoice is closed, you can no
longer adjust it.

• Use discretion when you adjust an invoice amount. The original invoice could be linked to a purchase order,
which could make reconciliation difficult due to fluctuating invoice totals.

Menu Path: Financial Management > Accounts Payable > General Operations > Adjustment

To adjust an open AP invoice or debit memo:
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1. Click the Supplier button to find and select the supplier on the invoice you need to adjust.

2. Now click the Invoice button.

3. The AP Invoice Adjustment - Invoice Selection window displays.

4. Select the invoice you need to adjust.

5. Click OK.
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6. You return to the AP Adjustment Entry window.

7. Enter the amount of the Adjustment you need.

8. Select the Apply Date on which you are making the adjustment.

9. The Fiscal Year and Period for the selected Apply Date display for your reference.

10. Click the first GL Account drop-down list to select the book against which you are placing this adjustment.

11. Click the second GL Account drop-down list to define the specific account against which this adjustment
will be placed.

12. Enter a Description for the adjustment.

13. Optionally, enter any additional Comments you want to record with the adjustment.

14. Select the Copy Rate check box as needed to use the original invoice exchange rate. This provides the ability
to write off an invoice with a zero gain/loss adjustment.

15. Click Save on the Standard toolbar.
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16. The adjustment is recorded to the database and the window clears. If you want to review the adjustments
you have made against the same invoice, load the invoice back into this window using the Supplier and
Invoice fields.

17. The adjustment displays within the Transactions Applied To This Invoice grid.
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Payment Instruments

Payment instruments are cashless methods of payment used to satisfy amounts due on AP invoices. You often
enter payment instruments in connection with a promissory note received with an accounts payable (AP) invoice.
You use payment instruments to withdraw funds needed to pay the debt incurred by the AP invoice. The application
contains a workflow you use to enter payment instruments, change their status, and write off the payment
instruments as needed.

Payment Instrument Payable Entry

Use Payment Instrument Payable Entry to track instruments you need to apply to supplier invoices at a later date.
You can track and update the credit amounts on promissory notes, post-dated checks, and other future-dated
payment instruments.

You typically enter a payment instrument when a promissory note is received with an AP invoice. Payment
Instruments are used to withdraw funds needed to pay the debt.

You can use this program to:

• Track resulting movements and value changes for audit and credit control.

• Void instruments. Voiding an instrument re-opens the invoices against which it was originally applied.

• Change how payments are used. For example, the company pays one invoice covered by a note in cash. In
this case, you can allocate note payments to other payables.

• Reflect the tax results for payment instruments. This can include generating the journals needed to pay taxes
due on a final settlement or cash movement.

Menu Path: Financial Management > Accounts Payable > General Operations > Payment Instrument

Payment Instrument Payable Entry - Group

You begin the payment instrument process by creating entry groups. Entry groups batch instruments together
for processing. The sheet lists the instruments assigned to the group and displays their cumulative amount.

To create a group:

1. Click New on the Standard toolbar.

2. In the Group field, enter the identifier for the payment instrument group.
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3. The Bank Account field specifies the default bank account for the company. If you need, change the
account.

4. The Currency field displays the currency of the bank account. You can select another currency for the group.
The amounts update to reflect the new, or target, currency.

5. Click the Prom. Note Date drop-down list to define the default transaction date for the group.

6. Select the Rate Type used when the instrument contains a currency different from the currency on the
bank account. The rate type defines the conversion rules applied to update amounts from the original
(source) currency to the new (target) currency.

7. When you finish, click Save.

Payment Instrument Payable Entry - Header

Use the Header sheet to define a payment instrument. Fields on this sheet define the supplier, bank accounts,
and currency for the transaction.

To create an instrument:

1. Click the Down Arrow next to the New button; select New Payment Instrument.

2. The Payment Instrument Payable > Header sheet displays.

3. Select the Manual check box if you want to directly enter the payment instrument identifier. If you do not
select this check box, the ID is automatically generated by the application.

4. Use the Payment Instrument ID and Description fields to identify the instrument.

5. If you need, change the Transaction Date. The application uses this date and the terms from the supplier
record to determine the payment schedule.
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6. Enter the supplier’s identifier in the Supplier field.

7. Click the Type drop-down list to select a payment instrument. The type value indicates what kind of payment
instrument it is; for example, promissory notes and future-dated checks are both payment instrument types.

8. Select a Status.

9. Optionally, change the bank in the Supplier’s Bank Info area. By default, the field displays the bank
associated with the selected supplier. The bank you select here determines the account where payments
are deposited against this instrument.

10. If necessary, use the Currency field to change the currency applied against the instrument amounts. You
can adjust bank amounts and the rate type when the currency of the instrument differs from the currency
on the supplier’s bank account.

11. When you finish, click Save on the Standard toolbar.

12. If necessary, use the Info sheet to enter a supplier or company address specific to the instrument. The default
information is pulled from either Supplier Maintenance or Company Maintenance.
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Payment Instrument Payable Entry – Bank Fees

Use the Bank Fee sheet to enter bank charges that apply to the instrument. Here is how:

1. Click the Down Arrow next to the New button; select New Bank Fee.

2. Use the Bank Fee field to identify the bank fee you need to place against the instrument.

3. Enter the Bank Fee Amount using the currency selected for the instrument.

4. When you finish, click Save on the Standard toolbar.

Payment Instrument Payable Entry – Invoice Detail

Use the Invoice Detail sheet to select the invoices for which you want to allocate the instrument amount. The
Invoices list displays all open invoices for the supplier selected in the Header sheet. You can allocate the amount
of the instrument to one or multiple invoices.

To do this:

1. Click the Down Arrow next to the New button; select New Invoice Payment.

2. Click the Invoice drop-down list to select an invoice to which the payment applies. The currency of the
payment must match the currency on the invoice.
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3. When you finish, click Save on the Standard toolbar.

4. You can also use the Payment Instrument Payable > Allocate sheet to delete invoices selected on this
sheet. You can then adjust the amounts allocated to each remaining invoice.

Payment Instrument Payable Entry – Select Invoices

You can also select invoices automatically using the Actions menu. To do this:

1. From the Actions menu, select Selected Invoices.

2. The Select Invoices window displays.

3. Select the Due Date required for payment on these invoices.

4. If you need, select the Include Invoice without Payment Method check box. This indicates any invoices
that do not have a payment method are still selected to be paid through the current payment instrument.

5. Optionally, use the Filter sheet to restrict the search by payment method or supplier group.

6. Click OK.
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7. The Invoice Payment Selection window displays.

8. Select one or multiple invoices you want to apply against this payment instrument.

9. Click OK.

10. The invoices you selected display in the Invoices grid on the Payment Instrument Payable > Allocate sheet.
You can now use the current payment instrument against the amounts on the selected invoices.
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Payment Instrument Payable Entry – Post Invoices

After you enter payment instruments and define the invoices against which the payment instrument will be used,
you are ready to post these transactions to the general ledger.

To post invoices:

1. From the Actions menu, select Post Group.

2. The AP PI Payment Post Process window displays.

3. Click Submit on the Standard toolbar.

The payments generated through the current payment instrument are saved to the general ledger.
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Payment Instrument Statuses

As a payment instrument (PI) moves through your business flow, it goes through a number of stages that indicate
its progress, and each stage can contain multiple levels, or statuses, required for your financial processes. For
example, in the AR Portfolio stage, you can have a Portfolio Signed status and Portfolio Posted status.

As the payment instrument moves through the flow, you change its status, modifying any dates and legal numbers
as you need.

Create Payment Instrument Statuses

You define the statuses required for your workflow within Payment Instrument Status Maintenance.

Menu Path: Financial Management > Accounts Payable > Setup > Payment Instrument Status

To create a new status:

1. Click New on the Standard toolbar.

2. In the Status field, enter a unique identifier for the status level.

3. Enter a Description for the status level. This text displays on the Status drop-down list in other programs,
so be sure to enter a value that clearly indicates the purpose for the status.

4. Click the Use In drop-down list to define whether this status is used for either AP or AR. For this example,
you select AP.

5. The Stage drop-down list now displays the various pre-defined stages available for accounts payable.
Available AP stages:

• Unapproved - Used after a supplier has sent an invoice to a customer and it remains outstanding.

• Portfolio - Used when a signed document has been received (Signed status), or an AP invoice has been
reduced by the allocation from the Payment Instrument (Posted status).

• Settled - Used when the cash is defined as paid.

• Cancelled - Used when a Payment Instrument is returned or canceled and all accounting movements
are reversed.

6. Optionally, enter the Electronic Bank Code this status uses. Enter this value using the electronic remittance
format required for the bank code used for your payment instruments.
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7. Use the GL Control sheet to link the GL control type and GL controls you need to associate with this payment
instrument status.

8. When you finish, click Save.

Create Payment Instrument Types

You next create payment instruments types. You can assign statuses to each type in order to define default
behavior when each status is selected.  

Menu Path: Financial Management > Accounts Payable > Setup > Payment Instrument Type

To create a new payment instrument type:

1. Click New on the Standard toolbar.

2. Enter the identifier for the Type. On certain reports, trackers, and other programs, you may only see this
value.

3. Next, enter a Description for the payment instrument type. This value displays on various drop-down lists.

4. Click the Initiation drop-down list to define how this payment instrument is initiated. You have two options
- Generation (initial payment instrument is created) or Received (initial payment instrument is a received
document).

5. Because this type is for accounts payable, you have some default behavior you can define within the Accounts
Payable section.

6. Select the Supplier Bank Required check box to indicate bank details need to be included on all payment
instruments that use this type.
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7. Click the First GL Update Stage drop-down list to indicate whether the general ledger is updated through
a bank statement or a portfolio.

8. Click the Initial drop-down list to define the default status for all starting payment instruments that use
this type.

9. Click the Reconciled drop-down list to define the default status for all reconciled payment instruments that
use this type.

10. If this type initiates through the Generation mode, the Generation Options section is active.

11. Click the Type drop-down list to define whether payment instruments are generated through a check or
another option.

12. Select the Default check box to indicate this generation type is selected automatically on payment instruments
that use this type.

13. When you finish, click Save.

Change Payment Instrument Status

Use AP Payment Instrument Status Change to change the status of a selected payment instrument.  When you
select an individual payment instrument, all of its details display within this program, including its associated
invoices. Although you cannot change most of these fields, you can modify the Due Date and the Description
fields on the Header sheet.

You may also need to enter a general ledger (GL) journal entry to move the payment instrument balance if one
of its associated stages has a Posted status and the old and new posting codes are different. Because of this, you
may also be required to create a new legal number for the status change.

Menu Path: Financial Management > Accounts Payable > General Operations > PI Status Change

To change the status on a payment instrument:

1. Click the ID button to find and select the payment instrument you need.
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2. Optionally, edit the Description of the payment instrument to help identify its current status.

3. You can also change the Due Date for this payment instrument.

4. To change the status, from the Actions menu, select Status Change.

5. The Status Change window displays.

6. Click the PI Status drop-down list and select the status you need.

7. Click OK to close the Status Change window.

8. You can also change the payment instrument type by clicking the PI Type drop-down list and selecting the
new type.

9. If the status change also requires a new legal number, from the Actions menu, select Legal Number >
Assign Legal Number.

10. If you need, you can also stop using an existing legal number by selecting Void Legal Number.

11. When you finish, click Save on the Standard toolbar.
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Payment Instrument Write Off

To complete the payment instrument functionality, the Accounts Payable module contains the AP Payment
Instrument Write Off program. You use this program to indicate a selected payment instrument is settled and
all of its associate instruments are fully paid. The payment instrument is then considered written off by the
application, and is recorded in this state within the general ledger.

Menu Path: Financial Management > Accounts Payable > General Operations > PI Write Off

1. Click the ID button to find and select the payment instrument you want to write off.

2. Click the PI Status drop-down list to select the status you want to associate with this payment instrument.
In this example, the AP Settled status displays.

3. Click the first GL Account drop-down list to select the book to which you will record this payment instrument
write off.

4. Click the second GL Account drop-down list to select the specific account to which you will record the
write off.

5. If you need, enter an additional Comment you want to associate with the current payment instrument.

6. When you finish, click Save on the Standard toolbar.

The payment instrument is now considered written off by the application.
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Payment Entry

Use AP Payment Entry to pay AP invoices through check or electronic payments. After you enter the payments
and process the checks, you then record these transactions in your General Ledger. This is done by posting the
payments using the Actions menu. You can make payments against invoices created to pay suppliers. You can
also pay miscellaneous expenses that do not have an invoice, enter manual checks for extra expenses, process
debit memos, and make payments to one-time suppliers.

You start the process by creating a group for the payments. You can then create payment records that satisfy
both invoices and miscellaneous payments. After you enter the payments and process the checks, you can post
the payments.

Menu Path: Financial Management > Accounts Payable > General Operations > Payment Entry

Payment Entry – Group

You begin the Payment Entry process by creating a payment group; each group is used for batch processing of
payments. When Payment Entry launches, the Group sheet displays by default.

To create a new payment group:

1. Click New on the Standard toolbar.

2. In the Group field, enter a unique identifier for the group. Entry groups can use any combination of letters
or numbers.

3. In the Bank Account field, select the bank account from which these payments are withdrawn. You can
change the account before a payment run or define a different account for a manual payment.

If entering an Electronic File Transfer (EFT) payment, select
the bank account with the EFT payment method.

4. The Default Currency field displays the currency used for the selected bank account. Depending on the
payment method, you can or cannot change the currency used for the group.
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5. Click the Payment Method drop-down list to select the method used as the output format for the payment
run. If you select the manual payment method, you can then directly enter checks.

6. Use the Payment Date field to define the date on which the payments are run through this group. This
value determines the active exchange rate used to convert bank account amounts to other currencies.

7. If you need, click the Rate Type drop-down list to select the currency rate type that applies to these group
payments. Rate types define the conversion rules used to update amounts from the original (source) currency
to a new (target) currency.

8. When you finish, click Save.

Payment Entry – New Payments

You use the Header sheet to create payments for specific invoices, miscellaneous payments, electronic payments,
and manual checks.

1. Click the Down Arrow next to the New button; select New Payment.

2. The Payment > Header sheet displays. Enter the supplier’s identifier in the Supplier field. The program
automatically displays the supplier name and address, as well as other information linked to the supplier.

3. If the group uses a manual payment method, the Manual check box is automatically selected and some of
the fields in the Manual Payment pane are enabled.

4. Select the Enter Payment Total check box to enable you to enter a check amount in the Payment Total
field. The Enter Payment Total check box is enabled when the Manual check box is selected and when the
bank currency is different from the company’s base currency. If the Enter Payment Total check box is not
selected, the Payment Total field displays a total amount that cannot be changed.

5. For manual payments, enter the check number in the Payment field and the check date in the Date field.
The check date can be changed as needed on manual payments.
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6. For manual payments, select the bank account in the Bank field.

7. A selected Electronic Payment check box indicate this payment uses EFT. This check box is automatically
selected when the payment method is set up for EFT payments. For more information on setting up electronic
payments, review topics in application help.

8. Select the Force Discount check box to indicate the application calculates the payment using the best
possible discount terms offered by the supplier. When the check box is clear, the application calculates the
discount based on the effective discount rate defined by the supplier’s purchasing terms.

9. If you need, use the Exchange Rate field to change the default exchange rate you defined on the Group
sheet. This field is available when the bank currency is different from your company’s base currency.

10. When you finish, click Save on the Standard toolbar.

Payment Entry – Bank

Use the Bank sheet to select or update a bank account for the current supplier. The bank defined for the payment
method selected on the Group sheet displays by default. If the supplier is linked to a bank that uses the same
payment method, AP Payment Entry uses this bank as the default. If the banks are different, however, the primary
bank is used as the default instead.

To select a bank account:

1. In the Bank Account Number field, search for and select the supplier’s bank account.

If entering an Electronic File Transfer (EFT) payment, select
the bank account with the payment method.

2. When you finish, click Save on the Standard toolbar.

Epicor ERP | 10.0.700450

Epicor ERP Application User Guide - Part TwoChapter 8 | Suppliers and Accounts Payable



Payment Entry – Invoice Payments

You use the Invoice sheet to enter and edit payments made against a specific invoice. You apply these payments
against open invoices created for the supplier you selected on the Header sheet.

To do this:

1. Click the Down Arrow next to the New button; select New Invoice Payment.

2. Navigate to the Payment > Invoice Detail > Detail sheet.

3. In the Invoice field, enter the number of the invoices against which the payment applies.

4. The Invoice Date, Invoice Value, Balance, Terms, and Discount Date fields automatically display
information from the selected invoice.

5. In the Description field, enter information about the payment. If this payment is made by check, this text
prints on the check stub.

6. Enter the Gross Value of the payment, excluding discounts, in the currency of the supplier’s invoice.

7. If you need, change the amount in the Discount field. The application uses the discount terms defined on
the supplier record to calculate the amount. You can, however, change this value. To learn how to create
these terms, review the Purchasing Terms section earlier in this chapter.

8. The program subtracts the discount amount from the gross amount to calculate the amount in the Net
Payment field. The company pays this amount.

9. The New Balance field displays the difference between the amount of the supplier’s invoice and the Net
Payment.

10. When you finish, click Save on the Standard toolbar.
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Payment Entry – Select Invoices

Use Select Invoices to generate payments for all invoices due on a specific date. To use this function, you need
to enter a payment record. This process is described within the Payment Entry – New Payments section earlier in
this chapter.

To select multiple invoices for payment:

1. From the Actions menu, select Select Invoices.

2. The Select Invoices window displays. In the Due Date field, enter the date used to select the invoices. The
function returns all invoices due on or before this date. By default, the field displays the group’s Payment
Date.

3. Select Consider Discount Dates to limit the results to invoices with discount dates on or after the specified
due date.

4. Select Include Invoice without Payment Method to limit the results to include invoices without a payment
method in the results.

5. If you need, use the Filter sheet to change entries in the Supplier Groups and Payment Methods fields.

6. Click OK.
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7. The Invoice Payment Selection window displays. All invoices that match your selection criteria display on
the grid. Highlight the invoices you want on the grid.

8. The Candidates field displays the total value of the invoices that match your selection criteria.

9. The Selected field displays the total value of the invoices currently selected on the grid.

10. The Remaining field displays the balance that remains to be paid on the invoices that are not selected.

11. To select all the invoices, click the Select All button.

12. To remove your selections, click the Deselect All button.

13. Click OK.
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14. The invoices display in the Payments grid on the Payment > Header sheet. If you need, highlight the
payment and click the Invoices tab; you can then make changes to the invoice payment as needed.

Payment Entry – Miscellaneous Payments

Use the Misc Detail sheet to define miscellaneous expenses, which typically record un-invoiced payments for
products or services used in the company’s operation. You can also use the sheet to enter taxes that apply to
the expense.

To enter a miscellaneous payment:

1. Click the Down Arrow next to the New button; select New Misc Payment.

2. Select the Payment > Misc Detail sheet. In the Payment Amount field, enter the expense amount.

3. Use the Description field to enter additional information used for processing the invoice. The description
displays on the check stub when a check is used to pay the expense.
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4. Use the Expense Account fields to select the book and account to which the entry posts.

5. Optionally, use the Tax Liability field to change the taxing liability linked to the supplier for the current
payment.

6. When you finish, click Save on the Standard toolbar.

Payment Entry – Bank Fees

Use the Bank Fee sheet to enter bank charges that apply to the payment. Here is how:

1. Click the Down Arrow next to the New button; select New Bank Fee.

2. Use the Bank Fee field to identify the bank fee you need to place against the instrument.

3. Enter the Bank Fee Amount using the currency selected for the payment.

4. From the Actions menu, select New Bank Fee Tax  If you need to add tax amounts for the bank fee.

5. Use the fields in the Bank Fee Tax Detail section to add bank fee tax amounts as needed.

6. When you finish, click Save on the Standard toolbar.
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Payment Entry – Payment Tax

To add a tax to the payment:

1. Click the Down Arrow next to the New button; select New Tax.

2. A new line displays within the Payment Sales Tax list.

3. Select a Tax ID from the drop-down list. The program calculates the tax amounts based on the payment
amount and the tax percentage defined for the selected ID.

4. If you need, select the Manual check box. You can now directly enter the tax information by using the
Percent, Fixed Tax Amount, and Taxable Amt fields. The tax amount is calculated using these amounts.

5. When you finish, click Save on the Standard toolbar.

Epicor ERP | 10.0.700456

Epicor ERP Application User Guide - Part TwoChapter 8 | Suppliers and Accounts Payable



Payment Entry – Processing Pre-Payments

You can enter pre-payments in AP Payment Entry. Typically you generate pre-payments for a contract agreement
when AP invoices are not available.

To enter a pre-payment:

1. Click the Down Arrow next to the New button; select New Misc Payment.

2. Navigate to the Payment > Misc Detail sheet.

3. Enter the Payment Amount for the pre-payment.

4. Enter the Expense Account. This value defines the account recording the pre-payment amount.

5. Select the Pre-Payment check box. This indicates the amount is a pre-payment being sent to the supplier.

6. Continue entering more pre-payments as you need. When you finish, click Save on the Standard toolbar.
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Payment Entry – Processing Payments

When you finish entering your payments, you are ready to process them. You do this through Process Payment.
You launch this program from the Actions menu. Use this action to print checks or create electronic payments
files for all payments within the current group. For Electronic File Transfer payments, this process creates an
electronic bank export payment file.

The Payment Type selected for the group determines the settings and defaults in this program. You can use this
program to both print checks and create electronic payment files for group payment entries.

To do this:

1. From the Actions menu, select Process Payments.

2. The Process Payments window displays.

3. The Payment Date field defines the date applied to payments in the run. The company’s default fiscal
calendar determines the values that display in the Fiscal Year and Period fields.

4. The Forms field indicates whether the print run uses the Check form, the Remittance form, or Both forms.
The payment method determines the available options.

5. If you need, use the Bank Account field to change the bank account from which the payments are
withdrawn. By default, the field displays the account defined for the payment group.

6. If necessary, select the Override Payment check box and enter the first payment number in the run in the
Payment number currently loaded field. Each check or EFT (electronic file) in the run is given a sequential
number that begins with this value.
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7. When the group includes EFTs (electronic files), use the Bank Export File field to specify the file used to
send electronic payments. The default file originates from the payment method.

8. When you finish, click Print on the Standard toolbar.

Payment Entry – Post Payments

The Post command on the Actions menu completes the payment group process. Run this command after you
have processed the payments and verified that all checks printed correctly.

To post a payment group:

1. From the Actions menu, select Post.

2. The AP Payment Post Process window displays.

3. Click the Submit button on the Standard toolbar to post the payments contained within the current group
to the general ledger.

When the payment run contains checks, the application prompts you to verify that all checks printed correctly.
If posting errors occur, select the Group > Posting Log sheet to review an error log. You can re-post the group
after correcting the errors. If you post a receipt in error, run Void Payment Entry to correct the error.

Apply Debit Memo/Prepayment

Use the Apply Debit Memo/Prepayment program to record, or apply, debit memos against the total amount due
on selected AP invoices. The amount you apply is then subtracted from the total amount due on each AP invoice
you define through this program.

Prepayments are payments you make to a supplier in advance of receiving goods or services; you enter prepayments
within AP Payment Entry. You can then select the prepayment within Apply Debit Memo/Prepayment to add the
amount you are applying against the prepayment as a debit memo on the invoice. After you create a debit memo
against a prepayment, you can then add other invoices to the debit memo and enter additional amounts to apply.
When you enter all of the amount values you want on the debit memo, you then apply them against the selected
invoices.

Menu Path: Financial Management > Accounts Payable > General Operations > Apply Debit Memo / Prepayment

To update and apply debit memos:
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1. Click the Down Arrow next to the New button; select New Debit Memo/Correction Invoice.

2. Now find the prepayment you need for the current debit memo. Click the Invoice button to find and select
an invoice against which a prepayment was entered.

3. To limit the prepayment records to a specific supplier, click the Supplier button to select a record. You can
then click the Invoice button to find prepayments made against invoices linked to the selected supplier.

4. Enter the total amount of the debit memo in the Amount to Apply field.

5. Click the Transaction Apply Date drop-down list to select the date on which the demo memo will be
placed against the selected invoices.

6. Click Save on the Standard toolbar.

7. Optionally, you can add additional invoices to this debit memo. To do this, click the Down Arrow next to
the New button, the select New Invoice.

8. Navigate to the Detail sheet.

Epicor ERP | 10.0.700460

Epicor ERP Application User Guide - Part TwoChapter 8 | Suppliers and Accounts Payable



9. Click the Invoice button to find and select an invoice you need.

10. Click the Apply Date drop-down list to select the date on which you want this debit memo applied against
the selected invoice/invoice line.

11. Enter the Debit Amount you want to apply.

12. Click Save on the Standard toolbar.

13. To apply the debit memo against the selected invoices, from the Actions menu, select Debit
Memo/Correction Invoice. The total amount due on the selected invoices is reduced by the amounts you
entered against each invoice.

Void Payment Entry

Use Void Payment Entry to cancel posted payments. When you run this process, you create a reversing journal
and reopen the supplier invoice against which the payment was applied.

Menu Path: Financial Management > Accounts Payable > General Operations > Void Payment Entry

To void a payment:

1. Click the Binocular Search to find and select the payment that you need to void.

2. The Supplier ID, Name, and Address fields display the supplier for the listed payment.

3. Click the Apply Date drop-down list to select the date on which you are canceling the payment. Review
other information related to the payment to make sure you have selected the correct entry.

4. Click the Void button to complete the process. To the confirmation message, click Yes.
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Use Tax Calculation

Run the Use Tax Calculation process to send posted invoices that may need use taxes to Avalara. You only run
this process if you conduct business in a locality, such as the United States, that requires use taxes. This process
catches any additional use taxes required after an AP invoice was posted to your general ledger. Because use
taxes do not affect invoice totals, they often need to be recorded separately within your general ledger data.

You can select posted invoices by date range, supplier, and specific invoice/invoice line.

Menu Path: Financial Management > Accounts Payable > General Operations > Use Tax Calculation

To run the Use Tax Calculation process:

1. If you need to select posted invoices linked to a specific supplier, click the Supplier button to find and select
a record.

2. To select invoices posted during a specific time period, use the From and To data fields to select the dates
you need. All invoices posted on and between these dates are selected by the Use Tax Calculation process.
The dates for the current fiscal period display by default.

3. Select the Tax Category code for which you are reporting use taxes, or leave the field blank for all tax
category codes. These codes classify different products and services based on taxes, and are equivalent
AvaTax

®
 Tax codes.

4. You can limit the process to a specific invoice or a range of invoices. You can also limit the process to a
specific invoice line or a range of invoice lines on a selected invoice. To do this, click the Filter tab and select
the invoices you need.

5. After you finish your invoice selections, a summary of your choices displays within the Filter Summary area.

6. The use tax calculations are recorded within a log file. The default filename and directory path display within
the Log File Name field. If you need to change these options, click the Log File Name button to find and
select the directory path and file you need.

7. To calculate use taxes on the selected records, click the Submit button.
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Reports

This section describes some key reports you use to view information about Accounts Payable. You can run these
reports whenever you need. You can also set up each report to generate and print through a recurring, automatic
schedule. Review the Automatic Schedules section in the Epicor ERP Implementation Guide for information on
how you link a report to a recurring schedule.

Logged Invoice Suspense Balance Report

The Logged Invoice Suspense Balance Report is used for reconciliation of the logged invoice suspense account.
It shows the balance of the logged invoice suspense account and lists the logged invoices charged to it. This
report can either be generated by fiscal period or by a specific cut off date and be sorted by supplier or invoice.

Menu Path: Financial Management > Accounts Payable > Reports > Logged Invoice Suspense Balance

To set up and run this report:

1. In the Select By field, select whether the report displays logged invoices based on:

• Fiscal Year - Displays logged invoices for the specified fiscal year and period.

• Invoice Date - Displays logged invoices with invoice dates on or before the specified cutoff date.

2. If you selected Invoice Date, specify the Cutoff Date. Logged invoices with invoice dates prior to this date
print on the report.

3. If you selected Fiscal Year, specify the Fiscal Year and Fiscal Period. Logged invoices in the specified fiscal
year and period print on the report.

4. Select the Currency used to generate the amounts displayed on the report. The base currency for the current
company appears by default, but you can select another currency available for the company.
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5. Clear the Summary check box to print a detailed list of logged invoices charged to the suspense account.
Select the check box to print summarized logged invoice information.

6. Use the sheets under the Filter tab to select specific GL accounts and suppliers to include on the report.

7. When you finish, click Print on the Standard toolbar.

Received Not Invoiced Report

The Received but not Invoiced report lists the purchase orders for which no invoice is available.

Menu Path: Financial Management > Accounts Payable > Reports > Received Not Invoiced

To set up and run this report:

1. Use the Receipt Date From field and the To field to define the date range for the report. Receipts that
arrived during the specified range display on the report.

2. When you finish, click Print on the Standard toolbar.

AP Invoice Balance Report

The AP Invoice Balance Report lists AP invoice balance information for open, closed, or all invoices for one or
multiple suppliers. You can optionally select debit memos, pre-payment invoices and GL account information for
inclusion on the report. You can also filter AP invoice information using various criteria including supplier, supplier
group, GL control and GL accounts.

Menu Path: Financial Management > Accounts Payable > Reports > AP Invoice Balance

To set up and run this report:

1. In the Range By area, select whether the report displays invoices based on:

• Fiscal Period - Displays logged invoices for the specified fiscal year and period.

• Apply Date - Displays invoices with apply dates within the specified begin and end date ranges.

• Open Invoices at End Date - Displays invoices with invoice dates on or before the specified end date.
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• Invoice Date - Displays invoices with invoice dates within the specified begin and end date ranges.

2. In the Begin Date field:

• If you selected Apply Date, enter the beginning apply date. Invoices with apply dates on or after this field
display on the report.

• If you selected Invoice Date, enter the beginning invoice date. Invoices with invoice dates or after this
field display on the report.

3. In the End Date field:

• If you selected Apply Date, enter the ending apply date. Invoices with apply dates on or before this field
display on the report.

• If you selected Invoice Date, enter the beginning invoice date. Invoices with invoice dates on or before
this field display on the report.

• If you selected Open Invoices at End Date, enter the beginning invoice date. Open invoices with invoice
dates on or before this field display on the report.

4. In the PI Option field, select a payment instrument option for the report:

• Open Balance Only - Include open balance payment instruments only.

• Exclude Outstanding PI - Exclude outstanding payment instruments from the report.

• List Separately - List payment instruments separately.

• Display PI Only - Display payment instruments only on the report.

5. In the Book field, select the GL book used for the report.
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6. If you selected Fiscal Year, specify the Fiscal Year, Begin Period and End Period. Invoices in the specified
fiscal year and period range print on the report.

7. Select Include Debit Memos to include debit memo transactions in the report.

8. Select Pre-Payments Only if you want to include only pre-payment transactions in the report.

9. Select Include GL Account Information to include GL account information on the report.

10. Clear the Summary Data Only check box to print a detailed list of open invoices. Select the check box to
print summarized open invoice information.

11. In the Sort By field, select the sort criteria for the report in the Available field, and then click the right
arrow button to move the selected sort criteria to the Selected field.

12. Use the sheets under the Filter tab to select specific suppliers, supplier groups, GL controls and GL accounts
to include on the report.

13. When you finish, click Print on the Standard toolbar.

Payment Proposal Report

The Payment Proposal Report lists all AP invoices that need to be paid up to a specified due date. This report
displays amounts in the base currency selected for the current company, and sorted by due date on each AP
invoice.

Menu Path: Financial Management > Accounts Payable > Reports > Payment Proposal

To set up and run this report:

1. Specify the Due Date for which the proposed payments are selected. Any unpaid invoices due on or before
this date display on this report. The current date displays by default, but if you need, you can select a different
date from the drop-down calendar.
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2. Select the Consider Due Dates check box if the report should calculate discounts on all invoices selected
for the report. If a invoice falls within the discount period defined for the payment terms on an invoice, the
amount to pay on this invoice is reduced to reflect the discount available for prompt payment

3. If you selected the Consider Due Dates check box, use the Exclude Invoices with Zero Discount check
box to indicate if invoices with zero discount amounts should be excluded from the report.

4. Select the Include Invoices On Hold check box invoices placed on payment hold that are due on or before
the specified due date should be included on the report.

5. Use the sheets under the Filter tab to select specific supplier groups and payment methods to include on
the report.

6. When you finish, click Print on the Standard toolbar.

Aged Payables Report

The AP Aged Payables Report displays each supplier’s open invoices. These invoices display in order by the number
of days in which they are past due. You can create the aging format and then select the format you want on
this report.

To learn more about creating aging formats, review the Aging
Report Format Maintenance topic within application help.

Menu Path: Financial Management > Accounts Payable > Reports > Aged Payables

To set up and run this report:

1. In the Select By area, select whether the report displays invoices based on:

• Apply Date - Displays invoices with apply dates on or before the Aged As Of date.
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• Invoice Date - Displays invoices with invoice dates on or before the Aged As Of date.

2. In the Age By area, select whether the report ages the invoices based on:

• Due Date - Compares the invoice’s Due Date to the Aged As Of Date to determine into which aging
column the invoice is placed.

• Invoice Date - Compares the Invoice Date with the Aged As Of Date to determine into which aging
column the invoice is placed.

3. In the Aged As Of field, enter the date used to calculate aging for the report. When you generate this
report, its aging columns are calculated in increments based on both the selected aging method and this
date.

4. Select Include Logged Invoice to include logged invoices in the report. Logged invoices are recorded and
posted to a suspense account and are not posted to your financial records until approved and paid. For
more information, review the Logged Invoice Entry section earlier in this chapter.

5. Select Include Payment Instrument to include payment instruments in the report. Payment instruments
refer to a diverse range of payment methods like promissory notes and future-dated checks. For more
information on payment instruments, review the Payment Instrument Payable Entry section earlier in this
chapter.

6. Select Include Pre-Payments to include pre-payment transactions in the report. For more information on
pre-payments, review the Payment Entry – Processing Pre-Payments section earlier in this chapter.

7. Select Pre-Payments Only if you want to include only pre-payment transactions in the report.

8. Select Summary Only to generate a report that only displays totals.

9. Optionally, change the currency of the report in the Target Currency field. The amounts on this report
update to display values using the current exchange rate for the new (target) currency.
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10. Fields in the Filter Summary section limit the invoices included on the report. Use the Filter sheet to restrict
this report to only display transactions created for specific GL Controls and Suppliers.

11. The Aging field defines the aging method used for this report. The method selected within Company
Configuration displays by default, but you can select a different method.

For more information on Company Configuration, review
the Epicor ERP Implementation Guide.

12. When you finish, click Print on the Standard toolbar.

Use Tax Report

Even though the Avalara service offers a set of reporting options you can leverage to track the amount of use
tax you are assessed, a corresponding Use Tax Report is also available in the application. You only run this report
if you conduct business in a locality, such as the United States, that requires use taxes. Leverage this report to
compare and reconcile against the Avalara information generated on the AvaTax site.

This report is similar to the Sales Tax Report found in the Accounts Receivable module.

Menu Path: Financial Management > Accounts Payable > Reports > Use Tax

To set up and run this report:

1. Use the From and To fields to define the date range for the report. Any transactions that occur on or
between these days display on the report.

2. Optionally, click the Target Currency drop-down list and change the currency of the report.

3. Select Summary Only if you want to only print header information for all the transactions included on the
report.

4. Use the Filter sheet to restrict this report by specific tax types or tax liabilities. These settings display in the
Filter Summary section of the Selection sheet.

5. When you finish, click Print on the Standard toolbar.
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VAT Tax Report

Use the VAT Tax Report to set up reports and electronic files for value-added taxes (VAT) and other taxes. VAT
is calculated for transactions within the European Union, as well as other countries. This report automatically
displays all the VAT amounts levied during a fiscal period that you select, for specified customers, suppliers, tax
liability codes, tax type codes, report category codes and tax jurisdiction codes.

The application updates VAT report tables with transactions created through invoice and bank movement
processes. Because of this, it may be necessary to review the report output and then make needed adjustments.
Use this as an opportunity to correct timing issues. This can also help you account for transactions not tracked
by the invoice and bank movement routines - like partially irrecoverable expense payments or self supplied material
quantities.

The first VAT report you run includes sales tax information from all previous periods for the current year. This
makes sure that all invoices are reported to tax authorities.

Menu Path: Financial Management > Accounts Payable > Reports > VAT Tax

Tax Report – Detail

Use the Detail sheet to create a new report and to select various report options.

To set up and run this report:

1. Click the Report ID button to find and select a report identifier. If you are creating a new VAT report, enter
the identifier in this field. To edit an existing VAT report, click the Report ID button to find and select it.

2. In the Description field, enter a description for the report. This text is printed on the report.

3. In the Report Title field, enter a title that will print at the top of the VAT report.

4. Click the Fiscal Calendar button to search for and select an existing fiscal calendar record that applies to
the tax report.
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5. Click the From drop-down list to select the date on which the report will start. All sales taxes levied on this
date forward to the To date will be included on the report.

If you have selected a Fiscal Calendar, this date becomes
the first date of the selected fiscal period and this field is
disabled. If you do not select a Fiscal Calendar, you can
enter this date directly, or click the Down Arrow to select
a date from the calendar.

6. Click the To drop-down list to define the date on which this report will end. All sales taxes levied on this
date back to the From date will be included on the report. The report uses the To date to determine what
invoices will be included in the VAT calculations. The tax lines must have Invoice Dates that are less than or
equal to the To Date. The tax lines must also have Invoice Dates that occur after the To Date on the previous
report.

7. In the Report Date field, enter the date on which this VAT report was created. The Enter Date for the report
must be less than or equal to the Report Date.

8. Select the Accounts Payable and/or Accounts Receivable check boxes to indicate the transactions from
the corresponding module are included in the report.

9. Use the sheets under the Filter tab to select a specific range of records to display on your report.
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Tax Report – Print Form

Use the Print Form command from the Actions menu to print the current report in its form version.

To print the form:

1. From the Actions menu, select Print Form.

2. Click the Target Currency drop-down list and select the code of the currency used for the report.

3. Select the Report Style, the Schedule, and the Archive Period for the report.

4. Click Print Preview to preview the report.

5. When you finish, click Print on the Standard toolbar.
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Tax Report – Print Edit List

The Print Edit List command lets you print out the current tax report in an edit list format. Use this report to
review the details for tax amounts calculated by the report.

To generate the report:

1. From the Actions menu, select Print Edit List.

2. Click the Target Currency drop-down list to select the code of the currency used for the report.

3. Select the Print Tax Account Summary check box to add GL analysis to your report.

4. Select the Backdated Items option for the print edit list.

• Backdated Items Are Included - Include backdated tax transactions on the report.

• Backdated Items Are Excluded - Exclude backdated tax transactions from the report.

• Only Backdated Items Are Included - Include only backdated tax transactions on the report.

5. Select the Report Style, the Schedule, and the Archive Period for the report. Enter the User Description.

6. Click Print Preview to preview the report.
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7. When you finish, click Print on the Standard toolbar.

Tax Report - Post Report

Use the Post Report command to close the current report once you are ready to finalize the VAT amounts. A
report is automatically closed after it is posted and no longer can be updated. The report can, however, be viewed
and printed.

When the VAT report is posted, the user is prompted to enter the Report Date. The posting process writes the
Report ID, the Report Date, and the Post Date into the tax line. This is for auditing purposes. Even when the tax
report is deleted, the tax lines keep this audit trail.

To post the report:

1. From the Actions menu, select Post Report.

2. Click the Report Date drop-down list to select the appropriate date you want to use for the report.

3. Select the Update Tax Box Summary (TaxRptDtl) check box.

4. Click OK.
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Tax Report – Electronic Report Maintenance

Use the Electronic Report Interface selection as needed to export reports for electronic transmission It uses
electronic interface records defined in Electronic Interface Maintenance to format tax box or tax detail reports.

To set up and run this selection:

1. In the Electronic Interface field, select the interface that supplies formatting for the exported file. Exported
files use formatting defined in Electronic Interface Maintenance.

2. Select Export File to search for the file that should store the exported information.

3. Select the Backdated Items option for the electronic interface export.

• Backdated Items Are Included - Include backdated tax transactions on the report.

• Backdated Items Are Excluded - Exclude backdated tax transactions from the report.

• Only Backdated Items Are Included - Include only backdated tax transactions on the report.

4. In the Actions menu, select Generate Export File. The interface uses properties defined for the interface
to export the report file.
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Tax Report – VAT Tax Journal Report

Use the VAT Tax Journal Report to create a report displaying tax amounts analyzed by both VAT codes and chart
of accounts. This report supplements the standard VAT Tax Report and is used to audit the accuracy of the
standard VAT Report. It is specific to countries that require additional tax reporting. You can also filter VAT tax
journal information using various criteria including supplier, supplier group, GL control and GL accounts.

To set up and run this report:

1. Select Accounts Payable to include AP invoices on the report.

2. Select Accounts Receivable to include AR invoices on the report.

3. Select the Summary Only check box to print only summarized VAT tax totals on the report. Clear the check
box to print VAT detail information.

4. Use the sheets under the Filter tab to select specific suppliers, supplier groups, GL controls and GL accounts
to include on the report.

5. When you finish, click Print on the Standard toolbar.
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Chapter 9: Cash Management

The Cash Management module contains functionality for creating and managing both bank and cash accounts. These
records affect how payments generate and how cash receipts are received.

Cash Management includes setup programs used to define bank accounts and bank fees associated with cash receipts,
cash payments, bank statements, and bank adjustments. Bank Branch Code Maintenance defines codes used to group
bank accounts. Bank Account Maintenance identifies bank accounts and defines their routing information, payment
methods, and posting accounts. Finally, Bank Fee Maintenance defines the tax and accounting results of bank fees.

You also use Cash Management programs to manage bank accounts and the company’s general ledger cash accounts.
Bank Adjustment Entry adjusts bank account amounts and enters bank fees. Bank Funds Transfer transfers amounts
between bank accounts. Bank Reconciliation Entry reconciles a bank balance with cash balances in the company’s
books.

To help you manage these accounts, generate the reports in this module so you can review the information you need.
The Payment Proposal report displays the AP invoices that must be paid up to a selected due date. The Check Register
report displays all the checks created during a selected period. This report includes all regular checks, manual checks,
voided checks, and electronic payments.

With an additional license from Epicor, the Cash Management module includes Petty Cash functionality. Petty cash is
cash on hand that a company may use to:

• Pay wages and salaries in cash

• Pay employee expenses in cash

• Receive cash from customers

• Pay cash to suppliers

By leveraging this functionality, you can create petty cash document forms in compliance with the requirements needed
by many government organizations. Key features are in place to support legal requirements for petty cash for legal
numbering, document forms, and daily balances and reports.

Setup

This section describes the primary records you need to create for the Cash Management module. These programs
are contained within the Setup folder for this module. Only the primary records are described here. Some areas
within the next Operations section may also document setup records if they are required for a specific workflow.

Bank Branch Code Maintenance

Use Bank Branch Code Maintenance to define codes used for specific bank branch offices. You can associate
branch codes with accounts in Bank Account Maintenance; these codes group bank accounts together under a
specific branch.

Menu Path: Financial Management > Cash Management > Setup > Bank/Branch Code

To define a branch:
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1. Click New on the Standard toolbar.

2. In the Code field, enter a unique identifier for the branch. You can click the Code... button to search for
existing bank branch codes.

3. In the Name field, enter the name of the branch. This name displays within other programs.

4. In the Bank Name field, you can optionally enter the name of the parent bank that owns the bank branch
office.

5. When you finish, click Save.

Bank Account Maintenance

Use Bank Account Maintenance to identify the company’s bank accounts and define their routing information,
payment methods, and posting accounts. You use this program to set up account currencies, the general ledger
accounts affected by transfers and adjustments, and the method used to post balances. You can associate an
account with either a supplier or a customer, as well as with payments, checks, and invoices. The Balance sheet
displays account balances by fiscal period for accounts currently in use.

Menu Path: Financial Management > Cash Management > Setup > Bank Account

Detail

Use the Detail sheet to identify the account, supply routing information, and set defaults that affect posting of
account transactions.

To define an account:
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1. Click New on the Standard toolbar.

2. In the Account field, enter a unique identifier for the account. You can click the Account... button to search
for existing bank accounts.

3. In the adjacent field, enter the description of the account. This description helps you select the correct
account during transaction entry.

4. In the Bank Name field, enter the full name of the bank.

5. In the Bank Identifier field, enter the identifier provided to the bank by a regulatory body. This values help
you select the account in application programs. For example, you can enter the identifier assigned to a U.S.
financial institution by the American Bankers Association (ABA).

6. If you need, in the Bank/Branch field, enter the branch where the account is located.
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7. Optionally, enter the international identifier for the bank in the IBAN Account Code field. The IBAN standard
is designed to facilitate payment routing within the European Union (EU) and among banks in other non-EU
countries.

8. If the account is used for checking, in the Checking Account field, enter the number of the checking
account.

9. Click the Currency drop-down list to define the currency of the account.

10. Optionally enter a Payer Reference for the account.

11. Letter of Credit Limit

12. Use the Closed check box to indicate this bank account can no longer be used. If an account is closed, it is
not available for selection when you make payments.

13. If the account is limited to deposits resulting from debit notes, select the Debit Notes Only check box.
Debit notes are used to recoup undercharges, additional service charges, and other deductions applied to
a customer’s payment or invoice.

14. Select the Use Bank Average for Payment check box to use the bank average value as the rate for
payments from this account. Bank accounts that are set up with this option are excluded by default from
revaluation selection when running the Currency Revaluation Process.

15. Use the Routing Information section to define the bank code used to process direct deposits and other
automated transfers.

• In the Routing field, enter the Federal Reserve Routing Symbol.

• In the ID field, enter the ABA Institution Identifier.
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• In the Check Digit field, enter the Check Digit.

16. In the Entry Class Code field, enter the Standard Entry Class (SEC) code that identifies the nature of entries
connected with the account. For example, you might enter WEB (Web Initiated-Entry) for an account used
for transactions from a credit card authorization service. Contact your bank for the appropriate value. Other
options include Prearranged Payments and Deposits for consumer items (PPD), Cash concentration and
disbursements for non-consumer items (CCD), and Reversal items (REV).

17. In the Service Class Code field, enter the Automated Clearing House (ACH) number that designates the
type of entries processed through the account. For example, you enter 200 if the account is used for both
debits and credits.

18. Select the Consolidate Invoice Print check box to indicate that multiple invoices can be applied against
the same check remittance when using the specified bank account. If you select this check box, the
Preprinted Check Numbers check box and Invoices on Check Stub field are enabled. Select the Preprinted
Check Numbers check box to print the number of invoices indicated in the Invoices On Check Stub field on
each check stub, and to generate a new check number for each check stub printed.

19. When you finish, click Save.
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GL Controls

Use the GL Control sheet to select controls that define the GL accounts affected by the bank account’s activities.

For more information on GL Controls, review the General
Ledger chapter in the Epicor ERP Implementation Guide.

Bank Account Maintenance – Payment Methods

Use the Payment Methods sheet to associate payment methods used for account deposits and withdrawals. You
can designate AR and AP payment methods for the account. The designated module determines which methods
can apply when the account is selected in AP and AR entry programs. For more information on payment methods,
review topics in application help.

If you want, you can define multiple AR and AP payment methods, including an Electronic Interface payment
method for Electronic Funds Transfer (EFT) processing. When multiple methods are defined, users can select the
method used when they enter transactions.

The following instructions describe how to associate an AP payment method with the account. These instructions
generally apply to defining an AR payment method as well.

To associate an AP payment method with an account:

1. Click the Down Arrow next to the New button; select New AP Payment Method.

2. From the Payment Method drop-down list, select a payment method associated with the account.
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3. If multiple methods are defined, select the Is Default check box to designate the default payment method
for this account in AP entry programs.

4. When you finish, click Save on the Standard toolbar.

Bank Account Maintenance - Bank Reconciliation

Use the Bank Reconciliation sheet to define bank reconciliation settings for AR and AP. On this sheet you can
specify whether you want to use an AR or AP pending account for reconciling balances.

When the Reconciled AR Balance or Reconciled AP Balance check boxes are selected, deposits and cash
withdrawals are posted to pending cash accounts and moved from the corresponding pending accounts to cash
when these items are reconciled via Bank Reconciliation Entry.

To use an AR or AP pending account for reconciling balances:

1. Navigate to the Bank Reconciliation sheet.

2. Select Reconciled AR Balance to delay the posting of deposits and receipts to the cash account until the
bank statement is reconciled in Bank Reconciliation Entry. The selection of the Reconciled AP Balance option
delays the posting of withdrawals until after bank reconciliation.

3. Select Reconciled AP Balance to delay the posting of withdrawals to the cash account until the bank
statement is reconciled in Bank Reconciliation Entry.

4. When you finish, click Save on the Standard toolbar.

Bank Fee Maintenance

Use Bank Fee Maintenance to define the tax and accounting effects of bank fees. Bank Fee Maintenance can
also be used to record an interest percentage that your company earns. Banks assess fees for overdrafts, processing
foreign currency cash receipts, and other reasons.

You use this program to associate a tax rate with a taxable fee and determine the general ledger accounts to
which fee amounts post. Users can use fee codes with cash receipts or payment entries, or with bank adjustments
when reconciling a bank’s statement.

Menu Path: Financial Management > Cash Management > Setup > Bank Fee

Use the Detail sheet to identify the fee and associate a rate with taxable fees.

To define a bank fee:
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1. Click New on the Standard toolbar.

2. In the Bank Fee field, enter a unique identifier for the fee.

3. In the Description field, enter a description that helps you select this fee during transaction entry.

4. If taxes apply to the fee, click the Tax Code drop-down list to select the tax type that applies to the fee.
You can apply Invoicing and Self-assessment tax types to bank fees.

5. If a tax code is selected, click the Rate Code drop-down list to select the effective rate used to calculate
tax. You can override the rate in entry programs where fees apply.

6. When you finish, click Save.

7. Use the Description sheet to enter translations for the fee description.
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8. Use the sheets under the GL Control tab to select GL controls that determine the accounts affected when
the fee is applied.

For more information on GL Controls, review the General
Ledger chapter in the Epicor ERP Implementation Guide.

Legal Numbers

Use the following programs to set up the legal numbers you require for cash transactions.

Document Type Maintenance

Use Document Type Maintenance to define a document type that will link a system transaction to a unique legal
number. Examples of document types include AP Invoices, Promissory Notes, Petty Cash transactions, and
Withholding Taxes.

Menu Path: Financial Management > Cash Management > Setup > Transaction Document Type

Refer to the Legal Numbers chapter in the Epicor ERP Implementation Guide for instructions on creating document
types.

Legal Number Maintenance

Use Legal Number Maintenance to configure legal number sequences and associate the sequences with document
types. This association allows the use of the numbers with internal transactions and external documents.

Menu Path: Financial Management > Accounts Payable > Setup > Legal Number

Refer to the Legal Numbers chapter in the Epicor ERP Implementation Guide for instructions on creating legal
numbers.
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Electronic Interfaces

Use the following programs to set up the electronic file transfers you need for cash transactions.

Electronic Interface Maintenance

Use Electronic Interface Maintenance to define the electronic interfaces used in both EFT and soft-format reports.
For EFT, the interface’s .p (Progress) program formats the data to match the bank format while the interface
properties define the fields used to send the data. For soft format reports, the .p plug-in file and its properties
provide the formatting needed to generate a report file.

Menu Path: Financial Management > Accounts Payable > Setup > Electronic Interface

Refer to the Electronic Interfaces chapter in the Epicor ERP Implementation Guide for instructions on creating
electronic interfaces for EFT processing.

Pay Method

Use Pay Method Maintenance to set up an electronic interface to receive payments. You can then associate this
payment method with customers in Customer Maintenance or suppliers in Supplier Maintenance for EFT processing.

Menu Path: Financial Management > Accounts Receivable > Setup > Payment Method

Refer to the Electronic Interfaces chapter in the Epicor ERP Implementation Guide for instructions on how to
create a new payment method.

Petty Cash Operation Type

Use Petty Cash Operation Type Maintenance to define the various petty cash operations your company uses (for
example, payments to suppliers or receipts from customers). These operation types are based on the petty cash
operation classes (cash issue or receipt) defined in the Epicor application.

This program is only available with an additional license from
Epicor.

Menu Path: Financial Management > Cash Management > Setup > Petty Cash Operation Type

Use the Detail sheet to define petty cash operation type properties and to link petty cash operations to
system-defined petty cash operation classes.

1. Click New on the Standard toolbar.
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2. In the Operation field, enter a unique identifier for the operation type and a description in the adjacent
field.

Click the button the search and select existing operation types.

3. Click the Direction drop-down list to select either Cash Issue or Cash Receipt.

4. Enter a Reason text for the transaction. This field is required.

5. From the Recipient/Payer Type field, select the appropriate recipient or payer type.

6. Click the Operation Class drop-down list to select the operation class to be linked to the operation type.
The available options depend on the selections made in the Direction and Recipient/Payer Type fields above.

7. If you have selected Customer or Supplier in the Recipient/Payer Type field, you can select a Default
Role Code from the  drop-down list (for example, AR Manager).

8. Select the Payroll Balance check box to indicate this operation type must balance payroll accounts. If you
select Wages and Salaries for the Operation class, this check box is automatically selected.

9. If you need to enter a custom exchange rate during Petty Cash Entry, select the Override Exchange Rate
Date check box.

10. When you finish, click Save.

11. Use the sheets under the GL Controls tab to select controls that determine the accounts affected by the
operation type.
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For more information on GL Controls, review the General
Ledger chapter in the Epicor ERP Implementation Guide.

Petty Cash Desk Maintenance

Use Petty Cash Desk Maintenance to enter and update petty cash desk properties and defaults. You can also set
up authorized users and operations.

This program is available if you have the additional Petty Cash
module license.

The petty cash desk is the main facility for petty cash operations. Use this program to maintain daily balances,
provide cash day open and close procedures, and define cash limits.

Menu Path: Financial Management > Cash Management > Setup > Petty Cash Desk

Petty Cash Desk Maintenance – Detail

Use the Detail sheet to define a new petty cash desk. To add a petty cash desk record:

1. Click New on the Standard toolbar.

2. In the Cash Desk field, enter a unique identifier for the cash desk.

You can click the button to search for existing records.

3. Enter a Name for the petty cash desk.
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4. Click the Day Close Mode drop-down list to select either the Soft or Strict option. With the Soft option,
more than one cash day can be active at one time. With the Strict option, only one cash day can be active.

5. Enter the Cashier name.

6. If required, enter the Entrusted Cashier name. This person is then responsible for handling cash desk
entries.

7. When you enter an Entrusted Cashier, use the Entrusted From and Entrusted To date fields to select the
time period during which this person is responsible for cash desk transactions.

8. The Allow Negative Balance check box is selected by default. This parameter only affects the petty cash
entry routine.

It is not possible to close a petty cash day with a negative
balance.

9. If you want to set a cash limit for the petty cash desk, enter an amount in the Cash Limit Total field. If you
enter zero, the cash limit for the petty cash desk is not checked.

10. The Except Payroll value defines an exception to the cash limit total, reserved for employee salaries and
social payments. This is required in some countries.

11. If the cash desk has an initial balance, enter the total in the appropriate Initial Balance or Initial Payroll
Balance field. These balances apply from the In Operation From date.

12. When you finish, click Save.
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13. Use the Authorized Users sheets to add users to the list of people who can access the petty cash desk.
The user who creates a petty cask desk is automatically added to this list.

14. Use the GL Controls sheets to select controls that determine the accounts affected by the petty cash desk.

For more information on GL Controls, review the General
Ledger chapter in the Epicor ERP Implementation Guide.

Petty Cash Desk Maintenance – Available Operations

Use the Available Operations sheet to define the operation types available for a specific petty cash desk. To
activate a petty cash desk, you must specify at least one operation.

To associate an operation type with a petty cash desk:
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1. Click the Down Arrow next to the New button; select New Available Operation.

2. Click the Operation Type drop-down list to select the operation type you want linked to the petty cash
desk.

3. When you finish, click Save on the Standard toolbar.

4. You can now activate the petty cash desk. Navigate to the Detail sheet.

5. Clear the Inactive check box.

6. Click Save.
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Review the previous section for details on how to create petty cash operation types.

Operations

This section describes the operations available in the Cash Management module. Each operation is described as
a workflow to help guide you through the process from start to finish. These programs are primarily found within
the General Operations folder for this module. If a unique setup record is required to run the operation, this
record is also described in this section.

Bank Adjustment Entry

Use Bank Adjustment Entry to adjust bank account amounts and to enter bank fees. You can use Print Group
Edit List on the Actions menu to review entries prior to posting. Use Post on the Actions menu to post transactions
in the selected adjustment group.

Menu Path: Financial Management > Cash Management > General Operations > Bank Adjustment Entry

Bank Adjustment Entry – Summary

Use the Summary sheet to define a group used to post adjustments and to select the bank account to which the
adjustment applies.

To create an adjustment group:

1. Click New on the Standard toolbar.

2. In the Group ID field, enter the identifier for the entry group. Entry group names can use a combination of
letters or numbers.

You can click the button to search for existing entry groups.

3. Click the Trans Apply Date drop-down list to select the default date for adjustments in the group.

4. The Trans Apply Date entry and the company’s default fiscal calendar determine the entries displayed in the
Fiscal Year and Fiscal Period fields.
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5. Click the Bank drop-down list to select the bank where the account is located. The sheet displays the bank
currency and the account number.

6. When you finish, click Save.

Red Storno transactions are only used in certain countries.
For information on how to enable or disable red storno,
refer to the Company Configuration chapter in the Epicor
ERP Implementation Guide.

Bank Adjustment Entry – Adjustment

Use the Adjustment sheet to either create entries for an adjustment group or enter lines on a bank reconciliation
statement. You can use this sheet to enter adjustments and bank fees.

To create an adjustment:

1. Click the Down Arrow next to the New button; select New Adjustment.

2. Navigate to the Adjustment sheet.

3. If you need, change the default in the Transaction Apply Date field. The period to which an adjustment
applies is determined by this date and the book selected on the Adjustment sheet.

4. In the Reference field, enter additional information about this adjustment.

5. In the Amount field, enter the adjustment amount. A positive amount represents a deposit and a bank
balance increase. A negative amount represents a cash withdrawal and a bank balance decrease.

6. If required, click the Bank Fee button to search and select the fee that applies to the adjustment.

7. Click Save.

The G/L Account field populates with the default GL account for this transaction.
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8. To change the GL account, use the G/L Account fields to select the book and the account to which the
adjustment posts, then click Save. The fiscal calendar for the selected book determines the apply date for
the transaction and the COA for the book determines the available accounts.

9. If you have changed the GL account, you can click the Get Default button to revert to the default account,
then click Save.

10. To apply tax to the transaction, click the Down Arrow next to the New button; select New Tax.

11. Select the applicable Tax ID (Tax Type) and Rate Code.

12. To adjust amounts, select the Manual check box and use the Percent, Fixed Tax, Taxable Amt, and Tax
Amt fields to adjust the calculated amounts.

13. When you finish, click Save.

14. The amount fields update to reflect the tax impact.

You can now post the adjustment.
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15. From the Actions menu, select Post.

16. The Bank Adjustment Post Process window displays.

17. Click Submit, then close the window.

The bank adjustment is posted.

Bank Funds Transfer

Use Bank Funds Transfer to move amounts between bank accounts. This program supports currency conversions
when the two accounts use different currencies.

Refer to the Currency sheet in Company Configuration to determine the setting you want for bank funds transfers
when the accounts use different currencies. You define this setting on the Currency Exchange Difference
drop-down list. Available options:

• Always use the default rates

• Use explicit transfer amount, or use default rates

• Use explicit transfer amount, or use source amount

The transfer creates journals that post to accounts determined by the GL controls assigned to the bank accounts.
The journals typically debit and credit cash and transfer (clearing) accounts for the bank accounts involved in the
transfer.

Refer to the Bank Funds Transfer topic in the application help
for examples of the Currency Exchange Difference options.

Menu Path: Financial Management > Cash Management > General Operations > Bank Funds Transfer

To transfer funds:
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1. Click New on the Standard toolbar.

2. Click the Apply Date drop-down field to change the date on which the transfer occurs. This value and the
company’s default fiscal calendar determine the values displayed in the Fiscal Year and Period fields.

3. In the Transfer From section, click the Bank drop-down list to select the bank from which the funds are
withdrawn. The balance details for the account update.

4. In the Amount field, enter the amount to transfer, in the currency of the account.

5. The New Balance field updates to display what the bank balance will be after the transfer.

6. In the Transfer To section, click the Bank drop-down list to select which bank receives the funds deposit.

7. If two accounts use different currencies, you can use the Rate Group field to select which rate group the
exchange rate comes from.

8. Optionally, you can use the Amount field in the Transfer To section to further adjust the converted amount.

9. If you need, enter an alternative text in the Reference field. The application creates a default reference that
uses the short names of the two accounts.

10. When you finish, click Transfer.
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11. The Bank Funds Transfer Process window displays.

12. Click Submit.

The bank transfer is posted.

Cash Receipts Entry

Use Cash Receipts Entry to enter and post cash receipts. These receipts are transactions you enter for customer
payments, customer credits, or miscellaneous cash amounts.

You process cash receipts through groups. Payments are grouped to post in a batch mode and update the General
Ledger (GL). Unlike an invoice entry group, a cash receipts entry group always defines the date of all payments
in the group, the fiscal period to which it posts, and the receiving bank account.

If you would like to use EFT processing and/or legal numbers
for cash receipts, review the Legal Numbers and Electronic
Interfaces chapters in the Epicor ERP Implementation Guide.

You can create the following cash receipt transaction types. Refer to the Customers and Accounts Receivable
chapter in this guide for instructions on creating deposit payments and miscellaneous payments in Cash Receipts
Entry.

• Invoice Payments – Enter these transactions with basic check information. They include detail lines that
describe how the check is used against the customer’s outstanding invoices. These transactions debit the
Cash account and credit the Accounts Receivable account.

• Deposit Payments – These transactions track down payments made against specific sales orders (allocated)
or not linked to a sales order (unallocated). They debit the Cash account and credit the account number you
enter, which is normally a Prepayments liability account.

• Miscellaneous Payments – These transactions track miscellaneous cash received from sources other than
customers. They debit the Cash account and credit the account number you select.

• Debit Notes – Enter these transactions when a customer requires a payment or invoice deduction. These
transactions create open payable amounts. Debit notes can be applied as unallocated amounts on a payment.
They can also be linked directly to an invoice, reducing the invoice’s total amount due.

You can also create Unapplied Receipts. By selecting the On Account check box, these transactions are automatically
created when you enter a customer payment that is not applied to a specific open invoice or credit memo.

You can use Apply Credit Memo to apply the credit memo
amount  to another invoice. You can also use AR Write Off
and Adjustment to adjust the balance of the invoice.  For more
information, refer to the Apply Credit Memo and AR Write Off
and Adjustment topics in the application help.

When cash receipts post, they update invoice balances, create GL entries, and update Bank Reconciliation deposit
information.
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Enter Receipts

This section describes how you enter cash receipts in Cash Receipts Entry.

Menu Path: Financial Management > Cash Management > General Operations > Cash Receipt Entry

Groups

You begin the Cash Receipts Entry process by creating an entry group. You can then enter and post cash receipts
and invoice payments that are processed through this entry group.

To create a new entry group:

1. Click the Down Arrow next to the New button; select New Group.

2. In the Group field, enter an identifier for the entry group.

You can also click the button to search for existing entry groups that have not yet been posted.

3. In the Bank Account field select the bank account you want for your transaction. The cash receipts for the
group are deposited within this bank account.

If a receipt is received through an electronic payment,
select a bank account set up for EFT processing. When
you select a payment method linked to an electronic
interface, the Electronic Interface options activate on the
Actions menu.

4. Click the Payment Method drop-down list to select the payment method for your invoice payments.

You can set the default in Bank Account Maintenance.

5. The Transaction Apply Date defines the date placed on the cash receipts within the group. The current
date displays by default; if you need, select a different date.

6. Click Save.
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You are now ready to add an invoice payment or cash receipt to your entry group.

Invoice Payments

Typically, you use Cash Receipt Entry to enter customer payments made against specific invoices. Enter payment
information, then select the invoices against which this payment is made.

To enter an invoice payment:

1. Click the Down Arrow next to the New button; select New Invoice Payment.

2. The A/R Receipt > Header sheet displays.

3. In the Check field, enter the number that identifies the check. You can enter the number from the check
or any other reference number.

4. Use the Receipt Amount field to enter the amount of the payment.

5. Select the Receipt Currency from the drop-down list.

6. Use the Settlement Currency field to define the currency of the invoice. This updates the Settlement
Amount field, which you can also adjust. To use these fields, the company must be configured to use
currency settlements.
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7. Click the Customer ID button to find and select the customer who made the invoice payment. You can
also enter the Customer ID directly.

8. The Unapplied field displays the current amount not yet applied against an open invoice. You select which
invoices are paid or partially paid through this payment on the Invoice Selection sheet.

9. If you want the program to create a new unapplied entry against the customer for any remaining unapplied
amount, select the On Account check box. If this check box is clear, you cannot enter other payments until
you have allocated the entire unapplied amount.

10. When you finish, click Save.

Select Invoices

Use the Invoice Selection sheet to select the open invoices against which this customer’s payment is applied.
When you select a customer on the A/R Receipt > Header sheet, the customer’s open invoices display on this
sheet.

If you have selected a Bank Account and Payment Method set
up for EFT processing, refer to the Cash Receipt Entry >
Electronic Interface > Select Invoices procedure below for
invoice selection.

To apply the cash receipt against one or more invoices:

Epicor ERP | 10.0.700500

Epicor ERP Application User Guide - Part TwoChapter 9 | Cash Management



1. Navigate to the Invoice Selection sheet.

2. The customer’s open invoices display in the Invoices grid. You can select one or multiple invoices.

3. The Amount to Apply field displays the total amount that is to be paid on the selected invoices.

4. Click the On Account check box to create a new unapplied entry against the customer for any remaining
unapplied amount. If this check box is not selected and the payment has an unapplied amount, you must
allocate this amount before you can access other functionality.

5. The Unapplied field displays the current amount on the payment not yet placed against an invoice.

6. Click the Automatic Selection button to have the system automatically select invoices for the customer
within the Invoices grid until the receipt amount is all allocated. This updates the Allocated amount,
Discount and Cash Applied amounts in the grid. This operation only selects invoices; it does not apply
them (see below).

7. If you want to apply payments against all the displayed invoices, click the Select and Apply button. The
system automatically allocates a payment amount equal to the invoice amount, considering any applicable
cash discount. The system picks the invoices for allocation starting with credit memos and then the next
oldest invoice. The allocation is performed until the Unapplied field value is equal to zero.
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8. If you want to undo your selections, click the Clear All button.

9. You can still force application of the nearest period's payment discount if the payment date is beyond
discount periods of the terms that apply to the selected invoice. To do so, click the Force Discount button.
The application calculates the payment discount amount and displays it in the Discount column of the grid.

10. You can manually update the Discount value field if necessary. If you do not want to apply any discount
to the invoice, enter zero in this field.

11. Click the Apply button to move the selected invoices to the Allocate sheet. The total payment is applied
to the selected invoices. Discount amounts that apply are subtracted from the amounts.

Allocate

Use the Allocate sheet to modify the amounts paid on the invoices previously selected on the Invoice Selection
sheet. You can also use this sheet to link a payment to a new or existing AR invoice.

For invoices that reflect discounts, a company setting determines how the allocation applies the credit. The
allocation process can charge the credit back to the defined discount accounts or to the selected invoices.

To use these features:

1. When you click Apply on the Invoice Selection sheet, the Allocate sheet displays with the invoices you
applied.

2. The Check number from the A/R Receipt > Header sheet displays. If you need, you can modify this value.

3. The invoices you selected on the Invoice Selection sheet display within the Invoices grid.

4. If you want to alter the payment placed against this invoice, enter a new amount in the Cust. Amount
field.

5. If you applied this payment with discounts, these discount amounts display within the Discount column. If
you need, enter a new amount.

6. The Unapplied amount field displays the current payment amount that has not yet been placed against an
invoice.
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7. If you want the program to create a new unapplied entry against the customer for any remaining unapplied
amount, select the On Account check box. If this check box is clear, you cannot enter other payments until
you have allocated the entire unapplied amount.

8. To allocate amounts to another existing invoice, add a line to this sheet. Click the Down Arrow next to
the New button; select New Line.

9. In the new line, enter the invoice number, or right-click the Invoice field to display its context menu and
select the Invoice Search program to find and select the invoice you want to make the payment against.

10. When you finish, click Save.

Debit Notes

Debit Notes are records you enter when a deduction is required on a customer’s payment or invoice. After you
enter the debit note, you can then apply its amount. This applied amount is either added as an unallocated
amount on the payment or subtracted from a selected invoice’s balance.

To enter an invoice payment:
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1. Click the Down Arrow next to the New button ; select New Invoice Payment.

If your entry group uses a bank account that has the Debit
Notes Only option selected, New Invoice Payment is the
only option.

2. In the Check field, enter a number.

3. Enter the value of the debit note in the Receipt Amount field.

4. Click the Customer ID button to find and select the customer. You can also enter the Customer ID directly.

5. To put the amount on the customer’s current account, select the On Account check box.

6. Click Save.

Enter Debit Note

To enter a debit note:
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1. Click the Down Arrow next to the New button; select New Debit Note.

2. Enter a Debit Note Reference.

3. In the Debit Note Value field, enter the amount of the debit note.

4. Click the Debit Note Due Date drop-down list and select a date.

5. Click the Apply button.

6. Click Save.

Cash Receipts Entry - Other Payment Types

You can receive other payment types for cash receipts. This section describes how you receive these payment
types.

Bank Fees

Use the Bank Fee sheet to enter bank fees and taxes for deposited checks. You can only enter one bank fee per
cash receipt, but you can enter multiple taxes against each receipt.

Deposit Payments

You can use Cash Receipts Entry to enter customer deposits, or prepayments. You can create deposit payments
as allocated deposits (linked to sales orders), or as unallocated deposits (not linked to sales orders). You can then
convert deposit payments to deposit invoices. Deposit payments you convert to deposit invoices do not have to
be linked to sales orders. Allocated deposits are processed and closed automatically once you process a shipment
invoice for the linked sales order. Refer to the Customers and Accounts Receivable chapter for instructions on
creating deposit payments in Cash Receipt Entry.

Miscellaneous Payments

You can also enter miscellaneous payments through Cash Receipt Entry. These transactions track miscellaneous
cash received from sources other than customers. You can also enter sales taxes that are levied against the
miscellaneous payment. Both functions are available on the Miscellaneous sheet. Refer to the Customers and
Accounts Receivable chapter for instructions on creating miscellaneous payments in Cash Receipt Entry.
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Credit Card

Use the Cash Receipts > Credit Card sheet to review the credit card information displayed on cash receipts. Click
the Credit Card Entry button to enter or update the credit card information.

Cash Receipt Entry - Electronic Interface

The following sections describe how you enter receipts you receive electronically into Cash Receipts Entry

Electronic Interface - Select Invoices

Use the Electronic Interface > Select Invoices option to create a list of invoices against which you make an electronic
payment. This option is only enabled when you select a payment method set up for EFT processing. You can
filter customers and payment methods to create your selection list.

1. From the Actions menu, select Electronic Interface > Select Invoices.

2. The Select Invoices window displays.

3. Click the Due Date drop-down list to select a due date.

4. Click OK.
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5. The Invoice Payment Selection window displays.

6. Select the invoices you want and click OK.

Process Receipts

Use the Electronic Interface > Process Receipts option to process customer payments for a selected group of
invoices. When you select a payment method that uses EFT processing, this option is enabled. An electronic bank
export receipt file is created for all customers set up for EFT payments within the group.

1. From the Actions menu, select Electronic Interface > Process Receipts.

2. The Process AR Receipts window displays.

3. Enter the Bank Account setup for EFT processing.

4. Click the Bank Transfer File button and enter a path and name for the file (for example,
C:\tmp\arpayment.txt).

5. Click Print.

Mass Delete

Use the Electronic Interface > Mass Delete option to delete a selected group of payments. When you select a
payment method that uses EFT processing, this option is enabled.

After payments have been posted, you can no longer delete
them. If you post a payment in error, you can use Reverse Cash
Receipt to reverse the transaction, or enter an offsetting
transaction.
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1. From the Actions menu, select Electronic Interface > Mass Delete.

The invoices are deleted from the Payment grid on the Group > Detail sheet.

Post Receipts

To complete the Cash Receipt Entry process, you post the group’s receipts to the AR accounts within the general
ledger. When an entry group is posted, the transactions update your cash receipts information.

When you finish entering cash receipts, you can select the Group sheet to verify you have correctly entered the
cash receipts. You can also view the total amount of the receipts you entered within this group.

To post a cash receipts group:

1. From the Actions menu, select Post.
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2. The Cash Receipt Post Process window displays.

3. Click Submit.

4. If any errors occur, they display on the Group > Posting Log sheet. The group must be open to view the
posting log details. When you correct any errors, you can post the group again.

After you successfully post cash receipts, you can no
longer edit or delete them. Use Reverse Cash Receipt to
reverse the transaction if you post a receipt in error.

AP Payment Entry

Use AP Payment Entry to pay AP invoices through check or electronic payment. Typically a payment is made
against an invoice created to pay a supplier. Additionally, you can pay miscellaneous expenses that do not have
an invoice, enter manual checks written for extra expenses, process debit memos, and make payments to one-time
suppliers. Use AP Payment Entry to generate a bank export file that can be processed in the AP bank File Import
Workbench.

Use the Process Payments option from the Actions menu to either print checks or create EFT payment files for
all payments within the current group. The options available depend on the Payment Method selected on the
Group sheet of AP Payment Entry. If the payment method is for EFT payments, you can select the Bank Export
File used to receive the payment information.

This section focuses on creating EFT payments. Refer to the Suppliers and Accounts Payable chapter for more
detailed information on AP Payment Entry.

Menu Path: Financial Management > Cash Management > General Operations > Payment Entry

509Epicor ERP | 10.0.700

Cash Management | Chapter 9Epicor ERP Application User Guide - Part Two



Payment Entry – Group

You begin the Payment Entry process by creating a payment group; each group is used for batch processing of
payments. When Payment Entry launches, the Group sheet displays by default.

To create a new payment group:

1. Click the Down Arrow next to the New button; select New Group.

2. In the Group field, enter a unique identifier for the group. Entry groups can use a combination of letters or
numbers.

3. Click the Bank Account drop-down list to select the bank account from which these payments are made.
You can change the account before a payment run, or define a different account for a manual payment.

If entering an EFT payment, select a bank account set up
for electronic payment.

4. The Default Currency field displays the currency used for the selected bank account. Depending on the
payment method, you can or cannot change the currency used for the group.

When entering an EFT payment, select a payment method
set up with an electronic interface payment method.

5. Click the Payment Method drop-down list to select the method used as the output format for the payment.

6. Click the Payment Date drop-down list to select the date on which the payments are run through this
group. This value determines the active exchange rate used to convert bank account amounts to other
currencies.

7. If you need, click the Rate Type drop-down list to select the currency rate type that applies to these group
payments. Rate types define the conversion rules used to update amounts from the original (source) currency
to another (target) currency.

8. When you finish, click Save on the Standard toolbar.
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Payment Entry – Select Invoices

Use the Select Invoices option to generate payments for all invoices due on a specific date.

To select multiple invoices for payment:

1. From the Actions menu, select Select Invoices.

2. The Select Invoices window displays.

3. On the Selection sheet, Click the Due Date drop-down list to define the date used to select the invoices.
The function returns all invoices due on or before this date. By default, this field displays the group Payment
Date.

4. Select the Consider Discount Dates check box to include invoices with discount dates on or before the
specified due date.

5. Select the Include Invoice without Payment Method check box to include invoices without a payment
method in the results.

6. Select the Include Invoice with Letter of Credit check box to include invoices linked to letters of credit.
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7. If you need, use the Filter sheet to add filtering. Available options: Supplier Groups, Payment Methods,
Invoice Currencies, and Suppliers.

8. Click OK.

9. The Invoice Payment Selection window displays. All invoices that match your selection criteria display on
the grid.

10. In the grid, highlight the invoices you want to include.

11. The Candidates field displays the total value of the invoices that match your selection criteria.

12. The Selected field displays the total value of the invoices currently selected on the grid.

13. The Remaining field displays the balance of the invoices that are not selected.

14. To select all the invoices, click the Select All button.

15. To remove your selections, click the Deselect All button.

16. Once you have selected the required invoices, click OK.
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17. The invoices display in the Payments grid on the Payment > Header > Invoice List sheet.

18. If you highlight an invoice payment and navigate to the Invoice Detail > Detail tab, you can view information
about the selectd invoice.
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19. You can also make changes to the invoice payment if required.

Payment Entry – New Payments

Instead of selecting mulitple invoices through the Select Invoices command, you can also use the Payment >
Header sheet to create payments for specific invoices, miscellaneous payments, EFT payments, and manual checks.

1. Click the Down Arrow next to the New button; select New Payment.

2. The Payment > Header sheet displays.

3. Enter the Supplier, or click the button to search and select the supplier name. The program automatically
displays the supplier name and address.

4. When entering an EFT payment, select a supplier set up with an electronic interface payment method. The
Electronic Payment check box is then automatically selected. For more information on setting up EFT
payments, review topics in the application help.
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5. If the payment method is manual, the Manual check box is automatically selected instead, and you must
also enter a payment number in the Payment field.

For other payment methods, the Manual check box is
clear.

6. Select the Force Discount check box to indicate the application calculates the payment using the best
possible discount terms offered by the supplier. When the check box is clear, the application calculates the
discount based on the effective discount rate defined by the supplier’s purchasing terms.

7. When you enter manual payments and the payment currency is different from the bank currency, the Enter
Payment Total check box is enabled. Select this check box to enter the amounts in the different currencies.

8. Selecting the Enter Payment Total check box activates the Payment Total and Bank Total fields. Enter the
amounts you need in the different currencies.

9. You can also override the Bank Total value by changing the Rate Mode option from System to User
Defined.

10. If you need, use the Exchange Rate field to override the payment currency to base currency exchange rate,
which defaults in according to the Rate Type and Payment Date defined on the Group sheet. This field is
available when the payment currency is different from your company’s base currency.

11. When you finish, click Save on the Standard toolbar.

Payment Entry – Invoice Payments

You use the Invoice sheet to enter and edit payments made against a specific invoice. You apply these payments
against open invoices created for the supplier you selected on the Header sheet.

To do this:
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1. Click the Down Arrow next to the New button; select New Invoice Payment.

2. A new invoice line displays in the Payments grid on the Invoice List sheet.

3. Navigate to the Payment > Invoice Detail > Detail sheet. This is the easiest place to select the invoice for
payment.
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4. In the Invoice field, enter the number of invoice against which the payment applies, or click the button to
search for the required invoice.

5. The Invoice Date, Invoice Value, Balance, Terms, Discount Date, Due Date, and Legal Number (if
applicable) fields automatically display information from the selected invoice.

6. In the Description field, you can enter information about the payment. If this payment is made by check,
this text prints on the check stub.

7. You can update the Gross Value of the payment, excluding discounts, in the currency of the supplier’s
invoice.

8. If you need, change the amount in the Discount field. The application uses the discount terms defined on
the supplier record to calculate the amount. You can, however, change this value. To learn how to create
these terms, review the Purchasing Terms section in this guide.

9. The program subtracts the discount amount from the gross amount to calculate the amount in the Net
Payment field. The company pays this amount.

10. The Gain/Loss field displays the gain or loss amount for payments of foreign currency invoices.

11. If required, you can use the Payment > Invoice Detail > Tax sheet to add taxes.

12. When you finish, click Save on the Standard toolbar.

For more detail on adding taxes to a payment, review the
Suppliers and Accounts Payable chapter.

Payment Entry – Bank Fee

Use the Bank Fee sheet to add a bank fee to a payment.

To do this:

1. Click the Down Arrow next to the New button; select New Bank Fee.

2. The Payment > Bank Fee sheet displays.
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3. Click the Bank Fee button to find and select the code for the bank fee you want to add to your payment.

Refer to the Bank Fee Maintenance topic earlier in this
chapter for more information on creating a bank fee.

4. In the Bank Fee Amount field, enter the amount of the bank fee.

5. Click Save on the Standard toolbar.

6. The default account populates the Book and Account fields, based on the GL Control for the bank fee.
You can change these details if required.

7. If you have changed the GL account, click Get Default to revert back to the default account.

Payment Entry – Process Payments

When you finish entering your payments, you are ready to process them. You do this through the Process Payment
program, which you launch from the Actions menu. Use this action to print checks or create EFT payment files
for all payments within the current group. For EFT processing, the action creates an electronic bank export
payment file for all suppliers set up for EFT payments within the group.

The Payment Type selected for the group determines the settings and defaults in this program. You can use this
program to both print checks and create EFT payment files for group payment entries.

To do this:

1. From the Actions menu, select Process Payments.
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2. The Process Payments window displays.

3. The Payment Date field defines the date applied to payments in the run.

4. The company’s default fiscal calendar determines the values that display in the Fiscal Year and Period fields.

5. The Forms field indicates whether the print run uses the Check form, the Remittance form, or Both forms.
The payment method determines the available options.

6. If you need, click the Bank Account drop-down list to change the bank account from which the payments
are withdrawn. By default, this field displays the account defined for the payment entry group.

7. If necessary, select the Override Payment check box and enter the first payment number in the run in the
Payment number currently loaded field. Each check or EFT payment in the run is given a sequential
number that begins with this value.

8. If the group includes EFT files, click the Bank Export File button to select the file used to send EFT payments.
The default file originates from the payment method.

9. When you finish, click Print on the Standard toolbar.

AP Payment Entry – Print Group Edit List

You can print the Group Edit List to ensure the payments within the active group are correct before you post
them.

To do this:

519Epicor ERP | 10.0.700

Cash Management | Chapter 9Epicor ERP Application User Guide - Part Two



1. From the Actions menu, select Print Group Edit List.

2. The Payment Entry Group - Edit List Report window displays.

3. If you need, navigate to the Filter sheet and select a book to filter your report.

4. If necessary, select the report settings you need.

5. Click Print on the Standard toolbar.

Payment Entry – Post Payments

The Post option on the Actions menu completes the payment group process. Run this option after you have
processed the payments and verified all checks printed correctly.

To post a payment group:
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1. From the Actions menu, select Post.

2. The AP Payment Post Process window displays.

3. Click the Submit button on the Standard toolbar to post the payments in the current group.

If the payment run contains checks, the application prompts you to verify all checks printed correctly. If posting
errors occur, select the Group > Posting Log sheet to review the error log. You can re-post the group after
correcting the errors. If you post a receipt in error, run Void Payment Entry to correct the error.

Petty Cash Entry

Use Petty Cash Entry to enter, update, and post petty cash transactions. You can also create cash issue and receipt
documents against sales and purchase invoices. A legal number must be assigned to cash issue or cash receipt
document before it can be posted.

This program is available if you have the additional Petty Cash
module license.

Menu Path: Financial Management > Cash Management > General Operations > Petty Cash Entry

Petty Cash Document

Use the Petty Cash Document sheet to create a cash receipt or cash issue document and to define payment
information.

To create a petty cash document:
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1. Select a petty cash desk from the Petty Cash Desk field.

2. Click the Down Arrow next to the New button; select either New Cash Receipt Document or  New
Cash Issue Document.

3. Select the Operation Type.

4. The sheet displays for the Cash Recipient/Payer type associated with the operation type (for example,
Customer) under the Payment Info tab.

5. Click the Search button to find and select the recipient or complete the enabled fields.

6. If you need, enter a different date in the Exchange Rate Date field.

This field is only active if the Override Exchange Rate check
box was selected on the Petty Cash Operation Type.

7.  To save as an authorized document, clear the Draft check box.

This check box is only available if Allow Drafts is selected on the Available Operations sheet in Petty Cash
Desk Maintenance.
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8. Click the Down Arrow next to the New button; select the appropriate option for your transaction (for
example, New AR Deposit Receipt).

9. The appropriate window displays, depending on the transaction type (for example, the Deposit Payment
window).

10. Make entries in the fields that open for entry, in this example Sales Order and Amount.

11. When you finish, click Save on the Standard toolbar

12. The Book and Account fields display the default GL account, taken from the GL Control of the petty cash
operation type. You can change this account if necessary; save any changes you make.

The cash receipt or cash issue document is now authorized.

Assign Legal Number

Use the Assign Legal Number option to assign a legal number to a new cash receipt or cash issue document prior
to posting.

Legal numbers generate through a sequence you define. For
more information, review the Legal Numbers chapter in the
Epicor ERP Implementation Guide.
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1. From the Actions menu, select Assign Legal Numbers.

2. If legal numbers are set up to generate automatically, the assigned Legal Number now displays.

You are now ready to print the document.

To learn more about automatic and manual legal number
generation, review the Legal Numbers chapter in the
Epicor ERP Implementation Guide, or review the
application help.

Post Statement

Posting the statement completes the petty cash transaction cycle. This option is available once a receipt or issue
document has been authorized, a legal number assigned, and the report printed.

Posting the statement creates journals for transactions and blocks any further changes to transactions in this
program. If you make a mistake, you need to create an offsetting entry to correct the error.

To post a statement:

1. From the Actions menu, select Print Document.
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2. The Petty Cash Report window displays.

3. Click Print on the Standard toolbar.

When you have printed the report, you can close the Petty Cash Report window.

4. Once the report is Authorized, has a Legal Number assigned, and has been Printed, you can post the
statement.

5. From the Actions menu, select Post Statement.
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6. The Petty Cash Post Process screen displays.

7. Click Submit.

After you post the transactions, you can no longer edit
or delete them. If you post a transaction in error, you must
enter an offsetting transaction.

Close Cash Day

Use Close Cash Day to close the cash day. This finalizes daily cash operations and freezes balances for the day.
Closing a cash day also enables you to create and print the final day reports.

This program is available if you have the additional Petty Cash
module license.

Menu Path: Financial Management > Cash Management > General Operations > Close Cash Day

To close a cash day:

1. Select a Petty Cash Desk from the drop-down list.

2. Select the closing date from the Close Cash Day(s) Up to drop-down list.

3. Click the Purge Drafts Created Before drop-down list to select a date to purge any draft documents.

4. From the Actions menu, select Post Day Batch
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5. The Petty Cash Post Process window displays.

6. To post and close the cash day, click Submit.

Bank Reconciliation Entry

Use Bank Reconciliation Entry to reconcile a bank balance with cash balances in the company’s books. Typically
when you post the bank reconciliation results, the adjusted bank account balance equals the adjusted cash
balance per book.

To reconcile a bank statement, you select the receipts and payments that match bank statement lines. The
program’s clearing sheets divide these transactions by type to help you reconcile the statement.

You can create transactions for both bank charges in the statement and transactions for statement lines that do
not have matching receipts or payments. You can open A/P Bank Adjustment from within this program to enter
the fees.

Settings in Bank Account Maintenance determine when bank account deposits and receipts affect cash accounts
in the books. When the Reconciled AR Balance or Reconciled AP Balance check boxes are selected, deposits and
cash withdrawals are posted to pending cash accounts and moved from the corresponding pending accounts to
cash when these items are reconciled via Bank Reconciliation Entry.

Menu Path: Financial Management > Cash Management > General Operations > Bank Reconciliation

Statement

Use the Statement sheet to create the bank reconciliation and to identify the statement being reconciled.

To create the reconciliation:
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1. In the Bank ID field, enter the code of the bank that sent the statement, or click the button to search for
the bank. When you complete this field, the application displays the bank’s currency, account, and the
reconciliation statement if an open statement already exists.

2. If a statement does not display, click New on the Standard toolbar to create one.

3. In the Opening Date and Closing Date fields, enter the period included in the statement and the bank
balances on the two dates. The balances help you track how entries in the program affect the line total and
variance.

4. If you need, change the Apply Date for the reconciliation. This value and the company’s default fiscal
calendar determine when the statement will be posted to the general ledger (for example, all variances,
movement from pending cash to cash, and so on).

5. Use the Statement fields to identify and describe the statement.

6. If you select the Closing Date Cutoff check box, the statement Closing Date is the last day transactions
can be selected for reconciliation. This allows you to hide transactions later than the statement end date for
bank reconciliation. If you clear the check box, transactions after the Closing Date will also be available for
selection.

7. When you finish, click Save.

Transaction Clearing

Use the Transaction Clearing sheet to select deposits that correspond to entries on the bank statement. These
transactions originated in Cash Receipts Entry.

To select a transaction:

Epicor ERP | 10.0.700528

Epicor ERP Application User Guide - Part TwoChapter 9 | Cash Management



1. Click the Down Arrow next to the New button; select New Transaction Clearing.

2. The Transaction Clearing sheet displays.

The Transactions grid displays the items available for selection.

3. The total amount of available items displays in the Candidates field.

4. Select the entries that correspond to your bank statement. The select a transaction, select the Cleared Bank
check box.

5. The total amount currently selected displays in the Selected field.

6. Click Select All to include all the available entries. If you cleared the Closing Date Cutoff check box on the
Statement sheet, this list includes entries that apply to future bank statements. Be sure to only select entries
available to reconcile.

7. The Clear button is another way to select (or clear) the Cleared Bank check box for a selected item.

8. If necessary, you can adjust the Bank Cleared Amount if the cash receipt currency differs from the bank
currency.

The difference is calculated as (Bank Cleared Amount – Original Bank Transaction Amount) * Exchange rate
per bank reconciliation Apply Date) and posted to the realized gain/loss account. If the GL book currency is
different from the bank currency, this gain/loss amount will be translated to the book currency using the
bank reconciliation Apply Date.

9. When you finish, click Save on the Standard toolbar.
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10. Navigate to the Statement sheet.

11. The selected items display in the Bank Reconciliation Lines grid.

12. The Line Total and Variance fields are updated according to the selected transactions.

The instructions for the Transaction Clearing sheet generally apply to the other clearing sheets in Bank Reconciliation
Entry, although there are some exceptions for AP Payment Clearing.

For example, you can always adjust the Bank Cleared Amount for AP payments. If the AP payment and bank
currencies are the same, the corresponding variance is recorded in the Bank Variance account, but if they are
different, the variance is recorded in the Currency Realized Gain/Loss account.

For other transactions, use the program’s clearing sheets to select payments, payroll checks, deposits, and receipts
that match lines in the bank statement. When you include amounts in the reconciliation, this clears them from
future reconciliations.

A/P Bank Adjustment

Use A/P Bank Adjustment to enter an account adjustment commonly used to reflect bank charges in the company’s
cash balance.

To enter an adjustment:
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1. Click the Down Arrow next to the New button; select New Bank Adjustment.

2. The Bank Adjustment window displays.

3. The Transaction Apply Date defaults from the bank reconciliation Apply Date.

4. The Reference field displays the bank statement description.

5. In the Amount field, enter the adjustment amount. This amount can be positive or negative.

6. The G/L Account fields populate automatically with the default account. You can change the account to
which the adjustment posts.

You follow similar steps to enter transaction adjustments
in other programs. Use the Deposit Payment and
Miscellaneous Cash Receipt programs to create
transactions that reflect bank deposits in the company's
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cash balance. Use AP Payment Entry and Invoice Payment
to create transactions that reflect bank withdrawals in the
company's cash balance.

7. If you need, use the Bank Fee field to apply fees connected with the adjustment. When a fee is applied
that modifies tax results, this value displays within the Bank Fee Tax Detail grid.

8. When you finish, click Save on the Standard toolbar.

Print Edit List

You can print an edit list to review reconciliation details before you post them.

1. From the Actions menu, select Print Edit List.

2. The Bank Reconciliation - Edit List window displays.

3. By default, all Books to which statement transactions post are selected.

4. If you need, use the Filter sheet to limit the list to a specific book.

5. Click Print on the Standard toolbar.

Post Statement

Posting the statement completes the reconciliation process. This option is available if a transaction on the current
statement has been cleared, and the statement's Variance amount is zero.

Posting the statement creates journals for bank and check transactions. Posting also blocks any further changes
to transactions in this program. If you make a mistake, you need to create an offsetting entry to correct the error.

To post a statement:
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1. Verify the statement Variance is zero.

2. From the Actions menu, select Post Statement. Click Yes at the verification prompt.

3. The Bank Reconciliation Post Process window displays.

4. Click Submit and close the Bank Reconciliation Post Process window.

5. After you post, you can print a GL recap report. To do this, open the statement, and verify the Posted status
displays.

6. From the Actions menu, select Print GL Recap.
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7. The Bank Reconciliation - Print GL Account Recap window displays.

8. Click Print.

Reports

This section describes some key reports you use to view information about Cash Management. You can run these
reports whenever you need. You can also set up each report to generate and print through a recurring, automatic
schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information
on how you link a report to a recurring schedule.

Check Register

Use the Check Register to display all the checks created during a selected period. This report includes all regular
checks, manual checks, voided checks, and EFT payments.

Main Menu Path: Financial Management > Cash Management > Reports > Check Register

To set up and run this report:

1. Select the Begin Date and End Date for your report.

For details on using the Dynamic check box, review the Dynamic Date Options topic in the Application Help.
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2. Use the sheets under the Filter tab to filter the report by specific bank accounts.

3. Click Print on the Standard toolbar.

Payment Proposal Report

Use the Payment Proposal report to display the AP invoices that need to be paid up to a selected due date. This
report displays its amounts in the base currency selected for the current company. One line prints for each invoice
due on or before the selected due date. The report is sorted by the due date value on each AP invoice.

Menu Path: Financial Management > Cash Management > Reports > Payment Proposal Report

To set up and run this report:

1. Select the payment Due Date for your report.

2. Select the Consider Discount Dates check box to consider invoices as due according to the last date when
their discount still applies.

3. To display invoices placed on hold, select the Include Invoices on Hold check box.

4. Use the sheets under the Filter tab to select specific supplier groups and payment methods to display on
your report.

5. Click Print on the Standard toolbar.
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Print Petty Cash Documents

Use the Print Petty Cash Documents feature to print the details of petty cash documents. Some localities legally
require you print a petty cash document as a record of a transaction.

Menu Path: Financial Management > Cash Management > Reports > Print Petty Cash Documents

To set up and run this report:

1. Select a petty cash desk from the Petty Cash Desk field.

2. In the Cash Day field, select the apply date. The current date defaults.

3. If you want to select a specific document to print, click the Document Search button to find and select a
petty cash document.

4. To print a legal number on the document, select the Assign Legal Number check box.

5. Use the sheets under the Filter tab to select specific employees, customers, suppliers, banks, and petty cash
desks to display on your report.

6. When you finish making any other report selections, click Print on the Standard toolbar.

Print Petty Cash Day Book

Use the Print Petty Cash Day Book feature to print a list of all operations within a specified cash day.

Both the Print Petty Cash Documents and the  Print Petty Cash
Day Book features are available if you have the additional Petty
Cash module license.

Menu Path: Financial Management > Cash Management > Reports > Print Petty Cash Day Book
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To set up and run this report:

1. Select a Petty Cash Desk.

2. Use the From Cash Date and To Cash Date fields to select the date range for the report. Any transactions
that occur on or between these days display on the report.

3. When you finish making any other report selections, click Print on the Standard toolbar.
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Chapter 10: Advanced Allocations

The Advanced Allocations functionality distributes specific amounts posted to the general ledger across various receiving,
or target, accounts. Through this feature set, you define a series of allocations that first pulls amounts from financial
source data and then spreads these allocated amounts across multiple target accounts. You can set up as simple or as
complex an allocation structure as you need.

You set up allocation criteria through allocation codes. An allocation code contains a set of parameters for source data
(either from accounts or transactions) and then allocation ratios and other parameters that define how amounts will
automatically divide across multiple target accounts. Allocations can be divided from a fixed total source amount or
from a calculated amount generated through a formula.

To process allocations, you create allocation batches; each batch processes the allocations you define through the
codes. Within each batch, the allocation codes can be further organized into different levels, or tiers. Any tiers processed
after the first tier use the journal details generated through all the previous tiers.Each tier processes one level of
allocations, followed by the next level of allocations, and so on until all tiers have generated allocation amounts to the
journals set up to receive them at each tier level.

You can run the allocation process whenever you need. You can also set it up to run on an automatically recurring
schedule. By specifically defining the calculating and processing of allocations, you save time and ensure allocations
are consistently dispersed across your selected target accounts.

Setup

This section describes the primary records you need to create for general ledger allocations processing. These
programs are contained within the Setup folder of the General Ledger module. Only the primary records are
described here. Some areas within the next Operations section may also document setup records if they are
required for a specific workflow.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for the General
Ledger module; the Configuration topic details the options you define within Company Configuration. You can
also review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Allocation Code Maintenance

Use Allocation Code Maintenance to enter allocation codes and define settings for each code. Each allocation
code can only be used within a specific general ledger book. You indicate whether each allocation code disperses
amounts through a fixed value or a formula you create. Each allocation code can also be assigned to a tier level
that indicates at what point in the process its allocation routine will run. To track the transactions generated by
each allocation code, you assign specific stamps that appear next to the allocation transaction on various reports
and trackers.

Menu Path: Financial Management > General Ledger > Setup > Allocation Code

Primary Allocation Code Setup

To add an allocation code and define its general features:
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1. Click the New button on the Standard toolbar.

2. Select the Detail sheet.

3. Enter the Allocation Code identifier.

4. Enter a Description. Enter a concise explanation that helps you quickly understand the allocation code
purpose.

5. Select an Allocation Type. Available options:

• Transactional - The source data originates from general ledger transactions.

• Balance-Based - The source data originates from account balances.

6. Next, select a Book for which this allocation code will disperse amounts. By design, allocations are restricted
to disperse amounts within a single book. When multiple allocation codes are processed through an allocation
batch, these codes all must share the same book.

7. If you need, select the Offset GL Account. This account stores the amount values used before the allocations
are generated; you use this account to record the total amounts you allocated during the process and to
offset the original balances without zeroing out the accounts. When you select an offset account, its
Description value displays as well.

8. Select the Ratio Setup Option. These options define how the allocation amounts are divided across accounts.
Available options:

• Fixed Value - Defines a set value for each allocation amount. The total amount is divided evenly using
this starting fixed value.

• Formula - Calculates the allocation amounts using a formula you create. When the allocation process
runs, it calculates the allocation amounts using the expressions you define through the formula.

9. Enter the Percentage To Allocate value for this code. This value indicates how much of the source amounts
are available to allocate through this code. The default is 100 percent, indicating all source amounts will be
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spread across multiple target accounts. In this example, 65 displays, indicating that 65 percent of the source
amounts will be distributed through this allocation code.

10. Select the Use Allocation Units check box to indicate whether allocation units or percentages are used to
calculate amounts through this allocation code. If you select this check box, you then assign units to each
target account that receives amounts from the sources. For example, your Percentage to Allocate is 100%,
and you will distribute amounts between three target accounts. Each target account has 50 allocation units,
which indicates each account receives 33.33% of the total source amount.

11. Enter a number in the Tier field. This value defines the level, or tier, for this allocation code. When this
allocation code is processed, all codes assigned to Tier 1 allocate their amounts first. Then the generated
allocations are further distributed through the codes assigned as Tier 2, and the process continues through
all the tiers you define on the allocation codes. The journal details generated at each earlier tier level are
available on subsequent tier levels.

12. Enter the Target Allocation Stamp. This value is placed on transaction details within the receiving, or
target, accounts for the allocation. You can then track which accounts received allocation amounts through
this code.

13. Define the Source Allocation Stamp for this code. This value is placed on transactions within the original,
or source, accounts from which the allocation amounts are pulled. This makes sure the allocation amounts
are not allocated again by mistake.

14. Use the fields in the Stamped Transactions area to identify which higher tier allocation results you want
to use for this allocation. Leverage this functionality when the allocation code is a level 2 or higher tier. You
can decide not to use the previous stamp by selecting the Exclude check box. You can also use all of the
previous stamps by clicking the Include All check box or select a specific stamp from the Allocation
Stamp drop-down list.

15. Continue adding the codes you need. When you finish, click Save on the Standard toolbar.

Source Account Setup

You next define the source accounts from which you want to allocate amounts. You can allocate amounts from
four sources - Categories, Journal Codes, GL Account Masks, and Account Segment Ranges. During this example,
you will set up an allocation from a GL account mask.

Use these types in tandem to filter the sources from which the amounts are pulled. When you select multiple
categories, for example, the application pulls amounts from all of the categories you select on this sheet. If you
use both a category and a GL account, however, only those sources that share both the category and the GL
account are used as sources during the allocation process.

Technically, these items either have an “AND” or an “OR”
relationship. When you select multiple sources from the same
type (for example, journal codes), the application views these
items as sharing an “OR” relationship - all sources that use
Category A or Category B are used. When you select multiple
sources from different types (journal codes and categories),
the application views these items as sharing an “AND”
relationship - all sources that use Journal Code 237 and
Category A are used.

To enter source data criteria:

Epicor ERP | 10.0.700540

Epicor ERP Application User Guide - Part TwoChapter 10 | Advanced Allocations



1. Click the Down Arrow next to the New button.

2. Notice you can select difference sources from this drop-down list - New Source Account Category, New
Source Journal Code, New Source GL Accounts/Masks, and New Source Segment Range. For this example,
you select New Source GL Accounts/Masks.

3. The Source Data > GL Accounts/Masks sheet displays.

4. Select the GL Account or mask you wish to use. Financial transactions for this allocation code originate
from this source account.

5. If your source amounts will be pulled from account categories, you define these items on the Account
Categories sheet.

6. If you indicated you will pull source amounts from journal codes, you select these codes on the Journal
Code sheet. This functionality only works with Transaction based allocations.

7. If you will pull amounts from a range of account segment values, you define these segments on the Ranges
sheet.

8. Continue to add the account masks, account segment ranges, journal codes, and categories as you need.
When you finish, click Save on the Standard toolbar.
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Target Account Setup

Each allocation code must have a list of receiving, or target, accounts. These target accounts receive the dispersed
source amounts using the ratios defined on the allocation code.

To add a target account:

1. Click the Down Arrow next to the New button; select New Target Account.

2. The Target Accounts > Details sheet displays.

3. Enter the Target Account directly or select the specific target account or target account mask from the
drop-down list.

4. After you select the account, the Account Description displays, explaining the purpose of the account.
You cannot change this value. If you selected a GL account mask, this field is blank.

5. The Ratio Setup Option indicates whether this allocation code disburses amounts using a Fixed Value or
a Formula. You defined this value when you first set up the allocation code; in this example, Fixed Value
displays.

6. If you selected the Use Allocation Units check box on the Detail sheet, the Allocation Units field is available.
Use this field to enter how many units of the source amounts will be assigned to the current target account.

For example, your Percentage to Allocate is 100%, and you will distribute amounts between three target
accounts. You enter 50 allocation units in the Allocation Units field on each target account, which indicates
each target account receives 33.33% of the total source amount.

7. The Units field displays the total number of allocation units currently assigned through this allocation code.
As you enter more units on other target accounts, this total number increases.

8. If you do not use allocation units, the Percentage Value field is available. Use this field to define the total
allocation amount this target account will receive. In this example, you enter 30 in this field, which indicates
this target account receives 30% of the 65% amount distributed from the source amounts. You will have
35% left from the allocation percentage to distribute to other target accounts.
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9. The Percentage field displays the total Percentage To Allocate value you entered on the Detail sheet. This
value indicates how much of the source amounts are available to allocate to the target accounts you define
on this sheet. In this example, 65% percent displays in this field.

10. Continue to add the target accounts that will receive allocation amounts through this code. When you finish,
click Save on the Standard toolbar.

Formula Parameters

Allocation codes can also distribute amounts through one or multiple formulas you define. Each formula you
enter must contain the arithmetic operators and operands needed to complete the expression. The available
operands are fixed values, balances of specific GL accounts, non-financial data, and summary balances generated
across several GL accounts. Select the operators and define the operands you need to create the formula you
will run through this allocation code.

To distribute amounts using a formula ratio:

1. Create a new Allocation Code as described previously.      

2. Click the Ratio Setup Option drop-down list and select Formula.
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3. After you finish entering all the other options you need, click the Down Arrow next to the New button;
select New Formula Parameters.

4. The Formula Parameters > Detail sheet displays.

5. Enter the unique Name and concise Description you need for this formula parameter.

6. From the Type drop-down list, indicate what kind of parameter will be used with this formula. The value
you select here determines what sheets are available under the Formula Parameters > Settings tab and
the New menu. Available options:

• Account Balance - The formula uses the total account balance to calculate the allocation ratios.

• Summarized Balances - The formula totals a series of items to calculate the allocation ratios.

• Non-financial Data - The formula pulls in values from Look-Up tables and fields in order to generate
the amounts it needs to disperse between the target accounts.

• Business Activity Queries (BAQ) - A BAQ is a query tool that pulls in specific data views you define.
When you select this type, you must select the BAQ that will be used to pull in this information.

You create and modify BAQs through the Business Activity
Query Designer. For more information on how to leverage
this tool, review the Business Activity Queries chapter in
the Epicor ICE Tools User Guide.

7. If you select the Account Balance type, the GL Account field activates. Use this field to find and select the
GL account whose balance is used for the receiving target accounts.

8. If you select the Account Balance type, you can optionally select the Use Target Account check box to
indicate the balance received by the target accounts will be used to disburse amounts calculated through
this formula.

9. Likewise, if you select the Account Balance type, select an option from the Use as Parameter
Value drop-down list to indicate what item will be used as the parameter to gather data for the allocation
formula. Available options:

• Account Balance - This parameter holds the total amount available in the account.

• Debit Turnover - This parameter holds the debit amount that will be distributed through this allocation
code.
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• Credit Turnover - This parameter holds the credit amount that will be distributed through this allocation
code.

10. If you select the BAQ type, click the BAQ button to find and select the business activity query from which
you will pull in financial data.

Set Parameters and Formula

1. Your selection from the Type drop-down list also affects what items are available on the New drop-down
menu. For example, if you select the Summarized Balances type, a number of summarized options are
available for you to select (for example, New Summarised Range). These summarize options match the
data you can use for source amounts - account categories, journal codes, GL accounts/masks, and ranges
of segment values.  

2. Depending on the summarized option you select, the Account Categories, Journal Code, GL
Accounts/Masks, or Ranges sheets become active. For the following example, the Ranges sheet displays.
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3. If you select the Non-Financial Data type, when you access the New drop-down menu, the New
Non-Financial Data option is available.

4. Select the table from the Lookup Table drop-down list that holds the non-financial data you need.

5. Now select the specific field that holds this data within the Use Target Field drop-down list.

6. Click the Get Source Records button to pull in all of the records linked to the selected table and field.

7. The Source Fields grid displays the non-financial data for your allocation formula.
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8. When you finish setting up your formula parameters, navigate to the Target Accounts > Details sheet.

9. The Formula Criteria field is active. Use this field to enter the criteria expression you need to run against
the parameters you have defined. You can enter these values directly.

10. You can also right-click this field to display a context menu; use this context menu to select the values and
operators you need.

11. To verify the formula will compile when it runs, click the Check Syntax button. A message box displays
indicating the allocation code formula is correct.

12. Continue to add the allocation formulas you need. When you finish, click Save on the Standard toolbar.

Allocation Batch Entry

Use Allocation Batch Entry to define the groups, or batches, of allocations you want to run sequentially. Each
batch defined in allocation Batch Entry must also have a unique code. You then manually add allocation codes
to each batch. A batch can contain as many allocation codes as you need, but these codes must all be in the
same general ledger book. After you create the batches, you set up a schedule to define the fiscal year during
which these allocations run.

Menu Path: Financial Management > General Ledger > Setup > Allocation Batch

Create an Allocation Batch

To create an allocation batch:
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1. Click the New button on the Standard toolbar.

2. Enter the Batch ID.

3. Enter a Description for the batch. Be sure to enter a concise explanation that will help you identify the
purpose of the batch.

4. Select a general ledger Book to which this allocation batch posts when this process runs.

5. Select a Journal to which this allocation batch will post.

6. You can also define whether an allocation automatically reverses and then indicate the dates during which
the reversal occurs. To do this, click the Reverse check box.

7. When you finish, click Save on the Standard toolbar.

Add Allocation Codes

After you enter an allocation batch, you need to add codes for this batch.

To add allocation codes:
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1. Click the Down Arrow next to the New button; select New Allocation Batch Code.

2. Select an Allocation Code. You create allocation codes within Allocation Code Maintenance.

3. Continue to add the allocation codes you want to include with this batch. When you finish, click Save on
the Standard toolbar.

Define the Schedule

Once you create a batch and assign allocation codes to that batch, you need to generate an allocation run
schedule.

To define a schedule:

1. From the Actions menu, select Generate Schedule.

2. The Generate Schedule window displays.

3. In the Fiscal Year field, verify the current calendar year displays.
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4. Click the Generate button. A message displays and tells you how many schedules were created. Click OK to
close this message.

Operations

This section details the operations you can run to process general ledger allocations. Each operation is described
as a workflow to help guide you through the process from start to finish. These programs are primarily found
within the General Operations folder for this module. If a unique setup record is required to run the operation,
this record is also described in this section.

Generate GL Allocations

After allocation codes are grouped into batches, use the Generate GL Allocations program to process the allocation
amounts, and, when you are ready, post them to the general ledger. Typically you set up this process and then
create the Allocation Edit List. Use this list to verify the allocations are distributed into the expected accounts
using the amount ratios defined on each allocation code. If you are satisfied with the results, you can then post
these transactions to the general ledger.

You can also run this program in a simulation mode. In this mode, you calculate and save allocation transactions
without affecting the general ledger. Use this mode when you are first setting up your GL allocations and want
to see the calculated results before you actually run and post allocations. Simulated results are saved separately
from the general ledger; you display these results within the Allocation History Tracker for evaluation. You can
then verify and make adjustments to your allocations before you process the results against your actual data.

Menu Path: Financial Management > General Ledger > General Operations > Generate Allocations

To generate and post allocations:

1. Specify the general ledger Book to which this allocation run will post.

2. Enter the Apply Date.

3. By default, the program selects the Fiscal Year and Period that contains the Apply Date.

4. If you wish to run allocations for the entire year so far, select the Year-To-Date Allocation check box. The
Start Date field automatically displays January 1st for the current year, and the allocations from the beginning
of the year to the current fiscal period will generate.
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5. If you do not select the Year-To-Date Allocation check box, both the Start Date and the End Date fields
display the first and last days of the current fiscal period. If you need, you can change these dates.

6. Navigate to the Allocation Batches sheet. The scheduled allocation batches display in the grid.

7. To find and select additional batches you wish to run, click the Search Allocation Batches button.

8. The batches selected on this sheet generate their allocations when this process is run. If you wish to remove
a scheduled batch, highlight it on the grid.

9. Click Delete on the Standard Toolbar.

10. You can also indicate you wish to reverse the results of a selected allocation batch. To do this, select the
Reverse check box. When you run the Generate Allocations process, the allocations are reversed from your
general ledger (they remain in your records, however, for reference). Use this functionality to undo the
general ledger results of a specific allocation batch.

11. When you have selected the batches you wish to run, click the Generate Allocations tab.

12. On the Generate Allocations sheet, the Allocation Batch field displays the Selected status, indicating that
multiple batches will be processed.

13. You are now ready to review the allocations. Click the Actions menu and select Edit List.
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14. The Process GL Allocations - Edit List program displays.

15. You can print or preview this report. To display the report on your screen, click the Print Preview button.
Review the allocation results in the preview. If you are not happy with the results, close the Print Preview
window, make changes to the allocation codes and batches, and then run the Generate Allocation process
again.

16. When you are ready to post the allocations to the general ledger, click the Submit button on the
Standard toolbar. Your GL allocations post to the general ledger.

You can also set up this process to run on a regular,
automatic schedule. To learn how to do this, review the
Automatic Data Processing chapter in the Epicor ERP
Implementation Guide.

Simulated GL Allocations

You can also run the Generate GL Allocations program in simulation mode. When you use this option, the
allocation results distribute to the target accounts, but these results are not placed in the general ledger. Instead
they display within the Allocation History Tracker, where you can review the transactions. These transactions are
also stored in a separate data table for reporting purposes.

Use this mode when you are first setting up allocation codes and you want to verify the allocations are set up
correctly. You may need to use this feature multiple times to ensure allocation amounts are correctly dispersed
across the correct target accounts.

To simulate the allocation results:

1. Select the Book you need from the drop-down list.
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2. Either enter or select an Apply Date.

3. Select the Simulation check box. This check box indicates the allocated transactions will not be saved to
the general ledger; instead, they are placed within a separate table within the database.

4. Modify the Start Date and End Date values as you need.

5. Click the Allocation Batches tab to select the batches you wish to include in the simulation.

6. Click Submit on the Standard toolbar.

The next section describes the tracker available to view details of simulated or posted allocations.

Allocation History Tracker

The Allocation History Tracker stores all allocation transaction information and provides references to the source
data. The tracker also stores information about the allocation process runs with dates and user IDs. If you need,
you can reverse allocation runs within this tracker.

Menu Path: Financial Management > General Ledger > General Operations > Allocation History Tracker

Display Allocation History

To review allocation transactions:

1. Select the parameters you need to filter the transactions that display on the tracker.

2. Click Retrieve.

3. Based on the criteria you defined, one or more batch codes display in the Allocation Runs grid. Select a
batch code you wish to review.
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4. Navigate to the Allocation Details > GL Details sheet.

5. Click Retrieve.

6. The GL Details grid displays all transactions resulting from your allocation run. Review the transactions to
verify they dispersed into the correct accounts using the allocation ratios you set up.

Reverse Allocation History

To reverse an allocation run:

1. From the Actions menu, select Reverse Allocation Run.
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2. The Reverse GL Allocations window displays.

3. Enter the Reverse Date. All allocations run on this date are reversed from the general ledger.

4. Click Submit on the Standard toolbar.

You can also reverse the results of a specific batch within the
Generate Allocations program. Review the previous section for
more information.

The allocations are reversed from your general ledger. The original entries remain for your reference, and display
on various trackers or reports. You can return to Allocation Code Maintenance and Allocation Batch Entry to
modify the allocations as you need. You can then run the Generate Allocations program again to create the
allocation transactions.
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Chapter 11: Consolidation and the General Ledger

The General Ledger module is the central financial data capture point that defines the structure of the business from
an accounting, organizational, and time based viewpoint. Programs in the General Ledger module set up the application’s
posting processes and manage the accounting cycle. The Multi-Site module contains consolidation programs to merge
the financial results of subsidiary companies into one consolidated book within the parent company.

This chapter focuses on the General Ledger and consolidation Multi-Site operation programs of Epicor ERP. Details on
setting up your General Ledger module and your consolidation process can be found in the General Ledger chapter in
the Epicor ERP Implementation Guide.

You use many General Ledger programs to perform routine tasks. For example, you use Journal Entry to manually enter
journals you later post to the general ledger. The Review Journal previews journal results, displays journal errors and
contains tools for correcting these errors. The GL Currency Revaluation Process revalues currency segments in a chart
of accounts to the values you need in a different currency. You can use GL Transaction Matching to match debit and
credit movement against a GL account.

As described in the General Ledger chapter of the Epicor ERP Implementation Guide, you can create multiple books to
record your organization’s financial transactions. You can create a standard, or main book, to record the financial
activity of the company. You can also create local statutory and consolidation books; these books regulate the transfer
of consolidation journals between two standard books. You use consolidation-related programs to set up and manage
the consolidation process. You use Consolidate to Parent Entry to run a consolidation. Other programs are also available
to help you set up and manage the consolidation process.

Lastly, General Ledger provides tools for financial reporting. Various balancing methods are available, like daily, periodic,
summary, trial, carry-forward, and currency balances. The General Ledger Report displays financial information based
on journal details using period and summary balances. The Journal Listing Report lists journal entry details. The
Consolidation Report program generates a report where you can review consolidation journals prior to posting them.
By leveraging the functionality available within the General Ledger module, you can ensure your financial data is
accurate and up-to-date.

Setup

Details on the primary records you need to create to set up your General Ledger module and consolidation
processing can be found in the General Ledger chapter in the Epicor ERP Implementation Guide.

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for the General
Ledger module; the Configuration topic details the options you define within Company Configuration. You can
also review the Company Configuration chapter in the Epicor ERP Implementation Guide.

Operations

This section details operations available in the General Ledger and Multi-Site modules. Each operation is described
as a workflow to help guide you through the process from start to finish. These programs are primarily found
within the General Operations folder for this module. If a unique setup record is required to run the operation,
this record is also described in this section.
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Journal Entry

Use Journal Entry to create, reverse, and post manual journal entries and allocation templates. Journal entry
involves the definition and maintenance of journal groups, journals, and journal lines.

You also manage allocations, print journals, and post journals through options on the Actions menu.

Menu Path: Financial Management > General Ledger > General Operations > Journal Entry

Journal Entry - Group Detail

The Group sheet defines most of the settings applied to its journals. When you specify an entry mode, you
determine the context used to enter the group journals. The context determines the group’s fiscal calendar,
posting period, currency, and COA.

To create a group:

1. Click New on the Standard toolbar.

2. Use the Group ID field, enter a unique identifier for the group. This value displays on several reports and
programs. Use specific numbers to make it easy to find journal entries during an audit; for example
XXDDMMYYnn where XX are your initials, DDMMYY indicate the date, and nn indicates the number of the
group on that day.

3. Use the Single-Book and Multi-Book options to select the entry mode for journals in the group:

• Single-Book - Select this option to enter journals for a specific book. The fiscal calendar, currency, and
chart of account values all default from the selected book.

• Multi-Book - Select this option to enter journals for multiple books. These journals use company options
as the default values for journal entries in the group. The company’s fiscal calendar, currency, and Master
COA provide default values for journal entries.
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4. Click the Period Type drop-down list to designate whether the single book or multi-book journals post to
an ordinary or a closing period. This option is available in both single-book and multi-book mode journals.

If multiple books have different calendars, the posting
process automatically determines which period should be
used for each book using the specified Apply Date, Closing
Period, and validation rules defined for each GL book.

5. In the Apply Date field, enter the default apply date for journals in the group. If this journal is a multi-book
entry, the company’s default fiscal calendar determines the values that display in the Fiscal Year and Period
fields. If this journal is a single book entry, the book’s default fiscal calendar determines the Fiscal Year and
Period.

6. Click the Rate Type drop-down list to select the default rate type applied against journals in the group.
Rate types define the conversion rules used for multiple currencies. You can apply a different rate type to
individual journals. When necessary, the application uses the rate type to convert an amount from the
original, or source, currency to the target currency. The rate type you select is used either to convert amounts
for currency accounts on the journal details, or to convert amounts from a company currency to a book
currency in multi-book transactions.

7. In the Journal field, enter the default journal code for journals in this group. You can use journal codes as
a parameter for reports and trackers.

8. When you finish, click Save.

Journal Entry - Journal Header

Most settings applied to journal headers originate from the journal group to which the journal belongs. Journal
headers define the apply date, journal code, and rate type for a journal and its lines. Additionally, you can use
the header to reverse a journal.

To define journals for the group:
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1. Click the Down Arrow next to the New button; select New Journal.

2. The application creates a number to identify the journal and a legal number (if legal numbering is configured
for manual journals). Use the Description field to identify the journal. This description displays within this
program, GL reports, and the Chart Tracker.

3. Click the Apply Date drop-down list to select the date on which you want to apply these journal details.
This value defines the default date value for this journal. You can enter dates within the fiscal period to
which the journal posts.

4. If you need, select the Corr. Accounting check box. You can specify the credited and debited account for
each line in a journal entry with correspondence accounting. This functionality is for countries that require
each individual line of a journal to have matching debit and credit entries.

5. Use the Red Storno option to create a reversing journal. Reversing journals require an apply date for the
reversal in the adjacent field. Reverse transactions post debit amounts equal to credit amounts on the original
journal, and credit amounts equal to debit amounts on the original journal. Red Storno transactions contain
negative amounts. These transactions are a financial standard used in Russia and other countries; this
standard is sometimes referred to as negative posting.

6. When you finish, click Save on the Standard toolbar.
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Journal Entry - Journal Detail

Journal details define the accounts to which debit and credit amounts post. In addition, you can post a line to
another company’s COA for multi-company accounts. The journal posts to the Master COA of the subsidiary
company.

To define journal details:

1. Click the Down Arrow next to the New button; Select New Journal Line.

2. The application creates a Line number to identify the detail.

3. In the G/L Account field, enter a unique account identifier. The journal group determines the COA to which
its journals post. This field designates the account to which the detail amount posts. The application validates
the account value you enter.

4. Enter a Description to identify the journal detail. The Description value from the journal header displays by
default, but if you need, you can change this value. This description text displays in the GL reports, the
Journal Tracker, and the Chart Tracker.

5. Use either the Debit field or the Credit field to enter the amount posted to the selected account. Each
detail has either a debit or credit.

Multi-currency journal details can only be posted on
currency accounts. If a selected account is a currency
account, you can enter an amount in a foreign currency.
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This amount is then converted to the book currency using
the rate type specified for the journal. You can override
the exchange rate by adjusting the calculated amount.

6. If required, click the Auto Balance button to create a balancing detail based on an entered credit or debit
amount. Company options require you to enter balanced journals unless specifically overwritten.

7. If you need, post the detail to the COA of a receiving company, designated by the settings in the
Multi-Company pane.

8. When you finish, click Save on the Standard toolbar.

Journal Entry – Review and Posting Options

Before you post group journals, verify the GL accounts and transactions amounts are correct. You should display
or print out an edit list to review what you are about to post. When you are satisfied with the results on the edit
list, post the journal group. After you post the journal entries, you can no longer edit or delete them. If you post
an entry in error, you must either enter an offsetting transaction or use an automatic transaction reversal routine.

A Company Configuration setting usually requires you to enter balanced journals. If this method is required, the
application displays a warning message when you attempt to post an unbalanced journal.

To verify journal entries and post a journal group:

1. From the Actions menu, select Print Edit List. You can either print a hard copy of this report or display it
through a preview window. Use this list to review and verify the journals you wish to post.

2. When you are satisfied with the journal entries, select Post. To the confirmation message, click Yes.

3. You can also select the Post Asynchronous option. Use this process when you need to post a large entry
or group of journal entries. The asynchronous process can post large quantities of data easier than the
standard posting routine.
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4. If any errors occur during posting, select the Group > Posting Log sheet.

5. Any errors display on the Posting Log sheet. When you correct the errors, post the journal group again.

General Ledger Import

Use the General Ledger Import process to import data from other applications into the Epicor application. Once
you submit the General Ledger (GL) Import process, the changes update the application. You can review the
imported data before it posts to the GL, or post the imported data immediately upon being imported.

The imported file must be a comma delimited file (CSV) and
follow the format of the GL Import File Template when
importing a general ledger file from another application. Refer
to the General Ledger Import application help for the template
and examples.

Menu Path: Financial Management > General Ledger > General Operations > General Ledger Import

To import data from another application:
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1. In the Group ID field, enter the identifier for the group to be imported and press Tab.

2. Select the date you want for the Apply Date.

3. Select a Journal from the drop down menu.

4. Click the Import Filename button to find and select the file to be imported.

5. Select the Post check box to immediately post the imported data; otherwise, clear the check box to review
the data before posting.

If the Post check box is clear (not selected), you can use
the Print Edit List option from the Action menu to review
the data. When ready, you can later use the Post option
on the Actions menu to record the data within GL Journal
Entry.

6. Click Submit to run this process and update the database.

GL Transaction Matching

Use GL Transaction Matching to match debit and credit movements against a GL account. Once you complete
matching, you can produce a listing of GL transaction movements that remain unmatched by selecting the
Unmatched option when running the General Ledger Account Summary Report.

You can only match those GL transactions that contain natural accounts or account segments for which the
Enable Transaction Matching check box has been selected in COA Category Maintenance, or Account Segment
Values.

Menu Path: Financial Management > General Ledger > General Operations > GL Transaction Matching

To perform GL transaction matching:
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1. Click the Binoculars button.

2. The Non Matched GL Transaction Search window displays.

3. You can search using several options, including Book, Segment, Apply Date, and Book Amount. You
can only load and match journal transactions from one book. The application filters transactions with natural
segments that do not have matching enabled.

4. Click the Search button to select unmatched GLJrnDtl records.

5. The records display in the GL Transaction List grid.

6. Use the Select check boxes to select individual rows to be matched.
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7. Click Select All to select all displayed rows for matching.

The rows are matched. The application then assigns a
Match Code and a Match Date and then removes them
from the grid. You can review the matching code and
date in the Chart Tracker.

8. The Balance field displays the running unmatched balance total for all selected rows.

9. After selecting rows for matching, click Match to assign a match code and match date to the selected rows.

The Match button is available if the Balance is zero. This
occurs when the debit and credit amounts for the selected
rows are zero.

The Epicor application flags the rows as matched, assigns a match code and match date, and then removes them
from the display grid. You can view this matching code and date in the Chart Tracker.

GL Transaction Matching – Remove Match Code

To remove the match code from a previously matched row:

1. From the Actions menu, select Remove Match Code.

2. The Matched GL Transactions Search window displays.

3. You can enter a Book, a Match Code, and a Match Date to search.

4. Click Search.
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5. All GLJrnDtl records containing the selected book/match code/match date display in the Match Code column
of the GL Transaction List.

6. Select the records from which you want to remove the match code by using the Select check boxes.

7. Click the Select All button to select all records displayed.

8. Click the Remove Match button; the match codes are removed from the records.

Review Journal

Use Review Journal to adjust, re-validate, cancel, and confirm accounting transactions. You can also view source
lines for any summarized lines. Typically, review journals are used to review posting errors and to preview the
results from your custom posting rules.

Generally, you use entry programs to correct errors in company transactions, and use this program to change
transactions originating from outside company (multi-company) databases. You can use commands from the
Action menu to revalidate and post edited journals.

If you need to “debug” your custom posting rules, use the
Posting Engine Log. This file records how your custom posting
rules interact with your Epicor application. For details on using
this log file, review the Posting Engine Technical Reference
Guide within application help.

Menu Path: Financial Management > General Ledger > General Operations > Review Journal

To adjust a review journal:
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1. Click the Journal Entry button to find and select the journal to review.

2. The Tree View lists the book or books to which the selected journal was posted along with its transaction
number. The journal entries display by book. Additionally, book-level validation settings determine errors
and warnings. If a transaction fails to post in one book, the transaction will also fail to post in other books.
The Review Journal displays all books and transactions affected by the error.

3. Select the Transactions > Error Log sheet to review posting errors.

4. Review the entries in the Error Log sheet to determine the changes needed to correct the invalid journal.
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5. When you select a journal number in the Tree View, the Transactions > Detail sheet displays information
from the journal header.

6. To review journal details, select the Transaction Line you want to view in the Tree View.

7. When you select the line, the Transactions > Lines > Detail sheet displays.

8. If you need, use the GL Account field to correct a line posted to an invalid account.

9. Optionally, you can also edit the Description for the journal line.

Verify Balances

Use Verify Balance Records to rebuild balances when they become inaccurate or you have made changes to the
balance setup. Select the Update Balances check box to update and audit balance records. In addition, a Rebuild
Balances Required message displays in Chart of Accounts Structure Maintenance, notifying users to run the Verify
Balance Records process. The Update Required check box is automatically selected in Verify Balance Records any
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time a segment with any Balance Control type selected on it is added, deleted, or updated in Chart of Accounts
Structure Maintenance.

Menu Path: Financial Management > General Ledger > General Operations > Verify Balances

To run the Verify Balance Records process:

1. Select a Book.

2. To update and audit balance records by creating a report, select the Update Balances check box.

3. Select the check boxes of the balances to verify. Available options: Period Balances, Standard Trial
Balances, and Daily Balances.

4. Select the Starting Period and End Period of the balances you want to update and/or audit.

5. Select the Starting Date and Ending Date of the balances you want to update and/or audit.

6. Click the Log Filename button to find and select a directory and file name for the log file.

7. Click Process.

Update Business Entity Segment Values

Use the Update Business Entity Segment Values process to manually update dynamic segment values based on
reference-type and user-defined business entities created in Chart of Accounts Structure Maintenance.

If you need information on setting up accounts, refer to the
General Ledger chapter of the Epicor ERP Implementation
Guide.

Menu Path: Financial Management > General Ledger > General Operations > Update Business Entity Segment
Values

To update the segment values of an updated GL COA:
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1. Click the COA Code drop-down list to select the chart of accounts that has been updated.

2. Click Submit.

Rebuild Display GL Account

Use the Rebuild Display GL Account process to update the display order throughout the Epicor application of GL
chart of account (COA) segments after you change the segment order in a COA. Each GL account can have up
to 20 definable COA segments and they can display in any order.

Menu Path: Financial Management > General Ledger > General Operations > Rebuild Display GL Account

To update the display order throughout the Epicor application of an updated GL COA:

1. Click the COA Code drop-down list to select the chart of accounts that has been updated.

2. Click Submit.

Automatic Transaction Reversal

Use Automatic Transaction Reversal to cancel posted journals. You can reverse a journal through either the
Reverse Transaction method or the Reverse as Red Storno method. When you reverse a journal using Red Storno,
you reduce tax consequences in jurisdictions that levy tax amounts based on the negative amounts within general
ledger accounts. Journal Entry users can also select journals and indicate they use Red Storno posting. Any future
transactions in these journals post using the Red Storno method.

Menu Path: Financial Management > General Ledger > General Operations > Automatic Transaction Reversal

To cancel posted journals:
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1. Click the Source Journal Number button to find and select the journal to reverse.

2. If the journal posts to multiple books, in the Tree View, select the books to which the journal posted. You
can reverse a journal posted to one book without reversing the same journal posted to other books.

3. Use the Reverse Transaction and Reverse As Red Storno check boxes to select the method used to
reverse the journal. Reverse transactions post debit amounts equal to credit amounts on the original journal
and credit amounts equal to debit amounts on the original journal. Red Storno transactions contain reversing,
negative amounts. Red Storno is sometimes referred to as negative posting.

4. In the Tree View, select a line.

5. Click on the Transaction Details > Details sheet to display the details.

6. In the Reversing Line Description field, describe the reason for the reversal. The description displays in
this program, GL reports, and the Chart Tracker.
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7. From the Actions menu, select Reverse.

Void Pre Numbered Forms

Use Pre Printed Forms to void damaged or spoiled pre-numbered folios. If you selected the Use Pre Numbered
Formats option in Legal Number Maintenance during configuration of a number sequence, a set of numbers
generates that are later applied to documents or checks in a folio.

Use Pre Printed Forms to void specific numbers applied to the documents or checks. You can then continue to
use the sequence that contains the number. Refer to the Legal Numbers chapter of the Epicor ERP Implementation
Guide for information on setting up legal numbers.

Menu Path: Financial Management > General Ledger > General Operations > Void Spoiled Folios

To void a legal number folio:

1. Click the Legal Number button to find and select the legal number that contains the folios you want to
void. Only legal numbers created with the Use Pre Numbered Format option display in the search results.

2. Designate the numbers to void by completing the From Legal Number and To Legal Number fields.

3. In the Reason field, enter an explanation for the void.

4. Click the Void button to void the numbers. A Void Confirmation window displays showing the number of
legal numbers to be voided.

Close Period Entry

Use Close Period Entry to close ordinary and closing periods for financial books. If you close the last closing period
in the fiscal year, a warning displays stating this will close all periods in the year.

At the beginning of the next fiscal year, all opening balances from the previous fiscal year update automatically,
carrying the last values recorded during the previous year. All income and expense accounts revert to a zero value
for their opening balances. You can configure an income statement account to keep the balances in a separate
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field for informational purposes. For example, you do this to track expenses for a project lasting more than one
fiscal year.

Menu Path: Financial Management > General Ledger > General Operations > Close Fiscal Period/Year

To close a fiscal period:

1. Click the Book drop-down list to select a book associated with the fiscal calendar that contains the period.
When you select a book, the current year’s periods display in the Fiscal Periods list.

2. Optionally, click the Fiscal Year/Suffix button to find and select a different year.

3. The fiscal periods display in the Fiscal Periods list.

4. In the Fiscal Periods list, select the Closed check box for the period or periods to close.

A warning displays if preceding periods are open or if you
are closing the last period in the year. Click Yes to
continue the process.

5. When you finish, click Save on the Standard toolbar.

GL transactions for closed periods stay in your database after you close them. You can then enter any changes
you need on these transactions. To restrict this functionality, you can use Earliest Apply Date Entry to prevent
users from entering transactions earlier than a specific date. To prevent any transaction entry within a specific
fiscal period, use the Close Period option within this same General Ledger program. When you are ready to
completely remove transactions from the database, use the Purge General Ledger History program.

Transfer Opening Balances to Next Year

As part of your year end procedures, you can manually transfer opening balances to the next year by running
the Transfer Opening Balances to Next Year process after you close the last fiscal period to update the future
year. You can schedule the Transfer Balances process. After you transfer balances the first time, they update with
each posted transaction and can be re-transferred any time. You can then transfer balances to the next year
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before the current year end and create early drafts of next year's opening balance. Then, you can transfer the
final balances after all the previous year adjustments are complete.

Your GL book can be configured to update future years automatically. You activate this feature in Book
Maintenance by selecting the Auto update future balances option from the Future Opening Balances drop-down
list. The balances automatically update and transfer to the new year.

Menu Path: Financial Management > General Ledger > General Operations > Transfer Opening Balances to
Next Year

1. Click the Transfer drop-down list in the Books pane to select the type of book balance transfer you want.
Available options: Individual, By Fiscal Calendar, or All Books.

2. Make the appropriate entries in the enabled fields in the Books and Years panes. The enabled fields vary
depending upon your Transfer field selection in the Books pane.

3. Click the Schedule drop-down list to select when you want this process to run.

4. Click the Log Filename button to find and select the directory and filename you want for your log filename.

5. Click Process to schedule the process.

GL Currency Revaluation Process

Use GL Currency Revaluation to calculate and apply adjustments to any accounts that use a different currency.
The process affects currency accounts; these accounts contain a natural account segment configured to use
currency conversion features like rate types A natural account can be configured to maintain balances in one or
more foreign currencies.

Menu Path: Financial Management > Currency Management > General Operations > G/L Currency Revaluation

Use the Selection sheet to select the GL book, fiscal period, and dates used in the process. You can revalue
amounts through a reverse journal and post actuals to an accrual account instead of the base account.
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1. Click the G/L Book drop-down list to select a book associated with the chart that contains the accounts.

2. Optionally, use the Fiscal Year and Fiscal Period fields to change the defaults. These fields display the
current period for the fiscal calendar associated with the selected book.

3. If you need, change the value in the Exchange Rate Date field. The exchange rate date applies the rates
effective on the date to transactions entered on or before the date.

4. If you need, change the value in the Apply Date field. The apply date determines the date on which the
revalued amounts are recorded within the general ledger.

5. Click the Journal drop-down list to select a journal code. This code groups together journals created by the
process. Use this value to locate journals in various reports and trackers.

6. In the Transaction Text field, enter a comment that displays for users tracking the process.

7. Optionally, select the Reverse check box to automatically reverse journals created by this process. If you
create reversing journals, specify the reverse date and indicate whether the process posts the reversal to an
accrual account.

For information on configuring a currency account and
setting up multiple currencies, review the Multi-Currencies
chapter in the Epicor ERP Implementation Guide.

8. Use the Filter sheet to limit the process to specified Currencies and Accounts.

9. Click Submit to run the process.

Consolidation

Consolidation is a legal process through which you merge the financial results of subsidiary companies into one
consolidated book within the parent company. The process rolls up financial results between source and target
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books, typically books from a child, or subsidiary company, to a parent company or an external application. You
run this process at the end of each fiscal period or on a continuous basis and then complete the consolidation
results at the end of each fiscal year.

When consolidation is complete, you can either preview the results in an intermediate (consolidation) book in
the source company or review the final results in the parent company. If you use periodic consolidation, you can
preview the results in an intermediate book; you then later transfer the approved results to the parent company.
Through the consolidation process, you can re-calculate the financial results posted in one currency to another
currency. You can also report these results using a different fiscal calendar and chart of accounts selected on the
parent company book.

Details on setting up the consolidation process can be found
in the General Ledger chapter in the Epicor ERP Implementation
Guide.

You can set up the consolidation process to handle any multi-company structure you need. Consolidations can
be a one-to-one relationship between a source subsidiary book in one company to a parent target book in another
company. You can set up a consolidation routine that consolidates transactions from multiple child companies
into one target parent company. You can also consolidate multiple child, or subsidiary books, into multiple parent
books in different companies. You might do this, for example, when the parent company is also an operational
company and needs to consolidate its results with other entities.

The financial data from the source book is transformed into the account structures defined in the intermediate
book. The chart of accounts structure matches the structure in the target book, so this data can now move from
the intermediate book into the target book within the target company. The intermediate book transforms the
transactions into the currency, fiscal calendar, and accounting structures needed within the target book. You
use the intermediate book to verify the consolidation results before they are posted to the target book.

The consolidation sequence:

1. The general ledger transactions post to the source book. These transactions use the posting process defined
for the source book.

2. The consolidation process begins transferring balances into the format needed for the intermediate
(consolidation) book. If the intermediate book uses a different currency, the process first converts the amounts
using the exchange rate calculated by the selected consolidated rate type and the consolidation type.
Consolidation Rate Type Maintenance defines the method used to calculate the consolidation rates.
Consolidation Type Maintenance defines the method used to calculate consolidation amounts using the
consolidation rates.

3. The balances are then transformed into the account structure required for the intermediate book.

4. The balances are calculated and adjustment transactions are created within the intermediate book.

5. Using the Multi-Company Direct Server Process (for companies that reside on the same server) or the
Multi-Company Server Process (for companies that reside on different servers), the GL transactions transfer
from the intermediate book in the source company to the target book within the parent target company.

The parent target book is updated with the transactions.

For more information on consolidation, refer to the Multi-Site
Technical Reference Guide within application help.
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Consolidate to Parent Entry

Use Consolidate to Parent Entry to post and transfer consolidation journals from a source book’s COA to
intermediate and target books. This program specifies the consolidation period and the consolidation definition
used to run the process. You only use this program when you are running a periodic consolidation within the
source company.

The consolidation process creates journals for source COA segments that maintain balances. You use consolidation
journals to validate entries and adjust journals to account for inter-company loans, ownership of common stock,
inter-company sales, and other elimination entries. You use the posting process to convert the results into the
currency amounts and account structures required for the intermediate book. If the Immediate Transaction check
box is selected on the consolidation definition, these results are automatically transferred to the target book as
well. If this option is not selected, you will need to transfer the results manually. You use the Actions menu to
run the consolidation.

Menu Path: Financial Management > Multi-Site  > General Operations > Consolidate to Parent

Consolidate to Parent Entry - Detail

To define the consolidation:

1. Click New on the Standard toolbar.

2. The application creates a value in the Consolidation ID field.

3. Enter a Description for the consolidation. This concise explanation indicates the purpose for the record to
other users.

4. In the Cons. Def. ID field, enter a unique identifier to apply consolidation definition defaults.

5. If you need, change the value in the Output File Name field. The selected consolidation definition defines
the default value displayed in this field. Use this field when the consolidation creates consolidation journals
for a different ERP system or a Sonic interface.

6. When you finish, click Save.
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Consolidate to Parent Entry – Source Control

Use the Source Control sheet to set the consolidated period and other default values used in the consolidation
process. These default values are pulled from the consolidation definition. Consolidation source settings apply
to the book you are consolidating.

To define source settings:

1. Select the Source Control > Detail sheet.

2. Optionally, change the value in the Source Book field. The consolidation uses this book as the source for
consolidation journals. Continuous consolidations can have multiple source books that directly consolidate
to the target book; periodic consolidations use an intermediate book that converts financial data from
multiple source books.

3. In the Fiscal Year/Suffix field, enter the fiscal year that contains the period to consolidate.

4. In the Fiscal Period field, enter the period to consolidate.

5. If you need, enter a value in the Closing Periods field. This field determines the last closing period that will
be consolidated. If it is a zero (0) value, closing periods are not consolidated.

6. If you need, change the Exclude Open Periods option to either include or filter open periods in this
consolidation. If you select this check box, you limit the consolidation to closed periods.

You can re-run a consolidation for the last period multiple
times. You may want to do this if you posted GL journals
in the source book in periods you have previously
consolidated (typically to make adjustments). You can
only consolidate the last period and the full consolidation
results are sent to the parent. You can reverse previously
posted consolidated journal entries manually via the
Automatic Transaction Reversal program.
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7. Optionally, select the Bypassed check box to indicate you do not want to receive a warning message if you
post subsequent periods before processing the selected period. If you do not select this check box, a warning
message displays when you begin to post subsequent periods.

8. If you need, change the value in the Exchange Rate Diff Account field. This field specifies an exchange
account in the intermediate or target book.

9. When you finish, click Save on the Standard toolbar.

Consolidate to Parent Entry – Source Rates

Use the Source Rates sheets to define exchange rates. Consolidation exchange rates apply to the calculated
consolidation balances.

To define source rates:

1. From the Actions menu, select either Get Default Rate or Get All Defaults Rates to retrieve consolidation
rate types for the consolidation. You run one of these processes regardless of whether you consolidate
books with the same or different currencies.

2. The calculated rates display in the Consolidation Source Rates List grid.

3. Select a source rate that applies to the consolidation.
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4. The Source Control > Source Rates > Detail sheet displays the consolidation rate types used during the
consolidation process.

5. If you need, use the Exchange Rate field to change the exchange rate to be used to convert between the
currency of the source book and the currency of the target book.

By default, the rate is set to 1.00 when the source and
target books use the same currency. You cannot enter a
zero (0) value.

6. When you finish, click Save on the Standard toolbar.

Consolidate to Parent Entry – Post

After you enter consolidation parameters, you can post consolidation results to intermediate books and target
books.

To post review journals from the source book:

1. From the Actions menu, select Post.
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2. The Consolidation Post Process window displays.

3. Click the Log File Name button to select the path and name of the file to be used to write the log of the
process.

4. Click Submit to run the process. If this definition is selected for immediate transaction, the data transfers
directly to the target book. However, if this consolidation definition does not automatically transfer data to
the target book (the Immediate Transaction check box is clear on the definition), you can now review the
financial results before you transfer these results to the target book.

Following posting, you can run the Transfer Intermediate
process from the Actions menu. This completes the
process when the consolidation uses an intermediate
book. Typically, journals created in the intermediate book
are validated before their final transfer to the target book.

5. To create a consolidation report, select Print Report from the Actions menu.

6. The Consolidation Report displays.
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This report is also available from the Main Menu. Refer to the Consolidation Report topic later in this
chapter for more information.

Import Consolidation From Subsidiary

Use this optional program if you need to import balances from a source book which exists in a different Epicor
database, ERP system, or Sonic interface. Unlike a consolidation which occurs between multiple companies within
the same database, you need to import an external file that contains the consolidation data.

You run this program when your organization is set up with a multi-site environment that uses the Sonic application
to send and receive data.

The import transfers subsidiary account balances to a consolidated parent book for use in legal and tax reporting.
Typically, the journals transfer balances from a source book owned by a subsidiary to a consolidated book owned
by its parent.

Menu Path: Financial Management > Multi-Site  > General Operations > Import Consolidation From Subsidiary

This program is not available in the Epicor Web Access.

To create a consolidation file import:
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1. Click New on the Standard toolbar.

2. The application creates an identifier for the consolidation in the Import ID field.

3. Enter a Description for the import record. The description identifies the record to users of this program.

4. Click the Book ID drop-down list to select the book to which the consolidation results will post. Consolidation
definitions specify a target COA used to create journals when the consolidation process creates an output
file. Select a target book that uses the same COA used in the imported file.

5. In the Fiscal Year and Period fields, enter the the period to which the imported journals post. The fiscal
calendar for the selected book determines available fiscal years and periods.

6. In the Group ID field, enter a journal group ID. The application uses this identifier in batch processing of
imported journals.

7. Optionally, specify the journal code you want in the Journal field. Journal codes applied during posting can
be used to group journals on reports and trackers.

8. If you need, change the date in the Apply Date field. The selected group ID determines the default. Posting
errors might occur if journals apply to a closed period.

9. In the Import File Name field, enter the path and name of the import file.

10. In the Journal Header Description field, enter the description that includes the purpose of the journal.
This value displays within various GL reports, the Journal Tracker, and the Chart Tracker.

11. Click Import to run the process.

Consolidated Year End Process

You must run the Consolidated Year End Process after you have fully consolidated a fiscal year and before you
can proceed with consolidating periods in the next year. Only run this process after you have posted the last fiscal
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period in Consolidate to Parent Entry. This process posts the consolidation balances for a fiscal year and then
creates opening consolidation balances for the next fiscal year.

This process is available if you need to consolidate financial
results for a fiscal year. If you consolidate a period into the next
fiscal year, you generate the same results.

Menu Path: Financial Management > Multi-Site  > General Operations > Consolidated Year End

To post consolidation balances for a fiscal year:

1. Click the Source Book ID drop-down list to select a book from which consolidation journals originate.

2. In the Fiscal Year field, enter the year to close.

3. Click Submit to run the process.

Reports

This section describes some key reports you use to review information about the General Ledger. You can run
these reports whenever you need. You can also set up each report to generate and print through a recurring,
automatic schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for
information on how you link a report to a recurring schedule.

General Ledger Report

The General Ledger Report lists financial information for a range of accounts and/or periods that you select. You
can print both a summary and a detailed version of this report.

Menu Path: Financial Management > General Ledger > Reports > General Ledger

To set up and run this report:
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1. If you need, change the fiscal year that displays in the Fiscal Year field. By default, the field displays the
current year in the fiscal calendar for the selected book.

2. In the Starting Fiscal Period and Ending Fiscal Period fields, enter the period included in the report.

3. If you want this report to display all the transaction details within each account, select the Print Details
check box. If you clear this check box, each selected account only displays its Opening Balance, Total Debits,
Total Credits, and Ending Balance values.

4. Click the Book drop-down list to select the book that contains the report information.

5. Use the Natural Account Range fields to define the first and last accounts in a natural account range to
appear in the report.

6. Use the options in the Grouping pane to define how the report groups details. Available options:

• Detail Account – Organizes accounts based on detail balances.

• Summary Account – Organizes accounts based on summary balances.

• Full Account – Organizes accounts based on journal details.

7. If you want, click the Filter sheet to filter the report to only display results for specific books and/or account
segments.

8. When you finish, click Print on the Standard toolbar.
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General Ledger Account Summary Report

The General Ledger Account Summary Report displays financial information for a range of accounts and/or periods
you select. Summary, detail, and full versions of the report are available. You can also specify whether matched
or unmatched transactions are included in the report results.

Menu Path: Financial Management > General Ledger > Reports > General Ledger Account Summary

To set up and run this report:

1. Select the appropriate Report Options from the Selection sheet of the report program.

2. Click the Grouping drop-down list to indicate how you want the report organized. Available options: Detail
Account, Summary Account, Full Account.

3. Click the Matched Transactions drop-down list to select how you want transactions to display on the
report. Available options: All,Matched Only, Unmatched Only, and Open.

You match transactions in the GL Transaction Matching
program. For more information, review the previous
section in this chapter.

4. Select the Print Match Code check box if you want assigned match codes listed next to the matched records
in the report.

5. Optionally, click the Filter sheet and filter your report by Book, Segment, Natural Account, or Excluded
Natural Account.

6. When you finish, click Print.
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Journal Listing Report

Use the Journal Listing Report to review a list of detailed journal entries. You can select the specific journals you
want to display on the report. You can also limit this report to display either a selected fiscal period or a date
range.

Menu Path: Financial Management > General Ledger > Reports > Journal Listing

To set up and run this report:

1. In the Selection Method pane, indicate the time frame included in the report. Available options: By Fiscal
Period or By Date Range.

2. Click the Book drop-down list to select the book that contains the report information.

3. If you selected By Fiscal Period, use the Fiscal Year and Period fields to enter the fiscal year and period for
the report.

4. If you selected By Date Range, use the Start and End fields to enter the start date and the end date for the
report.

5. Use the Filter sheet to limit the report to specified Journals and External Company(ies).

6. Select the Show External Company Details check box to add information about the external companies
you are including on the report.

7. Select the Multi-Company Journals Only check box to only display journals that include multi-company
data.

8. When you finish, click Print on the Standard toolbar.
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Consolidation Report

Use the Consolidation Report program to generate a report to review consolidation journals prior to posting
them. The report includes information about journal accounts and balances and exchange rates if the source
book and the target book use different currencies. With this information, you can determine whether to adjust
consolidation journals prior to posting them.

This report also runs from the Actions Menu in Consolidate to Parent after you generate review journals.

Menu Path: Financial Management > Multi-Site  > Reports > Consolidation Report

To set up and run this report:

1. Click the Consolidation ID button and search for and select the consolidation for which you want to run
the report.

2. The Company, Book and COA associated with the consolidation display in the Target Details pane.

3. Click Print on the Standard toolbar.
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Chapter 12: Expense Management

Use Expense Management to enter and manage expenses incurred by employees. You can use Expense Management
programs to enter, approve, and correct expense transactions, and to set defaults used in the expense approval process.
You can also define payment methods and determine whether they are reimbursable.

Employees, managers, and department supervisors typically use Expense Management to enter and manage their own
expense entries and the expense entries of other employees. When configured, an optional approval process can require
the approval of expense entries by authorized approvers.

Typically, employees enter their incurred expenses and then submit their expenses for approval. Authorized approvers
then review, correct, approve, or reject the expense transactions. Accounts payable (AP) invoices are generated so
employees are reimbursed for expenses they incur. Employees can assign an optional claim reference number to a
group of expenses during expense entry and then retrieve those expenses for easy reconciliation with AP invoices.

Employee Maintenance, Site Configuration Control, and Pay Method Maintenance are some of the programs you use
to set up the expense entry and approval processes.

Setup

This section describes the primary records you need to create for the Expense Management module. These
programs are contained within the Setup folder for this module. Only the primary records are described here.
Some areas within the next Operations section may also document setup records if they are required for a specific
workflow.  

You may also need to set up some parameters within Company Configuration. Some modules have global settings
you define through this administration program. For more information, review application help for this module;
the Configuration topic details the options you define within Company Configuration. You can also review the
Company Configuration chapter in the Epicor ERP Implementation Guide.

Site Configuration

Use the Site Configuration Control program to determine whether expense transactions require approval. You
also define the approval logic, or method, used to approve indirect expenses. Indirect expenses are not associated
with a specific project. You can set the approval method to approve transactions automatically, or to approve
transactions according to a setting in Employee Maintenance.

Menu Path: System Setup > Company/Site Maintenance > Site Configuration

This program is not available in the Epicor Web Access.

1. Click the Site button to find and select the Site you need.
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2. The Name of the selected Site displays for your information. 

3. Navigate to the Modules > Time and Expense > Expense sheet.

4. Select the Restrict Entry check box to restrict all employees from entering expenses for other employees.
When selected, you designate users who can enter expenses for a specific employee in Employee Maintenance.
Clear the check box to allow any user to enter expenses for any employee.

5. If you selected the Restrict Entry check box, you can select the Supervisor Allowed Entry check box to
allow designated supervisors to enter, modify, and delete expense transactions for the employees they
supervise. Employee supervisors are designated in Employee Maintenance.

6. Select the Submit on Save check box to automatically submit new expense entries when you click Save.
To override this Site setting, you can select or clear this check box in Time and Expense Entry.

7. Select the Approval Required check box to indicate all expense entries submitted by employees must be
approved.

8. The Create Default Approval Workflows button allows a user to decide a workflow approval the Epicor
application will create. The options include:

• Multi Level Approval

• Supervisor  Approval

• Project Manager Approval

• PM and Supervisor Approval

Example  Assign the Multi Level Approval workflow
to an employee in order to require more than one
approval for their expense entry.
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9. Use the Rights section to define whether approvers can delete or change expense transactions submitted
for approval by employees.

10. Use the Logic section to define the approval method for indirect expense transactions submitted by
employees. If the method is Automatic, expenses are automatically approved when submitted. If the method
is Employee, then the transactions are approved as defined in Employee Maintenance. You define the
project expense approvals method on the project.

11. Use the Expense Defaults section to define a default Expense Workflow Group used to approve expenses
if an expense workflow group is not defined in Employee Maintenance.

12. When you finish, click Save on the Standard toolbar.

Employees

Use Employee Maintenance to define whether employees can enter expenses and then assign suppliers to them;
these expenses are then used for creating account payable invoices for reimbursement. If you set options in the
Site Configuration Control program to define approvals according to settings in Employee Maintenance, you
must also define whether an expense for a specific employee is approved automatically or by a specific workflow
group. You also assign a mandatory supervisor which may be used during the approval process, and you can
restrict who can enter expenses for another employee in this program.

For details about other setup requirements in Employee
Maintenance, review the chapter on Time Management and
the Personnel chapter in the Epicor ERP Implementation Guide.

Menu Path: Service Management > Expense Management > Setup > Employee

To set up an approval workflow for a specific employee:
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1. On the Detail sheet, click the ID button to find and select the employee record you need. The selected
employee record displays on the sheet.

2. You can also click the Person/Contact button to find and select the individual you want to define as an
employee.

If you have an individual who needs to be defined in
multiple records, such as a shop employee who is also a
buyer, you can define this person in Person/Contact
Maintenance first and then link this person record to the
other records throughout the application. To learn more
about this functionality, review the Personnel chapter in
the Epicor ERP Implementation Guide.

3. Click the Supervisor button to find and select a supervisor for this employee. If Approval Required is
selected in Site Configuration Control, then each employee must have a designated supervisor. When you
use a manual approval process and you have not selected a workflow group in either Employee Maintenance
or Site Configuration Control, the supervisor is the approver.
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4. Navigate to the Approvals > Expense > Detail sheet.

5. Select the Enter Expenses check box to allow the employee to enter expenses in the application. Employees
cannot enter expenses in Time and Expense Entry if this check box is clear.

6. Click the Supplier button to find and select a supplier ID for this employee. The supplier ID is used to create
AP invoices for the employee when entering expenses for reimbursement.

If the employee does not have a supplier ID, you can
create one manually or, if configured in Company
Configuration, the application adds a supplier ID
automatically when you save the employee record.

7. Define the approval workflow for expense transactions submitted by this employee. Select the Auto Approve
Expenses check box to automatically approve expense transactions.

8. Optionally, select a workflow group in the Expense Group field to designate a workflow group to approve
expense transactions.

9. You can view the workflow group you selected. To do this, click the Approval Tasks tab.
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10. Expand the workflow group tree to review the different tasks defined for the workflow group.

11. When you finish, click Save on the Standard toolbar.

Restrict Entry

If you selected the Restrict Entry check box in Site Configuration Control, you must also define who can enter
expenses for specific employees in Employee Maintenance. Designated users can enter expenses for employees
in Expense Entry.

To restrict an entry:

1. Navigate to the Production Info sheet.

2. In the User Name field, select the user who can enter expenses for the employee.

3. When you finish, click Save on the Standard toolbar.

The designated user can now enter expenses for the employee in Expense Entry.

Payment Method

Use Pay Method Maintenance to define the methods used to pay expenses. Employees associate a payment
method with individual expense transactions when entering expenses in Expense Entry. Payment methods indicate
the method by which the expense was paid, such as cash or credit card. Payment methods also determine whether
an employee receives reimbursement for an expense, and whether an AP invoice is created for the employee
entering the expense.

Menu Path: Service Management > Expense Management > Setup > Payment Method

To enter a new payment method:
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1. Click the New button on the Standard toolbar.

2. Enter the name of the Payment Method.

3. Verify the Scope field is set to AP.

4. Define whether an expense associated with this payment method is reimbursable to employees. Select the
Reimbursable check box to indicate employees receive reimbursement for an expense associated with this
method, or clear the check box to indicate the expense is company-paid and resources do not receive a
reimbursement.

5. Clear the Inactive check box to indicate the payment method is available for employees during expense
entry.

6. When you finish, click Save.

Miscellaneous Charge/Credit

Use the Miscellaneous Charge/Credit program to define expense details.

Menu Path: Service Management > Expense Management > Setup > Miscellaneous Charge/Credit
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1. Click the down arrow next to the New button on the Standard toolbar and select New Charge.

2. Enter a unique code for the Charge ID.

3. Enter a description for the miscellaneous charge

4. If the miscellaneous charge is for employee expenses, select the Expense check box.

5. From the Type drop-down menu, indicate if the miscellaneous charge is a flat amount or a percentage.

6. Select the Inactive check box to indicate the charge as inactive. The miscellaneous in unavailable to select
within the application.
Defaults as Active.

7. Click Save.
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8. Navigate to the Expense Type Detail sheet.

9. Select the Unit Based check box to indicate the miscellaneous charge is unit based.

10. Select the Chargeable check box if miscellaneous expense is able to be charged.

11. From the Tax Liability drop-down menu, specify if a tax liability is associated with the expense.

12. From the Pay Method drop-down menu, specify the payment method associated with the expense.

13. Select the Project check box to indicate if the expense can be selected for entry of project expenses.

14. Select the Indirect check box to indicate if the expense can be selected for entry of indirect (non-project)
expenses.

15. Select the Required check box to indicate if a comment is required for the expense.

16. In the Comment Instructions box, enter the required comments necessary for the expense.

17. Click Save and exit Miscellaneous Charge/Credit Maintenance.

Quick Entry Codes

Use Quick Entry Maintenance to define frequently used expense entries and associate them with a Quick Entry
code. You use Quick Entry Codes when entering expenses. When adding expenses in Expense Entry, you select
an expense quick entry code to populate the expense record with the defaults you define through this setup
program.  You can create a set of expense quick entry codes for each employee record. Users can then choose
from the available expense quick entry codes linked to their employee record.

Using expense quick entry codes helps you add expense transactions faster and more efficiently. For example, a
quick entry code is useful when users are working on a project and entering expense records for the same task
every day of the week. Your employees can select the expense quick entry codes they need, saving time and
ensuring accurate data entry.

Main Menu Path: Service Management > Expense Management > General Operations > Quick Entry
Code

Menu Path: Service Management > Expense Management > General Operations > Quick Entry Code

 To enter a new quick entry code:
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1. On the Detail sheet, click the Employee ID button to find and select the employee record. The selected
employee record displays in the sheet.

2. Navigate to the Expense > Detail sheet.

3. Click the Down Arrow next to the New button.

4. Select New Expense Quick Entry.
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5. In the Quick Entry field, enter a unique identifier for the quick entry code.

6. If the expense is not associated with a specific project or production job, select the Indirect Expense check
box. If you select this check box, the Project and WBS Phase fields are not available.

7. If the expense is associated with a specific project, click the Project button to find and select the project
identifier you need.

8. Click the WBS Phase button or use the drop-down list to select the Work Breakdown Structure Phase you
need to associate with this expense quick code.

9. Enter an optional Expense Type as needed. Default values associated with the selected expense type default
into the remaining fields. Edit these values as you need.

10. Optionally, enter a Payment Method. If a payment method is selected, the Reimbursable check box
indicates whether the employee can be paid back for this expense.

11. Select a Tax Liability method. The value associated with the selected Expense Type displays by default.

12. Select the optional Tax Included check box if the expense amount includes tax.

13. Optionally, select an Expense Currency. This value indicates the currency you will use to record expenses
through this expense quick entry code within your general ledger.

You can create currency records for all the currencies
through which your company conducts business. To learn
how to enter and maintain multiple currencies, review
the Multi-Currencies chapter in the Epicor ERP
Implementation Guide.
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14. If the expense will be submitted using a different currency, select this option from the Claim
Currency drop-down list.

15. When you finish, click Save on the Standard toolbar.

16. The quick entry code displays in the Tree View. Notice that all of the time quick entry codes and expense
quick entry codes or the selected employee display on this Tree View.

Operations

This section details the operations available within the Expense Management module. Each operation is described
as a workflow (or sequence) to help guide you through the process from start to finish. These programs are
primarily found within the General Operations folder for this module. If a unique setup record is required to run
the operation, this record is also described in this section.

Expense Entry

Use Expense Entry to enter employee expenses and submit them for approval. You can enter expenses for internal
transactions such as general supplies or training, or for transactions associated with a project. After expense
transactions are entered, you can view, modify, recall, and copy them. You can also monitor the status of entered
transactions and enter comments for approvers.

The sheets in Expense Entry provide different ways for entering expenses. The sections that follow demonstrate
some of the ways you can enter expenses.

Menu Path: Service Management > Expense Management > General Operations > Time and Expense Entry

Expense Entry Detail

Use the Expense > Detail sheet to enter a single expense transaction and submit it for approval.

To enter a new expense transaction:

1. On the Employee sheet, enter the Employee identifier or click the Employee ID button to find and select
the employee for whom you are entering an expense.
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2. Navigate to the Expense > Detail sheet.

3. Click the Down Arrow next to the New button; select New Expense.
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4. The current date displays in the Expense Date field by default; if you need, select a different date.

5. If you want to group multiple expenses and reconcile them with an AP invoice, enter an optional Claim
Reference number.

6. Select the Indirect check box to indicate the expense is internal, non-project related. Clear the check box
to indicate the expense is project-related. When the expense is project related, you can enter the Project
and WBS Phase for which the expense was incurred.

7. In the Expense Type field, select the type of expense you incurred. Values defined for the selected Expense
Type may populate the remaining fields. For example, an expense type determines if an expense is unit-based,
chargeable, or requires a comment, and may default a payment method and tax liability.

8. Select a Payment Method to apply to the expense. The Reimbursable check box is selected by default if
the payment method associated with the expense is reimbursable.

9. The Expense Currency and Claim Currency for the expense display in the fields. If you are reimbursed in
a different currency, change the claim currency.

10. Select the Tax Liability for the expense.

11. Enter the Expense Amount. Select the Tax Include check box if the expense amount includes tax, or clear
the check box if the amount does not include tax.

12. Enter an Expense Comment if an instruction appears in the Expense Comment Instruction field. Optional
Expense Comment Instructions are associated with the Expense Type, and they define required information
for the expense entry.

Epicor ERP | 10.0.700602

Epicor ERP Application User Guide - Part TwoChapter 12 | Expense Management



13. Navigate to the Expense > Comment > Detail sheet to enter new comments or review existing records. The
comment types are:

• SUB - Submit

• APP - Approve

• REJ - Reject

• INV - Invoice

You can directly enter the Submit  and Approve type
comments. The Reject and Approve comments are
available to view after an approver either rejects or
approves an expense with comment.
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14. Click Save on the Standard toolbar.

15. The application calculates the tax for the expense and the Claim Total Amount displays.

16. Select the Submit on Save check box to automatically submit new expense entries when you click Save.
Selecting or clearing this check box in Time and Expense Entry overrides the default value selected for
the Site.

17. The status of the expense is Entered until you submit it for approval.

18. The AP Invoice ID and AP Invoice Status fields populate when an AP Invoice is created for a reimbursable
expense.

Expense Entry List

Use the Expense > List sheet to quickly enter and submit multiple expense entries; each row is an expense entry.
Fields in this sheet display in a grid format for easy entry. Tab through the fields to enter values.

To enter multiple expenses in the Expense > List sheet:
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1. Navigate to the Expense > List sheet.

2. In the Calendar, select the date you incurred the expense.

3. Click the Down Arrow next to the New button; select New Expense.

4. A new row displays in the Employee Expenses grid. 

5. Enter a Claim Reference number (optional), the Project ID associated with the expense, the Expense
Type, and the Payment Method.

6. Tab to the Expense Amount field and enter the expense amount with tax included.

7. Select the Tax Include check box to indicate the tax is included in the expense amount.

8. Use the scroll bar to review the remaining fields.

9. When you finish, click Save on the Standard toolbar. Repeat these steps to enter more expenses.

10. Select all the expense rows.
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11. Click the Submit button to submit the expenses.

Calendar View Expense Entry

The Calendar sheets display your expense entries for review by day, week, or month. You can also use the
Calendar to enter expenses.

1. Navigate to the Calendar sheet.

2. Select a date in the Calendar section.

3. You can view the Day, Week, or Month for the selected date. Click the Month tab.

4. The Month of the selected date displays with the date highlighted. Right-click and select New Expense.
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5. The Expense > Detail sheet displays.

6. Enter the Expense Type, Payment Method, and Expense Amount. Depending on the configuration of
your application, default values may populate the remaining fields. You can change these values as needed.

7. When you finish, click Save on the Standard toolbar.

Selection Calendar

You can use the expense entry selection Calendar to review and manage your expense entries and the expense
entries of your employees. The selection Calendar determines the expense transactions that display in the expense
entry tree, indicates the status of the transactions, and loads transactions into the expense entry sheets for review.

Menu Path: Service Management > Expense Management > General Operations > Time and Expense Entry
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1. On the Employee sheet, enter your Employee ID. By default, the current date is selected in the Calendar. 

2. Review the selection Calendar. If a number has a color, it indicates a transaction is entered on this date:

• Yellow - Expense transaction

• Green - Time transaction

• Blue - Both a Time and Expense transaction

• Red - Rejected transaction

3. Select a date in the selection Calendar to review expense transaction details. You can click and drag to
select and view multiple dates.

4. In the Tree View, expand the My Expenses node to see the transactions. Icons indicate the status of a
transaction. In this example, the transaction entered on 01/11/2010 has a Submitted status for approval as
indicated by the icon with the blue S. Other transaction statuses include Entered, Partially Approved, and
Approved.

5. In the tree, select a date.
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6. The transaction details for that day display on the Expense > Detail sheet.

7. Click the List tab to view a list of each expense entry. Each entry for the dates selected in the Calendar
displays in a separate row. Use the scroll bars to review the details.
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8. Click the Calendar tabs to view entries in the calendar. You can select Day, Week, or Month. In this
example, the entries display in the weekly calendar. Move your mouse over an entry to view details.

9. Click the Approvals tab to see who is assigned to approve the transaction.
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10. Click the Tax tab to view details of the tax amounts included in an expense transaction.

Expense Group

Use Expense Group Maintenance to attach a document to expenses grouped by a claim reference number. You
can attach a document that includes a list of scanned receipts associated with the same claim reference number.
The AP invoice includes a link to the expense group where other users, such as AP clerks, can review the receipts
document before issuing the AP invoice.

This program uses the Enterprise Content Management
functionality. This toolset defines types of files you can attach
to records and the third-party applications that can display
these files. For more information about this functionality, refer
to the Enterprise Content Management chapter in the Epicor
ERP Implementation Guide and the application help.

Menu Path: Service Management > Expense Management > General Operations > Expense Group

To attach a document to an expense group:

1. On the Detail sheet, click the Employee button to find and select your employee ID number.

2. Click the Expense Group button to find and select the claim reference number for the group of expenses.

3. Click the Attachments button on the Standard toolbar.
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4. The Attachments sheet displays.

5. Click the New button.

6. The Attachment Management window displays.

7. Select the kind of document you wish to attach from the Doc Type drop-down list.

8. Click the Browse button to find and select the file you wish to attach.

9. Enter the Title of the document you will link to the expense group.

10. Click OK.

11. The document is now attached to the expense group. It displays within the Attachments grid.

12. You can remove the document by selecting it on the grid and clicking the Delete button.

13. To display the file within its associated third-party application, select the file and click the View button.

14. When you finish, click Save.
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Expense Entry Search – Claim Reference

Use the Expense Entry > Search sheet to search for a group of expense transactions by a user-defined claim
reference number or an accounts payable invoice number. The search retrieves the expenses that match your
criteria in a read-only format. You can use the search results to reconcile submitted expenses with an invoice you
have received from your accounts payable department.

Menu Path: Service Management > Expense Management > General Operations > Time and Expense Entry

1. On the Employee sheet, enter the Employee identifier or click the Employee ID button to find and select
the employee for whom you are entering an expense.

2. Navigate to the Expense > Search sheet.

3. Click the Expense Search button.
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4. In the Employee Expense Search window, enter the claim reference number you assigned to your group
of expenses. The expenses associated with the claim reference number display in the Search Results grid.

5. To select all the expenses in the claim, click Select All and then click OK.

6. On the Expense > Search sheet, scroll to the Total Claim Amount field, right-click, and select Show
Summaries.
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7. Right-click the Summation symbol, select Sum, and click OK.

8. The Total Claim Amount displays. Compare this amount with the total on your invoice. If the totals match,
all expenses in the claim have been approved and processed.

9. If the totals do not match, you can scroll to the Invoice field and verify that each expense in the claim has
an invoice number. If an invoice number is missing, the expense may not have been processed.

Approval Workflow

Configure the application to define an approval workflow for expense transactions entered by employees and
submitted for approval in Expense Entry. You can define expense approval workflows for both indirect expenses
and project expenses.

You define approval workflows for indirect expenses through Site Configuration Control. Once you set an option
to require approvals for expense transactions, you then define the approval method as Automatic or Employee.
If you define an approval method as Employee, additional setup is required in several programs, including Employee
Maintenance.

Supervisor approval is the default approval workflow for the application when approvals are required. To use
this approval workflow, you select the Approval Required check box in Site Configuration Control.
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When a workflow uses Employee as the approval logic method and you want to designate a group of employees
as approvers, you must also set up an expense workflow group for approving expense transactions. A workflow
group contains the tasks, task sets and group members assigned to an approver role. Once you create an expense
workflow group, you can associate it with a specific employee in Employee Maintenance, or you can set it as the
default expense workflow group in Site Configuration Control to apply it to all employees.

An approval workflow for project expenses is similar to a
workflow for indirect expenses, except that you have the
additional option to use a workflow defined on a project or a
project Work Breakdown Structure (WBS) phase. Also, the
approval logic, or method, used for project expenses is set on
the project instead of in the Site Configuration Control
program.

A graphical representation of the approvals workflow for indirect expenses is found within the chapter concerning
Time Management - Approval Workflow section.

To help define an expense approval workflow, includes pre-defined approval workflow groups are available to
use as templates to define an expense workflow. These pre-defined workflow groups include the roles, task type,
and task sets. Available workflow groups:

• Supervisor Approval

• Project Manager Approval

• Project Manager & Supervisor Approval

• Multiple Level Approval

If you use the Multiple Level Approval workflow group as your template, assign group members to the approval
roles in Workflow Group Maintenance. If you use the workflow groups Supervisor Approval, Project Manager
Approval, or Project Manager & Supervisor Approval as your template, you do not assign group members to the
approval roles in Workflow Group Maintenance because the application uses the supervisor of the employee
and/or the project manager of the project as approvers.

Before you can use the pre-defined workflow groups, you must first set up your Site to require approval for
expense transactions by selecting the Approval Required check box in the Site Configuration Control > Expense
sheet.

You can define expense approval workflows using a pre-defined
workflow group template or manually defining your own
workflow group. This chapter describes how to create a
workflow using a pre-defined workflow group template. The
process for creating approval workflows without using a
pre-defined workflow group template is discussed in the Time
Management chapter.

Tasks

An approval task is a combination of a task and a corresponding approval role. Different roles are used in the
different workflow groups. The following example shows the approval roles in the pre-defined approval workflow
groups.

Roles

Each approval task requires an approver role code.

Menu Path: Service Management > Expense Management > Setup > Role Code
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1. Notice the selected role includes a Role code identifier and a Description.

2. The selected check box in the Time and Expense Options section identifies the role as the Time and
Expense Approval role. The Time and Expense Approval role is used for the First Approval role and the
Second Approval role.

If you select more than one approver role option, tasks
will be created for all individuals matching those role
criteria.

Tasks

The following example shows the approval tasks in the pre-defined approval workflow groups. Different tasks
are used in the different workflow groups.

Menu Path: Service Management > Expense Management > Setup > Task

1. Notice the required role code of First Approval is assigned to the corresponding First Approval task.
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2. The required Task Type is Time & Expense Approval.

3. Select the Mandatory check box to indicate the task is required.

4. Select the Any Approver  check box to assign multiple approvers to the role, but you only want to require
one of them to approve a transaction. Clear the check box to require all users in the role to approve a
transaction.

Task Sets

A task set is a group of organized tasks and milestones. An expense approval task set includes all the approval
tasks required to approve an expense transaction.

Menu Path: Service Management > Expense Management > Setup > Task Set

The example here shows the pre-defined task sets used by the four pre-defined approval workflow groups.

1. Click the Down Arrow next to the New button; select New Task Set..

2. Enter a task Set ID and a Description for the task set.

3. Click the Workflow Type  drop-down list and select Time & Expense.

4. Click Save on the Standard toolbar.

5. Add milestones for each approval task included in the task set. To do this, add a new milestone for each
task in sequential order, such as First Approval and Second Approval.
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6. Select the First Milestone check box for the milestone that begins the series.

7. Click Save after adding each new milestone.

8. On the second milestone, clear the First Milestone check box .

9. Associate each milestone with the next milestone. To do this, select the First Approval Task milestone.

10. Click the Down Arrow next to the New button; select New Next Milestone .

11. The Milestones > Next Milestones > Detail sheet displays.

12. Click the Next Milestone drop-down list and select the Second Approval Task.

13. Click Save.
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14. When you finish, the task set structure is defined in the Task Sets tree.

Workflow Group

An expense approval workflow group consists of an approval task set and the group members assigned to the
approver roles. You assign group members to the roles in Workflow Group Maintenance.

You can copy a pre-defined workflow group, re-name it, and
edit it as needed to quickly create other workflow groups.

The next example applies only to the pre-defined Multiple Level Approval workflow group. If you use one of the
other pre-defined groups, you do not need to assign group members because the application uses the employee
supervisor and/or the project manager. After you assign group members to the pre-defined approval workflow
group, you associate the workflow group with a specific employee in Employee Maintenance or you apply the
workflow group to all employees by setting it as the default in Site Configuration Control. You can also associate
the workflow group with a specific project or WBS phase in Project Entry.

Menu Path: Service Management > Expense Management > Setup > Workflow Group

To assign group members to the pre-defined Multiple Level Approval workflow group:

1. Navigate to the Detail sheet.

2. In the Workflow Type field, select Time & Expense. 
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3. Click the Workflow Group button to find and select the Multiple Level Approval workflow group.

4. The Description and Default Task Set fields are populated with the required values.

5. Click the Down Arrow next to the New button; select New Group Member.

6. The Group Member > Detail sheet displays. 

7. In the Member field, select the employee you want to add to the workflow group.

8. In the Role field, select the approval role you want to assign to the group member from the approval task
set.

9. When you finish, click Save on the Standard toolbar.

10. To continue to add members to the workflow group, repeat steps 5-9 but a select different Member and
Role from the drop-down menu.

Workflow Setup Example – Indirect Expenses

The following example defines an approval workflow for indirect expenses. This workflow uses Employee as the
approval method for expense transactions, and it applies a specific expense workflow group to a specific employee.

Site Configuration Control

Menu Path: System Setup > Company/Site Maintenance > Site Configuration

This program is not available in the Epicor Web Access.

1. Click the Site button to find and select the Site you need.
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2. The Name of the selected Site displays for your information. 

3. Navigate to the Modules > Time and Expense > Expense sheet.

4. Select the Approval Required check box to require approval of all expense entries submitted by employees.

5. Select the method for approving indirect expense transactions in the Indirect Approval Logic field. Select
Employee to approve expense transactions as defined in Employee Maintenance.

6. If desired, select an optional default Expense Workflow Group.

7. When you finish, click Save on the Standard toolbar.

Employee Maintenance

Menu Path: Service Management > Expense Management > Setup > Employee
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1. On the Detail sheet, click the ID button to find and select the employee record you need. 

2. Clear the Auto Approve Expenses check box.

3. In the Expense Group field, select the expense approval workflow group Multiple Level Approval.

4. When you finish, click Save on the Standard toolbar.

Indirect expense transactions submitted for approval by this employee are sent to the employees who belong to
the Multiple Level Approval workflow group for approval.

Link Workflows to a Project

Through Project Entry a user is able to define an approval process for expense transactions entered by employees
on a project WBS phase.

Menu Path: Service Management > Expense Management > General Operations > Project Entry
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The example below displays how to link one of the predefined workflows to a project.

1. Click the Project button and select the project to assign the workflow.

2. Navigate to the WBS > Approvals > Expenses > Detail sheet.

3. In the Approvals Method drop-down list, select Project.

4. Click the Workflow Group button, search for and select the Workflow Group to assign.

5. The Approval Task Set and Description fields automatically populate.

6. Navigate to the Approval Tasks sheet to review the workflow.

7. Click Save and exit Project Entry.
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Expense Approval

Use the Time and Expense Approval program to review, approve, or reject expense transactions submitted by
employees. Depending on the configuration of your company, authorized approvers can modify submitted
transactions, or delete existing transactions during the approval process. Approvers can enter optional comments
for review by the submitters of the transactions.

Menu Path: Service Management > Expense Management > General Operations > Time and Expense Approval

To approve expense transactions:

1. On the Approver sheet, enter your Approver ID or click the Approver ID button to find and select your
ID. Your approver ID is the Workforce ID assigned to you in Work Force Maintenance.

2. All expense transactions submitted by employees for your approval display on the Expense > List sheet;
each expense transaction displays on a separate row.

3. Use the Expense > Comments sheet to review any comments entered by the submitter.

4. Select the row you want to approve; or, click the Select All button to select all rows for approval.

5. To approve the transaction(s) without entering comments, click the Approve button.

6. To enter comments for the  submitter, click the Approve With Comment button.

7. Use the Search button on the Standard toolbar to search for transactions.
This buttons allows an approver to search for time transactions that were already approved or rejected. This
is useful if the a time transaction was approved or reject erroneously.

Once the transaction is approved, it no longer displays in the grid.

Reject Expense Transactions

To reject expense transactions:
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1. On the Approver sheet, enter your Approver ID or click the Approver ID button to find and select your
ID. Your approver ID is the Workforce ID assigned to you in Work Force Maintenance.

2. Expense transactions submitted by employees for your approval display on the Expense > List sheet; each
expense transaction displays on a separate row.

3. Select the row you want to reject.

4. Navigate to the Approvals sheet to review a list of approvers who have approved this transaction and a
list of pending approvers to approve this transaction. 

5. To reject the transaction without entering a comment, click the Reject button.

6. To reject the transaction and enter an optional comment, click the Reject With Comment button.

7. The Approve/Reject Comment window displays.

8. Enter your comment and click OK.

The transaction is rejected and no longer displays in the window.

Generate AP Invoices for Expenses

Use the Generate AP Invoices for Expenses program to generate AP invoices for reimbursable and company-paid
expenses. After generating invoices, users such as AP clerks can open the invoices in Accounts Payable Invoice

Epicor ERP | 10.0.700626

Epicor ERP Application User Guide - Part TwoChapter 12 | Expense Management



Entry. Once the invoices for reimbursable expenses are posted, they are available for issuing expense payments
to the employees who incurred the expenses. You can also set up the Generate AP Invoices for Expenses program
to run through an automatic recurring schedule.

Menu Path: Service Management > Expense Management > General Operations > Generate AP Invoices for
Expenses

To run the Get Employee Expenses process:

1. On the Selection sheet, click the Inv Group button to find and select the invoice group for which you are
generating invoices. If the group you entered does not exist, the process will create a new group.

2. Leave the From Date and To Date fields clear to generate invoices for all approved expenses. You can enter
a date range in these fields to generate invoices for expenses incurred on or between these dates.

3. Click the Filter tab if you want to limit the generated invoices to specific employees.

4. When you finish, click the Generate Only button on the Standard toolbar.

The application processes the approved expenses and generates AP invoices. When the process is complete, you
can open the invoices in Accounts Payable Invoice Entry.

Reports

This section describes a key report you use to track employee expense transactions. You can run this report
whenever you need. You can also set up the report to generate and print through a regular schedule. Review
the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information on how you link
a report to a recurring schedule.

Employee Expense Report

Use the Employee Expense Report to generate and print a report for project and indirect expenses. You can use
this report to track expenses or to attach to receipts and other expense documentation to submit to the Accounts
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Payable department for expense reimbursement. This report can be executed for you and any employees that
report to you.

The Expense Management module includes an Employee Expense Report to help you manage your employees’
expenses and your own.

Menu Path: Service Management > Expense Management > Reports > Employee Expense

To set up and run this report:

1. In the Report Options area, specify the time frame to include in the report.

2. If desired, enter the Claim Reference Number or AP Invoice Number associated with the expenses.

3. Select the Expense Statuses you wish to include in the report.

4. Use the Filter sheet to find and select the ID of the employee whose expenses you want to review. You can
select one or more employees.

5. When you finish, click Print on the Standard toolbar.
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Chapter 13: Deferred Revenue Accounting

Use the Deferred Revenue Accounting module to recognize deferred revenue based on user-defined amortization
codes. Deferred revenue stems from the accounting concept of revenue recognition, under which revenues are
recognized only when the earnings process is complete.

If funds are received and no goods or services were provided, the process is incomplete and revenue cannot be
recognized. In this case, a deferred revenue liability is recorded. Specifically, the deferred revenue account is credited
and cash, or other assets, are debited.

The application’s deferred revenue functionality is flexible and allows you to update posted deferred revenue invoices,
simultaneously place multiple amortization periods on hold, and easily and accurately recognize revenue for your
company.  Deferred revenue can be enabled for a customer, product group, service contract, and Accounts Receivable
invoice line.

Reports in the module offer various views of revenue recognition and amortization details. The DRA Forecast Report
displays a forecast of revenue that will be recognized in future amortization periods. The DRA Reconciliation Report
provides the data to review discrepancies between revenue that should be posted on a specified date and the actual
date when revenue is recognized. The report details are sorted by GL account.

Setup

This section describes the setup programs within the Deferred Revenue Accounting module. These programs are
contained within the Setup folder for this module. You can also review the Company Configuration chapter of
the Epicor ERP Implementation Guide for more information.

Deferred Revenue Accounting

Use the Deferred Revenue Accounting functionality to determine how and when you recognize deferred revenue.
This section contains an overview of the main setup options.

Fiscal Calendar Maintenance

Use Fiscal Calendar Maintenance to create and edit fiscal calendars. You can use a fiscal calendar to structure
amortization recognition dates. For example, to recognize revenue on a weekly basis, you can set up a fiscal
calendar with weeks as periods. Revenue will then be recognized at the end of every week.

Note that the fiscal calendar defined for revenue amortization and selected for the Revenue Amortization Code
does not have to be the same fiscal calendar used for the GL books. However, a fiscal calendar defined for revenue
amortization can be used only to generate amortization periods based on amortization dates. Once the amortization
periods are generated, the posting engine defines which periods are affected in the GL books.

Create a Fiscal Calendar

Menu Path: Financial Management > Deferred Revenue Accounting > Setup > Fiscal Calendar

To create a fiscal calendar:
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1. Click New on the Standard toolbar.

2. Enter a Calendar identifier for this record. This identifier displays within other programs and reports.

3. Enter a Description for the fiscal calendar. Use this text to help explain the purpose of the fiscal calendar.

4. Click the Down Arrow next to the New button; select New Fiscal Year.

5. The current year displays in the Fiscal Year field  and the current date displays in the Start Date field for
the first fiscal year of the fiscal calendar.

6. If you want to add a suffix to differentiate the fiscal year, for example, by a quarter, enter a Year Suffix.

7. Select the End Date of the fiscal year. There is no default value for this field.

8. Enter the Number of Periods you want to allocate for the fiscal year. The default value is the number of
periods on the previous fiscal year. If a previous fiscal year does not exist, the default value is 0, but you
must select a number of 1 or greater.

9. Click Save on the Standard toolbar.

10. From the Actions menu, select Generate Periods.
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11. The Generate Periods window displays.

12. The Year and Start Date fields are filled in with the information you entered when you created the fiscal
year.

13. If necessary, complete the End Date and Period Duration fields. The default value of Period Duration is
1.

14. Click Generate.

Fiscal periods are used to structure amortization and
revenue recognition dates.

15. Verify that the message displays the correct number of fiscal periods created and click OK.

16. When you finish, click Save.

Revenue Amortization Code

Use Revenue Amortization Maintenance to define the amortization duration, amortization period frequency, and
recognition amount for each period.

Available amortization calculation methods:

• Equal Amounts – Use the equal amount calculation method to calculate the same amount for each
amortization period.

• Last Period – Use the last period calculation method to recognize 100% of the revenue amount in the last
amortization period.
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• Actual Days – Use the actual days calculation method to recognize revenue based on the number of days
in the period and not on a fixed percentage basis. The revenue distribution depends on the invoice date and
the number of periods in the amortization schedule.

Review application help for the equation used to calculate the
Actual Days method.

Once a revenue amortization code is created, the code can be used to enable default amortization details assigned
to a specific product group, customer, or service contract code. For example, you enable deferred revenue billing
for Dalton Manufacturing. When you create an invoice for this customer, the Defer check box is selected
automatically and the RA code linked to the customer record displays.

Create a Revenue Amortization Code

Menu Path: Financial Management > Deferred Revenue Accounting > Setup > Revenue Amortization Code

To create a revenue amortization code:

1. Click New on the Standard toolbar.

2. Enter an RA Code identifier.

3. Add a Description for the code.

4. Select the appropriate Fiscal Calendar.

5. In the Duration field, enter the number of fiscal periods over which the schedule is amortized.

6. Select the Use Contract Expire Date check box if you want the amortization period duration to use the
contract expire date for the calculation.

7. Click the Calculation Method drop-down to define how revenue is recognized. Available options:

• Equal Amounts - the same amount is recognized during each period.

• Last Period- revenue is recognized only in the last period.

• Actual Days - the revenue amount is based upon the number of days within a period.

8. Click Save.
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Customer Maintenance

Use Customer Maintenance to set up invoicing defaults for a customer.

Menu Path: Financial Management > Deferred Revenue Accounting > Setup > Customer

Enable DRA Billing

To enable deferred revenue billing for a customer, do the following:

Menu Path: Financial Management > Deferred Revenue Accounting > Setup > Customer

1. Click the Customer field and select the customer for who you want deferred revenue billing set up.

2. Customer details display in the Customer Address and Territory panes.
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3. Navigate to the Billing > Detail sheet.

4. Select the Deferred Revenue check box.

5. Select a schedule from the RA Schedule drop-down menu that is now enabled.

6. Click Save.

Operations

This section details the operations you can use within the Deferred Revenue Accounting module. Operation steps
are described as a workflow to help guide you through the process from start to finish. These programs are
primarily found within the General Operations folder for this module.

AR Invoice Entry

Use AR Invoice Entry to enter and post a deferred revenue invoice line.

Create a Group

Menu Path: Financial Management > Accounts Receivable > General Operations > Invoice Entry

To create a group:
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1. Click New on the Standard toolbar.

2. Enter a Group identifier.

3. Select the Invoice Date and Apply Date.

4. Click Save.
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5. Click the Down Arrow next to the New button; select New Miscellaneous Invoice.

You can apply deferred revenue to all invoices in AR
Invoice Entry. For the purpose of this guide, the deferred
revenue is applied to a miscellaneous invoice.

6. Select the appropriate Sold To Customer.
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7. Click the Down Arrow next to the New button; select New Line.

8. Enter a Part/Rev and a Description for the deferred revenue line.

9. Enter a Quantity and Unit Price.

10. Select the Defer check box.

11. Select the RA Code for the invoice line. This code is used to schedule amortization dates and revenue
recognition.

Depending on the product group, customer, or service
contract selected for the invoice, the revenue amortization
(RA) code may default. The default RA code is set up in
Product Group Maintenance, Customer Maintenance,
and Service Contract Code Maintenance respectively.
 Note you can modify the default deferred revenue
settings at the invoice line level.

12. If required, in the End Date field, enter a date to override the default end date for the amortization schedule.

If the invoice line is for a service contract and the Use
Contract Expire Date check box is selected in Revenue
Amortization Maintenance, the End Date field populates
with the Expire Date field from the service contract.

13. Click the Get Defaults button to pull in the default GL account.
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14. Click Save on the Standard toolbar.

15. The Generate Amortization Schedule window displays.

16. Click Yes to create a schedule.

Generate and Review Amortization Schedule

Do the following to generate an amortization schedule and review using the AR Invoice Action menu:

1. You can also generate a revenue amortization schedule from the Actions menu by selecting Line > Revenue
Amortization > Generate Revenue Amortization Schedule.

2. Navigate to the Line > Amortization sheet.

3. Review the generated amortization schedule for the invoice line that displays in the Revenue Amortization
Schedule grid.

4. You can update revenue amortizations “on the fly,” for example, by updating the Percent and Amount
fields.
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5. Use the Actions > Line > Revenue Amortization > Restore Amortization Schedule command to restore
the schedule back to the original from the revenue amortization code.

If there is a rounding difference, the difference is
recognized in the last amortization period. The
application’s logic always calculates the percentage first
and then multiplies the percentage by the revenue
amount.

6. The original schedule displays on the Revenue Amortization Schedule grid.

7. From the Actions menu, select Group > Post.
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8. The AR Invoice Post Process window displays.

9. Click Submit.

Revenue Recognition

Use Revenue Recognition to recognize revenue for selected amortization periods.

From the Actions menu, select Get Amortizations to populate the Amortizations grid with available invoices.
When the process is submitted, the appropriate GL journals are created and revenue moves from the deferred
revenue account to the corresponding sales account.

Recognize Revenue

Menu Path: Financial Management > Deferred Revenue Accounting > General Operations > Revenue Recognition

To recognize revenue:

1. On the Detail sheet, in the As of Date field, select the appropriate date.
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2. Navigate to the Filter sheets to filter revenue recognition by Customer, AR Invoice, or Service Contract.

3. On the Detail sheet, from the Actions menu, select Get Amortization.

4. Available records display in the Amortizations grid.

5. From the Actions menu, select Edit List.
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6. The Deferred Revenue Recognition - Edit List window displays.

7. Click Print Preview. Review the edit list, then close it and exit the Deferred Revenue Recognition - Edit List
window.

8. Click Submit.

9. The records clear from the Amortizations grid.

AR Invoice Tracker

Use the AR Invoice Tracker to view revenue amortization schedules and the status of revenue amortization periods.
Amortization periods can be unposted, posted, or on hold. If applicable, a hold Reason and Hold Text display.

View Revenue Amortization Information

Menu Path: Financial Management > Deferred Revenue Accounting > General Operations > Invoice Tracker

To view revenue amortization information:
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1. In the Invoice field, enter or search for and select the correct invoice.

2. Navigate to the Line > Amortization sheet.

3. In the Recognized field, view the amount of recognized revenue for the invoice line.

4. Use the Revenue Amortization Schedule grid to view the status and details of amortization periods.
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Posted Invoice Update

Use Posted Invoice Update to review and modify revenue amortization schedules for posted invoices. You can
edit amortization dates and percentages for posted invoices. You can also apply deferred revenue accounting to
posted invoices which are not currently set to defer revenue.

Update a Posted Invoice

Menu Path: Financial Management > Deferred Revenue Accounting > General Operations > Posted Invoice
Update

1. In the Invoice field, enter or search for and select the correct invoice.
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2. Navigate to the Line > Amortization sheet.

3. In the Revenue Amortization Schedule grid, you can change the Amort Date, Percent or the Amount for
the periods, if required. In order to change a scheduled amortization date, the new date must fall within
the same period.

4. Select the Hold check box to place a period on hold. If a period is on hold, it is not recognized until the
Hold status is removed.

5. In the Reason field, select a reason code for the period on hold.

If an amortization period has been recognized, no changes
can be made to the date or percentage. However, you
can update dates and percentages for remaining,
unrecognized periods in the amortization schedule.

6. When you have made all required changes, click Save.
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Apply Deferred Revenue to a Posted Invoice

1. If you want to defer revenue for a posted invoice which is not currently set to use deferred revenue, navigate
to the Line > Detail sheet.

2. Select the Defer check box.

3. Select the RA Code for the invoice line.

4. Click Save on the Standard toolbar.

5. The Generate Amortization Schedule window displays.

6. Click Yes to the message that displays to generate a schedule.
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7. From the Actions menu, select Revenue Amortization > Post to Deferred Revenue.

8. The Posted Invoice Update Posting window displays.

9. Click Submit. This action clears the Sales account, and charges the Deferred Revenue account.

Hold / Unhold Amortization Periods

Use Hold / Unhold Amortization Periods to place a number of amortization periods on hold. Revenue is not
recognized for periods that are on hold. Enter a hold reason and necessary text that relates to the hold.

Place Amortization Periods on Hold

Menu Path: Financial Management > Deferred Revenue Accounting > General Operations > Hold/Unhold
Amortization Periods

To place amortization periods on hold:

1. Select the appropriate Apply Date.The current date displays as default.
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2. Select a Hold Reason and enter the description in the Hold Text field. If you disable the Hold check box
for a period, the Hold Reason field automatically clears.

The reason codes available to place revenue amortization
periods on hold are created in Reason Code Maintenance.
To create a hold reason, select Deferred Revenue as the
Reason Type in Reason Code Maintenance.

3. If necessary, use the Filter sheet to narrow hold processing results.

4. On the Selection sheet, select a Get Amortization Option. Available options:

• All Records

• All Records On Hold

• All Records Not On Hold

5. From the Actions menu, select Get Amortizations.

6. In the Amortization Periods grid, select the Selected check box for the invoice amortization periods you
want to place on hold.

7. Click Submit. The records clears from the Amortizations grid.
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8. If necessary, navigate to the AR Invoice Tracker’s Line > Amortization sheet.

9. Verify the amortization periods were put on Hold.

Reports

This section describes some key reports you can use to review deferred revenue transactions. You can run these
reports whenever you need. You can also set up each report to generate and print through a recurring automatic
schedule. Review the Automatic Data Processing chapter in the Epicor ERP Implementation Guide for information
on how to link a report to a recurring schedule.

DRA Forecast Report

Use the DRA Forecast Report to review a forecast of the revenue to be recognized in future periods. The report
is grouped by invoice.  You can view the line number, total revenue of the invoice, and amount remaining to be
recognized for the invoice.

Four columns, or buckets, display for each report (for example, 06/30/2016, 07/31/2016, 08/31/2016, and
09/30/2016). You can view the amount to be recognized for each of the four columns and the Period Total which
reflects the total deferred revenue to be recognized in the period. You can view the grand total of deferred
revenue for the report date range and the total amount to be recognized in each date column.

Print a Forecast Report

Menu Path: Financial Management > Deferred Revenue Accounting > Reports > DRA Forecast

To print a forecast report:
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1. Select the As of Date for the report. This field defines the date of the report.

2. Select the Report Periods for the report.

3. Select a Hold Period Option for this report. Available options:

• Exclude On Hold

• Include On Hold

• Only On Hold

If necessary, use the Filter sheet to narrow the report
processing results by Customer or RA Code. You can then
select your Filter Summary options in the Selection sheet.

4. Select the Schedule to run the report. Select the Recurring check box to run the report on a repeated
basis. This check box is only available if a schedule other than Now is selected.

5. Select the Archive Period for which you would like to keep the report in the System Monitor for possible
reprinting. The default is 0 days and this report is deleted from the System Monitor shortly after it has been
printed.

6. Select a User Description explaining a specific run of the report. This description displays in the System
Monitor. This field is useful if you need to distinguish between scheduled runs of the same program. For
example, John's Monday Production Program.

7. Click Print to print the report.

DRA Reconciliation Report

Use the DRA Reconciliation Report to review discrepancies between revenue that should be posted at a specified
date and the actual date when the revenue is recognized. The account details are sorted by general ledger
account.

Four columns, or buckets, display on each report. You can view the amount to be recognized for each of the
four columns and a Period Total which reflects the total deferred revenue to be recognized in the period.
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Print a Reconciliation Report

Menu Path: Financial Management > Deferred Revenue Accounting > Reports > DRA Reconciliation

To print a reconciliation report:

1. Select the Book for which the report will print.

2. Select the As of Date. This field defines the date of the report.

3. Select the Report Periods for the report.

4. Select the Display Details check box if you want customer and invoice details on the report.

5. Select a Hold Period Option for this report. Available options:

• Exclude On Hold

• Include On Hold

• Only On Hold

If necessary, use the Filter sheet to narrow the report
processing results by Customer or RA Code. You can then
select your Filter Summary options in the Selection sheet.

6. Select the Schedule to run the report. Select the Recurring check box to run the report on a repeated basis.
This check box is only available if a schedule other than Now is selected.

7. Select the Archive Period for which you would like to keep the report in the System Monitor for possible
reprinting. The default is 0 days and this report is deleted from the System Monitor shortly after it has been
printed.

8. Select a User Description explaining a specific run of the report. This description displays in the System
Monitor. This field is useful if you need to distinguish between scheduled runs of the same program. For
example, John's Monday Production Program.

651Epicor ERP | 10.0.700

Deferred Revenue Accounting | Chapter 13Epicor ERP Application User Guide - Part Two



9. Click Print to print the report.
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part maintenance 20, 99

655Epicor ERP | 10.0.700

IndexEpicor ERP Application User Guide - Part Two



part price history report 79
parts 142
pay method 486
payment entry 448
payment entry – bank 450
payment entry – bank fee 517
payment entry – bank fees 455
payment entry – group 448, 510
payment entry – invoice payments 451, 515
payment entry – miscellaneous payments 454
payment entry – new payments 449, 514
payment entry – post payments 459, 520
payment entry – process payments 518
payment entry – processing payments 458
payment entry – processing pre-payments 457
payment entry – select invoices 452, 511
payment instrument batch generation 370
payment instrument payable entry 436
payment instrument payable entry - group 436
payment instrument payable entry - header 437
payment instrument payable entry – bank fees 439
payment instrument payable entry – invoice detail 439
payment instrument receivables entry 373
payment instrument status maintenance 369
payment instrument statuses 443
payment instrument type maintenance 368
payment instrument write off 447
payment instruments 368, 436
payment instruments - group 373
payment instruments - header 374
payment instruments – bank fees 375
payment instruments – invoice selection 375
payment instruments status change 377
payment method 594
payment proposal report 466, 535
payment terms 319
petty cash desk maintenance 488
petty cash desk maintenance – available operations 490
petty cash desk maintenance – detail 488
petty cash entry 521
petty cash entry – legal number 523
petty cash entry – petty cash document 521
petty cash entry – post statement 524
petty cash operation type 486
phantom pack out 249
place amortization periods on hold 647
posted invoice update 644
primary allocation code setup 538
print a forecast report 649
print a reconciliation report 651
print petty cash day book 536
print petty cash documents 536
print rma 275
print the job pick list 165
purchase order - miscellaneous charges 48
purchase order - releases 46
purchase order entry 40
purchase order suggestions 56
purchase orders - lines 41, 43
purchase orders – inspection plans 44
purchase points 27, 28
purchase terms 62

purchasing terms 397

Q

qualified manufacturers 163
quick entry codes 597

R

reason code maintenance 82
rebuild display gl account 570
receive an rma 275
receive material into inventory 171
receive materials 257
receive materials directly to a job 257
receive materials from a combined shipment 259
receive transfer order 267
received not invoiced report 464
recognize revenue 640
recurring cycle maintenance 321, 398
reject expense transactions 625
relationship class 324
reminder group maintenance 338
reminder letter generation 340
replenishment workbench 174
reports 79, 138, 207, 281, 313, 392, 463, 534, 584, 627, 649
request a credit for returned material 277
restrict entry 594
return material 171
return material authorization (rma) processing 272
return miscellaneous material 172
revenue amortization code 631
revenue recognition 640
reverse allocation history 554
reverse cash receipt 391
review journal 566
review new purchase orders 60
review purchase order suggestions 57
rfq entry 35, 158
rma disposition 278
rma line 273
rma summary 273
roles 616

S

sales (customer) company - enter sales order 66
sales (customer) company - receive completed items from
manufacturing (supplier) company 74
sales (customer) company – accept purchase order suggestions
72
sales (customer) company – create purchase order from purchase
order suggestions 68
sales (customer) company – generate purchase order suggestions
67
sales company – manufacturing company scenario 61
sales gross margin report 394
sales order pick list report 219
scheduled shipments report 217
select the part 37
select the suppliers 38
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selection calendar 607
serial matching 178
serial number format 145
serial number tools 178
serial number tracker 179
serial shipment container codes 224
setup 18, 81, 142, 212, 272, 283, 319, 396, 477, 538, 556, 
589, 629
ship items to customers 217
ship parts to a customer 219
ship subcontract items from a job 237
ship via 213
simulated gl allocations 552
Site configuration 589
Site configuration control 621
sites (counts) 188
sites (parts) 150
skip lot control code 98
source account setup 540
specification 86
spread code maintenance 287
stage ship confirm (master pack out) 248
stage ship confirm (phantom pack out) 253
standard pack out 243
stock status report 207
submit for approval 49
supplier maintenance 24, 399
supplier maintenance – banks 403
supplier maintenance – language, tax and general information
400
supplier maintenance – rohs, gl control and tax exemptions 401, 
402
supplier maintenance (inter-company setup) 63
supplier price history report 80
supplier price lists 30
supplier response and / or supplier price list 159
supplier responses 39
supplier shipment classes 215
supply side cross reference 156

T

target account setup 542

task sets 618
tasks (approval workflow) 616
tasks (pre-defined approval workflow) 617
tax report - post 474
tax report – detail 470
tax report – electronic report maintenance 475
tax report – print edit list 473
tax report – print form 472
tax report – vat tax journal report 476
test the inputs 95
time phased material requirements report 209
training course maintenance 133
training course schedule maintenance 135
transfer opening balances to next year 574
transfer order entry 264
transfer order shipment entry 265
transfer orders 264

U

update a posted invoice 644
update attendance and results 137
update business entity segment values 569
use tax calculation 462
use tax report 469

V

vat tax report 470
verify balances 569
view revenue amortization information 642
void a logged ap invoice 410
void legal numbers 367
void payment entry 461
void spoiled folios 572

W

warehouses 185
work station maintenance 216
workflow group 620
workflow setup example – indirect expenses 621

657Epicor ERP | 10.0.700

IndexEpicor ERP Application User Guide - Part Two



Epicor ERP | 10.0.700658

Epicor ERP Application User Guide - Part TwoIndex



Additional information is available at the Education and
Documentation areas of the EPICweb Customer Portal. To access

this site, you need a Site ID and an EPICweb account. To create an
account, go to http://support.epicor.com.

http://support.epicor.com
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